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Information in this document is subject to change without notice. No part of this document may be
reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, without
the express written permission of:

Sonotron NDT, 4, Pekeris st., Rabin Science Park, Rehovot, Israel, 76702

Covered by the United States patents 5524627, 5952577, 6545681; other US & foreign patents pending
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Sonotron NDT

4, Pekeris str., Rabin Science Park, Rehovot, 76702, Israel

Phone:++972-(0)8-9477701 Fax:++972-(0)8-9477712
http://www.sonotronndt.com

EC Declaration of Conformity

Council Directive 89/336/EEC on Electromagnetic Compatibility, as amended by
Council Directive 92/31/EEC & Council Directive 93/68/EEC

Council Directive 73/23/EEC ( Low Voltage Directive ), as amended by Council
Directive 93/68/EEC

We, Sonotron NDT Ltd., 4 Pekeris Street, Rehovot, 76702 Israel, certify that the product
described is in conformity with the Directives 73/23/EEC and 89/336/EEC as amended

ISONIC 2006

Portable Digital Ultrasonic Flaw Detector and Recorder with
B-Scan, C-Scan, D-Scan, P-Scan, and TOFD Inspection and Imaging Capabilities

The product identified above complies with the requirements of above EU directives by
meeting the following standards:

Safety
EN 61010-1:1993
EMC
EN 61326:1997
EN 61000-3-2:1995 /A1:1998 /A2:1998 /A14:2000
EN 61000-3-3:1995

DNV Cortification B.V,, The Nathardands:
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Sonotron NDT

4, Pekeris str., Rabin Science Park, Rehovot, 76702, Israel
Phone:++972-(0)8-9477701 Fax:++972-(0)8-9477712
http://www.sonotronndt.com

Declaration of Compliance

We, Sonotron NDT Ltd., 4 Pekeris Street, Rehovot, 76702 Israel certify that the product
described is in conformity with National and International Codes as amended

ISONIC 2006

Portable Digital Ultrasonic Flaw Detector and Recorder with
B-Scan, C-Scan, D-Scan, P-Scan, and TOFD Inspection and Imaging Capabilities

The product identified above complies with the requirements of following National and
International Codes:

e ASME Section | — Rules for Construction of Power Boilers

e ASME Section VIII, Division 1 — Rules for Construction of Pressure Vessels

e ASME Section VIII, Division 2 — Rules for Construction of Pressure Vessels. Alternative
Rules
ASME Section VIII Article KE-3 — Examination of Welds and Acceptance Criteria
ASME Code Case 2235 Rev 9 — Use of Ultrasonic Examination in Lieu of Radiography
Non-Destructive Examination of Welded Joints — Ultrasonic Examination of Welded
Joints. — British and European Standard BS EN 1714:1998
Non-Destructive Examination of Welds — Ultrasonic Examination — Characterization of
Indications in Welds. — British and European Standard BS EN 1713:1998
Calibration and Setting-Up of the Ultrasonic Time of Flight Diffraction (TOFD)
Technique for the Detection, Location and Sizing of Flaws. — British Standard BS
7706:1993
WI 00121377, Welding — Use Of Time-Of-Flight Diffraction Technique (TOFD) For
Testing Of Welds. — European Committee for Standardization — Document # CEN/TC
121/SC 5/WG 2 N 146, issued Feb, 12, 2003
Non-Destructive Testing — Ultrasonic Examination — Part 5: Characterization and Sizing
of Discontinuities. — British and European Standard BS EN 583-5:2001
Non-Destructive Testing — Ultrasonic Examination — Part 2: Sensitivity and Range
Setting. — British and European Standard BS EN 583-2:2001
Manufacture and Testing of Pressure Vessels. Non-Destructive Testing of Welded
Joints. Minimum Requirement for Non-Destructive Testing Methods — Appendix 1 to
AD-Merkblatt HP5/3 (Germany).— Edition July 1989
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FCC Rules

This ISONIC 2006 ultrasonic flaw detector and data recorder (hereinafter called ISONIC 2006) has been tested and found to comply
with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try
to correct the interference by one or more of the following measures:

. Reorient or relocate the receiving antenna

. Increase the separation between the equipment and receiver

. Connect the equipment into an outlet on a circuit different from that to which the receiver is connected

. Consult the dealer or an experienced radio/TV technician for help

Safety Regulations

Please read this section carefully and observe the regulations in order to ensure your safety and operate the system as intended
Please observe the warnings and notes printed in this manual and on the unit

The ISONIC 2006 has been built and tested according to the regulations specified in EN60950/VDEQ805. It was in perfect working
condition on leaving the manufacturer's premises

In order to retain this standard and to avoid any risk in operating the equipment, the user must make sure to comply with any hints and
warnings included in this manual

Depending on the power supply the ISONIC 2006 complies with protection class | /protective grounding/, protection class IlI, or
protection class IlI

Exemption from statutory liability for accidents

The manufacturer shall be exempt from statutory liability for accidents in the case of non-observance of the safety regulations by any
operating person

Limitation of Liability

The manufacturer shall assume no warranty during the warranty period if the equipment is operated without observing the safety
regulations. In any such case, manufacturer shall be exempt from statutory liability for accidents resulting from any operation

Exemption from warranty
The manufacturer shall be exempt from any warranty obligations in case of the non-observance of the safety regulations
The manufacturer will only warrant safety, reliability, and performance of the ISONIC 2006 if the following safety regulations are closely

observed:

. Setting up, expansions, re-adjustments, alterations, and repairs must only be carried out by persons who have been authorized by
manufacturer

e  The electric installations of the room where the equipment is to be set up must be in accordance with IEC requirements

e  The equipment must be operated in accordance with the instructions

e  Any expansions to the equipment must comply with the legal requirements, as well as with the specifications for the unit concerned

. Confirm the rated voltage of your ISONIC 2006 matches the voltage of your power outlet

e  The mains socket must be located close to the system and must be easily accessible

. Use only the power cord furnished with your ISONIC 2006 and a properly grounded outlet /only protection class I/

. Do not connect the ISONIC 2006 to power bar supplying already other devices. Do not use an extension power cord

e Any interruption to the PE conductor, either internally or externally, or removing the earthed conductor will make the system unsafe
to use /only protection class I/

e Any required cable connectors must be screwed to or hooked into the casing

e  The equipment must be disconnected from mains before opening

e To interrupt power supply, simply disconnect from the mains

e Any balancing, maintenance, or repair may only be carried out by manufacturer authorized specialists who are familiar with the

inherent dangers

Both the version and the rated current of any replacement fuse must comply with specifications laid down

. Using any repaired fuses, or short-circuiting the safety holder is illegal

If the equipment has suffered visible damage or if it has stopped working, it must be assumed that it can no longer be operated

without any danger. In these cases, the system must be switched off and be safeguarded against accidental use

Only use the cables supplied by manufacturer or shielded data cable with shielded connectors at either end

Do not drop small objects, such as paper clips, into the ISONIC 2006

Do not put the ISONIC 2006 in direct sunlight, near a heater, or near water. Leave space around the ISONIC 2006

Disconnect the power cord whenever a thunderstorm is nearby. Leaving the power cord connected may damage the ISONIC 2006

or your property

e  When positioning the equipment, external monitor, external keyboard, and external mouse take into account any local or national
regulations relating to ergonomic requirements. For example, you should ensure that little or no ambient light is reflected off the
external monitor screen as glare, and that the external keyboard is placed in a comfortable position for typing
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Do not allow any cables, particularly power cords, to trail across the floor, where they can be snagged by people walking past

The voltage of the External DC Power Supply below 11 V is not allowed for the ISONIC 2006 unit

The voltage of the External DC Power Supply above 16 V is not allowed for the ISONIC 2006 unit

Charge of the battery for the ISONIC 2006 unit is allowed only with use of the AC/DC converters / chargers supplied along with it or
authorized by Sonotron NDT

Remember this before:

balancing

carrying out maintenance work
repairing

exchanging any parts

Please make sure batteries, rechargeable batteries, or a power supply with SELV output supplies power

Software

ISONIC 2006 is a software controlled inspection device. Based on present state of the art, software can never be completely free of
faults. ISONIC 2006 should therefore be checked before and after use in order to ensure that the necessary functions operate perfectly

in the envisaged combination. If you have any questions about solving problems related to use the ISONIC 2006, please contact your
local Sonotron NDT representative
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1. Introduction
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ISONIC 2006 uniquely combines functionality and mobility of high performance portable digital ultrasonic
flaw detector with recording, imaging, and data processing capabilities of large smart computerized
inspection system

ISONIC 2006 resolves a variability of ultrasonic inspection tasks:

o A-Scan-based inspection using conventional pulse echo, back echo attenuation, and through
transmission techniques

o Straight Line Scanning Record - based inspection:

a Thickness Profile B-Scan imaging and recording, which is performed through continuous
measuring of thickness value along straight line type probe trace

O B-Scan cross-sectional imaging and recording of defects for longitudinal and shear wave
inspection, which is performed through continuous measuring of echo amplitudes and reflectors
coordinates along straight line type probe trace

a CB-Scan horizontal plane-view imaging and recording of defects for shear, surface, and guided
wave inspection, which is performed through continuous measuring of echo amplitudes and
reflectors coordinates along straight line type probe trace

a TOFD Inspection — RF B-Scan and D-Scan Imaging along straight line type probe trace
For Straight Line Scanning records it may be used:

0 Time-based mode — ISONIC 2006 is equipped with built-in real time
clock

0 True-to-location mode — ISONIC 2006 is equipped with built-in
incremental encoder interface

o XY-Scanning Record - based inspection:

a Thickness Map imaging and recording, which is performed through continuous measuring of
thickness value along probe trace

Q Flaw Detection — Pulse Echo 3D imaging (C-Scan, B-Scan, D-Scan, P-Scan) and recording of
defects for longitudinal and shear wave inspection, which is performed through continuous
measuring of echo amplitudes and reflectors coordinates along probe trace with probe swiveling
angle dependency where applicable

O Flaw Detection — Through Transmission / Back Echo Attenuation 2D imaging and recording

(C-Scan) which is performed through continuous measuring of signal amplitudes along probe
trace

Q CB-Scan horizontal plane-view imaging and recording of defects for shear, surface, and guided
wave inspection, which is performed through continuous measuring of echo amplitudes and
reflectors coordinates along probe trace with probe swiveling angle dependency where
applicable

Q TOFD Inspection — RF B-Scan and D-Scan Imaging along probe trace

For XY-Scanning records ISONIC 2006 is equipped with built-in airborne ultrasound encoder
controller and appropriate interface

For all types of Straight Line Scanning and XY-Scanning records A-Scans are captured for each probe
position along probe trace and may be played back and evaluated off-line at postprocessing stage. This
unique feature makes it possible off-line defect characterization through echo-dynamic pattern
analysis

Thickness Profile B-Scan Data recorded during Straight Line Scanning and Thickness Map data
recorded during XY-Scanning is presented in the format compatible with various Risk Based Inspection and
Maintenance procedures. Off-line measurements and statistical analysis functions also meet the
requirements of said procedures
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ISONIC 2006 is a new generation successor of very well known ISONIC 2001 model, which became a
leader in competition between multitask portable ultrasonic testing and imaging devices during recent years
(2000 though 2006) and received Frost & Sullivan Award for Product Differentiation Innovation in 2004.
Comparing to its predecessor ISONIC 2006 has significantly improved portability and weight, battery life,
ultrasonic performance, data processing speed, and human interface

ISONIC 2006 has practically unlimited capacity for storing of

Single A-Scans accompanied with corresponding instrument settings

Ultrasonic signal spectrum graphs (FFT) accompanied with corresponding RF A-Scans and
instrument settings

Various A-Scans sequence records along with corresponding Thickness Profiles, B-Scans, CB-
Scans, C-Scans, D-Scans, P-Scans, or TOFD Maps depending on mode of operation selected;
each record is accompanied with corresponding instrument settings

ISONIC 2006 complies with the requirements of National and International Codes:

0000 0oOo

ASME Section | — Rules for Construction of Power Boilers

ASME Section VIII, Division 1 — Rules for Construction of Pressure Vessels

ASME Section VIII, Division 2 — Rules for Construction of Pressure Vessels. Alternative Rules
ASME Section VIII Article KE-3 — Examination of Welds and Acceptance Criteria

ASME Code Case 2235 Rev 6 — Use of Ultrasonic Examination in Lieu of Radiography
Non-Destructive Examination of Welded Joints — Ultrasonic Examination of Welded Joints. —
British and European Standard BS EN 1714:1998

Non-Destructive Examination of Welds — Ultrasonic Examination — Characterization of
Indications in Welds. — British and European Standard BS EN 1713:1998

Calibration and Setting-Up of the Ultrasonic Time of Flight Diffraction (TOFD) Technique for the
Detection, Location and Sizing of Flaws. — British Standard BS 7706:1993

WI 00121377, Welding — Use Of Time-Of-Flight Diffraction Technique (TOFD) For Testing Of
Welds. — European Committee for Standardization — Document # CEN/TC 121/SC 5/WG 2 N
146, issued Feb, 12, 2003

Non-Destructive Testing — Ultrasonic Examination — Part 5: Characterization and Sizing of
Discontinuities. — British and European Standard BS EN 583-5:2001

Non-Destructive Testing — Ultrasonic Examination — Part 2: Sensitivity and Range Setting. —
British and European Standard BS EN 583-2:2001

Manufacture and Testing of Pressure Vessels. Non-Destructive Testing of Welded Joints.
Minimum Requirement for Non-Destructive Testing Methods — Appendix 1 to AD-Merkblatt
HP5/3 (Germany).— Edition July 1989
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2. Technical Data
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2.1. Instruments manufactured on or before Dec 1, 2007

Pulse Type:
Initial Transition:
Pulse Amplitude:

Pulse Duration:

Energy (Spike Pulse):
Modes:

Damping:

Internal Matching Coil — Probe
Impedance Matching:

PRF:

Optional Sync Output / Input:
Gain:

Advanced Low Noise Design:
Frequency Band:

Ultrasound Velocity:

Range:

Display Delay:

Probe Angle:

Probe Delay:

Display Modes:

Reject:

DAC/TCG:

DGS:
Gates:
Gate Start and Width:

Gate Threshold:

Measuring Functions — Digital
Display Readout:

Freeze (A-Scans and Spectrum
Graphs)

Encoder Interface:

Encoding:

Airborne Ultrasound Based
Encoding Characteristics:

Coupling Monitor:

Positive Spike Pulse / Positive Square Wave Pulse

<5 ns (10-90%)

Spike pulse - smoothly tunable (18 levels) 50 V ... 400 V into 50 Q at 4 levels of excitation Energy
Square wave pulse - smoothly tunable (18 levels) 50V ... 400 V into 50 Q

Spike pulse - 10...70 ns for 50 Q load depending on Energy and Damping setup

Square wave pulse - 65...600 ns independently controllable in 5 ns step

4 discrete energy values / 40 uJ (min) to 250 uJ (max) — at 400V amplitude

Single / Dual

17 discrete resistances values / 25 Q min to 1000 Q max

16 discrete inductivity values / 2 pH min to 78 uH max

0 — optionally; 15...5000 Hz controllable in 1 Hz resolution
Max +5V, 1< 5ns, t 2100 ns, Load Impedance > 50 Q
0...120 dB controllable in 0.5 dB resolution
93 nV peak to peak input referred to 80 dB gain / 35 MHz bandwidth
0.35 ... 35 MHz Wide Band / 34 Sub Bands
300...20000 m/s (11.81...787.4 "/ms) controllable in 1 m/s (0.1 "/ms) resolution
0.5...7000 ps controllable in 0.01 us resolution
0...3200 pus controllable in 0.01 us resolution
0...90° controllable in 1° resolution
0to 70 us controllable in 0.01 us resolution - expandable
RF, Rectified (Full Wave / Negative or Positive Half Wave), Signal's Spectrum (FFT Graph)
0...99 % of screen height controllable in 1% resolution
Theoretical — through keying in dB/mm (dB/") factor
Experimental — through sequential recording echo amplitudes from variously distanced equal reflectors
46 dB Dynamic Range, Slope <20 dB/us, Capacity < 40 points
Available for Rectified and RF Display
Standard Library for 18 probes / unlimitedly expandable
2 Independent Gates /unlimitedly expandable
Controllable over whole variety of A-Scan Display Delay and A-Scan Range
in 0.1 mm /// 0.001" resolution
5...95 % of A-Scan height controllable in 1 % resolution
27 automatic functions / expandable; Dual Ultrasound Velocity Measurement Mode for Multi-Layer
Structures; Curved Surface / Thickness / Skip correction for angle beam probes; Ultrasound velocity and
Probe Delay Auto-Calibration for all types of probes
Freeze All — A-Scans and Spectrum Graphs / Freeze Peak — A-Scans / All measurements functions,
manipulating Gates, and £6dB Gain varying are available for frozen signals
. Built-in controller and interface for incremental mechanical encoder
. Built-in controller and interface for non-mechanical airborne ultrasound-based encoder
Straight Line Scanning:
o Time-based (built-in real time clock — 0.02 sec resolution)
o  True-to-location (incremental encoder — 0.5 mm resolution)
XY Scanning:
o Airborne Ultrasound (see below)

<2000x3000 mm /
<80x120 in

<500x500 mm /
<20x20 in

<200x200 mm /
<8x8in

Area of probe
manipulation:

Curvature radius >2000 mm /240 in >200 mm /28 in >37mm /21.5in

of scanning

surface:

Scanning Speed: <150 mm/s / <6 in/s <150 mm/s / <6 in/s <150 mm/s / <6 in/s
Scan Index: 1to 20 mm controllable in 1to 20 mm controllable 0.25mm; 0.5 mmor 1l

to 20 mm controllable
in 1 mm step
20.25 mm /20.01in

1 mm step in 1 mm step
Resolution for
determining of
probe
coordinates:
Resolution for - 1° 0.5°
determining of
probe swiveling

>1 mm/>0.04in >1 mm/>0.04in

angle:

Range of probe - +90° +90°
swiveling:

Immunity to <60 dB <60 dB <60 dB

ambient noise:
Built-in controller and interface for Coupling Monitor suitable for any kind of ultrasonic probe at scanning
speed up to 150 mm /sec (6 in /sec); resolution — 0.5 dB
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Testing Integrity Monitoring:

Imaging Modes:

Imaging Characteristics:

Length of one Straight Line
Scanning record:

Method of Record:

Region of Interest:

Off-Line Image Analysis:

Data Reporting:

Data Storage Capacity:

On-Board Computer:

RAM:

Internal Flash Memory - Quasi
HDD:

Outputs:

Screen:

Controls:

Compatibility with the external
devices:

Operating System:

Power:
Housing:
Dimensions:

Weight:

. Background imaging of Scanning Plan

. Recording and imaging of Actual Probe Trace

. Generating perceptible marks corresponding to current coupling degree, probe position, and
swiveling angle whilst scanning

. Interrupting recording and imaging of actual probe trace if missing coupling and/or probe position
and/or swiveling angle

Thickness Profile B-Scan, Cross-sectional B-Scan, Plane View CB-Scan, C-Scan, D-Scan, P-Scan, TOFD —

depending on mode of operation selected accompanied with corresponding instrument settings

Inspection: Angle Beam Straight Beam
Width of Volume 5to 300 mm controllable in 1 mm 50 to 2000 mm controllable in 1 mm
under test: resolution — expandable /// resolution — expandable ///

0.2to 12 in controllable in 0.01 in
resolution - expandable

0.2to 80in controllable in 0.01 in
resolution — expandable

510 300 mm controllable in 1 mm 0.5 to 300 mm controllable in 0.1 mm
resolution — expandable /// resolution — expandable ///

0.2 to 12 in controllable in 0.01 in | 0.02 to 12 in controllable in 0.01 in
resolution - expandable resolution - expandable

0.5mm x 0.5 mm x 0.5« Scan Index | 0.2 mm x 0.5 mm x 0.5 « Scan Index x

Thickness of Volume
under test:

Image Resolution:

x <2dB /Il <2dB /I
0.02 in x 0.02 in x 0.5 « Scan Index | 0.01 in x 0.02 in x 0.5 ¢« Scan Index x
x <2dB <2dB
Standard Color Scale e  Pseudo Color e  Pseudo Color
(Palette): . Gray . Gray
. Thermal . Thermal
User Defined Color <2% colors <2% colors
Scales (Palettes):
Signal Amplitude . Linear . Linear
Coloring Protocol: e  TCG Normalizing e  TCG Normalizing
. DAC Normalizing . DAC Normalizing
. DGS Normalizing . Customized

. Customized
50...20000 mm (2"...800"), automatic scrolling

Complete raw data recording

Controllable over entire Display Delay, Probe Delay, Range, Ultrasound Velocity and other appropriate

instrument settings

Recovery and play back of A-Scan sequence at various gain levels

Echo-dynamic pattern analysis

Defects sizing, outlining, pattern recognition

Statistical analysis of Thickness / Amplitude Map data

Converting Record into ASCII Format / MS Excel format / MS Word Format

Direct printout of Calibration Dumps, A-Scans, Spectrum Graphs, Thickness Profile B-Scans, cross-

sectional B-Scans, plane view CB-Scans, TOFD maps, CB-Scans, C-Scans, D-Scans, P-Scans, or TOFD

Maps

e  Atleast 100000 sets including calibration dumps accompanied with A-Scans and/or Spectrum
Graphs

e Atleast 10000 sets including calibration dumps accompanied with Thickness Profile B-Scans, cross-
sectional B-Scans, plane view CB-Scans, TOFD maps, CB-Scans, C-Scans, D-Scans, P-Scans, or
TOFD Maps and complete sequence of A-Scans captured during scanning

Pentium M 300MHz

128 Megabytes

4 Gigabytes

LAN, USB X 2, PS 2, SVGA

6.5" High Color Resolution (32 bit) SVGA 640x480 pixels 133x98 mm (5.24" x 3.86") Sun-readable LCD;
Maximal A-Scan Size (working area) — 130x92 mm (5.12" x 3.62")

Front Panel Sealed Keyboard, Front Panel Sealed Mouse, Touch Screen

PS 2 Keyboard and Mouse, USB Keyboard and Mouse, USB Flash Memory card, Printer through USB or
LAN, PC through USB or LAN, SVGA External Monitor

Windows™98SE — instrument operation

Fully compatible for networking and / or USB connection and off-line data analysis and reporting in
external PC running under Windows™98SE, Windows™2000, Windows™XP

Mains - 100...240 VAC, 40...70 Hz, auto-switch; Battery 12V 8AH up to 6 hours continuous operation
IP 53 rugged aluminum case with carrying handle

265x156x121 mm (10.43"x6.14"x4.76") - without battery

265x156x159 mm (10.43"x6.14"x6.26") - with battery

3.150 kg (5.83 Ibs) - without battery

4.280 kg (7.88 Ibs) - with battery
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2.2. Instruments manufactured after Dec 1, 2007

Pulse Type:
Initial Transition:
Pulse Amplitude:

Pulse Duration:

Energy (Spike Pulse):
Modes:

Damping:

Internal Matching Coil — Probe
Impedance Matching:

PRF:

Optional Sync Output / Input:
Gain:

Advanced Low Noise Design:
Frequency Band:

Ultrasound Velocity:

Range:

Display Delay:

Probe Angle:

Probe Delay:

Display Modes:

Reject:

DAC/TCG:

DGS:
Gates:
Gate Start and Width:

Gate Threshold:

Measuring Functions — Digital
Display Readout:

Freeze (A-Scans and Spectrum
Graphs)

Encoder Interface:

Encoding:

Airborne Ultrasound Based
Encoding Characteristics:

Coupling Monitor:

Positive Spike Pulse / Positive Square Wave Pulse

<5 ns (10-90%)

Spike pulse - smoothly tunable (18 levels) 50 V ... 400 V into 50 Q at 4 levels of excitation Energy
Square wave pulse - smoothly tunable (18 levels) 50V ... 400 V into 50 Q

Spike pulse - 10...70 ns for 50 Q load depending on Energy and Damping setup

Square wave pulse - 65...600 ns independently controllable in 5 ns step

4 discrete energy values / 40 uJ (min) to 250 uJ (max) — at 400V amplitude

Single / Dual

17 discrete resistances values / 25 Q min to 1000 Q max

16 discrete inductivity values / 2 pH min to 78 uH max

0 — optionally; 15...5000 Hz controllable in 1 Hz resolution
Max +5V, 1< 5ns, t 2100 ns, Load Impedance > 50 Q
0...120 dB controllable in 0.5 dB resolution
93 nV peak to peak input referred to 80 dB gain / 35 MHz bandwidth
0.35 ... 35 MHz Wide Band / 34 Sub Bands
300...20000 m/s (11.81...787.4 "/ms) controllable in 1 m/s (0.1 "/ms) resolution
0.5...7000 ps controllable in 0.01 us resolution
0...3200 pus controllable in 0.01 us resolution
0...90° controllable in 1° resolution
0to 70 us controllable in 0.01 us resolution - expandable
RF, Rectified (Full Wave / Negative or Positive Half Wave), Signal's Spectrum (FFT Graph)
0...99 % of screen height controllable in 1% resolution
Theoretical — through keying in dB/mm (dB/") factor
Experimental — through sequential recording echo amplitudes from variously distanced equal reflectors
46 dB Dynamic Range, Slope <20 dB/us, Capacity < 40 points
Available for Rectified and RF Display
Standard Library for 18 probes / unlimitedly expandable
2 Independent Gates /unlimitedly expandable
Controllable over whole variety of A-Scan Display Delay and A-Scan Range
in 0.1 mm /// 0.001" resolution
5...95 % of A-Scan height controllable in 1 % resolution
27 automatic functions / expandable; Dual Ultrasound Velocity Measurement Mode for Multi-Layer
Structures; Curved Surface / Thickness / Skip correction for angle beam probes; Ultrasound velocity and
Probe Delay Auto-Calibration for all types of probes
Freeze All — A-Scans and Spectrum Graphs / Freeze Peak — A-Scans / All measurements functions,
manipulating Gates, and £6dB Gain varying are available for frozen signals
. Built-in controller and interface for incremental mechanical encoder
. Built-in controller and interface for non-mechanical airborne ultrasound-based encoder
Straight Line Scanning:
o Time-based (built-in real time clock — 0.02 sec resolution)
o  True-to-location (incremental encoder — 0.5 mm resolution)
XY Scanning:
o Airborne Ultrasound (see below)

<2000x3000 mm /
<80x120 in

<500x500 mm /
<20x20 in

<200x200 mm /
<8x8in

Area of probe
manipulation:

Curvature radius >2000 mm /240 in >200 mm /28 in >37mm /21.5in

of scanning

surface:

Scanning Speed: <150 mm/s / <6 in/s <150 mm/s / <6 in/s <150 mm/s / <6 in/s
Scan Index: 1to 20 mm controllable in 1to 20 mm controllable 0.25mm; 0.5 mmor 1l

to 20 mm controllable
in 1 mm step
20.25 mm /20.01in

1 mm step in 1 mm step
Resolution for
determining of
probe
coordinates:
Resolution for - 1° 0.5°
determining of
probe swiveling

>1 mm/>0.04in >1 mm/>0.04in

angle:

Range of probe - +90° +90°
swiveling:

Immunity to <60 dB <60 dB <60 dB

ambient noise:
Built-in controller and interface for Coupling Monitor suitable for any kind of ultrasonic probe at scanning
speed up to 150 mm /sec (6 in /sec); resolution — 0.5 dB
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Testing Integrity Monitoring:

Imaging Modes:

Imaging Characteristics:

Length of one Straight Line
Scanning record:

Method of Record:

Region of Interest:

Off-Line Image Analysis:

Data Reporting:

Data Storage Capacity:

On-Board Computer:

RAM:

Internal Flash Memory - Quasi
HDD:

Outputs:

Screen:

Controls:

Compatibility with the external
devices:

Operating System:

Power:

Housing:

Dimensions:

Weight:

. Background imaging of Scanning Plan

. Recording and imaging of Actual Probe Trace

. Generating perceptible marks corresponding to current coupling degree, probe position, and
swiveling angle whilst scanning

. Interrupting recording and imaging of actual probe trace if missing coupling and/or probe position
and/or swiveling angle

Thickness Profile B-Scan, Cross-sectional B-Scan, Plane View CB-Scan, C-Scan, D-Scan, P-Scan, TOFD —

depending on mode of operation selected accompanied with corresponding instrument settings

Inspection: Angle Beam Straight Beam
Width of Volume 5to 300 mm controllable in 1 mm 50 to 2000 mm controllable in 1 mm
under test: resolution — expandable /// resolution — expandable ///

0.2to 12 in controllable in 0.01 in
resolution - expandable

0.2to 80in controllable in 0.01 in
resolution — expandable

510 300 mm controllable in 1 mm 0.5 to 300 mm controllable in 0.1 mm
resolution — expandable /// resolution — expandable ///

0.2 to 12 in controllable in 0.01 in | 0.02 to 12 in controllable in 0.01 in
resolution - expandable resolution - expandable

0.5mm x 0.5 mm x 0.5« Scan Index | 0.2 mm x 0.5 mm x 0.5 « Scan Index x

Thickness of Volume
under test:

Image Resolution:

x <2dB /Il <2dB /I
0.02 in x 0.02 in x 0.5 « Scan Index | 0.01 in x 0.02 in x 0.5 ¢« Scan Index x
x <2dB <2dB
Standard Color Scale e  Pseudo Color e  Pseudo Color
(Palette): . Gray . Gray
. Thermal . Thermal
User Defined Color <2% colors <2% colors
Scales (Palettes):
Signal Amplitude . Linear . Linear
Coloring Protocol: e  TCG Normalizing e  TCG Normalizing
. DAC Normalizing . DAC Normalizing
. DGS Normalizing . Customized

. Customized
50...20000 mm (2"...800"), automatic scrolling

Complete raw data recording

Controllable over entire Display Delay, Probe Delay, Range, Ultrasound Velocity and other appropriate

instrument settings

Recovery and play back of A-Scan sequence at various gain levels

Echo-dynamic pattern analysis

Defects sizing, outlining, pattern recognition

Statistical analysis of Thickness / Amplitude Map data

Converting Record into ASCII Format / MS Excel format / MS Word Format

Direct printout of Calibration Dumps, A-Scans, Spectrum Graphs, Thickness Profile B-Scans, cross-

sectional B-Scans, plane view CB-Scans, TOFD maps, CB-Scans, C-Scans, D-Scans, P-Scans, or TOFD

Maps

e  Atleast 100000 sets including calibration dumps accompanied with A-Scans and/or Spectrum
Graphs

e Atleast 10000 sets including calibration dumps accompanied with Thickness Profile B-Scans, cross-
sectional B-Scans, plane view CB-Scans, TOFD maps, CB-Scans, C-Scans, D-Scans, P-Scans, or
TOFD Maps and complete sequence of A-Scans captured during scanning

AMD LX 800 - 500MHz

512 Megabytes

4 Gigabytes

LAN, USB X 2, PS 2, SVGA

6.5" High Color Resolution (32 bit) SVGA 640x480 pixels 133x98 mm (5.24" x 3.86") Sun-readable LCD;
Maximal A-Scan Size (working area) — 130x92 mm (5.12" x 3.62")

Front Panel Sealed Keyboard, Front Panel Sealed Mouse, Touch Screen

PS 2 Keyboard and Mouse, USB Keyboard and Mouse, USB Flash Memory card, Printer through USB or
LAN, PC through USB or LAN, SVGA External Monitor

Windows™XP Embedded

Mains - 100...240 VAC, 40...70 Hz, auto-switch; Battery 12V 8AH up to 6 hours continuous operation
IP 53 rugged aluminum case with carrying handle

265x156x121 mm (10.43"x6.14"x4.76") - without battery

265x156x159 mm (10.43"x6.14"x6.26") - with battery

3.150 kg (5.83 Ibs) - without battery

4.280 kg (7.88 Ibs) - with battery
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3. ISONIC 2006 — Scope of Supply
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3.1. Instrument and basic accessories

# Item Order Code Note
(Part #)
1 |[ISONIC 2006 - Portable Digital Ultrasonic Flaw Detector and Recorder SA 80460 Standard Configuration

with B-Scan, C-Scan, D-Scan, P-Scan, and TOFD Inspection and
Imaging Capabilities
. ISONIC 2006 Electronic unit — including:
> Internal PC (P-MMX-S - 300 MHz, RAM-128M, Quazi-HDD Flash Memory
Card 2G, active TFT sVGA LCD High Color Sun-Readable Touch Screen,
Built-In Interfaces: 2XUSB; Ethernet; PS/2; Front Panel Sealed Keyboard
and Mouse; sVGA output)
> 100 ... 250 VAC AC/DC converter
> SE 256000 - Controller for Non-Mechanical Airborne Ultrasound Based
Monitoring of Probe Coordinates (X,Y,Z) and Orientation (Swiveling Angle) on
an Object Under Test While Scanning and for Coupling Monitoring Between
Probe and Object Under Test While Scanning
> SE 248000 - UDS 3-5 Pulser Receiver Card:
d Combined “Spike wave — Selectable Energy” / “Square Wave —|
Tunable Width” Tunable Firing Level Pulser; Single / Dual Modes of
Operation; Damping: 17 discrete resistances values / 25Q min to 1000Q2
max; Internal Matching Coil — Probe Impedance Matching: 16 discrete
inductivity values / 2 pH min to 78 uH max; Special Probe Protection
Circuit to Prevent Probe Damage for Not Properly Adjusted Pulse Width
O Gain: 0...120 dB controllable in 0.5 dB resolution; Advanced
Low Noise Design: 93uV peak to peak input referred to 80 dB gain / 35
MHz bandwidth; Ffrequency Band: 0.35 ... 35 MHz Wide Band / 34 Sub
Bands
O Built-In Incremental Encoder Interface
. Software
Ud  ISONIC 2006 Multi-Functional Package (SWA 99C06200)
® A-Scan Inspection and Straight Line Scanning Inspection
and recording (Full ISONIC 2005 Functionality)
4 A-Scan
= A-Scan (Full Wave / Neg Wave / Pos Wave
rectification; RF)
= Selectable A-Scan color scheme
= DAC, DGS, TCG
= Auto Calibration for Straight Beam and Angle Beam

Probes

= Curved Surface / Wall Thickness / Skip - Correction for
Angle Beam Inspection

= Smart Automatic Measurements of Gated Signals -
Flank / Flank First / Top / Top First; Auto-Marking Measuring Points on A-
Scan

= FFT (Frequency Domain Signal Presentation) -
additional feature for defects evaluation and / or pattern recognition /
probes characterization

= Enhanced Signal Evaluation for Live and Frozen A-
Scans including Gain Adjustments whilst in Freeze Mode

= Dual Ultrasound Velocity Multiecho Measurements
Mode

= Comprehensive Setup and A-Scan / FFT graph report,
Direct Connection To any Type of USB or LAN Windows Printer

4  Thickness Profile Imaging and Recording (Typical
Application: Corrosion characterization)

= Continuous measuring of thickness value along probe
trace

= Time-based (real time clock) and true-to-location (built-
in incremental encoder interface) modes of data recording

= Recording of complete sequence of A-Scans along with
thickness profile

= Off-line evaluation of thickness profile images featured
with:

» Sizing of thickness damages at any location along
stored image - remaining thickness, thickness loss, and length of
damage

» Play-back and evaluation of A-Scans obtained
during thickness profile recording

» Echodynamic pattern analysis

»  Off-line reconstruction of thickness profile image
for various Gain / Gate setup

= Comprehensive Setup and Scanning Reporting, Direct
Connection To any Type of USB or LAN Windows Printer

€  B-Scan cross-sectional imaging and recording of
defects for longitudinal and shear wave inspection (Typical
Application: Pulse echo inspection of welds, composites, metals,

plastics, and the like)
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Iltem Order Code Note
(Part #)

= Continuous measuring of echo amplitudes and
reflectors coordinates along probe trace
= Time-based (real time clock) and true-to-location (built-
in incremental encoder interface) modes of data recording
= Recording of complete sequence of A-Scans along with
B-Scan defects images
= Off-line evaluation of B-Scan record images featured
with:
P Sizing of defects at any location along stored
image — coordinates and projection size
P Play-back and evaluation of A-Scans obtained
during B-Scan imaging and recording

» Echodynamic pattern analysis

» Defects outlining and pattern recognition based on
A-Scan sequence analysis
»  Off-line reconstruction of B-Scan defects images
for various Gain / Rejection level setup
» DAC /DGS B-Scan normalization
= Comprehensive Setup and Scanning Reporting, Direct
Connection To any Type of USB or LAN Windows Printer
4  CB-Scan horizontal plane-view imaging and recording
of defects for shear, surface, and guided wave inspection (Typical
Application: Long range pulse echo and CHIME inspection of annular
plates and piping, stress corrosion, etc; weld inspection, surface wave
inspection)
= Continuous measuring of echo amplitudes and
reflectors coordinates along probe trace
= Time-based (real time clock) and true-to-location (built-
in incremental encoder interface) modes of data recording
= Recording of complete sequence of A-Scans along with
CB-Scan defects images
= Off-line evaluation of CB-Scan record images featured
with:
P Sizing of defects at any location along stored
image — coordinates and projection size
» Play-back and evaluation of A-Scans obtained
during CB-Scan imaging and recording
» Echodynamic pattern analysis
» Defects outlining and pattern recognition based on
A-Scan sequence analysis
» Off-line reconstruction of CB-Scan defects images
for various Gain / Rejection level setup
» DAC /DGS CB-Scan normalization
= Comprehensive Setup and Scanning Reporting, Direct
Connection To any Type of USB or LAN Windows Printer
€  TOFD Inspection — RF B-Scan and D-Scan Imaging
(Typical Application: weld inspection; CHIME inspection)
= Time-based (real time clock) and true-to-location (built-
in incremental encoder interface) modes of data recording
= Averaging A-Scans whilst recording as per operator's
selection
= Recording of complete sequence of A-Scans along with
TOFD map
= Off-line evaluation of TOFD Map featured with:
» Improvement of near to surface resolution through
removal of lateral wave and back echo records from TOFD Map
P Linearization and straightening of TOFD Map
P Increasing contrast of TOFD images through
varying Gain and rectification
» A-Scan sequence analysis
» Defects pattern recognition and sizing
= Comprehensive Setup and Scanning Reporting, Direct
Connection To any Type of USB or LAN Windows Printer

®  Activation Panel for Optional C-Scan and Other Modes of
Operation (Corrosion Mapping, Pulse Echo Straight Beam Inspection
and Mapping of Internal Defects, Through Transmission Inspection and
Mapping, Pulse Echo Angle Beam Weld Inspection and Imaging, Long
Range Inspection and Imaging; Non Mechanically Encoded True to
Location TOFD, etc - refer to Optional SW Licenses for ISONIC 2006

Instrument

. USB Flash Drive for External Data Storage
. 24 months warranty

. Lifetime free software update
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# Iltem Order Code Note
(Part #)
2 | Backup CD-ROM SCD 2006098 |Operating Manual on the
Backup CD-ROM
3 | Soft carrying bag with neck strap SK 2006101 |Optional item
4 | Rechargeable Battery Ni MH 9 AH / 12V SK 2005102 |Optional item
5 | Battery Charger SK 2005103 |Optional item
Required for battery charge
6 | Travel Hard Case SK 2006104 |Optional item
IAllows safe cargo
transportation
7 | External USB Keyboard SK 2005105 |Optional Item
Extremely Useful at
Postprocessing Stage
8 | External USB Optical Mouse SK 2005106 |Optional Item
Extremely Useful at
Postprocessing Stage
9 |Dual Channel TOFD preamplifier package including: SA 80442  |Optional Item

= Dual Channel TOFD preamplifier
= Set of 2 low noise coaxial cables (10 meters length each) for
connection to the signal input of ISONIC instrument

Improves long cable
connection to ultrasonic
probes. Typical applications
are TOFD, Corrosion
Detection, etc performed with
probes fitted into scanner /
crawler frame — refer to chapter
10 of this Operating Manual

10

ISONIC Alarmer - standard firmware configuration and hardware platform
including:

= Internal Speaker functioning according to alarm logic settings of UDS
3-5 Pulser Receiver in the ISONIC 2005, 2006, 2007 instruments / UDS
3-6 Pulser Receiver of ISONIC 2008 Instrument

= Speaker Volume Control Wheel

= Headphone Connector

= 25-pin programmable Input / Output interface (blank)

= USB port and cable for connecting to ISONIC 2005, 2006, 2007,
2008 instrument

SE 554780987

Optional Item
Refer to paragraph 8.8.5 of this
Operating Manual

11

Ultrasonic probes, fixtures, scanners, cables and other accessories
depending on the inspection tasks to be resolved

Optional Items

Ultrasonic probes, fixtures,
scanners, cables and other
laccessories from any
manufacturer may be used
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3.2. Components of Optional Non-Mechanical Airborne
Ultrasound Encoder for Monitoring Position and Orientation
(Swiveling Angle) of Manually Manipulated Probe

Complete list representing all components of optional nhon-mechanical airborne ultrasound encoder for
monitoring position and orientation (swiveling angle) of manually manipulated probe during XY scanning is
presented below. Some components may have two different implementations depending on temperature of

object under test — normal temperature implementation is suitable for inspection of objects, which's
temperature doesn't exceed 60°C; high temperature implementation is suitable for inspection of objects,
which's temperature doesn't exceed 300°C. With reference to catalog of optional inspection SW licensees
for ISONIC 2006 as per paragraph 3.4 of this Operating Manual it is easy to define list of components are
required for XY scanning and recording using

# Item Order Code Note
(Part #)
1 |Umbilical Cable for Connecting Airborne Ultrasound Stuff, Coupling S 70200
Monitor Stuff, and Probes to ISONIC 2006 while implementing Optional
C-Scan and Other Modes of Operation
2 |Umbilical High Temperature Protection Jacketed Cable for S 70200 HT |%¢ Inspection of Hot
Connecting Airborne Ultrasound Stuff, Coupling Monitor Stuff, Objects (60C and higher)
and Probes to ISONIC 2006 while implementing Optional C-Scan
and Other Modes of Operation
3 [Set of 2 (two) receivers of Airborne Ultrasound S 4030A Refer to Optional Inspection
SW Licensees for ISONIC
2006 related to XY
Scanning and recording
4 |(Set of 2 (two) receivers of Airborne Ultrasound - High Temperature S 4030 A HT |Refer to Optional Inspection
Implementation SW Licensees for ISONIC
2006 related to XY
Scanning and recording
4% Inspection of Hot
Objects (60C and higher)
3 [Holder for Airborne Ultrasound Receivers with Magnetic Attachments to S 2040 B
Object Under Test
4 |Double Emitter of Airborne Ultrasound S 4050 Refer to Optional Inspection
SW Licensees for ISONIC
2006 related to XY
Scanning and recording
5 |Double Emitter of Airborne Ultrasound - High Temperature S 4050 HT |Refer to Optional Inspection
Implementation SW Licensees for ISONIC
2006 related to XY
Scanning and recording
4 Inspection of Hot
Objects (60C and higher)
6 |Single Emitter of Airborne Ultrasound S 4060 Refer to Optional Inspection
SW Licensees for ISONIC
2006 related to XY
Scanning and recording
7 |Single Emitter of Airborne Ultrasound - High Temperature S 4060 HT |Refer to Optional Inspection
Implementation SW Licensees for ISONIC
2006 related to XY
Scanning and recording
% Inspection of Hot
Objects (60C and higher)
8 |Double Emitter of Airborne Ultrasound for scanning whilst receivers of S 4055 Refer to Optional Inspection
airborne ultrasound are placed in front of scanning area, for example, on SW Licensees for ISONIC
a tank shell 2006 related to XY
Scanning and recording
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# Item Order Code Note
(Part #)
9 [Double Emitter of Airborne Ultrasound for scanning whilst receivers of S 4055 HT |Refer to Optional Inspection
airborne ultrasound are placed in front of scanning area, for example, on SW Licensees for ISONIC
a tank shell - High Temperature Implementation 2006 related to XY
Scanning and recording
% Inspection of Hot
Objects (60C and higher)
10 |Fixture for placement of airborne ultrasound receivers on tank shell S 2045B Refer to Optional Inspection
SW Licensees for ISONIC
2006 related to XY
Scanning and recording
11 |Vacuum attachment system for placement ISONIC 2006 / ISONIC 201 S 1200A
accessories on objects made of non magnetic materials
12 |Fixture for placing airborne ultrasound receivers on small diameters pipes S 89000 Refer to Optional Inspection
and other tubular objects SW Licensees for ISONIC
2006 related to XY
Scanning and recording
13 |Fixture for airborne ultrasound receivers for scanning with high frontal S 86000 Refer to Optional Inspection
resolution SW Licensees for ISONIC
2006 related to XY
Scanning and recording
14 [Twister - Rotary Adapter S 904050 |This item may be necessary
for numerous applications -
refer to Notes for Inspection
Software Packages and
Accessories
15 |Carrying Case for Airborne Ultrasound and Coupling Monitor Sensors S 20001

and Accessories

16

Probe holders with clamping unit for fitting airborne ultrasound emitters -
depending on probes used for XY scanning

3. Optional Stuff for Coupling Monitoring

# Iltem Order Code Note
(Part #)
1 |Emitter of Acoustic Coupling Monitor Signal - Additional Emitters are S 4010
Recommended for heavy thickness objects
2 |Cable for coupling monitor emitter LEMO 01 male — LEMO 00 male S 799028
3 |Cable for coupling monitor emitter LEMO 01 male — LEMO 00 male - S 799028 HT |¢ Inspection of Hot
High Temperature Jacketed Objects (60C and higher)
4 |Splitter for parallel connection of up to 3 Emitters of Acoustic Coupling SE 20220
Monitor Signal - Additional Emitters are Recommended for heavy
thickness objects
5 |Splitter for parallel connection of up to 3 Emitters of Acoustic Coupling SE 20220 HT |¢ Inspection of Hot

Monitor Signal - Additional Emitters are Recommended for heavy
thickness objects - High Temperature Jacketed

Objects (60C and higher)

Probe holders equipped with Receiving Crystal for Acoustic Coupling
Monitor Signal - depending on probes used for XY scanning
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3.4. Optional XY Scanning Software Licensees

# Item Order Code Note
(Part #)

1 |Inspection SW Package for ISONIC 2006: [2-SONIC - Inspection of SWA 996600 |[Required Accessories:
Planar Butt Joints, Scanning from One Side, Complete Raw Data > S 4030A or S 4030A HT
Capturing >S5S 2040B

= Support of all A-Scan types (Full Wave / Neg Wave / Pos Wave > S 4050 or S 4050 HT
rectification; RF) while scanning, recording and imaging defects AND/OR S 4060 or S 4060
= Support of Linear or DAC- , DGS- , TCG- normalized recording HT
and imaging defects > S 70200 or S 70200 HT
= Support of Linear or DAC- , DGS-, TCG- normalized recording > Probe Holders for Angle
and imaging defects Beam Probes to Be Used
= FFT (Frequency Domain Signal Presentation) - additional feature for Weld Inspection
for defects evaluation and / or pattern recognition Optional Accessories:
= Testing Integrity / Coverage Imaging (Top View of Probe > S 4010
Manipulation Area) Showing of Actually Implemented Probe Trace > S 799028 or S 799028 HT
> C-Scan (Top View of Weld and Heat Affected Zone either Global > SWA 996014
or Sliced - switch able)
= B-Scan (Side View of Weld and Heat Affected Zone either Global
or Sliced - switch able)
= D-Scan (End View of Weld and Heat Affected Zone either Global
or Sliced - switch able)
= Versatile Color Palette for Defects Imaging
= Postprocessing: Off-line Recovery and Play-Back of A-Scans;
Echo Dynamic Pattern Recognition; Sizing of defects; Slicing and
Filtering Images
= Comprehensive Setup and Scanning Reporting, Direct
Connection To any Type of USB or LAN Windows Printer
2 |Inspection SW Package for ISONIC 2006: PLCROSS - Inspection of SWA 996603 |Required Accessories:

Planar Butt Joints, Scanning from Both Sides, Complete Raw Data
Capturing

= Support of all A-Scan types (Full Wave / Neg Wave / Pos Wave
rectification; RF) while scanning, recording and imaging defects

= Support of Linear or DAC- , DGS- , TCG- normalized recording
and imaging defects

= FFT (Frequency Domain Signal Presentation) - additional feature
for defects evaluation and / or pattern recognition

= Testing Integrity / Coverage Imaging (Top View of Probe
Manipulation Areas) Showing of Actually Implemented Probe Trace
= C-Scan (Top View of Weld and Heat Affected Zone either Global
or Sliced - switch able) / superimposing images obtained whilst
scanning from different sides

= B-Scan (Side View of Weld and Heat Affected Zone either Global
or Sliced - switch able) / superimposing images obtained whilst
scanning from different sides

= D-Scan (End View of the Weld and Heat Affected Zone either
Global or Sliced - switch able) / superimposing images obtained whilst
scanning from different sides

= Versatile Color Palette for Defects Imaging

= Postprocessing: Off-line Recovery and Play-Back of A-Scans;
Echo Dynamic Pattern Recognition; Sizing of defects; Slicing and
Filtering Images

= Comprehensive Setup and Scanning Reporting, Direct
Connection To any Type of USB or LAN Windows Printer

> S 4030A or S 4030A HT
>S2040B

> S 4050 or S 4050 HT
AND/OR S 4060 or S 4060
HT

> S 70200 or S 70200 HT
> Probe Holders for Angle
Beam Probes to Be Used
for Weld Inspection

> S 904050

Optional Accessories:

> S 4010
> S 799028 or S 799028 HT
> SWA 996014
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Butt Welds between Small Diameter Pipes (80 to 800 mm), Scanning

from One Side, Complete Raw Data Capturing
= Support of all A-Scan types (Full Wave / Neg Wave / Pos Wave
rectification; RF) while scanning, recording and imaging defects
= Support of Linear or DAC- , DGS-, TCG- normalized recording and
imaging defects
= FFT (Frequency Domain Signal Presentation) - additional feature
for defects evaluation and / or pattern recognition
= Testing Integrity / Coverage Imaging (Top View of Probe
Manipulation Areas) Showing of Actually Implemented Probe Trace
= C-Scan (Unfolded Top View of Weld and Heat Affected Zone either
Global or Sliced - switch able)
= B-Scan (Unfolded Side View of Weld and Heat Affected Zone either
Global or Sliced - switch able)
= B-Scan (Real Shape Side View of Weld and Heat Affected Zone
either Global or Sliced - switch able)
= D-Scan (End View of Weld and Heat Affected Zone either Global or
Sliced - switch able)
= Versatile Color Palette for Defects Imaging
= Postprocessing: Off-line Recovery and Play-Back of A-Scans; Echo
Dynamic Pattern Recognition; Sizing of defects; Slicing and Filtering
Images
= Comprehensive Setup and Scanning Reporting, Direct Connection
To any Type of USB or LAN Windows Printer

Item Order Code Note
(Part #)
Inspection SW Package for ISONIC 2006: CIRCROSS - Inspection of SWA 996604 |Required Accessories:
Circumferential or Spiral Butt Joints, Scanning from Both Sides, > S 4030A or S 4030A HT
Complete Raw Data Capturing, weld diameters 400 mm and above >S5 2040 B
= Support of all A-Scan types (Full Wave / Neg Wave / Pos Wave > S 4050 or S 4050 HT
rectification; RF) while scanning, recording and imaging defects AND/OR S 4060 or S 4060
= Support of Linear or DAC- , DGS-, TCG- normalized recording HT
and imaging defects > S 70200 or S 70200 HT
= FFT (Frequency Domain Signal Presentation) - additional feature > Probe Holders for Angle
for defects evaluation and / or pattern recognition Beam Probes to Be Used
= Testing Integrity / Coverage Imaging (Top View of Probe for Weld Inspection
Manipulation Areas) Showing of Actually Implemented Probe Trace > S 904050
= C-Scan (Unfolded Top View of Weld and Heat Affected Zone Optional Accessories:
either Global or Sliced - switch able) / superimposing images obtained > S 4010
whilst scanning from different sides > S 799028 or S 799028 HT
© B-Scan (Unfolded Side View of Weld and Heat Affected Zone > SWA 996014
either Global or Sliced - switch able) / superimposing images obtained
whilst scanning from different sides
= B-Scan (Real Shape Side View of Weld and Heat Affected Zone
either Global or Sliced - switch able) / superimposing images obtained
whilst scanning from different sides
= D-Scan (End View of the Weld and Heat Affected Zone either
Global or Sliced - switch able) / superimposing images obtained whilst
scanning from different sides
= Versatile Color Palette for Defects Imaging
= Postprocessing: Off-line Recovery and Play-Back of A-Scans;
Echo Dynamic Pattern Recognition; Sizing of defects; Slicing and
Filtering Images
= Comprehensive Setup and Scanning Reporting, Direct
Connection To any Type of USB or LAN Windows Printer
Inspection SW Package for ISONIC 2006: SM_PIPE - Inspection of SWA 996605 |Required Accessories:

> S 4030A or S 4030A HT
>S 2040 B

> S 4050 or S 4050 HT
AND/OR S 4060 or S 4060
HT

> S 70200 or S 70200 HT
> Probe Holders for Angle
Beam Probes to Be Used
for Weld Inspection

> S 89000

Optional Accessories:

> S 4010

> S 799028 or S 799028 HT
> S 86000

> SWA 996014
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Iltem Order Code Note
(Part #)
Inspection SW Package for ISONIC 2006: LONGWELD - Inspection of | SWA 996652 |Required Accessories:
Longitudinal Welds In Pipes, diameter 300 mm - 4000 mm, Scanning > S 4030A or S 4030A HT
from Both Sides, Complete Raw Data Capturing >S5 2040 B
= Support of all A-Scan types (Full Wave / Neg Wave / Pos Wave > S 4050 or S 4050 HT
rectification; RF) while scanning, recording and imaging defects AND/OR S 4060 or S 4060
> Support of Linear or DAC- , DGS- , TCG- normalized recording HT
and imaging defects > S 70200 or S 70200 HT
= FFT (Frequency Domain Signal Presentation) - additional feature > Probe Holders for Angle
for defects evaluation and / or pattern recognition Beam Probes to Be Used
= Testing Integrity / Coverage Imaging (Top View of Probe for Weld Inspection
Manipulation Areas) Showing of Actually Implemented Probe Trace > S 904050
= C-Scan (Top View of Weld and Heat Affected Zone either Global Optional Accessories:
or Sliced - switch able) / superimposing images obtained whilst > S 4010
scanning from different sides > S 799028 or S 799028 HT
= B-Scan (Side View of Weld and Heat Affected Zone either Global > SWA 996014
or Sliced - switch able) / superimposing images obtained whilst
scanning from different sides
= D-Scan (End View of the Weld and Heat Affected Zone either
Global or Sliced - switch able) / superimposing images obtained whilst
scanning from different sides
= Versatile Color Palette for Defects Imaging
= Postprocessing: Off-line Recovery and Play-Back of A-Scans;
Echo Dynamic Pattern Recognition; Sizing of defects; Slicing and
Filtering Images
= Comprehensive Setup and Scanning Reporting, Direct
Connection To any Type of USB or LAN Windows Printer
Inspection SW Package for ISONIC 2006: TRANSCAN - Inspection of SWA 996606 |Required Accessories:

Butt Joints for Defects Transversal to Weld Scanning from Both
Sides and/or Above Machined Weld Enforcement (Standard HP 5/3)
= Support of all A-Scan types (Full Wave / Neg Wave / Pos Wave
rectification; RF) while scanning, recording and imaging defects
= Support of Linear or DAC- , DGS- , TCG- normalized recording
and imaging defects
= FFT (Frequency Domain Signal Presentation) - additional feature
for defects evaluation and / or pattern recognition
= Testing Integrity / Coverage Imaging (Top View of Probe
Manipulation Areas) Showing of Actually Implemented Probe Trace
= C-Scan (Top View of Weld and Heat Affected Zone either Global
or Sliced - switch able) / superimposing images obtained whilst
scanning from different sides
= B-Scan (Side View of Weld and Heat Affected Zone either Global
or Sliced - switch able) / superimposing images obtained whilst
scanning from different sides
= D-Scan (End View of the Weld and Heat Affected Zone either

Global or Sliced - switch able) / superimposing images obtained whilst

scanning from different sides

= Versatile Color Palette for Defects Imaging

= Postprocessing: Sizing of defects; Slicing and Filtering Images
= Comprehensive Setup and Scanning Reporting, Direct
Connection To any Type of USB or LAN Windows Printer

> S 4030A or S 4030A HT
>S2040B

> S 4050 or S 4050 HT

> S 70200 or S 70200 HT
> Probe Holders for Angle
Beam Probes to Be Used
for Weld Inspection

> S 904050

Optional Accessories:

> S 4010
> S 799028 or S 799028 HT
> SWA 996014
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Item Order Code Note
(Part #)

Inspection SW Package for ISONIC 2006: EXPERT — High Resolution | SWA 996609 |Required Accessories:
Scanning of Welds (Frontal Resolution - 0.25 mm / 0.01"), Scanning > S 4030A or S 4030A HT
from One Side, Complete Raw Data Capturing >S5 2040 B

= Support of all A-Scan types (Full Wave / Neg Wave / Pos Wave > S 4050 or S 4050 HT

rectification; RF) while scanning, recording and imaging defects AND/OR S 4060 or S 4060

= Support of Linear or DAC- , DGS- , TCG- normalized recording HT

and imaging defects > S 70200 or S 70200 HT

= FFT (Frequency Domain Signal Presentation) - additional feature > Probe Holders for Angle

for defects evaluation and / or pattern recognition Beam Probes to Be Used

= Testing Integrity / Coverage Imaging (Top View of Probe for Weld Inspection

Manipulation Area) Showing of Actually Implemented Probe Trace > S 86000

= C-Scan (Top View of Weld and Heat Affected Zone either Global Optional Accessories:

or Sliced - switch able) > S 4010

= B-Scan (Side View of Weld and Heat Affected Zone either Global > S 799028 or S 799028 HT

or Sliced - switch able) > SWA 996014

= D-Scan (End View of Weld and Heat Affected Zone either Global

or Sliced - switch able)

= Defect Outlining Technology (DOT) - Extra-Capturing of A-Scan

Sequences for Weld Cross Sections selected by Operator Whilst

Scanning

= Versatile Color Palette for Defects Imaging

= Postprocessing: Off-line Recovery and Play-Back of A-Scans;

Echo Dynamic Pattern Recognition; Sizing of defects; Slicing and

Filtering Images

= Comprehensive Setup and Scanning Reporting, Direct

Connection To any Type of USB or LAN Windows Printer
Inspection SW Package for ISONIC 2006: NOZZLE — Inspection of SWA 996611 |Required Accessories:
Nozzle Welds, Scanning from One Side, Complete Raw Data > S 4030A or S 4030A HT
Capturing >S2040B

= Support of all A-Scan types (Full Wave / Neg Wave / Pos Wave > S 4050 or S 4050 HT

rectification; RF) while scanning, recording and imaging defects AND/OR S 4060 or S 4060

= Support of Linear or DAC- , DGS- , TCG- normalized recording HT

and imaging defects > S 70200 or S 70200 HT

= FFT (Frequency Domain Signal Presentation) - additional feature > Probe Holders for Angle

for defects evaluation and / or pattern recognition Beam Probes to Be Used

= Testing Integrity / Coverage Imaging (Top View of Probe for Weld Inspection

Manipulation Area) Showing of Actually Implemented Probe Trace > S 904050

= C-Scan (Top View of Weld and Heat Affected Zone either Global Optional Accessories:

or Sliced - switch able) > S 4010

= B-Scan (Side View of Weld and Heat Affected Zone either Global > S 799028 or S 799028 HT

or Sliced - switch able) > SWA 996014

= D-Scan (End View of Weld and Heat Affected Zone either Global > S 86000

or Sliced - switch able)

= Versatile Color Palette for Defects Imaging

= Postprocessing: Off-line Recovery and Play-Back of A-Scans;

Echo Dynamic Pattern Recognition; Sizing of defects; Slicing and

Filtering Images

= Comprehensive Setup and Scanning Reporting, Direct

Connection To any Type of USB or LAN Windows Printer
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# Item Order Code Note
(Part #)
9 [Inspection SW Package for ISONIC 2006: TOFD — TOFD Inspection, SWA 996610 |Required Accessories:
Complete Raw Data Capturing > S 4030A or S 4030A HT
= Averaging A-Scans whilst recording as per operator's selection >S2040B
= Recording of complete sequence of A-Scans along with TOFD > 4060 or S 4060 HT
map > S 70200 or S 70200 HT
= Off-line evaluation of TOFD Map featured with: > S 450000
» Improvement of near to surface resolution through removal of > S 799017
lateral wave and back echo records from TOFD Map
P Linearization and straightening of TOFD Map
P Increasing contrast of TOFD images through varying Gain and
rectification
» A-Scan sequence analysis
» Defects pattern recognition and sizing
= Comprehensive Setup and Scanning Reporting, Direct
Connection To any Type of USB or LAN Windows Printer
10 [Inspection SW Package for ISONIC 2006: CORROMAP — Inspection SWA 996608 |Required Accessories:

with Straight Beam Ultrasonic Probes for Corrosion Mapping,
Complete Raw Data Capturing
= Support of all A-Scan types (Full Wave / Neg Wave / Pos Wave
rectification; RF) while scanning, recording and imaging the Thickness
/ Corrosion Map
= Support of Linear or DAC- , DGS- , TCG- normalized recording
and imaging of Thickness / Corrosion Map
= FFT (Frequency Domain Signal Presentation) - additional feature
for defects evaluation and / or pattern recognition
= Testing Integrity / Coverage Imaging (Top View of Probe
Manipulation Area) Showing of Actually Implemented Probe Trace
= C-Scan (Top View - Thickness / Corrosion Map either Global or
Sliced - switch able)
= B-Scan (Side View - Thickness / Corrosion Profile either Global or
Sliced - switch able)
= D-Scan (End View - Thickness / Corrosion Profile either Global or
Sliced - switch able)
= Versatile Color Palette for Thickness / Corrosion Mapping
= Postprocessing: Off-line Recovery and Play-Back of A-Scans;
Echo Dynamic Pattern Recognition; Sizing of defects; Gate
Manipulation - Rebuild C-, B-, and D-Scan views for various Gate
Settings; Statistical Analysis; Slicing and Filtering Images
= Comprehensive Setup and Scanning Reporting, Direct

Connection To any Type of USB or LAN Windows Printer

> S 4030A or S 4030A HT
>S2040B

> 4060 or S 4060 HT

> S 70200 or S 70200 HT

> Probe Holders for Straight
Beam Probes to Be Used
for Inspection

Optional Accessories:

> S 4010
> S 799028 or S 799028 HT
> SWA 996014
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# Iltem Order Code Note
(Part #)

11 |Inspection SW Package for ISONIC 2006: CORROMAP CU — SWA 996608 |Required Accessories:
Inspection with Sraight Beam Ultrasonic Probes for Corrosion Cu > S 4030A or S 4030A HT
Mapping - Scanning above Tubular or Quasi-Tubular Surface >S5 2040 B
(Curvature Radius 40 - 400 mm), Complete Raw Data Capturing > 4060 or S 4060 HT

= Support of all A-Scan types (Full Wave / Neg Wave / Pos Wave > S 70200 or S 70200 HT
rectification; RF) while scanning, recording and imaging Thickness / > Probe Holders for Straight
Corrosion Map Beam Probes to Be Used
= Support of Linear or DAC- , DGS- , TCG- normalized recording for Inspection
and imaging of Thickness / Corrosion Map > S 89000
= FFT (Frequency Domain Signal Presentation) - additional feature Optional Accessories:
for defects evaluation and / or pattern recognition > S 4010
= Testing Integrity / Coverage Imaging (Top View of Probe > S 799028 or S 799028 HT
Manipulation Area) Showing of Actually Implemented Probe Trace > SWA 996014
= C-Scan (Unfolded Top View - Thickness / Corrosion Map either > S86000
Global or Sliced - switch able)
= B-Scan (Unfolded Side View - Thickness / Corrosion Profile either
Global or Sliced - switch able)
= B-Scan (Real Shape Side View - Thickness / Corrosion Profile
either Global or Sliced - switch able)
= D-Scan (End View - Thickness / Corrosion Profile either Global or
Sliced - switch able)
= Versatile Color Palette for Thickness / Corrosion Mapping
= Postprocessing: Off-line Recovery and Play-Back of A-Scans;
Echo Dynamic Pattern Recognition; Sizing of defects; Gate
Manipulation - Rebuild C-, B-, and D-Scan views for various Gate
Settings; Statistical Analysis; Slicing and Filtering Images
= Comprehensive Setup and Scanning Reporting, Direct
Connection To any Type of USB or LAN Windows Printer
12 |Inspection SW Package for ISONIC 2006: MULTISCAN-COMBO - S SWA 996613 |Required Accessories:

Inspection with Straight Beam Single Element or Dual Ultrasonic
Probes for Internal Defects with Tomographical and 3D Data
Presentation and User Defined Mapping Scheme, Complete Raw
Data Capturing
= Support of all A-Scan types (Full Wave / Neg Wave / Pos Wave
rectification; RF) while scanning, recording and imaging defects
= Support of Linear or DAC- , DGS- , TCG- normalized recording
and imaging defects
= FFT (Frequency Domain Signal Presentation) - additional feature
for defects evaluation and / or pattern recognition
= Testing Integrity / Coverage Imaging (Top View of Probe
Manipulation Area) Showing of Actually Implemented Probe Trace
= Pulse Echo Amplitude / Distance C-Scan (Top View of Scanning
Area either Global or Sliced - switch able)

= Pulse Echo B-Scan (Side View of the Scanning Area either Global

or Sliced - switch able)

= Pulse Echo D-Scan (End View of the Scanning Area either Global

or Sliced - switch able)

= Through Transmission / Back Echo Attenuation Amplitude C-Scan

(Top View of Scanning Area)

= Versatile Color Palette for Defects Imaging

= Postprocessing: Off-line Recovery and Play-Back of A-Scans;
Echo Dynamic Pattern Recognition; Sizing of defects; Gate
Manipulation - Rebuild C-, B-, and D-Scan views for various Gate
Settings; Statistical Analysis; Slicing and Filtering Images

= Comprehensive Setup and Scanning Reporting, Direct

Connection To any Type of USB or LAN Windows Printer

> S 4030A or S 4030A HT
>S2040B

> 4060 or S 4060 HT

> S 70200 or S 70200 HT

> Probe Holders for Straight
Beam Probes to Be Used
for Inspection

Optional Accessories:

> S 4010

> S 799028 or S 799028 HT
> S86000

> S 554230 AND/OR S
554231 AND/OR S 554232
AND/OR S 554233
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# Item Order Code Note
(Part #)

13 |Inspection SW Package for ISONIC 2006: MULTISCAN-COMBOS-CU - | SWA 996613 |Required Accessories:
Inspection with Straight Beam Single Element or Dual Ultrasonic Cu > S 4030A or S 4030A HT
Probes for Internal Defects with Tomographical and 3D Data >S52040 B
Presentation and User Defined Mapping Scheme - Scanning above > 4060 or S 4060 HT
Tubular or Quasi-Tubular Surface (Curvature Radius 40 - 400 mm), > S 70200 or S 70200 HT
Comp|ete Raw Data Capturing > Probe Holders for Straight

= Support of all A-Scan types (Full Wave / Neg Wave / Pos Wave Beam Probes to Be Used
rectification; RF) while scanning, recording and imaging defects for Inspection
=  Support of Linear or DAC- , DGS- , TCG- normalized recording > S 89000
and imaging defects Optional Accessories:
= FFT (Frequency Domain Signal Presentation) - additional feature > 54010
for defects evaluation and / or pattern recognition > 5799028 or S 799028 HT
= Testing Integrity / Coverage Imaging (Top View of Probe > 586000
Manipulation Area) Showing of Actually Implemented Probe Trace > S 554230 AND/OR S
= Pulse Echo Amplitude / Distance C-Scan (Top View of Scanning 554231 AND/OR S 554232
Area either Global or Sliced - switch able) AND/OR S 554233
= Pulse Echo B-Scan (Unfolded Side View of the Scanning Area
either Global or Sliced - switch able)
= Pulse Echo B-Scan (Real Shape Side View of the Scanning Area
either Global or Sliced - switch able)
= Pulse Echo D-Scan (End View of the Scanning Area either Global
or Sliced - switch able)
= Through Transmission / Back Echo Attenuation Amplitude C-Scan
(Top View of Scanning Area)
= Versatile Color Palette for Defects Imaging
= Postprocessing: Off-line Recovery and Play-Back of A-Scans;
Echo Dynamic Pattern Recognition; Sizing of defects; Gate
Manipulation - Rebuild C-, B-, and D-Scan views for various Gate
Settings; Statistical Analysis; Slicing and Filtering Images
= Comprehensive Setup and Scanning Reporting, Direct
Connection To any Type of USB or LAN Windows Printer
14 |Inspection SW Package for ISONIC 2006: FLOORMAP - Fast Tank SWA 996634 |Required Accessories:

Floor / Shell Inspection for Pitting and Deep Corrosion Damages -
Linear and/or Beam Swiveling Scanning with On-Line Image
Reconstruction
= Support of all A-Scan types (Full Wave / Neg Wave / Pos Wave
rectification; RF) while scanning, recording and imaging defects
= Support of Linear or DAC- , TCG- normalized recording and
imaging defects
= FFT (Frequency Domain Signal Presentation) - additional feature
for defects evaluation and / or pattern recognition
= Complete Coverage of Whole Region Of Ineterst through Non
Mechanically Encoded Linear and/or Beam Swiveling Scanning
= CB-Scan (Top View - of Area of Interest)
= Versatile Color Palette for Defects Imaging
= Postprocessing: Off-line Recovery and Play-Back of A-Scans;
Echo Dynamic Pattern Recognition; Sizing of defects; Filtering and
Normalization of CB-Scan Image
= Comprehensive Setup and Scanning Reporting, Direct

Connection To any Type of USB or LAN Windows Printer

> S 4030A or S 4030A HT

> S 2040B AND/OR S
2045B

> S 4050 or S 4050 HT
AND/OR S 4060 or S 4060
HT AND/OR S 4055 or S
4055 HT

> S 70200 or S 70200 HT

> S 544000 or S 544000 HT
Optional Accessories:

> S 904050
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3.5. Recommended Optional Postprocessing Software
Packages and Software Utilities

# Item Order Code Note
(Part #)

1 [Postprocessing SW Package for Office PC: IOFFICE - ISONIC Office SWA99C0203

= comprehensive postprocessing of inspection results files captured
by ISONIC 2001, ISONIC 2005, ISONIC 2006, ISONIC 2007, ISONIC
2008

= automatic creating of ISONIC 2001, ISONIC 2005, ISONIC 2006,
ISONIC 2007, ISONIC 2008 inspection reports in MS Word® format

2 |Postprocessing SW Package for Office PC: DSHEET - ISONIC D- SWA99C0201
Spreadsheet Creator

= automatic MS Excel® thickness spreadsheet creating through
conversion of C-Scan inspection results files captured By ISONIC
2001 and ISONIC 2006 using CORROMAP, CORROMAP CU,
MULTISCAN COMBO S, MULTISCAN COMBO S CU inspection SW
packages and thickness B-Scan files captured by ISONIC 2005 and
ISONIC 2006 using line scanning mode

= compliant with various Risk Based Inspection and Maintenance
procedures

3 |SW Utility for ISONIC 2001 and ISONIC 2006 Units: CSMAN — ISONIC | SWA 996014
Color Scale Manager
Management of Color Scales (palettes) of Inspection SW Packages

4 |SW Utility: ISONIC Par2Txt SWA99C0205
Converting A-Scan time domain and frequency domain files created by
ISONIC 2001, ISONIC 2005, ISONIC 2006 into pure ASCII file for further
analysis using Labview®, Mathlab®, etc
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4. Operating ISONIC 2006
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Please read the following information before you use ISONIC 2006. It is essential to read and understand
the following information so that no errors occur during operation, which could lead damaging of the unit or
misinterpretation of inspection results

4.1. Preconditions for ultrasonic testing with ISONIC 2006

Operator of ISONIC 2006 must be certified as at least Level 2 Ultrasonic Examiner additionally having the
adequate knowledge of

e operating digital ultrasonic flaw detector

e basics of computer operating in the Windows™ environment including turning computer on/off,
keyboard, touch screen and mouse, starting programs, saving and opening files
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4.2. ISONIC 2006 Controls

®

PS 2 Port Switch has 2 positions:
Front — Front Panel Keyboard and Mouse active; PS2 Port inactive
Rear — Front Panel Keyboard and Mouse inactive; PS2 Port active
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4.3. Turning On / Off

ISONIC 2006 may be powered from:

O 100...250 VAC through external AC/DC converter
O External 11...16V DC source (12V — typical)
O Rechargeable battery (optionally)

AC Power Supply

O  Ensure that power switch is in O position before connecting power cords

O Connect one end of AC power cord to AC/DC converter and plug another end into AC mains

O Connect DC power cord with suppression filter outgoing from AC/DC converter to DC Supply
Voltage Input of ISONIC 2006

External DC Power Supply

O Ensure DC mains do supply voltage between 11 V and 16 V

O Ensure that power switch is in O position before connecting power cord
O Connect one end of DC power cord with suppression filter to DC Supply Voltage Input of
ISONIC 2006 and plug another end into DC mains

Battery

O Ensure that power switch is in O position
O Plug in battery and fix it using 4 screws

Power-Up and Turn Off

To Power-Up ISONIC 2006 set power switch into | position. An automatic system test program will then be
executed; during this test various texts and information appear followed by the screen as below while
booting up

Instruments manufactured on or before Dec 1, Instruments manufactured after Dec 1, 2007
2007

Sonron NDT

ISONIC Instruments Line

Wait until |ISONIC 2006 start sgreenl becomes active automatically upon boot up is completed

[1|operate

[ 2 |settings

[ 3 |Exit To Windows

|4 |shut Down
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— ' -
Click on 1o Jorpress 1 on front panel keyboard or press [F1{ on external keyboard to operate
ISONIC 2006 — refer to Chapters 5 through 12 of this Operating Manual

2 |Settings . -
Click on LJ or press 2 on front panel keyboard or press on external keyboard to proceed
with general settings of ISONIC 2006 — refer to Chapters 13 through 15 of this Operating Manual

| 3 |Exit To Windows
Click on —J or press _3 Jon front panel keyboard or press on external keyboard if it is

necessary to fulfill some general purpose Windows procedures such as setting up drivers for external
devices (printers, USB memory card, and the like), connecting to LAN, quasi-disk management, etc — refer
to Chapter 15 of this Operating Manual

= ' -
To turn ISONIC 2006 off click on ™" Jor press —%_J on front panel keyboard or press [F4| on
external keyboard then wait until the screen as below appears:

Instruments manufactured on or before Dec 1, Instruments manufactured after Dec 1, 2007
2007

It°'s now safe to turn off
the ISONIC

Set power switch into O position upon

®

After turning ISONIC 2006 OFF wait at least 10...30 seconds before switching it ON again

ISONIC 2006 from Sonotron NDT - Operating Manual — Revision 1.21 - Page 41 of 480



5. UDS 3-5 Pulser Recelver
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5.1. Start Up UDS 3-5 Pulser Receiver

While ISONIC 2006 start screen| is active click on Lo Jorpress 1 on the front panel

[ 1 |operate

[ 2 |settings

[ 3 |Exit To Windows

|4 |shut Down

keyboard or press on external keyboard

5.2. Main Operating Surface

UDS 3-5 is fully controllable through the main operating surface:

UDS3-5 - ISOMIC Pulser/Receiver

] 05  Gain ‘ -
| 145 dB 1
| 100 Range ‘ ar
| 100 mm 2
| 5 US Velocity ‘ -
| 5920 m/s 3
| 100 Dizplay Delay o
| 0 ps 4
| -
_ . et 02 3
(Gl FULSER RECEIVER GATEA ) "Ds' 3 - 5
GATE B ALARM DAC/TCG MEASURE  Selection
$ Yalue: AVC[B 3 .
® |6 T a8 52
Cloze m 36 dB Freeze Save | Open | Frnt DGES
Value Box -

Digital Readout
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5.2.1. Main Menu

Main Menu consists of eight topics; each topic is associated with corresponding submenu appearing as
vertical bar showing names for five parameters or modes of operation, their current settings and current
value of increment/decrement for a parameter. The active topic is highlighted

Gain
14 b dB ‘

| Range

| 1ﬂﬂ mm ‘
|

|

|

|

|

UD53-5 - ISONIC Pulser/Receiver

5 U5 Velocity
5920 mjs ‘
100 Dizplay Delay
«

PULSER RECEIVER GATE A Menu
ALARM DAC/TCG /A MEASURE Selecign

Active Topic i { Main Menu i Vertical bar — Submenu
b ; corresponding to
To activate a topic the following manipulations are applicable: highlighted active tOpiC
e Keyboard A ;

B Press EJ on front panel keyboard or on external keyboard until highlighting required topic
OR
B Press <Alt>+<M> on external keyboard = Menu Selection fore color changes to white - then use
e Mouse /Touch Screen
B Click on topic's name

-

B Click on

e Combined

T »

B Click on Menu Selection = Menu Selection fore color changes to white - then use =, "=/,

‘ , ‘ / on front panel keyboard orI . . Ion external keyboard
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5.2.2. Sub Menu BASICS

To control Gain the following
manipulations are applicable:

. .
T

v dhdh dh 4 4

R Sk 3 3%

i T N Y NS

Mouse / Touch Screen

B Click or press and hold on the appropriate

Keyboard
-
B Press 1 J on front panel keyboard or or <Alt>+<G> on external keyboard = Gain fore color

changes to white - then use !J '_’J _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on Gain = Gain fore color changes to white - then use !J '_’J :J ij on front panel
keyboard or , , on external keyboard

®

Gain setup is also possible through a number of other submenus following the same rules as above
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e

T b | by | o by |

L
0% b
. I /
To control Range the following I
manipulations are applicable: I /
/
e Mouse / Touch Screen ly

B Click or press and hold on the appropriate

e Keyboard

®

-
Press 2 J on front panel keyboard or or <Alt>+<A> on external keyboard = Range fore color

changes to white - then use !J _J _J !J on front panel keyboard or , , , on

external keyboard
Combined

Click on Range = Range fore color changes to white - then use !J '_’J :J ij on front
panel keyboard or ,, , on external keyboard

Range setup is also possible through a number of other submenus following the same rules as above
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To control US Velocity the following
manipulations are applicable:

5 US Velocity

5920 mfs
100 Dizplay Delay

0 ps

Mouse / Touch Screen

B Click or press and hold on the appropriate

Keyboard

rd
m Press 3 J on front panel keyboard or or <Alt>+<U> on external keyboard = US Velocity fore

color changes to white - then use !J '_’J _J ij on front panel keyboard or , , , on

external keyboard
Combined

B Click on US Velocity = US Velocity fore color changes to white - then use !J '_’J !J !J
on front panel keyboard or , , , on external keyboard
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To control Display Delay the following l
manipulations are applicable: | /
/
e Mouse / Touch Screen 1/
4

B Click or press and hold on the appropriate
Keyboard

F
B Press _4 j on front panel keyboard or or <Alt>+<E> on external keyboard = Display Delay

fore color changes to white - then use !J '_’J _J !J on front panel keyboard or , , ,

on external keyboard

Combined
B Click on Display Delay = Display Delay fore color changes to white - then use !J '_’J !J

!J on front panel keyboard or , , , on external keyboard
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F
Click on this button or press 5 _

on front panel keyboard or or
<Alt>+<5> on external keyboard

Current value of
increment/decrement for
Reject setup,

%
to select value of
AN increment/decrement for Reject
\ setting

Current value of
Reject
% k

To control Reject the following
manipulations are applicable:

N

I
I
I

e Mouse / Touch Screen

B Click or press and hold on the appropriate

e Keyboard

/

F
B Press _3 _ on front panel keyboard or or <Alt>+<E> on external keyboard = Reject fore color

changes to white - then use ' ‘ ‘ , '.' on front panel keyboard or , , , on

external keyboard

e Combined

t)» & $

B Click on Reject = Reject fore color changes to white - then use =, / on front
panel keyboard or l i . l on external keyboard

¢ Signals below Reject level (small signals) are suppressed

¢ Signals exceeding Reject level (large signals) are presented on the A-Scan without affecting their
original height

¢ Part of large signal wave form below Reject level is suppressed

Reject =20 %

+ +
+ +
+ +
+ -
+ +
+ +
+ +
+ +
+ +

!
/
!
+ + + + F H O+ o+
{

++++++||+-

¢ Reject level may be applied to rectified signals only (Display Modes Full, NegHalf and PosHalf -
refer to paragraph 5.2.4 of this Operating Manual)
¢ Reject setup is also possible through a number of other submenus following the same rules as above
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5.2.3. Sub Menu PULSER

Amplitude of initial pulse (Firing Level) is controllable through button J appearing on the main operating
surface upon activating submenu PULSER

To activate |Firing Level Control subwindowl click on @

\

Tunin
e
Pulzer Mode
.
Pulze Width
226 nS ‘
D ampin
.
. "I | . 50 PEF ‘

BASICS PULSER GATE A Menu

GATE B ALARM DAC/TCG  MEASURE Selectiof.

T [ RO PPN

ln By

Cloze EM| 90 dB Freeze
L =
To control Firing Level the following manipulations are appllcabli. ,’/, -
Mouse / Touch Screen 2% -

® Click or press and hold on the appropriate Click on 2L

Firing Level Control popup window upon completing

or on any control outside

Combined

Click on Firing Level = Firing Level fore color changes to white - then use '. , ‘ , ‘ , '.'

ESC En re.r

on front panel keyboard or ﬂ E g @ on external keyboard. Press X" Jor *= on front panel
keyboard or ESc|or [Enter| on an external keyboard upon completing

®

There are 18 grades (1 through 18) for setting Firing Level — amplitude of initial pulse is controlled from
50 V (Firing Level = 1) to 400 V (Firing Level = 18)
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i Current value of
: Tuning :
5 pH 5
i o
PEEEEEEEEEEEEEEEEEEEEEREEREM ~
Pulser Mode
SINGLE
Pulse Width
220 nS
D amping
H}ﬂﬂ ‘.-'.1 *
4ﬂﬂ Hz *I
& UDS 3-5
11
To control Tuning the following 11
manipulations are applicable: 1]
e Mouse/ Touch Screen 1}
B Click or press and hold on the appropriate
e Keyboard
F 2
B Press _1 J on front panel keyboard or or <Alt>+<G> on external keyboard = Tuning fore
color changes to white - then use ?_ , ‘ ‘ '.' / on front panel keyboard orI . . Ion
external keyboard
e Combined
B Click on Tuning = Tuning fore color changes to white - then use ?_ ? . , " on front

panel keyboard or I . I on external keyboard

®

+ There are 16 (sixteen) matching coils, which may be connected at parallel to ultrasonic probe in
order to obtain best available probe impedance matching / signal to noise ratio. Possible values for

the matching coil inductance are: 2uH, 7uH, 12uH, 17uH, 24uH, 29uH, 34uH, 39uH, 41uH, 46uH,
51pH, 56pH, 63uH, 68uH, 73uH, and 78 uH

¢ Setting the Tuning to "NO" disconnects matching coil
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= By

Iro By

Pulse Width

220 nS ‘
Bl e
R «
& uns :'57’-5

To control Pulser Mode the following

——

=%

o2
vAhAh AR dh 4

iy

manipulations are applicable: III
|
e Mouse/ Touch Screen "
B Click or press and hold on the appropriate
e Keyboard
F

B Press _2 _J on front panel keyboard or or <Alt>+<U> on external keyboard = Pulser Mode

fore color changes to white - then use !_ ?/ . , !' on front panel keyboard or , , ,
on external keyboard

e Combined

®

There are two Pulser Modes available: Single and Dual
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Current value of Pulse Width

: Tuning
----------------- \-:-:---------" ]2 I.I.H ‘
~

(Duration of Square Wave
Initial Pulse)
ns

Pulser Mode
SINGLE ‘

ﬂl
e «
\_I uM 3-5

To control Pulse Width the following

>~

"'""l""""

Ty | = by [ 1o by | o by [ =y

manipulations are applicable: ' I
Iy

e Mouse/Touch Screen I/

B Click or press and hold on the appropriate
e Keyboard

i
B Press 3 J on front panel keyboard or or <Alt>+<E> on external keyboard = Pulse Width
fore color changes to white - then use ' , ‘ ‘ ‘ / on front panel keyboard orl . .

on external keyboard
e Combined

INCINIIR S

B Click on Pulse Width = Pulse Width fore color changes to white - then use
on front panel keyboard or , , , on external keyboard

®

¢ Pulse Width (Duration of Square Wave Initial Pulse) is tunable between 65 ns to 600 ns in 5 ns steps

¢ Attempt to decrease Pulse Width below 65 ns switches to excitation of Spike Pulse instead of Square
Wave Pulse. There are 4 (four) energy levels available for the Spike Pulse excitation; said levels are
indicated in the Pulse Width field:

0 Spike (250uJ) — spike pulse with the 250 nJ energy of excitation
0 Spike (160uJd) — spike pulse with the 160 pJ energy of excitation
0 Spike (90uJ) — spike pulse with the 90 pJ energy of excitation
0 Spike (40uJ) — spike pulse with the 40 pJ energy of excitation

¢ The energy of Spike Pulse excitation is controllable through the same controls as Pulse Width

¢ Attempt to increase energy of Spike Pulse excitation above 250 pJ switches to excitation of Square
Wave Pulse instead of Spike Pulse

¢ Energy levels of Spike Pulse excitation are calibrated at Firing Level =
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Current value of
Damping

E 0 ; Tuning
.............. -‘--\-----------1 12 I-IH ‘
N Pulzer Mode
\\ SINGLE ‘

= by

Ina By

S Pulse Width
N

e By

N\ 220 nS

N\ D -
amping
1000 &2 '
i1} FRF
400 Hz

&| uns

4= By

Itn By

To control Damping the following
manipulations are applicable:

\\\w
LS

e Mouse/Touch Screen /

B Click or press and hold on the appropriate

e Keyboard
F 3
B Press _4 J on front panel keyboard or or <Alt>+<A> on external keyboard = Damping fore

color changes to white - then use !_ ? ‘ , .' on front panel keyboard or , , , on

external keyboard

e Combined

L IACIRRIAR

B Click on Damping = Damping fore color changes to white - then use =, "=, = J ' T J on

front panel keyboard or , , , on external keyboard

®

There are 17 (seventeen) discrete damping resistors, which may be connected at parallel to ultrasonic
probe, their resistance values are 25€2, 30€2, 35€2, 40Q2, 45Q), 56Q2, 6502, 7602, 90C2, 115C2, 13012,
15002, 18002, 24002, 320Q2, 50002, and 1000 2
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Pulser Mnde

SINGLE
Pulse YWidth
136 nS
| Ddmping
1000 2
I /
I /
To control PRF the following I /
manipulations are applicable: I /
/
e Mouse/Touch Screen 1/
|4

B Click or press and hold on the appropriate |button|

e Keyboard
-
B Press _5 J on front panel keyboard or or <Alt>+<R> on external keyboard = PRF fore color

changes to white - then use !J '_’J :J !J on front panel keyboard or , , , on

external keyboard

e Combined

B Click on PRF = PRF fore color changes to white - then use !J '_’J :J !J on front panel

keyboard or , ,, on external keyboard

®

UDS 3-5 is equipped with a protection circuit preventing probe damage, which may be caused by not proper
setting of Tuning, or Damping, or Pulse Width, or Firing Level, or combination of them. Protection circuit
limits total energy delivered to firing output through automatic reducing of PRF until reaching safe mode of
operation
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5.2.4. Sub Menu RECEIVER

Current setting of Filter
representing central frequency
of the narrow band (resonant)

SssssassssssssEss
TR RN NN NN

Filter
MHz
..................... — Gain 47
-~ 1 1 dB 1
Filter o
BB ’ —
Frequency o
0.35-3b HHZ 3
Diszplay * _pl
Full 4
Beject 4
0% ‘ 2
1
To control Filter the following I II
manipulations are applicable: 1y
e Mouse/ Touch Screen I
!
B Click or press and hold on the appropriate
e Keyboard
F
® Press _2 J on front panel keyboard or or <Alt>+<L> on external keyboard = Filter fore color
changes to white - then use ? , * . " on front panel keyboard or , , , on
external keyboard
e Combined
B Click on Filter = Filter fore color changes to white - then use ? ‘ « '.' / on front panel

keyboard or , , , on external keyboard
®

¢ The are 6 (six) narrow bands (resonant) filters with central frequencies as below:
Q 0.5%0.15 MHz — recommended for 0.3 ... 0.8 MHz probes
Q 1+0.3 MHz-recommended for 0.8 ... 1.5 MHz probes
Q 2+0.6 MHz — recommended for 1.5 ... 3.2 MHz probes
Q 4+ 1.2 MHz —recommended for 3.2 ... 7.5 MHz probes
Q 10+ 3 MHz — recommended for 7.5 ... 12.4 MHz probes
Q 15+ 4.5 MHz — recommended for 12.4 ... 17 MHz probes

¢ The narrow band (resonant) filtering is negated upon setting Filter to BB (Broad Band)
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Current Frequency band of
the receiver

MHz
From —To
................. -
N\
N\ < -
SN 1
N
_
2
_
3
_
4/
LT Beject ﬁ
/
0% ‘ 3
To control receiver's Frequency band ) /
the following manipulations are /
applicable: /

I
|
Iy
e Mouse/ Touch Screen I/
B Click or press and hold on the appropriate
e Keyboard

-
B Press 2 J on front panel keyboard or or <Alt>+<E> on external keyboard = Frequency fore

color changes to white - then use ? ‘_ « , '.' on front panel keyboard or , , , on

external keyboard
e Combined

! ‘_ ‘ '.' on

B Click on Frequency = Frequency fore color changes to white - then use
front panel keyboard or ,, , on external keyboard

®

There are 28 (twenty eight) receiver's Frequency bands:

035-35MHz 035-195MHz 035-13MHz 0.35-52MHz 035-26MHz 035-13MHz 0.35-0.65MHz
0.7 — 35 MHz 0.7 -19.5 MHz 0.7 — 13 MHz 0.7 —5.2 MHz 0.7 — 2.6 MHz 0.7 - 1.3 MHz
1.4 - 35 MHz 1.4-19.5 MHz 1.4—-13 MHz 1.4-52MHz 1.4-2.6 MHz
2.8 —35 MHz 2.8 -19.5 MHz 2.8 -13 MHz 2.8 -5.2 MHz
7 — 35 MHz 7 —19.5 MHz 7 —-13 MHz
10.5-35MHz  10.5-19.5 MHz 10.5-13 MHz
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<
Current mode of signal 1 1_ dB
: presentation (Display) : Filter ‘
'---------------{--: ---------------- ] BB
S - Frequency ‘
S~ 0.35-35 MHz
S - Dizplay ‘
Full b,
5 Beject
0% /g
To select mode of signal presentation S, 2
7/

|u?~l{ b By e by o By =y

(Display) the following manipulations
are applicable: /
//
e Mouse/ Touch Screen 4y

’

B Click or press and hold on the appropriate

e Keyboard
-
B Press _%_J on front panel keyboard or or <Alt>+<I> on external keyboard = Display fore color

changes to white - then use !_ ?/ . ! on front panel keyboard or , , , on

external keyboard

e Combined

LINCINEINS 4

B Click on Display = Display fore color changes to white - then use =/, 4, = / on front

panel keyboard or , , , on external keyboard
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®

¢ There are four Display modes for time domain signal presentation:

RF —no
rectifying

+ + -T"ll ||-.|
|
. -+_—-—_—-—.4-.————4-—-'"|| + | | I|

| I___.l"
+ + + + || | +
W

PosHalf —
positive half
wave
rectifying

NegHalf —
negative half
wave
rectifying

Full — both
waves
rectifying
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¢ Frequency domain signal presentation is available through FFT Display mode. Refer to paragraph 5.2.14
of this Operating Manual for instructions related to frequency domain signal presentation

Time Domain

0.5 Gain
= )
R il «

B «
Al «
uns 2-5

1 |

DG5S

o By

ln By

]
Close Em | Freeze

Frequency Domain Signal presentation is not possible if:
o DAC is active (refer to paragraph 5.2.9 of this Operating Manual)
0 TCG is active (refer to paragraph 5.2.9 of this Operating Manual)

=
Open

«|=

Save
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5.2.5. Sub Menu GATE A

Current status of Gate A

N 05 Gain
N  IEXL ‘

il 4

2 aStart *
26 mm

2 awidth [N
mm

10 aThrezhold I
45 2% ‘

7

o iy [ ety oy | |y

To switch Gate A ON / OFF the

|
following manipulations are applicable: I II
e Mouse/ Touch Screen Iy
B Click or press and hold on the appropriate
e Keyboard
F

B Press _2 _ on front panel keyboard or or <Alt>+<T> on external keyboard = aSwitch fore

color changes to white - then use !_ ?/ « , !' on front panel keyboard or , , , on

external keyboard
e Combined

B Click on aSwitch = aSwitch fore color changes to white - then use !_ ?/ « , !' on front

panel keyboard or , , , on external keyboard
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Gain -
3 dB ‘ L
aSwitch o
~
/
R o] 2
~ o
3
a"w'ldth -
8 mm ‘ 4/
aThreshold -,
45 %% * ,d
/
To control delay of Gate A (aStart) | /
the following manipulations are applicable: 1y
11/
e Mouse/Touch Screen 1/

B Click or press and hold on the appropriate

Keyboard
Fd
B Press 3 J on front panel keyboard or or <Alt>+<A> on external keyboard = aStart fore color

changes to white - then use !J '_’J !J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on aStart = aStart fore color changes to white - then use !J '_’J !J !J on front
panel keyboard or , , , on external keyboard

Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)

®

¢ aStart setup is also possible through a number of other submenus following the same rules as

above
¢ Counting of aStart value starts after finishing of Probe Delay count (refer to paragraphs 5.2.12
and 5.2.13 of this Operating Manual)
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aStart
26 mm

g | 0 By [0 | 1=y

awidth
8 mm ‘ 2
10 aThreshold " o

4b 2% 5
To control duration of Gate A (awidth) , /
the following manipulations are applicable: I /

/

e Mouse/ Touch Screen 1y

B Click or press and hold on the appropriate

Keyboard
F
B Press _4 j on front panel keyboard or or <Alt>+<W> on external keyboard = aWidth fore

color changes to white - then use !J _J _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on awidth = awidth fore color changes to white - then use !J '_’J !J !J on front
panel keyboard or , , , on external keyboard

Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)
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To control threshold level of Gate A
(aThreshold) the following manipulations
are applicable:

aT hrezhold
45 2% ;

/
/

|

|

|
Mouse / Touch Screen 1/

[ 4

B Click or press and hold on the appropriate

Keyboard

-
B Press'_5 J on front panel keyboard or or <Alt>+<E> on external keyboard = aThreshold fore

color changes to white - then use !J '_’J _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on aThreshold = aThreshold fore color changes to white - then use !J '_’J :J !J
on front panel keyboard or , , , on external keyboard

Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)
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5.2.6. Sub Menu GATE B

To switch Gate B ON / OFF the

A
m,ﬁ
2 bStart
nomn Ko

thdth
ozmm K

hT hreshold
M e :

7

|
following manipulations are applicable: I II
e Mouse/ Touch Screen Iy
B Click or press and hold on the appropriate
e Keyboard
F
B Press _2 J on front panel keyboard or or <Alt>+<T> on external keyboard = bSwitch fore
color changes to white - then use !_ , ‘ ‘ '.' / on front panel keyboard orI Ion
external keyboard
e Combined
B Click on bSwitch = bSwitch fore color changes to white - then use ?_ ? ‘ , '.' on front

panel keyboard or , , , on external keyboard

)

Counting of bStart value starts after finishing of Probe Delay count (refer to paragraph 5.2.12 and
5.2.13 of this Operating Manual)
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b witch

ON
2 bS5tart

47 .9 mm

2 bwidth

13.2 mm
10 bThreshold

40 %5

To control delay of Gate B (bStart) (I
the following manipulations are applicable: 1y

11/
e Mouse/ Touch Screen 1/

B Click or press and hold on the appropriate

Keyboard
Fd
B Press 3 J on front panel keyboard or or <Alt>+<A> on external keyboard = bStart fore color

changes to white - then use !J _J _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on bStart = bStart fore color changes to white - then use !J '_’J :J !J on front
panel keyboard or , , , on external keyboard

Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)
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To control duration of Gate B (bWidth)
the following manipulations are applicable:

Mouse / Touch Screen

B Click or press and hold on the appropriate
Keyboard

F
B Press _4 j on front panel keyboard or or <Alt>+<W> on external keyboard = bWidth fore

color changes to white - then use !J _J _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on bWidth = bWidth fore color changes to white - then use !J '_’J !J !J on front
panel keyboard or , , , on external keyboard

Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)
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To control threshold level of Gate B
(bThreshold) the following manipulations
are applicable:

bSwnlch
N

2,  bwdth

13.2 mm
bThrezhold

40 %%

|

|

|
Mouse / Touch Screen 1/

[ 4

B Click or press and hold on the appropriate
Keyboard

-
B Press'_5 J on front panel keyboard or or <Alt>+<E> on external keyboard = bThreshold fore

color changes to white - then use !J '_’J _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on bThreshold = bThreshold fore color changes to white - then use !J '_’J :J !J
on front panel keyboard or , , , on external keyboard

Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)
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5.2.7. Drag and Drop: Gate A and Gate B

Gate A and Gate B may be manipulated through Drag and Drop provided that they are visible in the A-
Scan area. |[Mouse pointer changes shape| while placing it above appropriate section of a gate

05 Gain
e K
1

Range

oo Ko

100 mm

Alarm Switch
«
Alarm Logic
«
Setup Gate
GATE B

BASICS _ PULSER  RECEIVER  GATE A Menu "D" ? - 5
GATE B PG DAC/TCG  MEASURE  Selection

Cloze MI Freeze Save Print
To manage a gate just press and hold left mouse button or touch screen stylus and drag, then drop through
releasing of left mouse button or touch screen stylus

"

o By

e By

= By

[en By

e
DG5S

=
Open
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5.2.8. Sub Menu ALARM

------------------------------------- 1
Alarm Switch status for 3dB 3dB

! selected Gate is shown here 1 Range ‘ 1 Range ‘
FesssEsEEEEEEEEEEEEEEEEEEEEREEREE ‘- -: ‘I ﬂﬂ mm .I ﬂﬂ mm
AN Alarm Switch Alarm Switch ‘

GN ON

Alarm Logic Alarm Logic

Positive Negative
~ Setup Gate

GATE B

To select a Gate for Alarm Setup the 4 //
following manipulations are applicable: / p -
I ” -
/ - -
e Mouse/Touch Screen 1, o -
-
m Click or press and hold on the appropriate

e Keyboard

F
B Press _3 _ on front panel keyboard or or <Alt>+<T> on external keyboard = Setup Gate fore

color changes to white - then use ?_ ? « , '.' on front panel keyboard or , , , on

external keyboard
e Combined

LY

B Click on Setup Gate = Setup Gate fore color changes to white - then use =,
on front panel keyboard or , , , on external keyboard

® = =
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0.5 Gain

3 dB ‘
1 Ra
100mm B

8  Alarm Switch
ON

Alarm Switch
ON

R

Alarm Logic * Alarm Logic
Positive 7 Negative
Setup Gate I y g Sehup Gate
GATE A ‘ y 5 GATEB
L
/
To control Alarm Switch the Iy
following manipulations are Iy
applicable: 1y P
lr <, s
e Mouse/ Touch Screen llé//
B Click or press and hold on the appropriate
e Keyboard

-
B Press 2 J on front panel keyboard or or <Alt>+<W> on external keyboard = Alarm Switch

fore color changes to white - then use ?_ ? . , " on front panel keyboard or , , ,
on external keyboard

e Combined

D &

B Click on Alarm Switch = Alarm Switch fore color changes to white - then use ?

" on front panel keyboard or , , , on external keyboard
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"

A A A A A nn ke . Gai 05 Gain
Alarm Logic : 1 3 dB ‘
- » 1

................................ R al Range
» oo R

Alarm Switch
on K

Alarm Logic Alarm Logic

Positive : Negative
Setup Gale

o By

e By

len g = By

To select Alarm Logic the
following manipulations are applicable:

e Mouse/Touch Screen Iy 2
&

B Click or press and hold on the appropriate Ibuttonl

e Keyboard
-
m Press _4 J on front panel keyboard or or <Alt>+<L> on external keyboard = Alarm Logic

fore color changes to white - then use ?_ ? « , '.' on front panel keyboard or , , ,
on external keyboard

e Combined

LRI

B Click on Alarm Logic = Alarm Logic fore color changes to white - thenuse =, =, ~J ' T
on front panel keyboard or , , on external keyboard
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®

Alarm Example

= By

vdh dh 4bh 4h 4

05 Gain
e K
1

Range

T

100 mm
Alarm Switch
«
Alarm Logic
«
Setup Gate

GATE A

BASICS _ PULSER _ RECEIVER  GATE A Menu "D" ? - s
GATE B ALARM DAC/TCG MEASURE Selection
|_ Yalue: OFF ﬁ ﬂ & = I L
Cloze b Alarm ~ ~ Freeze Save | Open DGS
L. ~ -

S [ e ‘

: Alarm Indicator for : : Alarm Indicator for :

: Gate A : i GateB :

+ There is a pulse matching with Gate A and exceeding its threshold; the Alarm Logic setting for Gate A
is Positive = Alarm Indicator for Gate A is active

+ There is a pulse matching with Gate B and not exceeding its threshold; the Alarm Logic setting for Gate
B is Negative = Alarm Indicator for the Gate B is active
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5.2.9. Sub Menu DAC/TCG

Current status of ]
3 DAC/TCG/DGS N 1
PR TP P PP P P PP PN —
DAC/TCG/DGS "
Current quantity of : OFF 2
: stored echoes \ 2 aStart I r
: composing DAC :~ ~ 30 mm :‘ 3/
A ——_ ~ ~ ] F"
: Status of DAC : shombac T
: curve o~ - now o
Curve OFF 5
To select required mode for /
DAC/TCGI/DGS the following Iy
manipulations are applicable: Iy
I/
e Mouse/Touch Screen Iy
B Click or press and hold on the appropriate

e Keyboard

Fa

B Press _2_ on front panel keyboard or or <Alt>+<T> on external keyboard = DAC/TCG/DGS

fore color changes to white - then use ? ‘_ « , '.' on front panel keyboard or , , ,
on external keyboard

e Combined

B Click on DAC/TCG/DGS = DAC/TCG/DGS fore color changes to white - then use !
'.' on front panel keyboard or , , , on external keyboard

®

» &

S ——
[ | ’

¢ There are four possible modes for DAC/TCG:
There are four possible modes for DAC/TCG:

OFF - DAC Curve switches automatically to OFF while in OFF

DAC - available if quantity of stored echoes is 2 (two) or more. DAC Curve switches
automatically to ON while in DAC mode. Both experimental and theoretical methods for creating
DAC are available

TCG - available if quantity of stored echoes is 2 (two) or more. DAC Curve switches
automatically to OFF while in TCG mode

Update - allows to create/update new/existing DAC. Update of existing DAC performed through
erasing of a number of sequentially recorded echoes, starting from the latest one, and/or
recording of new echoes. The maximal number of echoes recorded into the one DAC is 40
(forty). DAC Curve switches automatically to ON if the number of recorded echoes is 2 (two) or
more and switches automatically to OFF if number of recorded echoes is less than 2 (two) while
in Update mode

¢ Itis possible to Create / Modify / Activate DAC and TCG for all Display modes (RF, Full, Negative, and
Positive)

¢ To create / modify DAC/TCG or DGS refer to paragraphs 5.2.10, 5.2.11 of this Operating Manual
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5.2.10. Create / Modify DAC
5.2.10.1 Theoretical DAC: dB/mm (dB/in)

Theoretical DAC represents pure exponential law for distance amplitude curve; said law is determined by
dB/mm (dB/in) factor and value of Probe Delay - refer to paragraphs 5.2.12, 5.2.13 of this Operating
Manual: at zero material travel distance theoretical DAC has start point at 100% of A-Scan height

Set DAC/TCG/DGS to Update then click

UD53-5 - ISONMIC Pulser/Receiver

1 Gain

s K

= Ty

32 dB
DAC/ICG/DGS
Update ‘
2 aStart
.
Show DAC
Curve OFF

BASICS PULSER _RECEIVER  GATE A Menu dwmml "D’l ? - s
GATE B ALARM DI MEASURE  Selection
ol Value: OFF I i = &

Close Em I Freeze Save EBrint

LERL 8

o By

= By

e By

L
DG5S

=
DOpen
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Click on this button or press
rF
1 on front panel keyboard or

or <Alt>+<1> on external
keyboard to select value of
increment/decrement for dB/mm
(dB/in) factor setting

Current value of

Current value of i . £
. increment/decrement for :

i dB/mm (dB/in) factor _ _
i dB/mm (dB/in) factor setting

DAC/TICG/DGS

Update
2 aStart

29 ¢ mm

Show DAC
Curve OFF

BASICS PULSER BRECEIVER GATE A _ dB/mm 10.001
GATE B ALARM MEASURE Selection

/7

i Theoretical DAC according to P // s
: entered dB/mm (dB/in) factor : /7 7
To control dB/mm (dB/in) factor the following P // 7
manipulations are applicable: P s
e Mouse /Touch Screen ,é

B Click or press and hold on the appropriate
e Keyboard

B Press '. , ‘ ‘ , ‘ on front panel keyboard or , , , on external keyboard
On completing dB/mm (dB/in) factor setting click on Ok or press =4/ on front panel keyboard

Enter|on external keyboard. This will return to main operating surface of UDS 3-5 Pulser Receiver and

dB/mm
activate theoretical DAC. Button becomes green while theoretical DAC is setup; set
DAC/TCG/DGS to DAC to activate theoretical DAC or to TCG if it is necessary to perform time correction of
gain in accordance with theoretical DAC law.

dB/
To modify or switch theoretical DAC off set DAC/TCG/DGS to Update then click on o . In the
appeared popup subwindow modify value dB/mm (dB/in) factor as it is described above or click on

OFF then on OK
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5.2.10.2 Experimental DAC: recording signals from variously located reflectors
If theoretical DAC is active then it must be switched off according to paragraph 5.2.10.1 of this Operating
Manual prior to building of experimental DAC. Switch on Gate A then set DAC/TCG/DGS to Update. Place

probe onto DAC calibration block and maximize echo from the reflector closest to the probe (first echo) then
place Gate A over received signal and capture first DAC echo

UD53-5 - ISONIC Pulser/Beceiver |
‘
¢
¢
o -

Show DAC
Curve OFF

BASICS PULSER RECEIVER GATE A Menu
GATE B ALARM DAC/TCG oAl Selection

HE
Cloze m I Freeze

To capture DAC echo the following
manipulations are applicable:

e Mouse/ Touch Screen

m Click fon]

e Keyboard
-
B Press _4 J on front panel keyboard or or <Alt>+<R> on external keyboard = Rec fore color

changes to white - then use ' ‘ ‘ , '.' on front panel keyboard or , , , on

external keyboard

e Combined

T » ol

B Click on Rec = Rec fore color changes to white - then use =, ' -~ on front panel keyboard or
on external keyboard

will appear

As a result the first DAC echo will be stored and corresponding
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Place probe onto DAC calibration block and maximize echo from next reflector then place Gate A over
received signal and capture next DAC echo. As result next DAC echo will be stored causing appropriate
modifying of [corresponding indications)

1 Gain

= Yy

24 dB ‘
DAC/ICG/DGS

Update ‘

1 aStart

3.3 mm

o By

[ By

= By

Show DAL
Curve ON

len By

¢ The highest echo in the Gate A will be stored said echo may either exceed Gate A threshold level or not
¢ Stored echo must be below 100% of A-Scan height

+ Atotal number of 40 echoes may be stored one by one by the same way as described above
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After creating a DAC (2 or more echoes stored) the DAC and / or TCG may be activated.
There are two styles of DAC indication in the DAC mode: Main Curve Only and Main Curve £ N dB, where

IN may be setup either as 2, 4, 6, 8,10, 12, or 14 dB|. To proceed follow the rules below:
1 Gain
.
DAC/TCG/DGS
.
1 aStart
.

= by

P By

o2
v Ah A AA 4

= By

len By

N
= B\

I~
vAhAh A\ 4

DAC/TC
DAC
1 aSkart
165 .3 mm

e By

= By

Show CALC
Curve+6dE

o iy

v =T
e Mouse/ Touch Screen y‘ = z -
B Click or press and hold on the appropriate
e Keyboard
F

B Press _35__ on front panel keyboard or or <Alt>+<H> on external keyboard = Show DAC fore
color changes to white - then use ' , * , . , " on front panel keyboard or , , , on

external keyboard
e Combined

B Click on Show DAC = Show DAC fore color changes to white - then use ' ‘ ‘ , '.'
on front panel keyboard or , , , on external keyboard
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It's possible to erase the last stored echo from the DAC. To proceed set the DAC/TCG/DGS to Update:

To erase the last stored echo from the DAC the following manipulations are applicable:
e Mouse/ Touch Screen

B Click Jonj.,

UDS53-5 - ISONIC Pulser/Neceiver
~

= by

DAC/ICG/DGS
Update

e By

Show DAC
Curve ON
BASICS PULSER _RECEIVER  GATE A Menu "D’l 2 - 5
GATE B ALARM DXV MEASURE  Selection
P Value: OFF = “
1 || I
LCloze m Freeze Save | Open DG5S
e Keyboard
F

B Press _4 J on front panel keyboard or or <Alt>+<R> on external keyboard = Rec fore color

changes to white - then use ‘ , ‘ on front panel keyboard or E Q on external keyboard

e Combined

B Click on Rec = Rec fore color changes to white - then use ‘ , ‘
Q, { on external keyboard

As a result the last stored echo will be erased causing appropriate modifying of |corresponding indications|

/ on front panel keyboard or

DAC/ICG/DGS
Update

e By

.
.
| Tyl Tl T TrrT T T T
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5.2.11. DGS
DGS A
To setup DGS set Display to Full then click on L= or press ﬂj on front panel keyboard or or

<Alt>+<D> on external keyboard. The following screen appears:

Disk shaped reflector (flat bottom hole - FBH)

EEIE B0 Sl 6 INTEIE ©f [sie] echo amplitude as function of metal travel

travel distance in the reference block for the

selected probe distance in the material under test for the

selected probe and FBH diameter

i ’

= Ty

05 Gain
3 dB ‘
1

Range

200 mm
5 US Velocit
250 ms K
100 Display Dela
BT -
5 Reject
o K

sl B r

Mo By

o By

4= By

e By

DACICC O O
| DGES Setup: SWB-60-5 f 7.7 mm

A
[swB-605 i 3 dB ¥
B Transfer Loss I [ (]
[ ~0dB ¥y - AN
[ b stomotin 1
‘\ —
0 dBf{n 1 K1 AVgq[1 51 =-165dB Backwall Echo
e =y
~t—
Close ||“ 0dB/m ¥ &d6ideim  2dB [dB/m) 1dB(dB/m|
~
——— PO . N
: Equivalent Diameter  : :  Probe selection box
:  (FBH)selectionbox e ;
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To activate DGS follow the steps below:

Step 1: Probe Selection

The following manipulations are applicable for the Probe selection:

e Mouse/ Touch Screen

B Click on m |Scroll probes list to see the selected onel

MwB-60-2

B Click on |selected probe

e Keyboard

2 »

B Press <Alt>+<P> on external keyboard = Probe fore color changes to white — then use =/, '~

:‘r, _!,/ on front panel keyboard or , , , on external keyboard

e Combined

t » @&« 3

B Click on Probe = Probe fore color changes to white - then use =, "=, = J ' T J on front

panel keyboard or , , , on external keyboard
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Step 2: Equivalent Diameter of disk shaped reflector (flat bottom hole — FBH)

The following manipulations are applicable for the selection of the Equivalent Diameter of disk shaped
reflector:

e Mouse/ Touch Screen
m Click m  |Scroll diameters list to see the selected on

\

[o.-8 mm—per|

B Click on |selected equivalent diameter|

e Keyboard

B Press <Alt>+<D> on external keyboard = Equivalent Dia fore color changes to white — then use

_t/, 2» ﬂ i on front panel keyboard or , , , on external keyboard

e Combined

)

B Click on Equivalent Dia = Equivalent Dia fore color changes to white — then use .tx

!/I on front panel keyboard or , , , on external keyboard
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Step 3: Attenuation in the reference block

DG5S Setup: MWB-70-4 /1.5 mm

BTN TR 7
weezos = 125dB ¥ a0
A 1 -
[5em =]l §dB Y ! Y Y

Modify M aterial Attenuation E " \

/ \

Apply | 42 dB/m 1 KZ Avgz=+208 Backwall Echo
)

Close 38 dB/m & dB [dB/m) 2 dB (dB/m) 1 dB [dB/m)

\
The following manipulations are \
applicable: \
\

e Mouse/ Touch Screen \

. N
B Click or press and hold on the appropriate |button|

e Keyboard

B Press <Alt>+<N> on external keyboard = Reference Attenuation fore color changes to white -

then use !J '_’J , :J , !J on front panel keyboard or , , , on external keyboard

e Combined

B Click on Reference Attenuation = Reference Attenuation fore color changes to white - then use

y, '_’J , !J , !J on front panel keyboard or , , , on external keyboard
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Step 4: Attenuation in the object under test

DG5S Setup: MWB-70-4 /1.5 mm
Probe

[Mwe704 =]} 12,5 dB
{1.5 mm =] \ & dB

Modity
v 42 dB/m

Close 38 dBim

o - | o - | o e

L=

Transfer Loss

3\
§.£ AVo = +2 dl’ Backgall Echo
Setup Step
& dB [dE/m)] f« 2 dB [dB/m] 1 dB [dB/m)

Apply

\
\
\

e Mouse/ Touch Screen \
B Click or press and hold on the appropriate

Keyboard

The following manipulations are
applicable:

B Press <Alt>+<M> on external keyboard = Material Attenuation fore color changes to white - then
use !J '_’J , :J , !J on front panel keyboard or , , , on external keyboard

Combined

B Click on Material Attenuation = Material Attenuation fore color changes to white - then use y

'_’J , :J , !J on front panel keyboard or , , , on external keyboard
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Step 5: Transfer loss

DG5S Setup: MWB-70-4 /1.5 mm

|MwB-70-4 |

|1.5 mm vI

Hodify M aterial Attenuation

12.5 dB

Transfer Loss

Apply

Cloze

42 dB/m

4 / ’
A
| \
I = (]
| 3
p \ B
f \
\
K2/ Avg; = +2 dB/ Bagkwall Echo

Reference Attenuatlun

[ 38dB/m

dB [dE/m] ¢ dB [dB/m)] T dB [dB /m]

The following manipulations are applicable:

e Mouse/ Touch Screen

\
\

\
A W
B Click or press and hold on the appropriate |button|

e Keyboard

B Press <Alt>+<T> on external keyboard = Transfer Loss fore color changes to white - then use

!J, 2] :J !J on front panel keyboard or , , , on external keyboard

e Combined

B Click on Transfer Loss = Transfer Loss fore color changes to white - then use !J 2] :J

!J on front panel keyboard or , , , on external keyboard

) )
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Step 6: Gain

Apply probe to the reference block to get the appropriate echo. There are two methods available:
B K1 or K2 reference block (reference block and reflector are defined in the probe data sheet and
reproduced automatically from the DGS data base upon probe selection)
\ B Inclined reference block (reference reflector — back surface)

\ \
\ \
0.5 Gain ‘ o
125 dB 1
1 Range ‘ o
100 mm 2
5 U5 Yelocity ‘ o
3260 mfs 3
100 Diszplay Delay ‘ o
6.23 ps 4
L] Beject o
i a
RACICS : . : : : bl ¢ T H Y L B o
| DG5S Setup: MWEB-70-4°/ 1.5 mm
\
[MwB-70-4 = 7\ \
= T— 9
E quivalent Di ¢
: Trahsfer Loss L \ \ 1
1.5 mm -
| [ 6 dB L X NG
Material hitenuation ‘
; A
42 d\B" m ¥ 2 avke-+2m Backwall Echo
ki st \ekitmiiin L Setup Step
Close ‘| 38 dE/m ¥~ idB [dE ] & 2dB (dB/m) _ ¢ 1dB([dB/m]
-
A A A A AR A .l................_ \ PP T .s..‘.é.d.’. ................................... .
Current Gain : \ : Click on Setup Step option or press <Alt>+<1> or .
: dB 1 \ i <Alt>+<2> or <Alt>+<6> on external keyboard to select
T s\ : required value for increment / decrement for increment /
\ : decrement for setting Gain. The last selected value of
\ : increment / decrement is checked: ®
\ : :
............................. | S

The goal of Gain setup is
: obtaining tip of maximized
: reference echo reaching back :
echo level (blue curve) E
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05 Gain
125 dB ‘

1 Range
Y «

5 U5 Velocity
3250 mjs ‘

100 Dizplay Delay
ﬁ s ls ‘

BACICG
| DG5S Setup: MWB-70-4 !1 5 mm

G
| |MwWB-70-4 T 12_5 dB

i Eauivalent Dia | Transfer Loss )
[1.5mm =] 6 dB A

;\

42 dB/m
! K2 AVygo =+2dB Backwall Echo

p———] Reference Attenuatiun Setup Step

Close 38 dB/m F\EdB (B /m] (v 2dB [dB/m) ¢ 1dE[dB/m)]

[ ]

The following manipulations are \
applicable for Gain setup: \

\
e Mouse/ Touch Screen \

B Click or press and hold on the appropriate

e Keyboard

t »

B Press <Alt>+<G> on external keyboard = Gain fore color changes to white - then use S, =

‘ , '.' / on front panel keyboard orI u u Ion external keyboard

e Combined

tT » @& 3

B Click on Gain = Gain fore color changes to white - then use o, =) J, = on front panel
keyboard or , H_H on external keyboard
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Step 7: Finalizing DGS curve and return to the main UDS 3-3/ UDS 3-4 window

Before finalizing the DGS curve:

: Finalized FBH echo curve (white) — depends on
: Probe, Equivalent Dia, and Material Attenuation

Finalized back echo curve (blue) — depends on
Probe and Reference Attenuation

1 Range ‘
100 mm
5 U5 Velocity

o Ko

3250 mifs

100 Dizplay Delay
623 s ‘
5
|

DACIEC D O O
| DGES Setup: MWB-70-4 /1.5 mm

oo | Gam
[wwe7o4 =I[ 125 dB
I Eouivolent Dia | Transtor Loss I
[1.5mm | 6 dB

42 dBfm

el
Close 38 dB/m

-

[ ]

Ve
K2 AVgy =+2dB Backwall Echo f

i~ BAR [dE./m] (+ 2 dB [dBfm] i 1dB [I:IB;]

Vi
/7 /
To finalize the DGS curve the following / /
manipulations are applicable: / /

/

[ e | et | |

/
Case 1 (K1 or K2 reference block) » Case 2 (Inclined reference block)/
/
e Mouse/ Touch Screen , 4 e Mouse/ Touch Screen

m click or]” m Click [or]

e Keyboard e Keyboard

/

B Pressing <Alt>+<K> on external B Pressing <Alt>+<B> on external
keyboard keyboard
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The finalized DGS curve appears upon accompanied with Automatic Gain Correction:

Finalized back echo : FIdDGS """""" d‘ : Finalized FBH echo 3 aui',rﬁgtziig"y 3
i ! ! Finalize curve (re : i ;3 . .
: curve (blue)  § (red) : curve (white) : i corrected Gain I

5 US Velocity

3250 mfs
100 Dizplay Delay

623 s

+

I
ﬁ,EIL,..,,. " ' "im'l |I‘Hl* |f W 1"" ™,

435 dB

| [ 6dB
Modity N
42 dB/m
Apply .
Elu=s 38 dB/m & dB [dB./m) & 2dB [dB/m] 1dB [(dB/m

To accept finalized DGS curve and return to the main operating surface the following manipulations are
applicable:

e Mouse/ Touch Screen

m Click on Apply

then

B Click on Close
e Keyboard

§ ESC
B Press <Alt>+<A> on external keyboard, then ESC or <Alt>+<C> or JF_) on front panel keyboard
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To negate the finalized DGS curve and return to main UDS3-5 window the following manipulations are
applicable:

e Mouse/ Touch Screen
B Click on M odify

B Click on Cloze

_ May |
e |

e Keyboard

ESC

B Press <Alt>+<0O>on external keyboard, then or <Alt>+<C> or “X_J on front panel keyboard

To create new DGS curve the following manipulations are applicable:

e Mouse/ Touch Screen

B Click on Modify |

e Keyboard

B Press <Alt>+<0> on external keyboard
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Step 8: Work whilst DGS is active

A typical screenshot with active DGS is shown below

UD53-5 - I50NMIC Pulser/Receiver

| +

|
I
'.+

A
'-"'|I|H'I|'I b "I"

A o
vof .
'-|||I H"'._.--._.I L e r‘,-,"l

GATE A
MEASURE

PULSER RECEIVER
ALARM DAC/TCG

D
Close EMI

BASICS
GATE B

.

Freeze

Selection

Probe and FBH Equivalent Diameter

corresponding to active DGS are indicated in the

caption of UDS3-5 window

DGS active [MWB-70-4 1.5 mm FEH]

0.5
435 dB

Range

Gain

pr

1

R «

100 mm
5 US Velocity
3250 m/s ‘
100 Dizplay Delay
6.23 s ‘
r- 5 i
Hy -

=

Erint

=
DOpen

Save

-»

L
DG5S

Some parameters and modes may not be modified whilst DGS is active - corresponding messages appear if

attempting to modify:

Modification of thiz parameter is imposzible

while DGS curve is active

Changing of thiz mode iz impozsible
while DGES curve is active

» Attention!

-

. . . = s
To continue operation click on the after message appears or press

keyboard or or on external keyboard

o
. ) DG5S
To negate the active DGS or create a new one click on
or <Alt>+<D> on external keyboard

ESC

A

L
Enter

or on front panel

%
or press ﬂj on front panel keyboard or
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5.2.12. Sub Menu MEASURE

Value

(]
Meaz Mode
-
0.2 Probe Delay h
b 84 ps
10 h

Angle

60 °

J
B uns 3-5

To select Measured Value

the following manipulations 1
are applicable: 1/
1/
e Mouse/ Touch Screen i
B Click or press and hold on the appropriate
e Keyboard
F

B Press _2 J on front panel keyboard or or <Alt>+<V> on external keyboard = Meas Value fore

color changes to white - then use ?_ ? ‘ , '.' on front panel keyboard or , , , on

external keyboard

e Combined

LY

B Click on Meas Value = Meas Value fore color changes to white - then use =/,

») & (&
on front panel keyboard or , , , on external keyboard

®

Refer to paragraph 5.2.13 of this Operating Manual for information about values available for automatic
measurement and indication in the Value Box (Digital Readout)
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Currently Active
Measurement Mode
........................... B . 3 dB

\ Meaz Yalue
\ OFF
i
0.2 Probe Delay
b 84 s
10 Angle
60 ° _

e | ey | | =y

jLann |
bl uny 2-5
To select Measurement Mode I /
the following manipulations are /
applicable: Iy
Iy
Mouse / Touch Screen 17
B Click or press and hold on the appropriate
Keyboard
-
B Press 3 Jon front panel keyboard or |[F3 or <Alt>+<E> on external keyboard = Meas Mode fore

color changes to white - then use ?_ ? ‘ , '.' on front panel keyboard or , , , on

external keyboard

Combined

» = =

B Click on Mgas Mode = Meas Mode fore color changes to white - then use !

on front panel keyboard or , , , on external keyboard

®

There are four Measurement Modes possible:

¢ Flank

¢ Top

¢ Flank-First
¢ Top-First

Refer to paragraph 5.2.13 of this Operating Manual for further information
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T il
il 4
il

-

To control Probe Delay the following I /
manipulations are applicable: ; /
/
e Mouse/ Touch Screen I/
4

B Click or press and hold on the appropriate
e Keyboard

-
B Press _4 J on front panel keyboard or or <Alt>+<R> on external keyboard = Probe Delay

fore color changes to white - then use !J '_’J _J !J on front panel keyboard or , , ,

on external keyboard

e Combined

B Click on Probe Delay = Probe Delay fore color changes to white - then use !J '_’J !J !J
on front panel keyboard or , , , on external keyboard

@ Refer to paragraph 5.2.13 of this Operating Manual for some hints on determining Probe Delay
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05 Gain
3 dB

Meas Yalue

OFF

= by

Ina By

o2
v b4 dh 4

= By

B uns 3;4

To control Incident Angle the following

manipulations are applicable: I /
e Mouse/ Touch Screen :,/

B Click or press and hold on the appropriate
e Keyboard

-
B Press' _5 J on front panel keyboard or or <Alt>+<N> on external keyboard = Angle fore color

changes to white - then use !J _J _J !J on front panel keyboard or , , , on

external keyboard

e Combined

B Click on Angle = Angle fore color changes to white - then use !J '_’J :J ij on front
panel keyboard or , , , on external keyboard

®

Refer to paragraph 5.2.13 of this Operating Manual for some hints on determining and / or checking Probe
Angle
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Advanced Measurements Settings Menu

£
. . b . .
Advanced measurement settings are available through button El_l appearing on the UDS 3-5 main
operating surface upon activating submenu MEASURE. Clicking on that button activates Advanced
Measurements Settings Menu:

[1] <=
[2] AUTOCAL
AS
4] X

- o
Press ' on front panel keyboard or on external keyboard or click on III |to
activate Advanced Scheme for Reflectors Depth Measurement Whilst Using Angle Beam Probe —

Thickness / Skip / Curved Scanning Surface Correction

F
Press 2 on front panel keyboard or on external keyboard or click on
activate Automatic Calibration Procedure

2] autocaL |

i
Press 2 J on front panel keyboard or on external keyboard or click on EI AS Ito
activate Dual Ultrasound Velocity Measurement Mode

> ESC
Press % Jor _)‘(\ on front panel keyboard or on external keyboard or click on

EI o |to return to main operating surface

®

Refer to paragraph 5.2.13.3 of this Operating Manual to get instructed on:
¢ Advanced Scheme for Reflectors Depth Measurement Whilst Using Angle Beam Probe —
Thickness / Skip / Curved Scanning Surface Correction
¢ Automatic Calibration Procedure
¢ Dual Ultrasound Velocity Measurement Mode
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5.2.13. Time Domain Signal Evaluation - Measurements Guide
5.2.13.1. Values available for Automatic Measurements and Digital Readout

Time of Flight - us of an echo matching
&-Scan with Gate A measured with respect to
Probe Delay:

T(A) = Absolute Delay A - Probe Delay
Value 2: T(B)
Time of Flight - us of an echo matching

with Gate B measured with respect to
Probe Delay:

T(B) = Absolute Delay B - Probe Delay
Value 3: S(A)

Material Travel Distance - mm or in of an
echo matching with Gate A:

s(A) =% - T(A) - US Velocity
Value 4: s(B)

Material Travel Distance - mm or in of an
Abzolute Delay & - Flank echo matching with Gate B:

Abzolute Delay B - Flank s(B) =% - T(B) - US Velocity

n|r.'rtia| Pulse Value 1: T(A)

Display Delay

Value 5: a(A)

Projection Distance - mm or in of reflector
returning an echo matching with Gate A,
measured with respect to Beam Incident
Point:

| | a(A) =s(A) - sin (Angle)

= Value 6: a(B)

Projection Distance - mm or in of reflector
returning an echo matching with Gate B,
Angle measured with respect to Beam Incident
Point:

Straight Beam Proke Angle Beam Probe

€@ 0
nn
o W
o

a(B) =s(B) - sin (Angle)

Value 7: t(A)
L Depth - mm or in of reflector returning an
* echo matching with Gate A:

t(A) =s(A) - cos (Angle)

Value 8: t(B)
Depth - mm or in of reflector returning an echo matching with Gate B:

t(B) =s(B) - cos (Angle)

Value 9: AT - ps:

AT =T(B) - T(A)
Value 10: As -mm orin:

As =s(B) —s(A)
Value 11: Aa - mm orin:

Aa =a(B) —a(A)
Value 12: At - mm orin:

At =t(B) —t(A)
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C&bsolute Delay B- Top)  Value 13: H(A)
Clabsolute Delay & - Top) Azsean Amplitude - % of A-Scan height of an echo
matching with Gate A

Value 14: H(B)
Amplitude - % of A-Scan height of an echo
matching with Gate B
Value 15: V(A)
Amplitude - dB of an echo matching with
Gate A with respect to aThreshold:

V(A) =20 - logyp (H(A) / aThreshold )
Value 16: V(B)
Amplitude - dB of an echo matching with
Gate B with respect to bThreshold:

V(B) = 20 - log1o (H(B) / bThreshold )

a-Threshold b-Threshaold

Value 17: AV - dB:
AV =V(B) - V(A)
Value 18: AVC(A) (dB to DAC)-dB:
AVC(A) = 20 - logyo (H(A) / C (Absolute Delay A_Top) )
Value 19: AVC(B) (dB to DAC)-dB:
AVC(B) =20 - logip (H(B) / C (Absolute Delay B_Top) )

¢ To proceed corresponding Gate or both Gates to be active
¢ AVC(A) (dB to DAC) measurements require active DAC/DGS

+ Amplitude measurements of echoes may be performed provided their heights don't exceed 200% of A-
Scan height

+ For 2 and more echoes matching with a Gate - refer to paragraph 5.2.13.2 of this Operating Manual
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5.2.13.2. Flank, Top, Flank-First, and Top-First Modes of Measurement

The table below represents distinguishing points on an A-Scan, which will be taken for automatic

measurements depending on Meas Mode setting

Meas Mode setting

A-Scan

Meaz Mode

Flank

- T(A)1 T(B)7 S(A)1 S(B)1 t(A), t(B), a(A)v
a(B), AT, As, At, Aa
#® - V(A), V(B), H(A), H(B), AV, AVC(A),
AVC(B)

1

| I T
Ly Fl ] ~|" l.'J'l
|r| [*)

Meas Mode
- T(A), T(B)! S(A), S(B)! t(A)! t(B), a(A)v
a(B), AT, As, At, Aa

® - V(A), V(B), H(A), H(B), AV, AVC(A),
AVC(B)

%

B |
bl 1
g I"# " b w A
¢ I'rJ‘L.‘|| ]J f | '-Irl.lt'rl I|u.||| il

Meaz Mode

Flank-First

- T(A)1 T(B)7 S(A)1 S(B)1 t(A), t(B), a(A)v
a(B), AT, As, At, Aa
#® - V(A), V(B), H(A), H(B), AV, AVC(A),
AVC(B)

lru"l-,ﬁ.‘J ]ll ¥

¥

|+ i
M, I" I'| -ﬁ'l 1| lfu.,l,.L

I
|I J|

Meaz Mode

Top-First

- T(A), T(B)! S(A), S(B)! t(A)! t(B), a(A)v
a(B), AT, As, At, Aa
# - V(A), V(B), H(A), H(B), AV, AVC(A),
AVC(B)

+ 1|| +I
[PRLNAY"

¥+
0 I-,,'L‘II | J f
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®

Distinguishing points of signals are automatically marked on A-Scan whilst measuring:

Gains
51.5 dB
Value: AT+

12.75 ps

'Il;—';';

+ + + |I,lll +1 L
|
T ‘l‘l’lﬁll"ﬂf‘a'i '.,I,l.llu‘llllu"n,hlIII F|,|II|' full |r|r1

Gains
51.5 dB
Value: AV

-3.5dB

J+k

K
ﬁ-‘: }|+ ||

+
|
L
I'I |||lll"| I|| |.|||II I'I'I'I
¥

1 Il I
+ + + ||,l|| + L th | I‘H |.||IHH"||+ ||,J|

|
Uy I'I.r._.'III.-'."'l,\.h'n'llu'u.r-.w,ll ‘l‘l’lﬁll"ﬂf‘a'i '.,I,l.llu‘llllu"n,hlIII F|,|II|' full |r|r1
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5.2.13.3. Advanced Scheme for Reflectors Depth Measurement Whilst Using Angle
Beam Probe — Thickness / Skip / Curved Scanning Surface Correction

[1] <=

Button

submenu MEASURE. The window as below appears after clicking on

-
_1_J on front panel keyboard or on external keyboard

Object under test may be designated as either

1] <=

or

£
| becomes available upon clicking on M if Angle setting differs from 0%in

pressing

* Flat - [click here

Or

>

e Curved -

While scanning above plates, tube wall, and the like the finite
thickness of object under test may be either

>

P

pr

o
1

»

¥ Ignore Thickness

e Ignored — |c|ick here_l
Or

e Entered —

Case 1 represents simplest scheme supposing that scanning
is performed above hemi-space whereas coordinates t(A),
t(B) are determined in accordance with appropriate sketches,
equations, and A-Scans shown in paragraphs 5.2.13.1 and
5.2.13.2 of this Operating Manual

Case 2 represents scanning above plate, or scanning above
tubular object longitudinally. Reflectors depth for half skip, full
skip, and multi skip insonification will be determined with
respect to actual Thickness value — t(A), t(B) readings will be
in accordance with sketches below:

wﬂh}’ uby Thickness
w—;}:t{h} Thickness

\ vﬂh}’ e f Thickness
Thickness

EVAN%i

> .

a
2

»

Apply

Cancel

Casel

* Flat Object

o~

pr

1 |p

" lgnore Thickness

@ 1 Thickness ‘ o .
25 mm =
Apply Cancel

Case 2
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Case 3 represents scanning above curved wall surface
circumferentionally. Reflectors depth for half skip, full skip,
and multi skip insonification will be determined with respect to
actual Thickness and Diameter values — t(A), t(B) readings
will be in accordance with sketch below:

Thickness

HA). tib)

0.5xDiameter

Thickness

t{ﬂ}: )

0.5xDiameter

Case 4 represents scanning above solid cylindrical object
cirmuferentionally or above spherical object. If this is a case
Thickness setting to be: Thickness = 0.5xDiameter and
reflectors depth will be determined with respect tio actual
Diameter value — t(A), t(B) readings will be in accordance
with sketch below:

t{ﬁ}.’:{h}

Diameter

™ Flat Object

10 Diameter

400 mm

L
1

\JHIL 4

" Ignore Thickness

'S

: 9

Apply

Cancel

Case 3

™ Flat Object

2 Diameter

=
254 mm

a4’

" Ignore Thickness

'S

: 9

Apply

Cancel

Case 4
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/

J

7
" Flat viect

10 Diameter

=
400 mm

" Ignore Thickness

Apply / Cancel
v A

To control Diameter the following
manipulations are applicable:

e Mouse / Touch Screen

B Click or press and hold on the appropriate

e Keyboard

-
B Press ! J on front panel keyboard or -1 on external keyboard = Diameter fore color changes to

white - then use !J '_’J :J !J on front panel keyboard or , , , on external

keyboard

e Combined

Click on Diameter = Diameter fore color changes to white - then use !J -' '_’J :J !J on front panel

keyboard or , , , on external keyboard
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To control Thickness the following
manipulations are applicable:

e Mouse / Touch Screen

" Flat O ect
b ?: 2 Diameter ‘
2b4 mm

" Ignore Thickness

B Click or press and hold on the appropriate

e Keyboard

'l
B Press LJ on front panel keyboard or on external keyboard = Thickness fore color changes

to white - then use !J '_’J gj !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Thickness = Thickness fore color changes to white - then use !J '_’J :J !J on
front panel keyboard or , , , on external keyboard

Apply
¢ Clickon

activate new settings

Cancel
¢ Clickon

negate new settings

| Enter
or press i,] on front panel keyboard or [Enter| on external keyboard to

| esc
or press \L] on front panel keyboard or on external keyboard to
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5.2.13.4. Dual Ultrasound Velocity Measurement Mode — Typical Example

For some practical applications it is necessary to measure sound path distances in dissimilar materials,
multi-layer structures, and the like. Also it may occur a need in measuring sound path distances for signals
representing various kinds of ultrasonic waves in the same object. Such cases are characterized by variety
of US Velocity values to be used while measuring intervals between signals on the same A-Scan. To
simplify measurement procedure and avoid operator's computations it may be activated Dual Ultrasound
Velocity Measurements Mode, which's use is illustrated by the example below

Supposing it's necessary to measure thickness of each layer of
bi-metallic part made through by means of explosion welding
between regular carbon steel ( US Velocity = 5920 m/s ) and
brass alloy ( US Velocity = 4720 m/s ) plates while probe to be
placed on low carbon steel plate. While placed on the steel side
10 MHz dual element probe with Probe Delay = 5.8 ps receives
two clear echoes 1 and 2 form the steel-to-brass boundary and
from the back surface of the brass layer correspondingly:

Steel
Braz=

UDS3-5 - ISONIC Pulser/Receiver

05 Gain
2 dB

= Ty

I By

5 U5 Velocity

H920 mfs
0.02 Display Delay

b8 s

o By

4 By

ln By

BASICS PULSER  RECEIVER  GATE A Menu "Ds’ ? - s
GATE B ALARM  DAC/TCG _ MEASURE _ Selection

] Value: OFF PPN g | = | -
Cloze Em | Freeze Save | Open DGE5S

US Velocity setting is suitable for steel and thickness of steel layer may be found through direct reading
upon placing Gate A above signal 1:

UDS53-5 - ISONMIC Pulser/Receiver

05 Gain

2 dB ‘
Meas Yalue

.
Meas Mode

.

0.5 Probe Delay
4'

BASICS PULSER RECEIVER GATE A Menu
GATE B ALARM IS InEE MEASURE Selection

]
Cloze EM| 3.08 mm Freeze
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If placing now Gate B above signal 2 and selecting As as Meas Value then interval between signals 1 and 2
will be measured. To obtain proper As readout value of US Velocity valid for brass alloy layer (second
material) must be keyed in

UDS3-5 - ISONIC Pulser/Receiver

0.5 G ain
72 dEﬁ ‘
;
Measz Mode
.
0.5 Fiobe Delay

|
"“I"‘ -| Ill +

BASICS PULSER RECEIVER GATE A Menu
GATE B ALARM DAC/TCG Selection

]
Close | IRy | 2 92 mm

This digital readout was obtained through use of steel

= US Velocity setting (first material) and may not be 3
_ recognized as a thickness of brass alloy layer (second _
matenal)

To obtain proper reading for the thickness of brass layer actlvate DuaI UItrasound VeIocny Measurements
£

M if:

Mode - Button AS becomes available upon clicking on

+ Both Gate A and Gate B are active (refer to paragraphs 5.2.5 and 5.2.6 of this Operating Manual)
¢ Meas Value setting is As (refer to paragraph 5.2.12 of this Operating Manual)

0.5 Gain ‘ o
12 dB 1
Meas Yalue
As ‘
Meas Mode ‘
- . LY
[2] AUTOCAL
. AS
BASICS PULSER RECEIVER GATE A Henu E E >
GATE B ALARM DAC/TCG MEASURE Selection
00 PN = [
Cloze M| 2.92 mm Freeze Save | Open DGES
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The screen as below appears after clicking on
keyboard or on external keyboard:

BASICS

GATE B ALARM

PULSER

+

| II.,|||\|

RECEIYER
DAC/TCG

HS

why

or pressing

|; gi

‘}\H

II||

GATE A
MEASURE

[ e Y—

Close | PR |

2_92 mm

Freeze

’+|HF|'--| I|I +

Menu
Selectio

.

L

05 Gain

_= Jon front panel

{2 dB ‘
Meas Yalue

e Ko
Meas Mod
e R

0.5 Probe Delay

L
5 U5 Velocity
5920 mfs

Click on this button or press 1
-~ keyboard or |[F1/or <Alt>+<1> on external keyboard

to select value of increment/decrement for second

US Velocity setting

-
-
-
0 o
02 1
292mm /
()% Tt
Click on appropriatelbuttonlorpress ' ‘ « '.'
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05 Gain
2 dB ‘
Meas Yalue

vl «

Asg
Meas Mode

Bl «

Flank

0.5 Probe Delay ‘
I'l,l 58 s
| .

+ N
|!";"1 "'Fli" 5 US Velocity
LI

4720 mfs

BASICS PULSER RECEIVER GATE A Menu
GATE B ALARM PEIwa Nty MEASURE Selectic

HE
Close MI 2.92 mm Freeze

-

[Digital readout for actual thickness of the brass alloy layer (second material)] is obtained upon completing
setting for second US Velocity

To return to the main ISONIC Pulser Receiver window click on 0k |or press = or '\ X Jon
front panel keyboard or <Alt>+<K> or [Enter|or on external keyboard

To printout A-Scan accompanied with setup list, measured value of As, and second US Velocity value click

on Erint | or press <Alt>+<P> on external keyboard (printer to be accessible through either USB or
LAN port and defined as default in the ISONIC 2006)
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5.2.13.5. Determining Probe Delay - Miniature Angle Beam Probes (contact face
width 12.5 mm /0.5 in or less) - Shear or Longitudinal Waves — Typical Example

Activate submenu PULSER then set:

O Pulser Mode to Single or Dual depending
on probe

O Pulse Width to Spike (240 pJ) for probe
having resonant frequency of 8 MHz and
higher or to PW ns, were PW =0.5/F (F
is the probe resonant frequency) for
probes having resonant frequency below 8
MHz

Q Firing Level to 18

Q Damping to 1000 Q

Q Tuning to NO

Activate submenu RECEIVER then set:

o Display to Full or RF
a Filter to BB
Q Frequency to completely cover probe's
effective bandwidth
Activate submenu BASICS topic then set:

Q US Velocity to 5920 m/s (233.1 in/ms) for
longitudinal wave probes or 3255 m/s
(128.1 in/ms) for shear wave probes

@ Rangeto50.0 mm (2in)

a Display Delay to 0 ps

QO Reject to 0%

Stage 1: Manipulate probe over main working
surface of V-2 reference standard and maximize
echo from 25 mm (1 in) radius concave reflector

Stage 2: Fix probe in found position - the center of
25 mm (1 in) radius concave reflector will indicate
incident point while the distance between probe's
frontal edge and incident point is equal to X-
Value

Stage 3: Tune Display Delay while probe is still
fixed in found position until rising edge of
maximized echo will match with 50%-grid of the A-
Scan width. Upon completing the obtained value
of Display Delay will be equal to actual Probe
Delay

+ It's necessary to setup Gain bringing height of maximized echo to 75-80% of A-Scan height

¢ Itis recommended to optimize Tuning in PULSER submenu upon obtaining maximized echo. The goal of
such optimization is increasing of ultrasonic excitation energy through better matching between firing
output and probe. Level of ultrasonic excitation energy is clearly represented by echo amplitude. Upon
completing Tuning optimization Gain to be adjusted to bring echo to 75-80% of A-Scan height
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5.2.13.6. Determining Probe Delay - Large and Medium Size Angle Beam Probes
(contact face width more than 12.5 mm /0.5 in) - Shear or Longitudinal Waves —

Typical Example

+ +
maving probe

v

f
!

!

+

* o

Activate submenu PULSER then set:

Q Pulser Mode to Single or Dual depending
on probe

O Pulse Width to Spike (240 pJ) for probe
having resonant frequency of 8 MHz and
higher or to PW ns, were PW =0.5/F (F
is the probe resonant frequency) for
probes having resonant frequency below 8
MHz

Q Firing Level to 18

a Damping to 1000 Q

Q Tuning to NO

Activate submenu RECEIVER then set:

a Display to Full or RF

o Filterto BB

Q Frequency to completely cover probe's
effective bandwidth

Activate submenu BASICS topic then set:

a US Velocity to 5920 m/s (233.1 in/ms) for
longitudinal wave probes or 3255 m/s
(128.1 in/ms) for shear wave probes

O Range to 200.0 mm (8in)

O Display Delay to O ps

O Reject to 0%

Stage 1. Manipulate probe over main working
surface of V-1 reference standard and maximize
echo from 100 mm (4 in) radius concave reflector

Stage 2: Fix probe in found position - the center of
100 mm (4 in) radius concave reflector will indicate
incident point while the distance between probe's
frontal edge and incident point is equal to X-
Value

Stage 3: Tune Display Delay while probe is still
fixed in found position until rising edge of
maximized echo will match with 50%-grid of the A-
Scan width. Upon completing the obtained value
of Display Delay will be equal to actual Probe
Delay

It's necessary to setup Gain bringing height of maximized echo to 75-80% of A-Scan height

It is recommended to optimize Tuning in PULSER submenu upon obtaining maximized echo. The goal of

such optimization is increasing of ultrasonic excitation energy through better matching between firing
output and probe. Level of ultrasonic excitation energy is clearly represented by echo amplitude. Upon
completing Tuning optimization Gain to be adjusted to bring echo to 75-80% of A-Scan height
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5.2.13.7. Determining Probe Delay - Straight Beam (Normal) Single Element and Dual
(TR) Probes — Typical Example
Activate submenu PULSER then set:

Q Pulser Mode to Single or
Dual depending on probe

Q Pulse Width to Spike (240
uJ) for probe having resonant
frequency of 8 MHz and
higher or to PW ns, were PW
=0.5/F (Fis the probe
resonant frequency) for
probes having resonant
frequency below 8 MHz

Q Firing Level to 18

a Damping to 1000 Q

Q Tuning to NO

Activate submenu RECEIVER then
set:

1 US Velocity
b920 m/s

* 153&;38;:?: o Display to Full or RF
. Q Filter to BB
+ Q Frequency to completely
+ cover probe's effective
bandwidth
Activate submenu BASICS topic then

set:

o US Velocity to 5920 m/s
(233.1 in/ms) for longitudinal
= wave probes or 3255 m/s
(128.1 in/ms) for shear wave
probes
O Rangeto25.0mm (1in)
a Display Delay to 0 ps
O Reject to 0%

Stage 1. Apply probe to a side surface of V-2 reference standard to receive back echo

Stage 2: Tune Display Delay until rising edge of the back echo will match with the 50%-grid of the A-Scan
width: in such case the obtained value of the Display Delay is equal to the actual Probe Delay

®

¢ It's necessary to setup Gain bringing height of back echo to 75-80% of A-Scan height

¢ Itis recommended to optimize Tuning in PULSER submenu upon obtaining back echo. The goal of such
optimization is increasing of ultrasonic excitation energy through better matching between firing output
and probe. Level of ultrasonic excitation energy is clearly represented by back echo amplitude. Upon
completing Tuning optimization Gain to be adjusted to bring echo to 75-80% of A-Scan height
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5.2.13.8. Automatic Calibration (AUTOCAL) of Probe Delay and US Velocity - Angle
Beam Probes - Shear or Longitudinal Waves — Typical Example

There are 2 maximized reference
echoes from 2 concave reflectors
with different radius 25 mm (1 in)
and 50 mm (2 in) in use for
performing automatic calibration
of Probe Delay and US Velocity.
A-Scan settings (Range, Display
Delay, US Velocity — refer to
paragraph 5.2.2 of this Operating
Manual) must allow observing of
both signals. Gate A to match
with first reference echo received
from concave reflector with
smaller radius (shorter material
travel distance) — refer to
paragraph 5.2.5 of this Operating
Manual. Gate B to match with
second reference echo received
from concave reflector with larger
radius (longer material travel
distance) — refer to paragraph
5.2.6 of this Operating Manual

®

¢ It's necessary to setup
Gain bringing height of
back echo to 75-80% of A-
Scan height

¢ Itis recommended to
optimize Tuning in
PULSER submenu upon
obtaining back echo. The
goal of such optimization is
increasing of ultrasonic
excitation energy through
better matching between
firing output and probe.
Level of ultrasonic
excitation energy is clearly
represented by back echo
amplitude. Upon
completing Tuning
optimization Gain to be
adjusted to bring echo to
75-80% of A-Scan height
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i

Obtain first reference echo, activate submenu MEASURE then click on

05 Gain
16 dB

= Ty

Meas Yalue
OFF
- . Ly

E AUTOCAL %

pr
p™
P

BASICS PULSER RECEIVER GATE A Menu H» IE' b
GATE B ALARM PEIwa Nty MEASURE Selection

Yalue: OFF 3 e
T & B3 I
Close Em Freeze Save | Open DGS
Fa
To activate AUTOCAL procedure click on SAUTDIEL | or press 2_ on front panel keyboard or

on external keyboard — the |AUTOCAL Control Surfacel appears

Gain

2 MTD-s[A)
sem K
B

T(A)
21.1 ps

S

GATE B ALARM priwgn gy MEASURE Selection

BASICS ~ PULSER  RECEIVER _ GATE A Eanmﬂk] ‘

0 O =
Cloze EM| Freeze ﬁ ﬂ Save ﬂpe}\ I

Click on this button or press press X" J on front

panel keyboard or or <Alt>+<C> on external
keyboard to interrupt AUTOCAL Procedure and
return to main UDS 3-5 control surface

If necessary Gain may be re-adjusted in the AUTOCAL Control Surface by the same way as it is explained
in paragraph 5.2.2 of this Operating Manual
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: Click on this button or press
Fa
2 on front panel

: keyboard or F2 or

: <Alt>+<2> on external
: keyboard to select value of
~ increment/decrement for
"

: Current value of :
: increment/decrement for =
: keying in Material Travel ;

Distance MTD-s(A),
: mm or in

1 Material Travel Distance

: MTD-s(A) in mm or in for the
i first reference echo to be

entered here while the said ST TPV

i echo matches with Gate A 3 2 MTD-s(A) RIS TR Y
S ssssEs s TN EEEEEEEEEEEEEEEEENEEEEEEEEEM 25 mm ‘
T L[ 0] R
: Digital readout box indicating  * 21.1 ps I
: automatically determined delay : 2 MTD-s(B) y
i of the first reference echo ¥ 74 3 i
: relatively firing pulse excitation : -0 mm I
: hs LS &
--------------------------------------- = ﬂ I.I.S | !
4
Eﬂﬂ[:El ’ I ‘ :....................' .................. .:
Ly S & Click on this buttonto  :
To key in Material Travel Distance MTD-s(A) I/ confirm er_‘tered Material :
the following manipulations are applicable: I : Travel Distance MTD-
e Mouse / Touch Screen [ : S(A)
B Click or press and hold on the appropriate

e Keyboard
Fa )
B Press _2_J on front panel keyboard or B or <Alt>+<A> on external keyboard = MTD-s(A) fore

color changes to white - then use L) , .4 , - , '.' on front panel keyboard or , H & on
external keyboard
e Combined
B Click on MTD-s(A) = MTD-s(A) fore color changes to white - then use L) , » , - , '.' on
front panel keyboard or ﬂ E g @ on external keyboard

Upon confirming keying in Material Travel Distance MTD-s(A) obtain second reference echo

05 Gain

Yl «

»

= &y

16 dB
Z MTD-sA)
T(A)
21.1 ps
0.1 MTD-s(B)
Rl «

L= By

BASICS PULSER RECEIVER GATE A !
GATE B ALARM PEIwa Nty MEASURE Selection

] &
Close Em | Freeze
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2 MTD-zlA)

2b mm

Click on this button to
N~ confirm entered Material
Travel Distance MTD-
s(B) :
To key in Material Travel Distance MTD-s(B) 1/ ]
the following manipulations are applicable: I

Click on this button if it is

necessary to return backto  :_.
keying in Material Travel

Distance MTD-s(A)

e Mouse /Touch Screen
B Click or press and hold on the appropriate
e Keyboard

-
B Press _4 j on front panel keyboard or or <Alt>+<B> on external keyboard = MTD-s(B) fore

color changes to white - then use !J '_’J :J !J on front panel keyboard or (T, , , on

external keyboard
e Combined

B Click on MTD-s(B) = MTD-s(B) fore color changes to white - then use !J '_’J :J !J on
front panel keyboard or , , , on external keyboard
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Material Travel Distance MTD-s(B) The screen as below appears upon confirming keying in

PULSER RECEIVER GATE A

ALARM DAC/TCG

oo
Close | TN |

BASICS
GATE B

Freeze

MEASURE

05 Gain
16 dB

Selection Autocal

p.

o
I DGS

¢ Clickon J if it is necessary to return back to keying in Material Travel Distance MTD-s(A)

A!tucal F.'ih"f

¢ Clickon or press

on front panel keyboard or Enter or <Alt>+<U> on external keyboard

to initialize automatic determining of US Velocity and Probe Delay based on above described keying

and echoes delays automatic measurements. As a result the screen as below appears:

Probe Delay

= by

05 Gain
16 dB ‘

Meas Yalue

OFF

| 5.82 IS
US Yelocity i

Meas Mode

Flank
Probe Delap

3272 mjs

Cancel

[ By

913 ps
10 Angle

ﬂﬁ

»
»
»
»
»

In by

PULSER
ALARM

BASICS
GATE B

= uns 2-5
‘ﬁﬂigeﬂin ‘IQES

ESC
or press 'F_) on front panel keyboard or

Esc|or <Alt>+<C> on external keyboard to negate
AUTOCAL results and return to main operating
surface without modifying Probe Delay and US
Velocity settings

]
Enter

Click on| or press on front panel keyboard or

Enter|or <Alt>+<A> on external keyboard to
accept AUTOCAL results and return to main
operating surface with appropriate modifying Probe
Delay and US Velocity settings

ISONIC 2006 from Sonotron NDT - Operating Manual — Revision 1.21 - Page 117 of 480



5.2.13.9. Automatic Calibration of Probe Delay and US Velocity - Straight Beam
(Normal) Single Element and Dual (TR) Probes — Typical Example

0.5

Gain

33 dB
LT Range
20 US Yelocity
4335 mfs

5

10 Display Delay

There are 2
sequentially
received back
echoes required for
performing
automatic
calibration of
Probe Delay and
US Velocity. A-
Scan settings
(Range, Display
Delay, US Velocity
— refer to
paragraph 5.2.2 of
this Operating
Manual) must allow
observing of both
signals.

Gate A to match with first back echo (shorter material travel distance) — refer to paragraph 5.2.5 of this
Operating Manual. Gate B to match with second back echo(longer material travel distance) — refer to
paragraph 5.2.6 of this Operating Manual

®

¢
*

It's necessary to setup Gain bringing height of back echo to 75-80% of A-Scan height

It is recommended to optimize Tuning in PULSER submenu upon obtaining back echo. The goal of such
optimization is increasing of ultrasonic excitation energy through better matching between firing output
and probe. Level of ultrasonic excitation energy is clearly represented by back echo amplitude. Upon
completing Tuning optimization Gain to be adjusted to bring echo to 75-80% of A-Scan height

All further operations to be performed identically to described in paragraph 5.2.13.8 of this Operating Manual

BASICS

GATE B ALARM

PULSER

05 Gain
33 dB ‘

Measz Yalue

Probe Delay

913 pus

US Yelocity

H(a)

Meaz Mode

.m

5952 mfs

Cancel

Apply

10

RECEIYER
DAC/TCG

[ T

Close | IFYERSY |

1796 %

GATE A
MEASURE

Freeze

Menu
Selection

Flank
Probe Delay

0 ps
Angle
ﬂ o
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5.2.13.10. Determining Incidence Angle (Probe Angle)

Caze Iltll

Case 3

L=

CF

Cazeh

-

o

Determining of incidence angle is
based on maximizing echo from
side-drilled hole in reference block
and reading the value of angle from
corresponding scale. Depending on
probe dimensions and angles there
are various reference blocks and
scales applicable:

Case 1. Miniature angle beam

probe, incidence angle 35° to 65°,
V-2 reference block

Case 2: Miniature angle beam

probe, incidence angle 65° to 75°,
V-2 reference block

Case 3: Medium or large size angle
beam probe, incidence angle 40° to
66°, V-1 reference block

Case 4: Medium or large size angle
beam probe, incidence angle 60° to
76°, V-1 reference block

Case 5: Medium or large size angle
beam probe, incidence angle 74° to
80°, V-1 reference block
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5.2.14. Frequency Domain Signal Presentation and Evaluation

Using Range and Delay parameters select a portion of A-Scan for frequency domain (FFT) presentation
then do activate submenu RECEIVER and switch Display to FFT (refer to paragraph 5.2.4 of this Operating
Manual). The screen as below appears:

FFT Measurements

Controls N ..,
\\\\ : : : : A
N ~N O 0 MHz
N\ * - * * UpperFreq
S N 5 MHz
N + + + +
+ + + + ﬁeiect
- 0% \‘
\
2l Uns'3-5
rdRd AT R P
Freeze Save | Open| Funt a DGS
A A AR B B e S | VR
: FFT Measurements : : Displayed Frequency
: Indicator 1 ] Range Controls

@ Display may not be switched into the FFT if the Range value is too long or DAC/TCG/DGS is active
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Lower frequency bound (LowerFreq)

To control LowerFreq the following
manipulations are applicable:

I
Mouse / Touch Screen ’//
B Click or press and hold on appropriate

Keyboard

-
B Press 2 J on front panel keyboard or or <Alt>+<W> on external keyboard = LowerFreq fore

color changes to white - then use !J ZJ _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on LowerFreq = LowerFreq fore color changes to white - then use !J ZJ :J !J
on front panel keyboard or , , , on external keyboard
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Upper frequency bound (UpperFreq)

To control UpperFreq the following
manipulations are applicable:

0.1 LowerFreq

0.1 UpperFreq

I

1
I

Mouse / Touch Screen /1,

B Click or press and hold on the appropriate Ibuttonl

Keyboard

Fd
B Press 3 jon front panel keyboard or or <Alt>+<U> on external keyboard = UpperFreq fore

color changes to white - then use !J ZJ _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on UpperFreq = UpperFreq fore color changes to white - then use !J 2J :J !J on
front panel keyboard or , , , on external keyboard
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Find maximum

Click on J — mouse pointer may be guided then just over FFT graph. FFT Readout Box displays
frequency corresponding to pointer position whilst guiding the cursor. Select first point of interest by mouse

click or through release of touch screen stylus. The appropriate mark 0 appears. Select the second point
of interest by the same way

Selection of Second
point FFT Mark and
corresponding
frequency value

Maximum’s frequency mark @appears and FFT Readout Box displays the found value automatically
upon mouse click or releasing of touch screen stylus:

Maximum’s
frequency mark and
digital readout

n
oo a o n s sy
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Find the —3db / —20db level bounds:

Maximum’s

frequency mark

- 3 dB bounds —
marks and digital
readout

Return to FFT Measurements toolbar:

=
Click on

Find frequency corresponding to selected single point on FFT graph:

Click on J — mouse pointer may be guided then just over FFT graph. FFT Readout Box displays
frequency corresponding to pointer position whilst guiding the cursor. Select first point of interest by mouse

click or through release of touch screen stylus. The appropriate mark n appears and FFT Readout Box
displays corresponding frequency:

Selected point
and
corresponding
freauency

+ + + 0+ + +, + + +

[+~ T
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Frequency difference (deviation) between two points:

Click on _I — mouse pointer may be guided then just over FFT graph. FFT Readout Box displays
frequency corresponding to pointer position whilst guiding the cursor. Select first point of interest by mouse

click or through release of touch screen stylus. The appropriate mark n appears. Select second point of

interest by the same way - the appropriate mark e appears and the FFT Readout Box displays difference
(deviation) between corresponding frequencies:

1 Selected points and
:  difference (deviation)
! between corresponding
: frequencies

f2 -1 = 0.85 MHz

Clear FFT Marks:

]
Click on

Exit FEFT Mode:

Change Display mode
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5.2.15. Freeze A-Scan / FFT Graph
UD53-5 - ISONIC Pulzer/Receiver

Ty

1 Gain
37dB ‘

Measz Yalue
«
Meaz Mode

.
0.01 Probe Delay
h 13 pus ‘
10 Angle
60 ° ‘

BASICS PULSER  RECEIVER _ GATE A Menu ﬁ| "D" ?_s
GATE B ALARM  DAC/TCG IETTEIGEN Selection

4= By

len By

R @l B|=]|8 =
Cloze EM| 41 .3 mm ErzPe Save | Open | Print DG5S

To freeze / freeze peak / unfreeze the A-Scan click or press i) on front panel keyboard or or
<Alt>+<F> on external keyboard

®

¢ Freeze Peak mode allows representing of Hilbert envelop for sequence of echoes obtained while
manipulating probe over some reflector. This function may be useful for localization of echo maximum
when working in A-Scan mode:

¢ Freeze Peak mode may not be activated for RF and FFT signal presentation
¢ Appearing of at the upper left corner of A-Scan indicates that it is frozen (Freeze)

Appearing of at the upper left corner of A-Scan indicates that Freeze Peak mode is active

The following operations are available when time domain A-Scan is frozen:

0 =6 dB Gain varying according to paragraph 5.2.2 of this Operating Manual

0 Manipulating Gates A and B according to paragraphs 5.2.5, 5.2.6, 5.2.7 of this Operating Manual

o0 Varying Alarm mode according to paragraph 5.2.8 of this Operating Manual

0 Selecting parameter (Meas Value) for automatic measurements and varying settings Probe
Delay and Angle as per paragraph 5.2.12 of this Operating Manual and obtaining corresponding
measurements results in the digital readout box (Value)

¢ The following operations are available while frequency domain FFT Graph is frozen:
0 =6 dB Gain varying according to paragraph 5.2.2 of this Operating Manual
o0 All FFT evaluation / measurements as per paragraph 5.2.14 of this Operating Manual

+ Caption of appropriate button changes in the UDS 3-5 Pulser/Receiver window when freeze / freeze
peak / unfreeze A-Scan / FFT Graph

Freeze FrzPeak
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5.2.16. Zoom A-Scan / FFT Graph

Double click on A-Scan / FFT Graph to get it enlarged. Enlarged A-Scan / FFT Graph occupies screen
completely

In upright corner of A-Scan there is a digital readout box indicating current Gain value and digital readout of
automatic measurements provided that corresponding Gate is active

To control Gain while A-Scan is enlarged use ' and '.' on front panel keyboard or , on external
keyboard

To freeze / freeze peak / unfreeze enlarged A-Scan press &J on front panel keyboard or on external
keyboard
If Gate A and / or Gate B is active then:

Parameters V(A), s(A), t(A), a(A) , V(B), s(B), t(B), and Parameters V(A), s(A), V(B), and s(B) are measured and
a(B) are measured and indicated automatically — refer to indicated automatically — refer to paragraph 5.2.13.1 of this
paragraph 5.2.13.1 of this Operating Manual Operating Manual

Parameters V(A), s(A), t(A), and a(A) are measured and Parameters V(A), and s(A) are measured and indicated
indicated automatically — refer to paragraph 5.2.13.1 of automatically — refer to paragraph 5.2.13.1 of this Operating
this Operating Manual Manual

Parameters V(B), s(B), t(B), and a(B) are measured and Parameters V(B), and s(B) are measured and indicated
indicated automatically — refer to paragraph 5.2.13.1 of automatically — refer to paragraph 5.2.13.1 of this Operating
this Operating Manual Manual

To select an additional parameter for automatic measurement and large character indication while A-Scan is

enlarged (Meas Value - refer taragraphs 5.2.12 and 5.2.13 of this Operating Manual) use ‘ and ‘

on front panel keyboard or , on external keyboard. Gate A and Gate B if active may be drag and drop
manipulated on enlarged A-Scan according to paragraph 5.2.7 of this Operating Manual. To return to main
operating surface window double click on enlarged A-Scan / FFT Graph
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5.2.17. Save an A-Scan and its Calibration Dump into afile

=
&=
To save the A-Scan / FFT Graph and Calibration Dump into a file click on ﬂ' or press 32 J on front

panel keyboard or or <Alt>+<S> on external keyboard — ISONIC 2006 Save/Open window becomes
active providing automatically created name for a new file in
File name: box:

ISONIC 2006 Save/Open EE

Save jn: Iﬁ UDS 3-5 Pulzer Receiver ﬂ gl

3| 5 tHz TOFD 40 mm O1.par
#] 5 MHz TOFD 40 rm 02, par
@ Composite Part - Singapore. par
&) Darkguk Mills - DELAM. par
] PUO0000T. par

@ zafetech composite sample. par

=y

o By

= By

[en By

W
N

~H'Held= s %l=NENNOHOYH -H=1| *
BASICS
gilwilellr ity llulliflolpiIll]
||_ al|ls|/djf hiljllk
Cloze m L L

To save a file:

e select disk drive and directory for placing a file using mouse or touch screen
e approve automatically created new file name

NP7y Y7
ooy
Myl v

| —
|L
[=
=1}
w

Del BS

OR
mark a file to be replaced from the list appearing in the destination directory
OR
type a new file name using either virtual keyboard generated in ISONIC 2006 Save/Open window or
external keyboard — standard Windows rules for file naming are applicable, long names (up to 64
characters) are supported

= Ente.r |
double click on file to be replaced or click on il or press ‘=== J or <+ on front panel
keyboard or press H or Enter or <Alt>+<S> on external keyboard

ISONIC 2006 Save/Open window disappears automatically upon completing saving a file

ESC
To exit from ISONIC 2006 Save/Open window without saving a file click on ﬂl or press &) on
front panel keyboard or on external keyboard
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5.2.18. Load an A-Scan and its Calibration Dump from afile

= | =
To load A-Scan/FFT Graph and Calibration Dump from a file click on "8P&R| or press ' &) on front panel

keyboard or or <Alt>+<0O> on external keyboard — <Alt>+<0O> on the keyboard — ISONIC 2006
Save/Open window becomes active

UDS3-5 - ISONIC

ISOMIC 2006 Save/Open

Lack, jr: Ia UDS 35 Pulzer Receiver j ﬁl

@& 5 tMHz TOFD 40 mm O1.par
&) 5 MHz TOFD 40 rmm 02, par
@ Compozite Part - Singapore. par
&) Dankguk Mils - DELAM. par
] PUIOO0ONT. par

@ zafetech compozite sample. par

BASICS File name: || Open I ]
j Cancel |
Z

I_ Files af type: ILIDS 35 Settings [*.par]

Cloze MI Freeze | vT- | Save I Qpenl Erint|

To open a file:

"

o By

= By

[en By

Yy Y
ooy
My lv v

— W
|

DG5S

e select disk drive and directory containing a file required

\ E-‘; Ente.r
e select then file then double click on its name or click on % or press &) or *=_ on front
panel keyboard or or [Enter| or <Alt>+<0O> on external keyboard

ISONIC 2006 Save/Open window disappears automatically upon completing loading a file

ESC
To exit from ISONIC Save/Open window without opening a file click on ___=aMee! |or press Lj on front
panel keyboard or on external keyboard
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5.2.19. Print A-Scan/FFT Graph and Settings List

Ensure the printer connection is in order (printer to be accessible through either USB or LAN port and

ﬁ I é
defined as default in the ISONIC 2006) then click on Erint or press m) on front panel keyboard or m
or <Alt>+<P> on external keyboard

5.2.20. Activate Main Recording and Imaging Menu

I

Click on or press LJ on front panel keyboard or on external keyboard. Refer to Chapter 6 of
this Operating Manual for further instructions

5.2.21. Switch OFF UDS 3-5

ESC
To switch OFF UDS 3-5 click on &I or press L) on front panel keyboard or or <Alt>+<C>

on external keyboard
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6. Main Recording and Imaging Menu
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Main Recording and Imaging Menu is shown below:

[1 |isonic 2005

| 2|IsoNIC 2006

E| Back

M
There are two recording and imaging modes possible in ISONIC 2006 instrument:
¢ Straight Line Scanning Recording and Imaging is a standard feature allowing:
a Thickness Profile B-Scan imaging and recording, which is performed through continuous
measuring of thickness value along straight line type probe trace

O B-Scan cross-sectional imaging and recording of defects for longitudinal and shear wave
inspection, which is performed through continuous measuring of echo amplitudes and
reflectors coordinates along straight line type probe trace

Q@ CB-Scan horizontal plane-view imaging and recording of defects for shear, surface, and
guided wave inspection, which is performed through continuous measuring of echo
amplitudes and reflectors coordinates along straight line type probe trace

Q TOFD Inspection — RF B-Scan and D-Scan Imaging along straight line type probe trace
For Straight Line Scanning records it may be used:

o0 Time-based mode — ISONIC 2006 is equipped with built-in real time
clock

0 True-to-location mode — ISONIC 2006 is equipped with built-in
incremental encoder interface modes

In ISONIC 2006 instrument Straight Line Scanning Recording and Imaging is implemented
- -

identically to ISONIC 2005; to enter this mode click on | e orpress ' _Jon

front panel keyboard or on external keyboard

¢ XY Scanning Recording and Imaging is optional feature, which may be implemented through
various license protected inspection software modes. Depending of license installed in the
ISONIC 2006 instrument there is a number of inspection applications listed below possible:

Q Thickness Map imaging and recording, which is performed through continuous measuring
of thickness value along probe trace

a Flaw Detection — Pulse Echo 3D imaging (C-Scan, B-Scan, D-Scan, P-Scan) and
recording of defects for longitudinal and shear wave inspection, which is performed through
continuous measuring of echo amplitudes and reflectors coordinates along probe trace with
probe swiveling angle dependency where applicable

Q Flaw Detection — Through Transmission / Back Echo Attenuation 2D imaging and
recording (C-Scan) which is performed through continuous measuring of signal amplitudes
along probe trace

a CB-Scan horizontal plane-view imaging and recording of defects for shear, surface, and
guided wave inspection, which is performed through continuous measuring of echo
amplitudes and reflectors coordinates along probe trace with probe swiveling angle
dependency where applicable

Q@ TOFD Inspection — RF B-Scan and D-Scan Imaging along probe trace

ISONIC 2006 from Sonotron NDT - Operating Manual — Revision 1.21 - Page 132 of 480



For XY-Scanning records ISONIC 2006 is equipped with built-in airborne ultrasound encoder
controller and appropriate interface

To enter XY Scanning Recording and Imaging mode click on l (2o a0ee or press

>,
2 on front panel keyboard or on external keyboard

ESC

- |
To return to main operating surface click on l ‘or press - < Jor 3 Jonfront panel

keyboard or or =3 on external keyboard

ISONIC 2006 from Sonotron NDT - Operating Manual — Revision 1.21 - Page 133 of 480



/. Straight Line Scanning Recording and
Imaging
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7.1. Straight Line Scanning Recording and Imaging Menu

Straight Line Scanning Recording and Imaging Menu is shown below:

IfTime Based Recording

[2|True to Location Recording

@Back

There are two straight line scanning recording and imaging submenus available:

+ Time Based Recording submenu relates to line scanning procedures where probe is
manipulated over object under test with constant speed and defects images are formed from

sequence of A-Scans captured at equal time intervals (real time clock). To open Time Based
| s

. . | [1]Time Based Recordi |
Recording submenu click on |- BeaRee o nress 1 on front panel keyboard or

on external keyboard

¢ Trueto Location Recording submenu relates to line scanning procedures where coordinate of
probe manipulated over object under test is transferred to ISONIC 2006 instrument by means
of position encoder while defects images are formed from sequence of A-Scans captured at

equal distance intervals. To open True to Location Recording submenu click on

= >
| | 2|True to Location Recording 2
|

or press —<_J on front panel keyboard or on external keyboard

. . . ] (3]s | ). %)
To return to Main Recording and Imaging Menu click on | or press or 2 Jon
front panel keyboard or [ESC|or on external keyboard
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7.2. Time Based and True to Location Recording Submenus

Both Time Based Recording and True to Location Recording submenus allow activating 4 protocols of
data recording:

[1]t-BScan (Th) [1]BScan (Th)

[2]t-ABiscan [2]ABIScan
[8]t-ToFD [8]ToFD
IZ]t—Floarmap 1= z‘ Floormap L
J B &
|?] Back |?] Back

+ Thickness Profile imaging and recording —t-BScan(Th) or BScan(Th) — click on ‘MJ or

- )
1 |BScan (Th) | . . .
[TBscan or press _ ' _Jon front panel keyboard or on external keyboard — illustrative video

is available at http://www.sonotronndt.com/video.asp?VideolD=1

¢ B-Scan cross-sectional imaging and recording of defects for longitudinal and shear wave

;o

t-ABIScan 2 |ABIScan |
2] ‘orl 2] ‘orpress 2 Jon

inspection — t-ABIScan or ABIScan — click onl
front panel keyboard or on external keyboard — illustrative video is available at
http://www.sonotronndt.com/video.asp?VideolD=2

¢ TOFD Inspection — RF B-Scan and D-Scan Imaging — t-TOFD or TOFD - click on ‘&J or

-
3 TOFD |
2 or press 2 on front panel keyboard or on external keyboard — illustrative video

is available at http://www.sonotronndt.com/video.asp?VideolD=4

¢ CB-Scan horizontal plane-view imaging and recording of defects for shear, surface, and guided

l E‘t-Floormap L ‘ l EFloormap L
or

wave inspection — t-FLOORMAP L or FLOORMAP L click on press
- |
_4_ on front panel keyboard or on external keyboard — illustrative video is available at
http://www.sonotronndt.com/video.asp?VideolD=3
. . . . . . [5]Back
To return to Straight Line Scanning Recording and Imaging Menu click on or press

ESC -
L) or'_5__ on front panel keyboard or or on external keyboard
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7.3. Thickness Profile Imaging and Recording — t-BScan(Th)

and BScan(Th)

7.3.1. Setup Pulser Receiver for Thickness Profile Imaging and

Recording

UDS 3-5 Pulser Receiver window — main operating surface — appears on ISONIC 2006 screen upon

Lo l [1]t-BScan (Th) l [1]Bscan (Th) . . .
clicking on r . The following settings to be provided:
# | Parameter or Submenu Required Settings Note
Mode
1 aSwitch GATE A ON
2 Gain BASICS Gain and aThreshold settings to
aThreshold GATE A provide receiving an echo from the
minimal area of thickness degradation to
be detected; height of the said echo to
exceed aThreshold; signals from other
reflectors less then defined one not to
exceed aThreshold
3 DAC/TCG DAC/TCG DAC/TCG settings to meet requirements
of the Inspection Procedure
4 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
5 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing Level, To synchronize with Gain
Firing Level, and Damping settings to provide and aThreshold setting
Damping optimal signal to noise ratio procedure
6 Filter, Frequency RECEIVER Filter and Frequency settings to match | To synchronize with Gain
with probe's frequency and aThreshold setting
procedure
7 Display RECEIVER Display mode may be either Full, RF, The same Display mode to
PosHalf, or NegHalf be used for both Probe
Delay determining and
Thickness Profile Imaging
8 USVelocity BASIC USVelocity setting to be equal to actual
value of ultrasound velocity in the object
under test
9 Probe Delay MEASURE Probe Delay setting to be equal to Probe delay may be
actual probe delay determined according to
paragraph 5.2.13.7 or
5.2.13.9 of this Operating
Manual or similarly
10 | Angle MEASURE Angle = 0°
11 | Meas Mode MEASURE Flank
12 | Range, Display BASIC Range, Display Delay, AStart, and
Delay, AStart, GATE A aWidth settings to be performed with

awidth

reference to the Region of Interest for
t-BScan(Th) and BScan(Th) table
below

13 | Settings for other
parameters and
modes have no
significance

I
Upon completing click on J or press LJ on front panel keyboard or on external keyboard
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Region of Interest for t-BScan(Th) and BScan(Th)

. Scanning Surface

Surface to ROI Distance = SRD

ROl = Region of Interest

ROl Width = R
E;Ek Wall Profile
Initial
Pulze
SRD = aStart
Case 1
—_— RW = aWidth
0
Display Range
" Delay
Initial DisplavDel
ISplaybela .
Pulse SRD = %xUSVelocny
Case 2
-1 RW = aStart + awidth — SRD
0
Dizplay Range
" Delay
Initial
Pulse SRD = aSta.rt
DisplayDelay .
Case 3 L RW = — 5, xUSVelocity +
0 —
| Display Range + Range — aStart
" Delay
Initial
Pulze
DisplayDela .
SRD = 2iplayoelay USVelocity
Case 4 2
0 RW = Range
Display Range
" Delay
Preferred Initial ¢ aStart and aWidth setting to provide
embodimen Pulse 1t back echo appearance of whole Gate A on the A-Scan
t ¢ aWidth =(0.75...0.95) x Range
¢ First Back Echo at the thickest area of object
under test to be fully matching with Gate A
0 — ¢ First Back Echo at the thickest area of object
Display Range under test to "occupy” 5-10% of the Gate A
" Delay width on the A-Scan
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7.3.2. Thickness Profile Imaging — Implementation

7.3.2.1. t-BScan(Th) — Prior to Scanning

t-BScan(Th) control panel is shown below

= By

1 L. mm
-
Time, sec

T K
Time-0Out, sec
3
4 =]

Current A-Scan

p

Start Save

2y,

UDS3-5 Text Close

% Empty t-BScan(Th) record field
Gate

d End a0 10

33 mm

Scan Length / Scan Time

®

Display Delay and Range settings for current A-Scan to be used for the recording are equivalent to the
same setting of UDS 3-5 Pulser Receiver predcessing entering into t-BScan(Th) mode
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Scan Length and Scan Time

Scan Length — L represents length of section of test object to be displayed, over which probe will be
scanning during recording period. Time (Scan Time) is the duration of recording period

To control Scan Length — L the following ,
manipulations are applicable: /7 7

VR
yd
e Mouse /Touch Screen /s

—t
B Click on corresponding |button|

e Keyboard
-
m Press 1! J on front panel keyboard or on external keyboard = L fore color changes to white -
then use !J '_’J , _J !J on front panel keyboard or , , , on external keyboard

e Combined

B Click on L = L fore color changes to white - then use !J '_’J :J !J on front panel
keyboard or , , , on external keyboard

®

The value of Scan Length — L is adjustable between 50 and 1000 mm or 2 and 40 in
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: Current value of
: Scan Time —Time

|r.ul|.\ i By | 1= By

To control Scan Time — Time

the following manipulations are applicable:/ /, “
7
e Mouse /Touch Screen ,//
/4
B Click on corresponding
e Keyboard
F
m  Press _2 J on front panel keyboard or on external keyboard = Time fore color changes to
white - then use !» !/ « ! on front panel keyboard or [T} , , on external
keyboard

e Combined

B Click on Time = Time fore color changes to white - then use !» » « !

—J _/ on front panel
keyboard or , , on external keyboard

®

The value of Scan Time — Time is adjustable between 5 and 60 sec in 1 sec increment/decrement
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Time-out

Time-Out is waiting time for intermissions predcessing t-BScan(Th) recording, which starts unconditionally
upon Time-Out period is over

lllllllllllllllllllllllllll 1 L' mm
: Currentvalue of : 100 ‘
: Time-Out 3 Time, sec
1 sec :
b ’ 10 ‘
Time-Out, sec
3
7
. 7
To control Time-out 7 _ -

the following manipulations are applicable: P /’ -

z -
Mouse / Touch Screen P

B Click on corresponding Jbutton

Keyboard

?
B Press 3 J on front panel keyboard or on external keyboard = Time-out fore color changes

to white - then use !_ 2/, « ! on front panel keyboard or , , , on external
keyboard

Combined

LIRS NG I P

B Click on Time-Out = Time-Out fore color changes to white - then use —/,

front panel keyboard or , , , on external keyboard

®

The value of Time-Out is adjustable between 0 and 15 sec in 1 sec increment/decrements
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Insert Text Note

A text note may be entered to accompany t-BScan(Th) record. To proceed click on il or press
<Alt>+<X> on external keyboard

1 L. mm o
100 ‘ 1
Time, sec o
1 ‘ 2
s -
place your comments here ‘ 3
i =
e Open
~rif2fl3fl4lalell7z8l9lo)-|l=1| 1| @z_]_ Close
giwillellr ||ty lullillolprllll|] |
E aflsldll fHalfhlifdkf!ry:y"
Zllxllclivibln|mj, !
Del BS
Save Cancel
g
i
0 o 50 100
| “E

Type notes and comments to accompany scanning files: use either virtual keyboard appeared (touch screen
or mouse) or external keyboard

Save
Click on to store typed note and to return to t-BScan(Th) control panel
Cancel g
Click on or press L) on front panel keyboard or on external keyboard to

negate typed note and to return to t-BScan(Th) control panel
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Preview UDS 3-5 Settings

UDS 3-5 Pulser Receiver settings for the t-BScan(Th) record may be previewed through clicking on

UD53-5 | or pressing <Alt>+<D> on external keyboard . The corresponding window appears:

1 L. mm ar
oo KJH

UD53-5: Setup Data

UDS3-5: Setup Data

BASIC: PULSER

Gain = 44 4B Ratge = 41 mum Pulset Mode =DUAL  Tuning=T pH
Reject= 0 % Display Dielay = 6.63 ps PRF = 500 Hz Datrpitig = 1000 £
113 Velocity = 5920 mfs Pulge Width = 110 n3

GATE A: RECEIVER:

afwitch = ON adtart = 0 mm Filter = 4 MHz Diisplay = Full

Mt 25 25

BEEER| o Theeshold= 10 % a-Width= 332 mm Frequency =0.7-13 MHz
ga GATEB: ALARM:
bZwitch = OFF b-3tart = 30 fum afwitch = OFF al.ogic = Positive
b-Threshold = 40 2% b-Width = 25 tmam b3witch = OFF bLogic = Positive
DAC/TCGDGS: MEASTURE:
Mode: OFF Rec=10 FrobeDelay= 873 ps  Angle=0°
Cutve = OFF Measuring Mode = Flank
v

100

o 3Eimm
el | =
==

//

ESC
or press L) on front panel keyboard or <Alt>+<K> or on external keyboard to return to

return to t-BScan(Th) control panel
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Start/Stop t-BScan(Th) recording

4
Click on ﬂl or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard to

start t-BScan(Th) recording

4 | H |
stait | putton becomes invisible since t-BScan(Th) recording starts. __28P | putton occupies its

position. Click on stop | or press LJ on front panel keyboard or or <Alt>+<S> on external
keyboard to terminate t-BScan(Th) recording prior to automatic completion

= EA
stop | putton becomes invisible after completion / termination of t-BScan(Th) record. __ 3%t | putton

returns to its position

Save record into afile

Click on _38¥8 |or press ﬂ) on front panel keyboard or or <Alt>+<A> on external keyboard to
save captured t-BScan(Th) record accompanied with instrument calibration dump and text notes /
comments into a file. Refer to paragraph 5.2.17 of this Operating Manual to proceed with file saving

Open record from a file and starting postprocessing session

= | =
| &
Click on _Open | or press &) on front panel keyboard or or <Alt>+<0O> on external keyboard t-B-

Scan(Th) record accompanied with instrument calibration dump and text notes / comments from a file. Refer
to paragraph 5.2.18 of this Operating Manual to proceed with file opening. Refer to paragraph 7.3.2.5 of this
Operating Manual to proceed with postprocessing

Return to UDS 3-5 main operating surface

ESC
Click on __Elose |or press L) on front panel keyboard or <Alt>+<C> or on external keyboard
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7.3.2.2. t-BScan(Th) — Scanning

Q Apply probe to test object in the start point of selected scanning line

4

o Click on 3%t |or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard
O Guide probe over the scanning line synchronously with Recording Progress Bar — typical scanning
progress display during is shown and explained below

1 L. mm

+ -
10
Time-Out, zec
3
[ |
Stop
D=2377 mm
t-BScan(Th) record
Back Wall Profile
0 50 100
)|
Recording Currently
Progress Bar measured wall

thickness
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7.3.2.3. BScan(Th) — Prior to Scanning

BScan(Th) control panel is shown below

5 L. mm ‘ ) .
100 1
Encoder:
4 = =
Start Open Save Cloze
Text UD53-5
27.8 mm
g
=
Empty BScan(Th) record field

A

| 50 1o

Total Scan Length for L 1000 mm /40 in

¢ P

)41 L ]
g
=

BScan(Th) scrolling controls
20 L. mm ‘ - . %
2270 1
E Empty BScan(Th) record field
500 200 200 a0 1000 1100 1200 1300 1400 1500
1000 mm / 40 in Segment of Scrolled Total Scan Length exceeding 1000 mm /40 in

®

Display Delay and Range settings for current A-Scan to be used for the recording are equivalent to the
same setting of UDS 3-5 Pulser Receiver predcessing entering into BScan(Th) mode
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Scan Length

Scan Length — L represents length of section of test object to be displayed, over which probe will be
scanning during recording period

To control Scan Length — L the following P 7 i
manipulations are applicable: , -

s .-
e Mouse /Touch Screen 44 -

B Click on corresponding
e Keyboard

-
m Press 1 J on front panel keyboard or on external keyboard = L fore color changes to white -

then use !J '_’J , _J !J on front panel keyboard or , , , on external keyboard

e Combined

B Click on L = L fore color changes to white - then use !J '_’J :J !J on front panel
keyboard or , , , on external keyboard

®

The value of Scan Length — L is adjustable between 50 and 20000 mm or 2 and 800 in

Encoder
Select encoder to be used through appropriate box

Encoder:

Drefauilt j

Clamp probe into encoder — refer to Chapter 7 of this Operating Manual

Connect encoder to its input on the right side of ISONIC 2006 instrument

Insert Text Note

Refer to paragraph 7.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 7.3.2.1 of this Operating Manual
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Start/Stop BScan(Th) recording

4
Click on ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard to

start BScan(Th) recording

4 | u |
stait | hutton becomes invisible since BScan(Th) recording starts. _ 3B | button occupies its position.

-5
Click on _3%P_ | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate BScan(Th) recording

H 4

stop | putton becomes invisible after termination of BScan(Th) record. __2tamt | putton returns to its
position

Save record into afile

= |
Click on _38¥€ |or press ﬂ) on front panel keyboard or or <Alt>+<A> on external keyboard to

save captured BScan(Th) record accompanied with instrument calibration dump and text notes / comments
into a file. Refer to paragraph 5.2.17 of this Operating Manual to proceed with file saving

Open record from a file and starting postprocessing session

= | =
| &
Click on _Open | or press &j on front panel keyboard or or <Alt>+<0O> on external keyboard B-

Scan(Th) record accompanied with instrument calibration dump and text notes / comments from a file. Refer
to paragraph 5.2.18 of this Operating Manual to proceed with file opening. Refer to paragraph 7.3.2.5 of this
Operating Manual to proceed with postprocessing

Return to UDS 3-5 main operating surface

ESC
Click on __Elose |or press L) on front panel keyboard or <Alt>+<C> or on external keyboard
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7.3.2.4. BScan(Th) — Scanning

a Apply probe equipped with an encoder to test object in the start point of selected scanning line

4
O Click on 3%t |or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard

O Guide probe over the scanning line — typical scanning progress display is shown and explained below

o0 Rl
Encoder:

| E

D=2377 mm L=24.0 mm

BScan(Th) record
Back Wall Profile Currently
measured wall
thickness
0 - 50 100

Current Probe
Position
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7.3.2.5. t-BScan(Th) / BScan(Th) — Postprocessing
Postprocessing of t-BScan(Th) / BScan(Th) records is featured with:

Q Sizing thickness damages at any location along stored images (remaining thickness, thickness loss,

and length of damage)

Q Play-back and evaluation of A-Scans obtained and captured during thickness profile recording
@ Reconstruction of thickness profile image for various Gain and / or Gate A settings

The screen as below appears upon opening file. All postprocessing procedures are performed through
— touch screen stylus or front panel or external mouse to be used

~

| File: v|| Instrument || E dit v|| Measurements v|| A-Scan Recovery v|

£

18 3 mm

30 100 150 200

=

~Inspection Data— [ Thickness Measurements —

5Scan Length: 210 mm |
Encoder Mame: Default I I

Inspector’s Coments: ~Length Measurements

A
ol |

—A-5can Recovery

BScan (Th) |
POSTPROCESSING | |

Menu Bar Functions

File=>Open — opens new t-BScan(Th) / BScan(Th) file

File>Snapshots>Add Snapshot — stores current postprocessing screen snapshot accompanied with
appropriate settings and measurements into postprocessing session memory stack

File>Snapshots>Restore Snapshot — recalls earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

File>Snapshots>Delete Snapshot — deletes earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

File=>Print — prints out postprocessing screen snapshot(s) accompanied with appropriate settings and
measurements

File>EXit — returns to t-BScan(Th) / BScan(Th) control panel

Instrument — indicates setup of UDS 3-5 Pulser Receiver used for scanning when file was created
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A-Scan Recovery>ON — generates cursor representing sound path of probe's central beam in the
object under test that may be guided over t-BScan(Th) / BScan(Th) image using either touch screen

-»

stylus or mouse or ' _—/, ‘ on front panel keyboard or , on external keyboard — corresponding
A-Scan is recovered synchronously according to sound path cursor position. In the A-Scan Recovery

field there are indicated coordinate (L) of sound path cursor along t-BScan(Th) / BScan(Th) record and
corresponding remaining thickness value (D)

| File: v|| Instrurment || Edit v|| Meazurements v|| A-Scan Recoverny v|

d

12 Jnm

=

0 110 150 200

~Inspection Data—— [ Thickness Measurements —

Scan Length: 210 mm I
Encoder Name: Default | |

| o+ o+ o 4+ 4+

Inspector’s Coments: ~Length Measurements
iy
ol |
—A-Scan Recovery
BScan (Th) | L-99.9mm
POSTPROCESSING | D =85 mm

To fix position of sound path cursor with corresponding recovered A-Scan and remaining thickness

Ente'r
value left mouse click or release touch screen stylus or press *=_/ on front panel keyboard or [Enter
on external keyboard

ESC
To interrupt recovery of A-Scans and empty A-Scan Recovery field right mouse click or press L‘\
on front panel keyboard or on external keyboard

A-Scan Recovery=>OFF — erases sound path cursor, switches off recovered A-Scan, and empties A-
Scan Recovery field
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e Edit>Change Gain>0N — generates cursor representing sound path of probe's central beam in the
object under test that may be guided over t-BScan(Th) / BScan(Th) image using either touch screen

stylus or mouse or !/ f on front panel keyboard or , on external keyboard — corresponding

A-Scan is recovered synchronously according to cursor position. To select reference A-Scan release
Ente.r |

touch screen stylus or left mouse click or press ' *=_ on front panel keyboard or [Enter| on external

keyboard — this generates subwindow allowing off-line re-adjusting of Gain for all A-Scans captured

during t-BScan(Th) / BScan(Th) recording in £6dB range with £0.1 dB increments through clicking or

A

pressing and holding on b J or pressing !; ! on front panel keyboard or , on external
keyboard
isonicaos ]
Select Gain Change:
+44dB O
OK Cancel
b
During Gain re-adjusting reference A-Scan is modified accordingly. Upon completing re-adjusting Gain click
DK Ente.! |
on or press ' *=_ on front panel keyboard or on external keyboard — this applies new

Gain value to all captured A-Scans and redraws t-BScan(Th) / BScan(Th) image accordingly

Cancel e
To interrupt re-adjusting of Gain click on 4| or press L) on front panel keyboard or on

external keyboard

Edit->Change Gain=>OFF — negates Gain re-adjustment and returns to originally recorded t-BScan(Th) /
BScan(Th) image and original Gain setting
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Edit>ROI=>0ON - generates cursor representing sound path of probe's central beam in the object under

test that may be guided over t-BScan(Th) / BScan(Th) image using either touch screen stylus or mouse
r ? ‘ on front panel keyboard or , on external keyboard — corresponding A-Scan is

recovered synchronously according to cursor position. To select reference A-Scan release touch screen

FnTEr

stylus or left mouse click or press ' *=_/ on front panel keyboard or [Enter|on external keyboard — this

generates off-line Gate A controls n n n u m m allowing to redefine Region Of

Interest for t-BScan(Th) / BScan(Th) imaging

| File v|| Instrument || Edit v|| Measurements v|| A-Scan Recovery =

£

1% 3 mm

cinspectionData——— | - hickness Measurements —

Scan Length: 210 mm I
Encoder Name: Default I I

Inspector’s Coments: rLength Measurements

A
iRl |

=h-Scan Becoveny

BScan (Th) |
POSTPROCESSING | |

+ o+
+ o+
+ o+
+ o+
+ o+
+ o+
+ o+
+ o+
+ o+

Upon completing redefining of Region Of Interest click on — this applies new Gate A to all
captured A-Scans and updates t-BScan(Th) / BScan(Th) image accordingly

ESC
To interrupt selection of reference of A-Scan right mouse click or press L‘\ on front panel keyboard

or on external keyboard

To interrupt re-adjustment of Region Of Interest after selection of reference of A-Scan click on

Edit2>ROI=>0OFF — negates Gate A re-adjustment and returns to originally recorded t-BScan(Th) /
BScan(Th) image and original Gate A setting
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Edit>Flip Horizontal — reorders A-Scans captured during t-BScan(Th) / BScan(Th) recording in
reverse succession and redraws t-BScan(Th) / BScan(Th) image accordingly. This service function
may be useful for merging scans of neighboring sections of an object, which were scanned in opposite

direction due to access conditions, etc

| File v|| Instrument || Edit v|| Measurements v|| A-Scan Recovery v|

ROI 4
Change Gain ¥

~Inspection Data
Scan Length: 100 mm
Scan Time: 10 sec
Time-Out: 3 sec
Inspector's Coments:

B

|

t-BScan (Th)
POSTPROCESSING

~ Thickness Measurements —

~Length Measurements

—A-5can Recovery

®

| File v|| Instrument || Edit v|| Measurements v|| A-Scan Recovery -

E

Stimm

=

~Inspection Data
Scan Length: 100 mm
Scan Time: 10 sec
Time-Out: 3 sec
Ingpector's Coments:

[ |
||

t-BScan (Th)
POSTPROCESSING

~ Thickness Measurements —

~Length Measurements

—A-5can Recovery

100

Applying of Flip Horizontal function empties postprocessing session memory stack
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Measurements=>Length->ON — generates first vertical cursor that may be guided over t-BScan(Th) /

BScan(Th) image using either touch screen stylus or mouse or ?/ « on front panel keyboard or
, on external keyboard . Coordinate of the first vertical cursor along t-BScan(Th) / BScan(Th)
image (Lg) is indicated in the Length Measurements field. To fix position of the first vertical cursor left

Ente'r
mouse click or release touch screen stylus or press + J on front panel keyboard or [Enter|on
external keyboard . To interrupt vertical cursor manipulations and empty Length Measurements field

ESC
right mouse click or press L) on front panel keyboard or on external keyboard
Second vertical cursor appears upon fixing first one, it may be manipulated by the same way. Coordinate
of the second vertical cursor along t-BScan(Th) / BScan(Th) image (Lr) is indicated in the Length
Measurements field along with parameter W = Lr — Lg. Parameter W represents length of defect
provided that vertical cursors are placed appropriately
Measurements=>Length->OFF — erases vertical cursors and empties Length Measurements field
Measurements=>Thickness=>ON — generates first horizontal cursor that may be guided over t-

Y |

BScan(Th) / BScan(Th) image using either touch screen or mouse or =, _—_ / on front panel
keyboard or , on external keyboard . Coordinate of the first horizontal cursor along t-BScan(Th) /

BScan(Th) image (Dg) is indicated in the Thickness Measurements field. To fix position of the first
Ente'r

horizontal cursor left mouse click or release touch screen stylus or press ' -*=_/ on front panel keyboard
or [Enter| on external keyboard . To interrupt horizontal cursor manipulations and empty Thickness

ESC
Measurements field right mouse click or press L) on front panel keyboard or on external
keyboard
Second horizontal cursor appears upon fixing first one, it may be manipulated by the same way.
Coordinate of the second horizontal cursor along t-BScan(Th) / BScan(Th) image (Dr) is indicated in
the Thickness Measurements field along with parameter H = Dr — Dg. Parameter H represents
thickness loss provided that horizontal cursors are placed appropriately

Measurements=>Thickness=>OFF — erases horizontal cursors and empties Thickness
Measurements field

| File v|| Instrurment || Edit v|| Meazurements v|| A-Scan Recavery v|

2

a0 100 150 200

-

123 nm

=

~Inspection Data—— [ Thickness Measurements —

Scan Length: 210 mm I H=53mm
Encoder Name: Default

| Dg=86mm | Dr=13.9mm

Inspector's Coments: ~Length Measurements

B

| W =57.1mm
|Lg=859mm | Lr=143 mm

H
—A-Scan Recovery

BScan (Th) |
POSTPROCESSING | ||
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7.4. B-Scan cross-sectional imaging and recording of defects
for longitudinal and shear wave inspection — t-ABIScan or
ABIScan

7.4.1. Setup Pulser Receiver for t-ABIScan or ABIScan Imaging and
Recording

UDS 3-5 Pulser Receiver window — main operating surface — appears on ISONIC 2006 screen upon

[2]t-ABIscan ‘ l [2]|ABIScan
or

clicking onl
7.4.1.1. Straight Beam Probes

. The settings as below to be provided

# | Parameter or Submenu Required Settings Note
Mode
1 Gain BASICS Gain setting to be performed according
to inspection procedure providing
required echo heights from defects to be
detected
2 DAC/TCG DAC/TCG DAC/TCG settings to meet requirements
of inspection procedure
3 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
4 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing Level, To synchronize with Gain
Firing Level, and Damping settings to provide setting procedure
Damping optimal signal to noise ratio
5 Filter, Frequency RECEIVER Filter and Frequency settings to match | To synchronize with Gain
with probe's frequency setting procedure
6 Display RECEIVER Display setting may be either Full, RF, The same Display mode to
PosHalf, or NegHalf be used for both Probe
Delay determining and t-
ABIScan / ABIScan
Recording
7 USVelocity BASIC USVelocity setting to be equal to actual
value of ultrasound velocity in the object
under test
8 Probe Delay MEASURE Probe Delay setting to be equal to Probe delay may be
actual probe delay determined according to
paragraph 5.2.13.7 or
5.2.13.9 of this Operating
Manual or similarly
9 | Angle MEASURE Angle = 0°
10 | Settings for other
parameters and
modes have no
significance

I
Click on _| or press LJ on front panel keyboard or on external keyboard upon completing
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7.4.1.2. Angle Beam Probes

# | Parameter or Submenu Required Settings Note
Mode
1 Gain BASICS Gain setting to be performed according
to inspection procedure providing
required echo heights from defects to be
detected
2 DACI/TCG DAC/TCG DAC/TCG settings to meet requirements
of inspection procedure
3 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
4 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing Level, To synchronize with Gain
Firing Level, and Damping settings to provide setting procedure
Damping optimal signal to noise ratio
5 Filter, Frequency RECEIVER Filter and Frequency settings to match | To synchronize with Gain
with probe's frequency setting procedure
6 Display RECEIVER Display setting may be either Full, RF, The same Display mode to
PosHalf, or NegHalf be used for both Probe
Delay determining and t-
ABIScan / ABIScan
Recording
7 USVelocity BASIC USVelocity setting to be equal to actual
value of ultrasound velocity in the object
under test
8 Probe Delay MEASURE Probe Delay setting to be equal to Probe delay may be
actual probe delay determined according to
paragraph 5.2.13.5 or
5.2.13.6 or 5.2.13.9 of this
Operating Manual or
similarly
9 Angle MEASURE Angle setting to be equal to actual
probe angle
10 | Settings for other
parameters and
modes have no
significance

I
Click on _| or press LJ on front panel keyboard or on external keyboard upon completing
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7.4.2. B-Scan Cross Sectional Imaging — Implementation

7.4.2.1. t-ABIScan — Prior to Scanning (Straight Beam Probes)

t-ABIScan control panel for straight beam probe is shown below

1 Thickness o Coloring
P o+ o+ 43 mm ‘ 1 » I Pseudo
+ + o+ o+ — — |
o vt 0.5 2 Grayscale |
_‘:- ¥ + o+ o+ 5 Length ‘ o » Th | | o
P+ ¥ + + Efma
S+ . .l || 200 mm 3 _UDS35
+ o+ o+ 1 Time r b ﬁ’, E
o Ts ‘ 4 » Start | Open| Save | Cloze
tABIScan || | 26-Jan-2006
o -50 -100 -150 % -200
Empty t-ABIScan record field
< Scan Length not exceeding 600 mm or 24 in / Scan Time
20 Length o
1000 mm ‘ 3 »
0 -100 -Z00 -300 -400 -500 -600
Empty t-ABIScan record field
t-ABIScan scrolling controls -
4 I
Segment of Scrolled Total Scan Length exceeding 600 mm or 24 in / Scan Time
. g

®

Display Delay for current A-Scan to be used for the recording is equal to Probe Delay setting in
submenu MEASURE of UDS 3-5 Pulser Receiver predcessing entering into t-ABIScan mode
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Thickness

Thickness setting defines the region of interest starting from the scanning surface and automatic Range
setting for current A-Scan to be used for the recording: Range = Thickness. For objects whereas back echo
is feasible it may be useful to key in Thickness value slightly exceeding actual thickness of the object under
test — this will allow to record simultaneously defects signals and back echo itself. For the screenshot as
above the actual thickness of the test piece is 40 mm while the Thickness setting is 43 mm thanks to such
setting back echo is clearly resolved at the end of A-Scan

1 Thickness
43 mm

5 Length
200 mm

1 Fime

To control Thickness the following y;
manipulations are applicable: ///
e Mouse / Touch Screen ///

B Click on corresponding
e Keyboard

+
m Press 1! J on front panel keyboard or on external keyboard = Thickness fore color changes

to white - then use !J 2) :J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Thickness = Thickness fore color changes to white - then use !J '_’J !J !J on
front panel keyboard or , , , on external keyboard

®

The value of Thickness is adjustable between 5 and 300 mm or 0.2 and 12 in (expandable on special
inquire)

Skip #

This setting is ignored while using straight beam probes
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Scan Length and Scan Time

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period. Time (Scan Time) is the duration of recording period

1 Thickness

43 inm

=y

I By

3b ‘
oo K

-\

3
r
4
To control Length the following , . 7
manipulations are applicable: P
,.7
7
e Mouse /Touch Screen 4

B Click on corresponding
e Keyboard

Fd
B Press 3 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J '_’J _J 4 on front panel keyboard or , =, k=, U on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J '_’J !J ij on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 1000 mm or 2 and 40 in
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1 Thickrdess
43 mim

5 Length
209 mm

To control Time
: . . _ -,
the following manipulations are applicable: 7 -

e Mouse /Touch Screen ¢ -’
B Click on corresponding
e Keyboard

-
m Press _4 j on front panel keyboard or on external keyboard = Time fore color changes to

white - then use !J '_’J _J 4 on front panel keyboard or , =, k=, U on external

keyboard

e Combined

B Click on Time = Time fore color changes to white - then use !J '_’J !J ij on front panel
keyboard or , , on external keyboard

®

The value of Time is adjustable between 5 and 60 sec

Time-out

Time-Out is waiting time for intermissions predcessing ABIScan recording, which starts unconditionally
upon Time-Out period is over. Time-Out has fixed duration of 3 sec for t-ABIScan

Insert Text Note

Refer to paragraph 7.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 7.3.2.1 of this Operating Manual
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t-ABIScan Record Palette

There are four palettes available through click on appropriate button:

— Coloring

Pseudo

Pzeudo? I

Grayscale I

Thermal I

Start/Stop t-ABIScan recording

4
Click on ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard to

start t-ABIScan recording

4 |
ﬂ' button becomes invisible since t-ABIScan recording starts. ﬂ' button occupies its position.

-3 e
Click on _3%p | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate t-ABIScan recording prior to automatic completion

= | 2.
stop | putton becomes invisible after completion / termination of t-ABIScan record. __ 3%’ | putton

returns to its position

Save record into afile

Refer to paragraph 7.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 7.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 7.3.2.1 of this Operating Manual
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7.4.2.2. t-ABIScan — Scanning (Straight Beam Probes)

a

Apply probe to test object in the start point of selected scanning line

4
Click on ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard

Guide probe over the scanning line synchronously with Probe Icon moving with constant speed above t-
ABIScan record field — typical scanning progress display during is shown and explained below

+ 4+ o+ -
+
+

£
++++;|f+++

)

+ o+ 4+ o+ o+ |+ o+ 4+ -

B+ + + + +

t+-ABlScan || Scanning... L=42_ 37 mm

1 Thickness o r Colurisy
43 mm ‘ 1 » | Pseudo
+ -
.
- 0.5 2 Grayscale |
* 5 Length o | 7
i 200 mm ‘ 3 » Thermal UDS3-5
+ 1 Time o = [
+1~’n*'q is ‘ 4 » Open| Save Cloze
| 26-Jan-2006

- 150

% =200

e ——

——

Current Probe
Position

t-ABIScan record
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7.4.2.3. ABIScan — Prior to Scanning (Straight Beam Probes)

ABIScan control panel for straight beam probe is shown below

m 1 Thickness o Coloring
43 mm ‘ 1 I Pseudo
0.5 2 Grayscale |
5 Length ] | -
200 mm ‘ 3 Thermal UDS3-5
Encoder: } - =
IDefauIt j Start | Open| Save Cloze
| 26-Jan-2006
o -50 -100 -150 -200
Empty ABIScan record field
Scan Length not exceeding 600 mm or 12 in
< >
P
X
100 Length o
2600 mm ‘ 3 »
0 -200 -400 -E00 -500 -1000
Empty ABIScan record field
p] ABIScan scrolling controls field Y
< Segment of Scrolled Total Scan Length exceeding 600 mm or 12 in q

®

Display Delay for current A-Scan to be used for the recording is equal to Probe Delay setting in
submenu MEASURE of UDS 3-5 Pulser Receiver predcessing entering into ABIScan mode
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Thickness

Thickness setting defines the region of interest starting from the scanning surface and automatic Range
setting for current A-Scan to be used for the recording: Range = Thickness. For objects whereas back echo
is feasible it may be useful to key in Thickness value slightly exceeding actual thickness of the object under
test — this will allow to record simultaneously defects signals and back echo itself. For the screenshot as
above the actual thickness of the test piece is 40 mm while the Thickness setting is 43 mm thanks to such
setting back echo is clearly resolved at the end of A-Scan

1 Thickness
43 mm

5 Length ~
e
To control Thickness the following /7 7
manipulations are applicable: //
e Mouse / Touch Screen &

B Click on corresponding
e Keyboard

-
B Press 1 J on front panel keyboard or on external keyboard = Thickness fore color changes

to white - then use !J _J _J !J on front panel keyboard or , , , on external

keyboard
e Combined

,!J, !JOI’]

B Click on Thickness = Thickness fore color changes to white - then use !J '_’J
front panel keyboard or , , , on external keyboard

®

The value of Thickness is adjustable between 5 and 300 mm or 0.2 and 12 in (expandable on special
inquire)

Skip #

This setting is ignored while using straight beam probes
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Scan Length

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period

1 Thickness

=y

43 inm

3b
~ -~ 5 Length
200 mm
V4
4 s

LR

P

g
To control Length the following
manipulations are applicable: 7
// -
e Mouse /Touch Screen P %
&
B Click on corresponding
e Keyboard

-
B Press 3 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J '_’J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J '_’J :J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 20000 mm or 2 and 800 in

Encoder
Select encoder to be used through appropriate box

Encoder:

I Drefauilt j

Clamp probe into encoder — refer to Chapter 7 of this Operating Manual
Connect encoder to its input on the right side of ISONIC 2006 instrument

Insert Text Note

Refer to paragraph 7.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 7.3.2.1 of this Operating Manual
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ABIScan Record Palette

There are four palettes available through click on appropriate button:

— Coloring

Pseudo

Pzeudo? I

Grayscale I

Thermal I

Start/Stop ABIScan recording

4
Click on ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard to

start ABIScan recording

4 |
ﬂ' button becomes invisible since ABIScan recording starts. ﬂ' button occupies its position.

- S
Click on _3%p | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate ABIScan recording

- KA
stop | putton becomes invisible after termination of ABIScan record. _ 3tait | putton returns to its

position

Save record into afile

Refer to paragraph 7.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 7.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 7.3.2.1 of this Operating Manual

ISONIC 2006 from Sonotron NDT - Operating Manual — Revision 1.21 - Page 168 of 480



7.4.2.4. ABIScan — Scanning (Straight Beam Probes)

a Apply probe equipped with an encoder to test object in the start point of selected scanning line

..o
O Click on 3t |or press _J on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe over the scanning line — typical scanning progress display during is shown and explained

below
1 Thickness ~ Coloring
Current A-Scan o
— 42 mm 1 I Pzeudo
+ o+ W+ + o+ o+ - — |
: : : + : : : ‘ ! PSEUdDZ TE!t
—. 7 ot 0.5 2 Grayscale |
+ 4+ ﬁ-x__.__;;\ + o+ o+ 5 Length - — : | 7
+ o+ o+ ¥ O+ erma
P P 200 mm ‘ 3 UDS3-5
+ o+ + 4 o+t Encoder: [ ] a [
___ .+ J: +1~’n*'q+ _, IDefauIt j Stop | Open| Save| Cloze
I N N |
ABIScan | Scanning... L=43.50 mm | 26-Jan-2006
] [ 140 -100 -150 -200
— Current Probe
Position
L\ |
ABIScan record %
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7.4.2.5. t-ABIScan — Prior to Scanning (Angle Beam Probes)
t-ABIScan control panel for angle beam probe is shown below

5 Thickness - LE L]
+ A0 mm ‘ 1 » | Pzeudo
e »
* 0.5 Grayzcale |
* 5 Length I h : | i
N 80 mm ‘ 3 » erma UDS3-5
Current A-Scan 1 Time ‘ o » 3 = =
. . _ _ 105 4 Start | Open| Save | Close
t-ABlIScan 26-Jan-2006
5 g 40
>
Full Scan Length / Scan Time
For Total Length of t-ABIScan Record
Not Exceeding 600 mm or 24 in
Empty ABIScan record field
< >
Total Length of t-ABIScan Record
Not Exceeding 600 mm or 24 in
5 Length o
640 mm ‘ 3 »

=100 -2I|:II:I -SIIIIIII -400 -5I|:II:I -EIIZII:I

Empty ABIScan record

ABIScan scrolling controls field

Segment of Scrolled Total Scan Length / Scan Time and t-ABIScan Record For Total
Length of ABIScan Record Exceeding 600 mm or 24 in

®

O Display Delay for current A-Scan to be used for the recording is equal to Probe Delay setting in submenu
MEASURE of UDS 3-5 Pulser Receiver predcessing entering into t-ABIScan mode
O Total Length of t-ABIScan Record is determined automatically according to:
Total Length of t-ABIScan Record = Total Scan Length + 2 * Skip # * Thickness * Tan (Angle)
whereas
¢ Thickness, Skip #, and Total Scan Length = Length are the settings of t-ABIScan control panel

¢ Angle is setting in submenu MEASURE of UDS 3-5 Pulser Receiver predcessing entering into t-
ABIScan mode
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Thickness and Skip #

Thickness and Skip # settings define the region of interest starting from the scanning surface and automatic
Range setting for current A-Scan to be used for the recording:

Range =2 x Skip # x Thickness x Cos (Angle)
whereas
¢ Thickness and Skip # are the settings of t-ABIScan control panel
¢ Angle is setting in submenu MEASURE of UDS 3-5 Pulser Receiver predcessing entering into
t-ABIScan mode

For objects with parallel surfaces the actual Thickness value to be entered for full skip inspection (Skip # =
1)

5 Thickness
40 mm

5 Length
80 mm

To control Thickness the following /7
manipulations are applicable: ///
e Mouse /Touch Screen /,/

B Click on corresponding
e Keyboard

-
m Press 1 J on front panel keyboard or on external keyboard = Thickness fore color changes

to white - then use !J '_’J _J ¥ on front panel keyboard or [f, 53}, [, U on external

keyboard

e Combined

B Click on Thickness = Thickness fore color changes to white - then use !J '_’J :J ij on
front panel keyboard or , , , on external keyboard

®

The value of Thickness is adjustable between 5 and 300 mm or 0.2 and 12 in (expandable on special
inquire)
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To control Skip # the following
manipulations are applicable:

Skip # 3

oy 1o B[ |1y

Mouse / Touch Screen

B Click on corresponding Jjbutton

Keyboard

-
m Press _2 J on front panel keyboard or on external keyboard = Skip # fore color changes to

white - then use !_ ?/ . ! on front panel keyboard or , , , on external
keyboard

Combined

LY

B Click on Skip # = Skip # fore color changes to white - then use =/,

panel keyboard or , , , on external keyboard

2 & &

®

The Skip # setting may be 0.5 — half skip insonification or 1 — full skip insonification
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Scan Length and Scan Time

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period. Time (Scan Time) is the duration of recording period

5 Thickness
40 mm

=y

I By

3b ‘
J oo &

-\

3
r
4
To control Length the following , . 7
manipulations are applicable: P
,.7
7
e Mouse /Touch Screen 4

B Click on corresponding
e Keyboard

Fd
B Press 3 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J '_’J _J 4 on front panel keyboard or , =, k=, U on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J '_’J !J ij on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 1000 mm or 2 and 40 in
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1 Thickrdess
43 mim

5 Length
209 mm

To control Time
: . . _ -,
the following manipulations are applicable: 7 -

e Mouse /Touch Screen ¢ -’
B Click on corresponding
e Keyboard

-
m Press _4 j on front panel keyboard or on external keyboard = Time fore color changes to

white - then use !J '_’J _J 4 on front panel keyboard or , =, k=, U on external

keyboard

e Combined

B Click on Time = Time fore color changes to white - then use !J '_’J !J ij on front panel
keyboard or , , on external keyboard

®

The value of Time is adjustable between 5 and 60 sec

Time-out

Time-Out is waiting time for intermissions predcessing ABIScan recording, which starts unconditionally
upon Time-Out period is over. Time-Out has fixed duration of 3 sec for t-ABIScan

Insert Text Note

Refer to paragraph 7.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 7.3.2.1 of this Operating Manual
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t-ABIScan Record Palette

There are four palettes available through click on appropriate button:

— Coloring

Pseudo

Pzeudo? I

Grayscale I

Thermal I

Start/Stop t-ABIScan recording

4
Click on ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard to

start t-ABIScan recording

4 |
ﬂ' button becomes invisible since t-ABIScan recording starts. ﬂ' button occupies its position.

-3 e
Click on _3%p | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate t-ABIScan recording prior to automatic completion

= | 2.
stop | putton becomes invisible after completion / termination of t-ABIScan record. __ 3%’ | putton

returns to its position

Save record into afile

Refer to paragraph 7.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 7.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 7.3.2.1 of this Operating Manual
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7.4.2.6. t-ABIScan — Scanning (Angle Beam Probes)

a Apply probe to test object in the start point of selected scanning line

4
a Clickon ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe over the scanning line synchronously with Probe Icon moving with constant speed above t-
ABIScan record field — typical scanning progress display during is shown and explained below

Current A-Scan

5 Thickness o  Loloring
+ o+ ror 40 mm ‘ 1 » |  Pseudo ﬂ
+ + o+ o+ _ — |
T LT 05 £ Grayscale |
+ o+ + o+ 5 Length ‘ r » — | | -~
+ 4+ + o+ o+ Ermad
. P 80 mm 3 UDS3-5
+ o+ + o+ o+ 1 Time o i E
Y o, " .;rlh,:_m,,,-}',n“r 10s ‘ 4 » Open| Save Cloze
|
| 26-Jan-2006

Current Probe
Position

t-ABIScan record
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7.4.2.7. ABIScan — Prior to Scanning (Angle Beam Probes)
ABIScan control panel for angle beam probe is shown below

1 Thickness i Coloring
40 mm ‘ 1 » | Pseudo

+ o+ +
+ +
¥ * Grayzcale |
ot * 5 Length o Th : | i
o X 160 mm ‘ 3 » == UDS3-5
+ o+ Current A-Scan Encoder: ’ = ]
" _ | J Start [ Open| Save Cloze
ABlScan Z2b-Jan-2006
Full Scan Length
For Total Length of ABIScan Record
L< Not Exceeding 600 mm or 24 in »‘
00 &0 -5 00 150

Empty ABIScan record field

Total Length of ABIScan Record
Not Exceeding 600 mm or 24 in %

5 Length -
640 mm ‘ 3
=100 =200 =200 -0 -EIIIIEI -BIIZII:I

»

Empty ABIScan record

ABIScan scrolling controls field

>

Segment of Scrolled Total Scan Length and ABIScan Record For Total Length of ABIScan
Record Exceeding 600 mm or 24 in

®

O Display Delay for current A-Scan to be used for the recording is equal to Probe Delay setting in submenu
MEASURE of UDS 3-5 Pulser Receiver predcessing entering into ABIScan mode

O Total Length of ABIScan Record is determined automatically according to:
Total Length of ABIScan Record = Total Scan Length + 2 * Skip # * Thickness * Tan (Angle)
where
¢ Thickness, Skip #, and Total Scan Length = Length are the settings of ABIScan control panel
¢ Angle is setting in submenu MEASURE of UDS 3-5 Pulser Receiver predcessing entering into
ABIScan mode
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Thickness and Skip #

Thickness and Skip # settings define the region of interest starting from the scanning surface and automatic
Range setting for current A-Scan to be used for the recording:

Range =2 x Skip # x Thickness x Cos (Angle)
whereas

¢ Thickness and Skip # are the settings of ABIScan control panel

¢ Angle is setting in submenu MEASURE of UDS 3-5 Pulser Receiver predcessing entering into
ABIScan mode

For objects with parallel surfaces the actual Thickness value to be entered for full skip inspection (Skip # =
1)

1 Thickness

40 mm

5 Length
160 mm

To control Thickness the following /7 7
manipulations are applicable:

e Mouse / Touch Screen 4

B Click on corresponding
e Keyboard

-
B Press 1 J on front panel keyboard or on external keyboard = Thickness fore color changes

to white - then use !J '_’J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Thickness = Thickness fore color changes to white - then use !J '_’J !J !J on
front panel keyboard or , , , on external keyboard

®

The value of Thickness is adjustable between 5 and 300 mm or 0.2 and 12 in (expandable on special
inquire)
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Skip # o~

1 Thickness
40 mm ‘

5 Length
R «

To control Skip # the following
manipulations are applicable:

e Mouse / Touch Screen

B Click on corresponding

e Keyboard
F
B Press _2 J on front panel keyboard or on external keyboard = Skip # fore color changes to

white - then use !_ =, « ! on front panel keyboard or [T} , , on external
keyboard

e Combined
B Click on Skip # = Skip # fore color changes to white - then use !_
panel keyboard or , , , on external keyboard

2 = =

~/ on front

®

The Skip # setting may be 0.5 — half skip insonification or 1 — full skip insonification
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Scan Length

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period

1 Thickness

=y

40 inm

1
~ -~ 5 Length
160 mm
V4
4 s

LR

P

g
To control Length the following
manipulations are applicable: 7
// -
e Mouse /Touch Screen P %
&
B Click on corresponding
e Keyboard

-
B Press 3 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J '_’J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J '_’J !J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 1000 mm or 2 and 40 in

Encoder
Select encoder to be used through appropriate box

Encoder:

Drefault j

Clamp probe into encoder — refer to Chapter 7 of this Operating Manual
Connect encoder to its input on the right side of ISONIC 2006 instrument

Insert Text Note

Refer to paragraph 7.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 7.3.2.1 of this Operating Manual
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ABIScan Record Palette

There are four palettes available through click on appropriate button:

— Coloring

Pseudo

Pzeudo? I

Grayscale I

Thermal I

Start/Stop t-ABIScan recording

4
Click on ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard to

start ABIScan recording

4 |
ﬂ' button becomes invisible since ABIScan recording starts. ﬂ' button occupies its position.

-3 e
Click on _3%p | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate ABIScan recording prior to automatic completion

- KA
stop | putton becomes invisible after termination of ABIScan record. _ 3tait | putton returns to its

position

Save record into afile

Refer to paragraph 7.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 7.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 7.3.2.1 of this Operating Manual
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7.4.2.8. ABIScan — Scanning (Angle Beam Probes)

a Apply probe equipped with an encoder to test object in the start point of selected scanning line

..o
O Click on 3t |or press _J on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe over the scanning line — typical scanning progress display during is shown and explained
below

— Coloring

» I Pzeudo
» Pzeudo? | Text
Grayscale |

-~

omn

Bl <
5L h

roomn G

I By

Iz

upsS3-5

oo By

Thermal

Encoder: ] a H
I Drefault j : Open| Save| Close
ABIScan | Scanning... L=25.00 mm | 26-Jan-2006

Current Probe
Position

=50 -100 - 150

ABIScan record
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7.4.2.9. t-ABIScan / ABIScan — Postprocessing
Versatile postprocessing of t-ABIScan / ABIScan records is featured with:

Q Sizing defects at any location along stored images (coordinates, projection size, amplitude-based
evaluation)

Q Play-back and evaluation of A-Scans obtained and captured during t-ABIScan / ABIScan defects
imaging and recording

a Defects outlining and pattern recognition based on A-Scan sequence analysis — Echo Dynamic
Pattern Analysis

O Reconstruction of B-Scan defects images for various Gain, Reject, and off-line Gate level settings

o DAC/DGSt-ABIScan / ABIScan normalization

The screen as below appears upon opening file. All postprocessing procedures are performed through
— touch screen stylus or front panel or external mouse to be used

—_—
*File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

— Length Measurements

t-ABIScan |
POSTPROCESSING | | | |

—Depth Measurements

|' Filtering: I
|
| |
IVA-Scan Recovery
|

Menu Bar Functions

e File>Open - opens new t-ABIScan / ABIScan file
e File>Snapshots>Add Snapshot — stores current postprocessing screen snapshot accompanied with
appropriate settings and measurements into postprocessing session memory stack

e File>Snapshots>Restore Snapshot — recalls earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

e File>Snapshots>Delete Snapshot — deletes earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

e File=>Print — prints out postprocessing screen snapshot(s) accompanied with appropriate settings and
measurements
e File=>Exit — returns to t-ABIScan / ABIScan control panel

e View-—2>Instrument — indicates setup of UDS 3-5 Pulser Receiver used for scanning when file was
created

e View-=2Inspection Data — indicates operator's comments entered prior to scanning
e View—>Coloring — selects palette for t-ABIScan / ABIScan image
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A-Scan Recovery 20N (straight beam inspection record) — generates cursor representing sound path
of straight beam probe's central beam in the object under test that may be guided over t-ABIScan /

ABIScan image using either touch screen stylus or mouse or ?/ « on front panel keyboard or ,
on external keyboard — corresponding A-Scan is recovered synchronously according to sound path
cursor position. Starting position of cursor (L) corresponding to probe's center is indicated in the A-Scan
Recovery field. On the recovered A-Scan there is red Off-line Gate presented. Initially Off-line Gate
covers whole A-Scan range

| File v|| Wiew v|| E dit v|| I easurements v|| A-Scan Recovery v|

— Length Measurements

t-ABIScan |
POSTPROCESSING | ||

— Depth Measurements
" Filtering: I
|
| |

"A—S can Recovery

I I I I
E S e
I I I I

L =262 mm b 00%

-_—

|Automatic Measurements Display| accompanies recovered A-Scan and indicates (refer to
paragraphs 5.1.12, 5.2.13.1 and 5.2.13.2 of this Operating Manual):

o deptht of reflector (measurement mode - Flank)
o amplitude H of the maximal signal in the Off-line Gate expressed in % of full A-Scan height

o AVC (dB to DAC) of the maximal signal in the Off-line Gate provided that DAC was active
whilst recording t-ABIScan / ABIScan data

To fix position of sound path cursor with corresponding recovered A-Scan and Automatic

"
Enter

Measurements Display data left mouse click or release touch screen stylus or press ' *=_ on front
panel keyboard or [Enter| on external keyboard

ESC
To interrupt recovery of A-Scans and empty A-Scan Recovery field right mouse click or press L)
on front panel keyboard or on external keyboard

A-Scan Recovery>OFF (straight beam inspection record) — erases sound path cursor with recovered
A-Scan and Automatic Measurements Display and empties A-Scan Recovery field
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A-Scan Recovery 20N (angle beam inspection record) — generates cursor representing sound path of
angle beam probe's central beam in the object under test that may be guided over t-ABIScan / ABIScan

image using either touch screen stylus or mouse or 2/, « on front panel keyboard or , on
external keyboard — corresponding A-Scan is recovered synchronously according to sound path cursor
position. Starting position of cursor (L) corresponding to probe's incidence point is indicated in the A-

Scan Recovery field. On the recovered A-Scan there is red Off-line Gate presented. Initially Off-line
Gate covers whole A-Scan range

| File v|| Wiew v|| E dit v|| I easurements v|| A-Scan Recovery v|

— Length Measurements

ABIScan l
POSTPROCESSING | ||

— Depth Measurements
" Filtering: I
|
| |

A-5can Recovery
ﬁ L=-244mm

=

T T I
R e

t=0.2mm a=03mm
H=200% AVC=92dB

|Automatic Measurements Display| accompanies recovered A-Scan and indicates (refer to
paragraphs 5.1.12, 5.2.13.1 and 5.2.13.2 of this Operating Manual):

o deptht of reflector (measurement mode - Flank)

o0 distance a between probe incidence point and reflector taken along scanning surface
(measurement mode - Flank)

o amplitude H of the maximal signal in the Off-line Gate expressed in % of full A-Scan height

o AVC (dB to DAC) of the maximal signal in the Off-line Gate provided that DAC was active
whilst recording t-ABIScan / ABIScan data

To fix position of sound path cursor with corresponding recovered A-Scan and Automatic

"
Enter

Measurements Display data left mouse click or release touch screen stylus or press ' *=_/ on front
panel keyboard or [Enter| on external keyboard

ESC
To interrupt recovery of A-Scans and empty A-Scan Recovery field right mouse click or press L‘\
on front panel keyboard or on external keyboard

A-Scan Recovery=>OFF (angle beam inspection record) — erases sound path cursor with recovered A-
Scan and Automatic Measurements Display and empties A-Scan Recovery field
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e Edit>Change Gain>0N — (straight beam and angle beam inspection records) generates cursor
representing sound path of probe's central beam in the object under test that may be guided over t-

ABIScan / ABIScan image using either touch screen stylus or mouse or !/ f on front panel
keyboard or , on external keyboard — corresponding A-Scan is recovered synchronously
according to sound path cursor position. To select reference A-Scan release touch screen stylus or left

[
Enter

mouse click or press +4 _ on front panel keyboard or on external keyboard — this generates
subwindow allowing off-line re-adjusting of Gain for all A-Scans captured during t-ABIScan / ABIScan

recording in £6dB range with £0.1 dB increments through clicking or pressing and holding on ﬁ or

pressing —/, . / on front panel keyboard or , on external keyboard

ISONIC 2005 |

Select Gain Change:

+4.4 dB il

0K Cancel

by
During Gain re-adjusting reference A-Scan is modified accordingly. Upon completing re-adjusting Gain click

DK EﬂTE.! _'
on or press +4 _ on front panel keyboard or on external keyboard - this applies new

Gain value to all captured A-Scans and redraws t-ABIScan / ABIScan image accordingly

Cancel | g
To interrupt re-adjusting of Gain click on or press L) on front panel keyboard or on

external keyboard

Edit>Change Gain>OFF — negates Gain re-adjustment and returns to originally recorded t-ABIScan /
ABIScan image and original Gain setting
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Edit>ROI=>ON (straight beam inspection record) — generates cursor representing sound path of
straight beam probe's central beam in the object under test that may be guided over t-ABIScan /

ABIScan image using either touch screen stylus or mouse or 2/, « on front panel keyboard or ,
on external keyboard — corresponding A-Scan is recovered synchronously according to sound path
cursor position. To select reference A-Scan release touch screen stylus or left mouse click or press

Enter
_/ on front panel keyboard or [Enter|on external keyboard — this generates Off-line Gate controls

n n n n H n allowing to redefine Region Of Interest for t-ABIScan / ABIScan

imaging

| File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery -

— Length Measurements

ABIScan |
POSTPROCESSING | |

— Depth Measurements

Filtering: I
| |
IVA-Scan Recovery

|

To interrupt selection of reference of A-Scan right mouse click or press L) on front panel keyboard

or on external keyboard

To interrupt re-adjustment of Region Of Interest after selection of reference of A-Scan click on
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Upon completing redefining of Region Of Interest click on — this applies new Off-line Gate to all
captured A-Scans and updates t-ABIScan / ABIScan image accordingly — only segment of t-ABIScan /
ABIScan image covered by newly adjusted Off-line Gate remains visible

| File v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|

— Length Measurements

ABIScan l
POSTPROCESSING | | /

— Depth Measurements

Filtering: I
’—A—S can Recovery
|

It is possible then to perform A-Scan signals evaluation using newly adjusted Off-Line Gate through A-
Scan Recovery >ON

| File: v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|
a -50 100
== e e e s I |
- e e — e e n
- pr—— e —
—Length Measurements
ABIScan | .
POSTPROCESSING | N
— Depth Measurements +
Filtering: *
’7| I +
| | N
4
A-S5can Recovery N - +N
ﬁ L = E0.8 mm t=16.2mm H=76% i

o Edit>ROI>OFF (straight beam inspection record) — negates Off-line Gate re-adjustment and returns
to originally recorded t-ABIScan / ABIScan image and initial Off-line Gate setting
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Edit2>ROI=>0ON (angle beam inspection record) — generates cursor representing sound path of angle
beam probe's central beam in the object under test that may be guided over t-ABIScan / ABIScan

image using either touch screen stylus or mouse or ?/ « on front panel keyboard or , on
external keyboard — corresponding A-Scan is recovered synchronously according to sound path cursor

"
Enter

position. To select reference A-Scan release touch screen stylus or left mouse click or press ' *=_ on

front panel keyboard or Enter on external keyboard - this generates Off-line Gate controls

n n u u n allowing to redefine Region Of Interest for t-ABIScan / ABIScan

imaging

| File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery -

— Length Measurements

t-ABIScan |
POSTPROCESSING | ||

— Depth Measurements

Filtering: I
| |
IVA-Scan Recovery

|

ESC
To interrupt selection of reference of A-Scan right mouse click or press L) on front panel keyboard

or on external keyboard

. . . . . >
To interrupt re-adjustment of Region Of Interest after selection of reference of A-Scan click on .

ISONIC 2006 from Sonotron NDT - Operating Manual — Revision 1.21 - Page 189 of 480



Upon completing redefining of Region Of Interest click on — this applies new Off-line Gate to all
A-Scans captured during t-ABIScan / ABIScan recording and updates t-ABIScan / ABIScan image
accordingly — only segment of t-ABIScan / ABIScan image covered by newly adjusted Off-line Gate
remains visible: in the present example there was under surface crack detected using full skip
insonification and Off-line Gate was readjusted by such a way that only full skip segment of t-ABIScan /
ABIScan image remained visible — this allowed to eliminate disturbing presence of initial pulse
reverberations on the t-ABIScan / ABIScan image

| File v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|
g o
=
R T . il =
— Length Measurements
t-ABIScan |
POSTPROCESSING | |
— Depth Measurements
Filtering: I
| |
’—A—Scan Recovery [%
|

It is possible then to perform A-Scan signals evaluation using newly adjusted Off-Line Gate through A-
Scan Recovery >ON

| File: v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|

—Length Measurements

t-ABIScan |
POSTPROCESSING | ||

— Depth Measurements

" Filtering: —‘ I
A-Scan Recovery t=3.8mm a = 36.2mm
ﬁ L =-55.2 mm

H=126% AVC=6.0dB
e Edit=>ROI2>OFF (angle beam inspection record) — negates Off-line Gate re-adjustment and returns to
originally recorded t-ABIScan / ABIScan image and initial Off-line Gate setting

N

I S et S I
!
)

SR R R T
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Edit>Filtering>ON — (straight beam and angle beam inspection records) generates amplitude palette
bar with sliding cursor, which may be controlled using either touch screen stylus or mouse or ' -/, f

on front panel keyboard or , on external keyboard . Position of the sliding cursor on the amplitude
palette bar determines filtering level, which is indicated in the Filtering field. All elements of t-ABIScan /
ABIScan image representing signal amplitude below filtering level are suppressed:

| File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

-50
|

— Length Measurements E

t-ABIScan |
POSTPROCESSING | | | |

—Depth Measurements

Filtering: I
ﬁ 6.6dB
| |
IVA-Scan Recovery
|

Edit>Filtering>OFF (straight beam and angle beam inspection records) — returns to originally
recorded t-ABIScan / ABIScan image and empties Filtering field
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e Edit>Normalize to DAC->ON (straight beam and angle beam inspection records) — applies DAC/DGS
normalized color palette to t-ABIScan / ABIScan image, which was recorded with active DAC/DGS and
redraws t-ABIScan / ABIScan image correspondingly (dB to DAC/DGS normalization)

| File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|
Change Gain 4
ROI 4
Filtering 4

Momalize to DAC M
= [F|

t-ABIScan
POSTPROCESSING

— Length Measurements

+

|' Filtering: —‘
A-S5can Recoverp
ﬁ L="57.2mm

—Depth Measurements

t=4.5mm
b6

H=

a=355mm

AVC=856dB

3,
T+ o+ N+t + 4
i \
++I+++4.
i + o+ o+ 4+
+ +f+ + + A+ o+
!

| File v|| Wigw v|| Edit v|| Measurements v|| A-Scan Recavery v|

Lo

— Length Measzurements

t-ABIScan |
POSTPROCESSING | | | |

— Depth Meazurements

Filtering:
[ '
| |
A-S5can Recoverp
|_| L=-57.2mm

e Edit=>Normalize to DAC->OFF (straight beam and angle beam inspection records) — negates dB to
DAC/DGS normalization and returns to originally recorded t-ABIScan / ABIScan image

®

Applying of Edit->Normalize to DAC->ON or Edit->Normalize to DAC->OFF negates Filtering
(Edit>Filtering>OFF)

N,
T+ + W+ o+ o+ o+
15 \
',

',

t=4.5mm a=355mm

H=166% AVC=38.6 dB
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Measurements=>Length->ON — generates first vertical cursor that may be guided over t-ABIScan /

ABIScan image using either touch screen stylus or mouse or ?/ « on front panel keyboard or ,

on external keyboard . Coordinate of the first vertical cursor along t-ABIScan / ABIScan image (Lr)

is indicated in the Length Measurements field. To fix position of the first vertical cursor left mouse click
Ente‘r

or release touch screen stylus or press + J on front panel keyboard or [Enter|on external keyboard .

To interrupt vertical cursor manipulations and empty Length Measurements field right mouse click or

ESC
press L) on front panel keyboard or on external keyboard
Second vertical cursor appears upon fixing first one, it may be manipulated by the same way. Coordinate
of the second vertical cursor along t-ABIScan / ABIScan image (Lg) is indicated in the Length
Measurements field along with parameter W = Lg — Lr. Parameter W represents projection length of
defect provided that vertical cursors are placed appropriately
Measurements=2>Length->OFF — erases vertical cursors and empties Length Measurements field
Measurements>Depth>ON — generates first horizontal cursor that may be guided over t-ABIScan /

Y |

ABIScan image using either touch screen or mouse or =/, _T_ / on front panel keyboard or , on

external keyboard . Coordinate of the first horizontal cursor along t-ABIScan / ABIScan image (Dr) is
indicated in the Depth Measurements field. To fix position of the first horizontal cursor left mouse click

"
Enter

or release touch screen stylus or press *=_/ on front panel keyboard or [Enter| on external keyboard .
To interrupt horizontal cursor manipulations and empty Depth Measurements field right mouse click or

ESC
press L) on front panel keyboard or on external keyboard
Second horizontal cursor appears upon fixing first one, it may be manipulated by the same way.
Coordinate of the second horizontal cursor along t-ABIScan / ABIScan image (Dg) is indicated in the

Depth Measurements field along with parameter H = Dg — Dr. Parameter H represents thickness
loss provided that horizontal cursors are placed appropriately

Measurements>Depth->OFF — erases horizontal cursors and empties Depth Measurements field

| File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

o
n
[=]

— Length Measurements

t-ABIScan [ w-z25mm
POSTPROCESSING | | [Li=-173mm [Lg=206mm

—Depth Measurements

|'Fi|lering: —‘ I H=4mm

I | Dr=0mm | Dg=4mm
A-Scan Recovery t=45mm a=355mm
{I L = 57.2 mm H=166% AVC-=8.6dB
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7.5. TOFD Inspection — RF B-Scan and D-Scan Imaging and
Recording —t-TOFD or TOFD

7.5.1. Setup Pulser Receiver for t-TOFD and TOFD

UDS 3-5 Pulser Receiver window — main operating surface — appears on ISONIC 2006 screen upon

o l [3]t-ToFD ‘ l [3]ToFD ‘ . . .
clicking on or . The following settings to be provided:
# | Parameter or Submenu Required Settings Note
Mode
1 Pulser Mode PULSER Dual
2 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing Level, To synchronize with Gain
Firing Level, and Damping settings to provide setting procedure
Damping optimal signal to noise ratio
3 Filter, Frequency RECEIVER Filter and Frequency settings to match | To synchronize with Gain
with probe's frequency setting procedure
4 Display RECEIVER RF
5 USVelocity BASIC USVelocity setting to be equal to actual
value of ultrasound velocity in the object
under test
6 Probe Delay MEASURE Probe Delay setting to be equal to Accumulated Probe Pair
actual Accumulated Probe Pair Delay may be determined
Delay according to paragraph
7.5.1.1 of this Operating
Manual
7 Display Delay BASICS Display Delay and Range to provide Display Delay and Range
Range clear A-Scan representing: will be determined
o0 Lateral Wave and Longitudinal according to paragraph
Wave Back Echo Signals at the 7.5.1.2 of this Operating
beginning and at the and of A-Scan | Manual
correspondingly
OR
o Lateral Wave, Longitudinal Wave
Back Echo, and Mode Conversion
Back Echo at the beginning, middle,
and at the end of A-Scan
correspondingly
OR
o0 Other combination of signals
required by Inspection procedure
8 Gain BASICS Gain setting to be performed according Refer to paragraph 7.5.1.3
to inspection procedure providing of this Operating Manual
required amplitude of signals from
defects to be detected
9 | Settings for other

parameters and
modes have no
significance

I
Click on _| or press LJ on front panel keyboard or on external keyboard upon completing
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7.5.1.1. Accumulated Probe Pair Delay

Two probes to be used in order to capture the TOFD Map. The Probe Delay to be precisely measured for
each of them.

Measuring Probe Delay - Miniature Probes (contact face width 12.5 mm / 0.5 in or less) — Pulse Echo
Technique

" Longitudinal Wave Echo Activate submenu PULSER then set:
+ + + + +

Q Pulser Mode to Single

O Pulse Width to Spike (240 pJ) for probe
having resonant frequency of 8 MHz and
higher or to PW ns, were PW =0.5/F (F
is the probe resonant frequency) for
probes having resonant frequency below 8
MHz

Q Firing Level to 18

a Damping to 1000 Q

Q Tuning to NO

Activate submenu RECEIVER then set:

a Display to Full or RF

Q Filterto BB

Q Frequency to completely cover probe's
effective bandwidth

Activate submenu BASICS topic then set:

o US Velocity to 5920 m/s (233.1 in/ms)

O Rangeto50.0 mm (2in)

a Display Delay to 0 ps

O Reject to 0%

Stage 1. Manipulate probe over main working
surface of V-2 reference standard and maximize
echo from 25 mm (1 in) radius concave reflector

Stage 2: Fix probe in found position - the center of
25 mm (1 in) radius concave reflector will indicate
incident point while the distance between probe's
frontal edge and incident point is equal to X-
Value

Incidence
Foint

Stage 3: Tune Display Delay while probe is still
fixed in found position until rising edge of
maximized echo will match with 50%-grid of the A-
Scan width. Upon completing the obtained value
of Display Delay will be equal to actual Probe
Delay

It's necessary to setup Gain bringing height of maximized echo to 75-80% of A-Scan height

e

It is recommended to optimize Tuning in PULSER submenu upon obtaining maximized echo. The goal of
such optimization is increasing of ultrasonic excitation energy through better matching between firing
output and probe. Level of ultrasonic excitation energy is clearly represented by echo amplitude. Upon
completing Tuning optimization Gain to be adjusted to bring echo to 75-80% of A-Scan height

Supposing that Probe Delay values found for probes of the pair are PD1 and PD»
Accumulated Probe Pair Delay = 0.5¢(PD; + PD>)
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Measuring Probe Delay - Large and Medium Size Probes (contact face width more than 12.5 mm /0.5
in) — Pulse Echo Technique

N N N N N Activate submenu PULSER then set:
Longitudinal Wawve Echo Q Pulser Mode

O Pulse Width to Spike (240 pJ) for probe
having resonant frequency of 8 MHz and
higher or to PW ns, were PW =0.5/F (F
is the probe resonant frequency) for
probes having resonant frequency below
8 MHz

O Firing Level to 18

0 Damping to 1000 Q

Q Tuning to NO

Activate submenu RECEIVER then set:

a Display to Full or RF
O Filterto BB
O Frequency to completely cover probe's
effective bandwidth
Activate submenu BASICS topic then set:
O US Velocity to 5920 m/s (233.1 in/ms)
0 Range to 200.0 mm (8in)
O Display Delay to O s
O Rejectto 0%

Stagel
— Incidence

o1t

Stage 1: Manipulate probe over main working
surface of V-1 reference standard and maximize
echo from 100 mm (4 in) radius concave reflector

Stage 2: Fix probe in found position - the center
of 100 mm (4 in) radius concave reflector will
indicate incident point while the distance
between probe's frontal edge and incident point
is equal to X-Value

Stage 3: Tune Display Delay while probe is still
fixed in found position until rising edge of
maximized echo will match with 50%-grid of the
A-Scan width. Upon completing the obtained
value of Display Delay will be equal to actual
Probe Delay

Incidence
Foint

*

It's necessary to setup Gain bringing height of maximized echo to 75-80% of A-Scan height

¢ Itis recommended to optimize Tuning in PULSER submenu upon obtaining maximized echo. The goal of
such optimization is increasing of ultrasonic excitation energy through better matching between firing
output and probe. Level of ultrasonic excitation energy is clearly represented by echo amplitude. Upon
completing Tuning optimization Gain to be adjusted to bring echo to 75-80% of A-Scan height

Supposing that Probe Delay values found for probes of the pair are PD1 and PD>

Accumulated Probe Pair Delay = 0.5¢(PD; + PD>)
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Direct Measurement of Accumulated Probe Pair Delay - All Sizes of Probes — Through Transmission

Technique

Prake 1

Prohe 2

Proke 1

Probe 2

Activate submenu PULSER then set:

O Pulser Mode to Dual
O Pulse Width to Spike (240 pJ) for probe
having resonant frequency of 8 MHz and
higher or to PW ns, were PW =0.5/F (F
is the probe resonant frequency) for
probes having resonant frequency below
8 MHz
O Firing Level to 18
0 Damping to 1000 Q
O Tuning to NO
Activate submenu RECEIVER then set:
o Display to RF
a Filter to BB
O Frequency to completely cover probe's
effective bandwidth
Activate submenu BASICS topic then set:
0 Display Delay to O us

Stage 1: Manipulate probes over each other and
setup of Gain, Range, and USVelocity providing
firm indication of the signal propagating in the
probes wedges from emitting to receiving crystal
then maximize said signal

Stage 2: Fix the probe in the found position
corresponding to highest signal amplitude

¢ It's necessary to setup Gain bringing height
of maximized echo to 75-80% of A-Scan
height

¢ Itis recommended to optimize Tuning in
PULSER submenu upon obtaining
maximized echo. The goal of such
optimization is increasing of ultrasonic
excitation energy through better matching
between firing output and probe. Level of
ultrasonic excitation energy is clearly
represented by echo amplitude. Upon
completing Tuning optimization Gain to be
adjusted to bring echo to 75-80% of A-
Scan height
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I Probe 1

Probe 2

Stage 3: Increase Gain to provide height of first
half wave of received signal reaching 20 % of total
A-Scan height

Stage 4: Decrease Range to provide ~ 50% of
| the A-Scan width occupied by the signal

Probe 2

Stage 5: Start increasing of Display Delay aiming
displacement of signal's start point to beginning of
A-Scan horizontal base

Stage 6: Stop Display Delay manipulation upon
reaching the target — at this moment value of
Display Delay will represent Accumulated Delay
of the Probes Pair

UDS3-5 - ISONMIC Pulzer/Receiver

BASICS PULSER RECEIVER GATE A Menu
GATE B ALARM DAC/TCG MEASURE Selection

] Value: OFF PRIPES | = | -
Cloze EM| Freeze Save | Open DG5S
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7.5.1.2. Display Delay and Range
Display Delay depends on Accumulated Probe Pair Delay, Probe Separation, and USVelocity:

Display Delay = Probe Delay + Probe Separation / USVelocity

whereas:

a

a

USVelocity is the actual value of longitudinal wave velocity in the material, of which the object
under test is made

Probe Separation is the distance between incidence points of the emitting and receiving TOFD probes
measured along the lateral wave trace:

Probe Separation

Emitting Receiving
Probe Frobe

-Lateral Wave

%————- Longitudinal Wave Back Echo

Probe Separation should be optimized according to Inspection procedure and probes positions in the TOFD
fixture to be fixed upon. Display Delay and Range to be adjusted then to provide representing of signals
according to Inspection procedure — the typical examples are given below for 40 mm thickness welded
plates.

UDS53-5 - ISONMIC Pulser/Receiver

0.5 Gain

715 dB
0.2 Range

= Ty

Mo By

pr
13.4 mm ‘
1 U5 Velocit
o0 mn R
0.01 Display Dela
W -
RBeject
Yl «

o By

4 By

ln By

PULSER RECEIVER GATE A Menu "Df ? - 5
ALARM DAC/TCG MEASURE Selection
H | & | & L
Save | Open | Frnt DG5S

y A

/
Lateral Wave Longitudinal Wave
Signal Back Echo
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UD53-5 - ISONMIC Pulser/Beceiver

Gain

715 dB

= Ty

Range

Ino Ry

36.8 mm

1 U5 Velocity ‘

5920 mfs

0.01 Display Delay
2? 84 ps ‘

Beject ‘

0 %

[FHEAN FULSER  RECEIVER  GATE A Menu "D" 2_5
GATE B ALARM DAC/TCE  MEASURE  Selection

I by

[ By

+

In by

Yalue: OFF i i = = =3 e
Close Alaim I \EIEEZE Save \Open| Fnnt DGS
N\ \
\ \ \
Signal Back Echo Wave Back Echo
7.5.1.3. Gain

Depending on Inspection procedure (Inspection specs) Gain may be setup with the reference to:

Representative flaw sample

Artificial diffractors in the form of EDM notches or V-shaped notches
Side drilled holes

Grain noise

Lateral wave signal amplitude

0Oo0O0O0oOo

For both examples above the typical procedure of Gain setting was provided through bringing height of
lateral wave signal to 30% of A-Scan height
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7.5.1.4. Probe Separation

Probe Separation must be properly defined and entered to have the ability of precise defects sizing at
posprocessing stage. Most widely used way of Probe Separation determining is mechanical measuring of
distance between TOFD probes excitation points by using a scaled ruler. However mechanical

measurements are not accurate and their implementation becomes quite complicate for objects with curved
surfaces:

E mittin Receivin R y
Frobe g Frobe g Eﬁﬁtﬁgﬂg Ef.gg;"g

| ateral Wave Trace

Lateral Wave ]"1".;7«::«3=

Probe Separation Probe Saparation

Emitting Reaceaiving
Probe Probe

Lateral Wave Trace

Probe Separation

Probe Separation may be defined more precisely through the way as below:

UDS53-5 - ISOMIC Pulser/Receiver

Gain

= by

-88_5 dB ‘
Bl +
T B
Mrd «

A_qle

Ina By

e By

:

»

= By

Itn By

BASICS PULSER  RECEIVER _ GATE A Menu i "D’l 2_5
GATE B ALARM  DAC/TCG JICTESHIGIEN Selection

| [~ T 2=z =
7 Eluse m»‘ 60. 25 mm Freeze & * Save | Open | Pont DG5S

O Increase Gain to provide height of first half wave of lateral wave signal reaching 10-20 % of total A-
Scan height

Activate Gate A, setup aThreshold to 5%(submenu GATE A)

Select s(A) as Meas Value and set Meas Mode as Flank (submenu MEASURE)

Provide rising edge of first half wave of lateral wave will cross Gate A

Define Probe Separation as Probe Separation = 2 x s(A) whereas s(A) is the digital readout taken

from box

7’
7

ODo0Oo
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7.5.2. t-TOFD and TOFD — Implementation
7.5.2.1. t-TOFD - Prior to Scanning

t-TOFD control panel is shown below

+

Current A-Scan |

+ + o+ + + o+ o+
0o |
e '-1..|_-.—-.|:n.._p..--1p—..4..-q._.-u._+-\1

|l

20.30 ps

+ 0+ o+ o+ o+ o+ o+

I

+ 4+
+

+
+
¥

li
i
+
+
+

S+ F ¥ ¥

+ o+
+ o+
+ o+

5 Length
220 mm
1 Time

10s
Time-'% ait

Scan Length not exceeding 400 mm or 16 in / Scan Time

<

35
5 Baze
120 mm
Averaging

OFF

Empty t-TOFD record field

x ok dk dk dk s

2 5 Jorn By | e Bag e B i Bg | 1= By

hdh dh 4h 4h 4

4 = o
Start Open Save $
L]
g | u] 50 100 150 200
UDS3-5 Text
(2]

+ +
+

+
20.20 ps

+ +

t-TOFD scrolling controls field

++++-;++++
]
+ o+ o+ o+ + o+ 4+
!
|
}
I
4
£

g
+ o+t T

20 Length -~
Eflle » _
T Time - Empty t-TOFD record field
«7®
Time-Wait r
«»
5 Base o
4
‘ ; ' Segment of Scrolled Total Scan Length
‘ 5 * < exceeding 400 mm or 16 in / Scan Tlme’
2 = = 3
Start Open Save g
b u] 5:3 '1DID 15ID 2DID 25ID SCIID 35IEI 400
ups3-5 Text Close [x
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Scan Length and Scan Time

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period. Time (Scan Time) is the duration of recording period

o

|Lu?. SRS

I+~ gy

len By

To control Length the following
manipulations are applicable:

e Mouse /Touch Screen
B Click on corresponding
o Keyboard

-
B Press 1 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J '_’J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J '_’J !J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 1000 mm or 2 and 40 in
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5 Lerigth
220 mm

Averaging

OFF

To control Time
the following manipulations are applicabIE}://

/4
e Mouse / Touch Screen V/4

B Click on corresponding
e Keyboard

'l
s Press LJ on front panel keyboard or on external keyboard = Time fore color changes to

white - then use !J _J _J ij on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Time = Time fore color changes to white - then use !J '_’J !J !J on front panel
keyboard or , , on external keyboard

®

The value of Time is adjustable between 5 and 60 sec
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Time-Wait

Time-Wait is waiting time for intermissions predcessing t-TOFD recording, which starts unconditionally upon
Time-Wait period is over

5 Length ar
220 mm ‘ 1 »
1 Time o
10s ‘ 2 »
A AR AR AR . Time-W ait o
: Currentvalueof i 3s 3
] Time-Out - ~ 7
] sec : 1 »
tsssssssssEssssEEEEEEEEEEEE - =
Averaging ar
OFF 5 »
/7 7/
To control Time-Wait the following ’, 7
manipulations are applicable: //
/
e Mouse /Touch Screen /,/

— -
B Click on corresponding |button|

e Keyboard

?
B Press 3 on front panel keyboard or on external keyboard = Time-Wait fore color changes

to white - then use !_ ?/ « !' on front panel keyboard or , , , on external
keyboard

e Combined

LY

B Click on Time-Wait = Time-Wait fore color changes to white - then use —

2 & &
front panel keyboard or , , , on external keyboard

®

The value of Time-Wait is adjustable between 0 and 15 sec
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Base

Base represents Probe Separation

5 Length
220 mm

Time-' ait
35

b db 4

Averaging

|r.h},\|-ﬁ-l|. oo By f e By | (= By

A 4

To control Base the following
manipulations are applicable:

e Mouse /Touch Screen
B Click on corresponding
o Keyboard

-
B Press _4 J on front panel keyboard or on external keyboard — Base fore color changes to

white - then use !J '_’J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Base = Base fore color changes to white - then use !J '_’J !J !J on front panel
keyboard or , , , on external keyboard

®

The value of Base is adjustable between 25 and 500 mm or 1 and 20 in
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Averaging
Averaging of sequential A-Scans is required sometimes to improve signal to noise ratio of the t-TOFD

record
5 Length
220 mm ‘
1 Time
10s ‘
B . _ _
:  Current setting of Time-¥ ait ‘
: Averaging i 35
] mm or in ] 5 Base
T rireresserrrrrserees P
‘ <

Averaging

OFF

To control Averaging the following
manipulations are applicable:

e Mouse / Touch Screen

B Click on corresponding

e Keyboard
F
B Press _3 _ on front panel keyboard or on external keyboard = Averaging fore color changes

to white - then use !_ ?/ « !' on front panel keyboard or , , , on external
keyboard

e Combined

LINCIAAIARS

B Click on Averaging = Averaging fore color changes to white - then use =/,
front panel keyboard or , , , on external keyboard

®

Averaging may be either inactive (OFF) or setup for factor 2 or 4 or 8

Insert Text Note

Refer to paragraph 7.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 7.3.2.1 of this Operating Manual
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Start/Stop t-TOFD recording

4
Click on ﬂl or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard to

start t-TOFD recording

4 | u |
stait | putton becomes invisible since t-TOFD recording starts. __ 2P | putton occupies its position.

-
Click on 3P | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate t-TOFD recording prior to automatic completion

= A
stop | button becomes invisible after completion / termination of t-TOFD record. __ 3%t | putton returns

to its position

Save record into afile

Refer to paragraph 7.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 7.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 7.3.2.1 of this Operating Manual
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7.5.2.2. t-TOFD — Scanning

a Apply probes pair to test object in the start point of selected scanning line

4 | |
O Click on 3%t |or press LLJ on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe pair over the scanning line synchronously with Position Icon moving with constant speed
above t-TOFD record field — typical scanning progress display during is shown and explained below

|
=]
™
o
™

20 Length
«

-
1
1 Time o
s
Time-W ait o
s KR
5 Baze o
| oonm [l
Averaging o
o R
1 = "
Open Save
u] a0 100 150 2I:IIEI
Text Cloze
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7.5.2.3. TOFD — Prior to Scanning

TOFD control panel is shown below

Current A-Scan
+ + + + + 4+

20.30 ps

+ o+ o+ 4+ o+ .
L wrapesrs e _rpeen| |
y!
+ o+ +
+ o+ +
+ o+ +
+ o+ +

20 Length

= By

220 mm

5 Basze
B e

i e

Scan Length not exceeding 400 mm or 16 in

M gy

A - <
YEraging o
E
Encoder:
I Drefault j ]
Empty TOFD record field
4 = = )
Start Open Save £
& | 1 i
’ 0 &0 100 150 200
UuDs53-5 Text Cloze

o+ o+ o+
20.30 ps

TOFD scrolling controls field

o+t o+ + E o+ o+ o+ o+
i
o+ o+ o+ F
-

S
++++-h-++++
.
PN - S S
1
R

20 Length
1540 mm ‘

5 Base
.

Averaging
.

Empty TOFD record field

oty |1y
adh b4

E der:
ID";:ulf' = Segment of Scrolled Total Scan Length
< exceeding 400 mm or 16in >
| 2 = =] g
Start Open Save 2
’ a a0 100 150 200 2a0 200 260 400
uDs3-h Text Close
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Scan Length

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period

20" Length
1540 mm

Averaging

OFF

To control Length the following
manipulations are applicable:

e Mouse /Touch Screen
B Click on corresponding

o Keyboard

-
B Press' 1 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J _J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J 2J :J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 20000 mm or 2 and 800 in
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Base

Base represents Probe Separation

20 Léngth
1540 mm

= By

=

[ l|“

To control Base the following
manipulations are applicable:

e Mouse /Touch Screen
B Click on corresponding

o Keyboard

-
B Press 2 J on front panel keyboard or on external keyboard = Base fore color changes to

white - then use !J 2J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Base = Base fore color changes to white - then use !J 2J :J !J on front panel
keyboard or , , , on external keyboard

®

The value of Base is adjustable between 25 and 500 mm or 1 and 20 in
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Averaging
Averaging of sequential A-Scans is required sometimes to improve signal to noise ratio of the TOFD record

AR AR A A A A A A A A anans . 20 Length
:  Current setting of & 1540 mm ‘ »
: :

Averaging
mm or in

Averaging

OFF

To control Averaging the following
manipulations are applicable:

e Mouse / Touch Screen

B Click on corresponding
e Keyboard
-

B Press 3 Jon front panel keyboard or on external keyboard = Averaging fore color changes
to white - then use !_ 2/, « ! on front panel keyboard or , , , on external
keyboard

e Combined
B Click on Averaging = Averaging fore color changes to white - then use !_ 2/, « , ! on

front panel keyboard or , , , on external keyboard

®

Averaging may be either inactive (OFF) or setup for factor 2 or 4 or 8

Encoder
Select encoder to be used through appropriate box

Encoder:

Drefault j

Clamp fixture holding TOFD probe pair into encoder — refer to Chapter 7 of this Operating Manual

Connect encoder to its input on the right side of ISONIC 2006 instrument

Insert Text Note

Refer to paragraph 7.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 7.3.2.1 of this Operating Manual
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Start/Stop TOFD recording

4
Click on ﬂl or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard to

start TOFD recording

4 | H |
stait | hutton becomes invisible since TOFD recording starts. __ 3B | putton occupies its position. Click

-
on _ 3P | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate TOFD recording

N EA
atep | button becomes invisible after termination of TOFD record. __2tait | button returns to its position

Save record into afile

Refer to paragraph 7.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 7.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 7.3.2.1 of this Operating Manual
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7.5.2.4. TOFD — Scanning

a Apply probes pair to test object in the start point of selected scanning line

4 |
O Click on 3%t |or press Ll) on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe pair over the scanning line — typical scanning progress display during is shown and
explained below

20 Length o
1540 mm 1
5 Base o
120 mm ‘ 2
Averaging o
OFF ‘ 3
Encoder:
IDefauIt j
[ =
Open Save
UD53-5 Text Close
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7.5.2.5.t-TOFD / TOFD — Postprocessing
Versatile postprocessing of t-TOFD / TOFD records is featured with:

Q Improvement of near to surface resolution through removal of lateral wave and back echo records
from t-TOFD / TOFD Map, zooming t-TOFD / TOFD Map accompanied with appropriate A-Scan
expanding

Q Linearization and straightening of t-TOFD / TOFD Map

Q Increasing contrast of t-TOFD / TOFD images through varying Gain and rectification

Q Defects pattern recognition and sizing

The screen as below appears upon opening file. All postprocessing procedures are performed through
— touch screen stylus or front panel or external mouse to be used

—y
*File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-5can Recovery v|

22.04 ps

3447 ps

t-TOFD
POSTPROCESSING

—— e —

a0 100 180 200 2480 =00 260

o

Menu Bar Functions

e File>0Open — opens new t-TOFD / TOFD file

e File>Snapshots>Add Snapshot — stores current postprocessing screen snapshot accompanied with
appropriate settings and measurements into postprocessing session memory stack

e File>Snapshots>Restore Snapshot — recalls earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

e File>Snapshots>Delete Snapshot — deletes earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

e File=>Print — prints out postprocessing screen snapshot(s) accompanied with appropriate settings and
measurements

e File>EXit — returns to t-TOFD / TOFD control panel

e View-—2>Instrument — indicates setup of UDS 3-5 Pulser Receiver used for scanning when file was
created

e View-—2>Inspection Data — indicates operator's comments entered prior to scanning

e View—>Coloring=>Grayscale / View—=>Coloring>Thermal — selects base color for t-TOFD / TOFD
image
e View>TOFD->Logic>Negative / View>TOFD->Logic2>Positive — selects black / white tones for

representation of positive/negative half waves components of RF A-Scan on the TOFD Map — refer also

to paragraph 15.2.2 of this Operating Manual

e View>TOFD->Contrast>Natural / View>TOFD->Contrast->Soft / View2>TOFD->Contrast->Sharp

— selects contrast of the TOFD Map — refer also to paragraph 15.2.2 of this Operating Manual
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A-Scan Recovery=>ON - generates cursor corresponding to A-Scan base line that may be guided over

t-TOFD / TOFD image using either touch screen stylus or mouse or '_’J !J on front panel keyboard
or , on external keyboard — corresponding A-Scan is recovered synchronously according to A-

Scan base line cursor position. Indication of starting position of cursor (L) corresponding to the position
of TOFD probes pair accompanies recovered A-Scan

File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|

L=73.7 mm

t-TOFD
POSTPROCESSING

To fix position of A-Scan base line cursor with corresponding recovered A-Scan left mouse click or
Erlte.r
release touch screen stylus or press .“ij on front panel keyboard or Enter|on external keyboard

ESC
To interrupt recovery of A-Scans right mouse click or press \L) on front panel keyboard or on
external keyboard

A-Scan Recovery=>OFF - erases A-Scan base line cursor, indicator of its position, and recovered A-
Scan
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View—>Coloring2>Rectified — switches between rectified and RF presentation of t-TOFD / TOFD image

File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|

Colaring m Grayzcale

Zoam ¥ Themnal

Inspection Data
R

Instrument

oL _——

POSTPROCESSING 50 100 150 200 280

File v|| Wig v|| Farameters v|| Edit v|| Measurements v|| A-Scan Recovery

L=737 mm

22.09 ps

t-TOFD
POSTPROCESSING
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e View>Zoom->Zoom Factor% — expands t-TOFD / TOFD image along time line (vertically)

File v|| Wigw v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recoverny v|

Calaring » |
Zoom =100%
Inspection Data 200%
Instrumnent

t-TOFD
POSTPROCESSING 0 50 100 150 200 250 300 350
File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery -
L=2781 mm

t-TOFD
POSTPROCESSING

Expanded t-TOFD / TOFD image may be scrolled it vertically using appropriate

ISONIC 2006 from Sonotron NDT - Operating Manual — Revision 1.21 - Page 219 of 480



Green background highlights segment of recovered A-Scan corresponding to visible part of t-TOFD /
TOFD image. Said segment moves over recovered A-Scan background while scrolling t-TOFD / TOFD

image vertically

File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|
L=2781 mm
Start of visible
part of t-TOFD /
TOFD image

F — — — — —
End of visible part
of t-TOFD / TOFD

I image |

t-TOFD .
POSTPROCESSING | ° s a0 e

P —
200 250 200 250

Segment of recovered A-Scan corresponding to visible part of t-TOFD / TOFD image may be expanded
through double click on it — whole A-Scan background is green for the expanded segment. Vertical
scrolling of t-TOFD / TOFD image causes appropriate varying of Display Delay for recovered A-Scan
File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|

L=2781 mm

Start of visible :
part of t-TOFD /

I TOFD image |

e S U —

F — — — — —
End of visible part
of t-TOFD / TOFD

I image |

t-TOFD
POSTPROCESSING | ° s

150

To return to complete recovered A-Scan visibility double click on A-Scan area

®

¢ Zoom function is available for t-TOFD / TOFD image composed of A-Scans longer

than 5 us
¢ Possible zoom factors are defined by ISONIC 2006 software automatically

¢ Maximal possible Zoom factor is 400%
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e Parameters>Change... — allows re-adjusting of basic parameters (USVelocity, Base, Probe Delay)
for computation of defects depth and linearization of t-TOFD / TOFD image

File v|| Wigw v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recoverny v|

L = 23| Change..
Mark Zero

t-TOFD
POSTPROCESSING

File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery -
L=2781 mm

US Yelocity, mis

1
5020 Ol

Base, mm

1
131 Ol

Probe Delay, ps 0.01

r—
592 ﬂ
ok |

t-TOFD
POSTPROCESSING

| Erlte.r
On completing click LI or press :J on front panel keyboard or [Enter| on external

keyboard

To negate re-adjustments click on ﬂl or press \L) on front panel keyboard or on

external keyboard
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Parameters>Mark Zero Line — allows re-adjusting of Probe Delay for computation of defects depth
and linearization of t-TOFD / TOFD image through mark of start point of lateral wave signal on the
recorded t-TOFD / TOFD image with reference to recovered A-Scan. Initially this function generates
cursor corresponding to A-Scan base line that may be guided over t-TOFD / TOFD image using either

touch screen stylus or mouse or '_’J , !J on front panel keyboard or , on external keyboard —
corresponding A-Scan is recovered synchronously according to A-Scan base line cursor position

File =|| “iew =[| Parameters «|| Edit = | Measurements v|| A-Scan Recovery v|

Upon selecting reference A-
Scan with clear lateral wave
left mouse click or press
| Erlte.r

= J on front panel
keyboard or on
external keyboard — this
generates horizontal cursor,
which may be be guided over

t-TOFD / TOFD image using
either touch screen stylus or

mouse or !J !Jon front

panel keyboard or , on
external keyboard

t-TOFD
POSTPROCESSING

o

a0 100 180 200 2480 =00 260

File =|| “iew =[| Parameters «|| Edit = | Measurements v|| A-Scan Recovery -

To mark the beginning of

lateral wave signal

corresponding to zero depth

left mouse click or press
Erlte.r

- *==4 J on front panel

keyboard or on

external keyboard

22.04 ps

To interrupt function at any
moment right mouse click or

ESC
press \Q on front panel

keyboard or on
external keyboard

t-TOFD
POSTPROCESSING

2515 ps

=1

S0 100 150 200 250 200 250
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o Edit>Linearization=>0ON - recalculates depth for each point of t-TOFD / TOFD image and redraws it
as Longitudinal Coordinate — Depth map

| File v|| Wiga v|| Farameters v|| E dit v|| I easurements v|| A-Scan Recovery v|

Linearization OW
= 0F|

Femove Lateral Wave »

Straightening 4
Change Gain 4

Flip Honzontal

2447 ps

t-TOFD

| File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recoverny v|

280 300 350

t-TOFD
POSTPROCESSING

o Edit>Linearization>OFF — returns to original t-TOFD / TOFD image - Longitudinal Coordinate —
Time map
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Edit>Remove Lateral Wave>ON — removes rectangle segment designated by an operator from t-
TOFD / TOFD image. Most frequently this function is applied to lateral wave record, which is recorded
continuously during line scanning and allows to better resolve defects located closely to scanning
surface. Also this function may be applied to other signals continuously recorded during line scanning for
example, backwall echo, mode conversion backwall echo, etc. - this allows to better resolve defects
located closely to bottom surface. In addition to modifying of rectangle segment selected by an operator
this function automatically straightens t-TOFD / TOFD image in order to compensate deviations caused
by various factors during recording, for example, coupling instability, unevenness of scanning or bottom
surface, etc. The described function is based on selecting reference signal and defining a rectangle
segment on the t-TOFD / TOFD image. All signals corresponding to selected rectangle segment of t-
TOFD / TOFD image are equalized by straightening function and then removed; appropriate changes do
occur on t-TOFD / TOFD image above and under selected rectangle segment after its removal. Initially
cursor corresponding to A-Scan base line is generated; it may be guided over t-TOFD / TOFD image

using either touch screen stylus or mouse or '_’J :J on front panel keyboard or , on external
keyboard — corresponding A-Scan is recovered synchronously according to A-Scan base line cursor

E rlte.r

position. To select reference A-Scan left mouse click or release touch screen stylus or press - *=_ on
front panel keyboard or [Enter| on external keyboard

| File: v|| Wiew v|| Parameters v|| E dit v|| Measurements v| A-Scan Recovery v|

Linearization L4

| Remove Lateral Wave | 0N
Straightening F mOFF
Change G ain L4

Flip Horizontal

File =|| “iew =|| Parameters «|| Edit - | Measurements v|| A-Scan Recovery -

2204 ps

t-TOFD
POSTPROCESSII

2515 ps

t-TOFD
posTPn ocessl " G o a0 100 150 200 280 300 350
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First horizontal cursor appears on the t-TOFD / TOFD image upon selecting reference A-Scan. It may

be guided over t-TOFD / TOFD image using either touch screen stylus or mouse or !J !J on front
panel keyboard or , on external keyboard . To fix position of the first horizontal cursor and designate

L
Enter
start of reference signal left mouse click or release touch screen stylus or press _‘ij on front panel
keyboard or [Enter|on external keyboard . Second horizontal cursor appears upon fixing first one; it may
be manipulated by the same way and allows designating end of reference signal
View «|| Parameters - | Measurements 'H &-Scan Recovery v‘

View ~|| Parameters ~ | Measurements ][ A-5can Recovery ~

t-TOFD
POSTPROCESSIN

t-TOFD
POSTPROCESSING

®

Horizontal cursors are accompanied with appropriate time cursors moving over reference A-
Scan
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First vertical cursor appears upon designating end of reference signal. Its length corresponds to duration
of reference signal and it is located between first and second horizontal cursors. First vertical cursor may

be manipulated over t-TOFD / TOFD image using either touch screen stylus or mouse or '_’J - on
front panel keyboard or , on external keyboard . To designate first border of rectangle segment

| Erlte.r
left mouse click or release touch screen stylus or press ij on front panel keyboard or [Enter|on
external keyboard . Second vertical cursor completing defining a rectangle appears upon fixing first one;
it may be manipulated by the same way and allows to designate second border of rectangle segment

View «|| Parameters - | Measurements 'H &-Scan Recovery v‘

Wiew =[] Parameters - ‘ Measurements 'H A:5can Recovery -
u

t-TOFD
POSTPROCESSII

t-TOFD
POSTPROCESSING
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As a result:
0 Signs of reference signal and corresponding signals in the selected rectangle segment are
removed from t-TOFD / TOFD image
o t-TOFD /TOFD image is straightened above and under selected and modified rectangle
segment to compensate deviations caused by various factors during recording, for example,
coupling instability, unevenness of scanning or bottom surfaces, etc

| File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|

t-TOFD
POSTPROCESSING

—
To interrupt function at any moment right mouse click or press m on front panel keyboard or
on external keyboard

Edit>Remove Lateral Wave->OFF — negates madification of selected rectangle segment of t-TOFD /
TOFD image
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Edit->Straightening=>ON - straightens t-TOFD / TOFD image in order to compensate deviations
caused by various factors during recording, for example, coupling instability, unevenness of scanning or
bottom surfaces, etc. It is based on selecting reference signal (either lateral wave, or backwall echo, or
mode conversion backwall echo, etc) and defining a rectangle segment on the t-TOFD / TOFD image.
All signals corresponding to selected rectangle segment of t-TOFD / TOFD image are equalized by
straightening function and appropriate changes do occur on t-TOFD / TOFD image above and under
modified rectangle segment. Initially cursor corresponding to A-Scan base line is generated; it may be

guided over t-TOFD / TOFD image using either touch screen stylus or mouse or '_’J !J on front

panel keyboard or , on external keyboard — corresponding A-Scan is recovered synchronously
according to A-Scan base line cursor position. To select reference A-Scan left mouse click or release

Erlte.r
touch screen stylus or press _‘ij on front panel keyboard or [Enter| on external keyboard

| File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v| A-Scan Recovery v|

Linearization L4

Remove Lateral Wave #

Straightening ]
Change Gain LA R
Flip Horizontal

File =|| “iew -|| Parameters =f| Edit = | M easurements Y|| A-Scan Recovery -

2204 ps

t-TOFD
POSTPROCESSII

t-TOFD
PosTP“o CESSING o a0 100 150 200 280 300 350

2515 ps
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First horizontal cursor appears on the t-TOFD / TOFD image upon selecting reference A-Scan. It may

be guided over t-TOFD / TOFD image using either touch screen stylus or mouse or y !J on front
panel keyboard or , on external keyboard . To fix position of the first horizontal cursor and designate

L
Enter
start of reference signal left mouse click or release touch screen stylus or press :J on front panel

keyboard or [Enter|on external keyboard . Second horizontal cursor appears upon fixing first one; it may
be manipulated by the same way and allows to desighate end of reference signal

| File: v|| Wiew v|| Farameters v|| Edit v|| Meazurements v|| A-Scan Recoverny v|

File =|| Yiew =|| Parameters =[| Edit = | Measurements v|| A-Scan Recovery -

2204 ps

t-TOFD
POSTPROCESSI!

2515 ps

t-TOFD
POSTPROCESSING

a0 100 150 200 280 300 350

o
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First vertical cursor appears upon designating end of reference signal. Its length corresponds to duration
of reference signal and it is located between first and second horizontal cursors. First vertical cursor may
be manipulated over t-TOFD / TOFD image using either touch screen stylus or mouse or '_’J - on
front panel keyboard or , on external keyboard . To designate first border of rectangle segment

| Erlte.r
left mouse click or release touch screen stylus or press ij on front panel keyboard or [Enter|on

external keyboard . Second vertical cursor completing defining a rectangle appears upon fixing first one;
it may be manipulated by the same way and allows to designate second border of rectangle segment

| File: v|| Wiew v|| Farameters v|| Edit v|| Meazurements v|| A-Scan Recoverny v|

File =|| “iew =[| Parameters =|| Edit - | Measurements v|| A-Scan Recovery -

22.09 ps

t-TOFD
POSTPROCESSIP

2515 ps

t-TOFD
POSTPROCESSING

50 luls} 150 200 250 00 FE0

=1
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As aresult t-TOFD / TOFD image is straightened in, above, and under selected rectangle segment to
compensate deviations caused by various factors during recording, for example, coupling instability,
unevenness of scanning or bottom surfaces, etc

| File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery -

t-TOFD
POSTPROCESSING

Esc
To interrupt function at any moment right mouse click or press m on front panel keyboard or
on external keyboard

Edit->Straightening>OFF — negates modification of selected rectangle segment of t-TOFD / TOFD
image
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Edit>Change Gain=>0ON — generates cursor corresponding to A-Scan base line that may be guided

over t-TOFD / TOFD image using either touch screen stylus or mouse or '_’J !J on front panel

keyboard or , on external keyboard — corresponding A-Scan is recovered synchronously
according to A-Scan base line cursor position. To select reference A-Scan release touch screen stylus

| Erlte.r
or left mouse click or press ' *=1_ on front panel keyboard or on external keyboard — this
generates subwindow allowing off-line re-adjusting of Gain for all A-Scans captured during t-TOFD /

ﬂ
TOFD recording in £6dB range with £0.1 dB increments through clicking or pressing and holding on ‘
or pressing !J !J on front panel keyboard or , on external keyboard

Filz v|| Wigw v|| Parameters v|| E dit v|| M easurements v|| A-Scan Recovery v|
L=1272 mm

ISONIC 2005

Select Gain Change:

“ioswe

OK Cancel |
L&

File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery -

L=1272 mm

t-TOFD
POSTPROCESSII

s

t-TOFD
POSTPROCESSING o 50 100 150 200 250 300 350

During Gain re-adjusting reference A-Scan is modified accordingly. Upon completing re-adjusting Gain

DK | Erlte.r
click on or press ij on front panel keyboard or on external keyboard — this

applies new Gain value to all captured A-Scans and redraws t-TOFD / TOFD image accordingly
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Cancel ﬂ esc !
To interrupt re-adjusting of Gain click on 4' or press ¥ _J on front panel keyboard or

on external keyboard

Edit>Change Gain>OFF — negates Gain re-adjustment and returns to originally recorded t-TOFD /
TOFD image and original Gain setting

Edit=>Flip Horizontal — reorders A-Scans captured during t-TOFD / TOFD recording in reverse
succession and redraws t-TOFD / TOFD image accordingly. This service function may be useful for
merging scans of neighboring sections of an object, which were scanned in opposite direction due to
access conditions, etc

| File v|| Wiew v|| Parameters v|| E dit v|| Measurements v| A-Scan Recovery v|

Linearization L4
Remove Lateral Wave ¥
Straightening 4
Change Gain »
Flip Horizon

3447 ps

t-TOFD
posrpnocessl "G o S0 100 180 200 2560 200 280

| File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|

t-TOFD
POSTPROCESSING

®

Applying of Flip Horizontal function empties postprocessing session memory stack
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Measurements>Add Measure>Height — generates cursor corresponding to A-Scan base line that

may be guided over t-TOFD / TOFD image using either touch screen stylus or mouse or '_’J :J on
front panel keyboard or , on external keyboard — corresponding A-Scan is recovered
synchronously according to A-Scan base line cursor position. Indication of starting position of cursor (L)
corresponding to the position of TOFD probes pair accompanies recovered A-Scan. A-Scan base line
cursor to be positioned over defect image to minimize displacement of defect's signal with regard to
starting point of A-Scan. To fix position of A-Scan base line cursor release touch screen stylus or left

| Erlte.r
mouse click or press ' *=_J on front panel keyboard or on external keyboard . Indication of
starting position of cursor (L) corresponding to probe's center accompanies recovered A-Scan

| File v|| Wiga v|| Farameters v|| E dit v|| M easurements v|| A-Scan Recovery v|
Add Measure Length

Clear Lazt Heig
Clear Al

22.09 ps

File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery -

L=119.3 mm

t-TOFD
POSTPROCESSII

t-TOFD
POSTPROCESSING

50 400 150 200 250 200 250

=]
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First horizontal cursor appears upon fixing A-Scan base line cursor, it may be guided over t-TOFD /

TOFD image using either touch screen stylus or mouse or y !J on front panel keyboard or , on
external keyboard . First horizontal cursor is accompanied with first time cursor synchronously moving

over reference A-Scan. Coordinate of the first horizontal cursor - depth (H) and corresponding time of
flight (t) are indicated synchronously. To fix position of the first horizontal cursor left mouse click or

Erlte.r
release touch screen stylus or press :J on front panel keyboard or on external keyboard .
Second horizontal cursor appears upon fixing first one, it may be manipulated by the same way. Second
horizontal cursor is accompanied with second time cursor synchronously moving over reference A-
Scan. Coordinate of the second horizontal cursor measured relatively to position of first horizontal cursor

(dH) and corresponding delay of second time cursor relatively to first time cursor (dt) are indicated
synchronously. Provided the horizontal cursors are placed properly:

o H represents defect depth

o t represents time of flight for first diffracted signal

o dH represents defect's height

o dt represents delay of second diffracted signal relatively first diffracted signal

Filz v|| Wigw v|| Parameters v|| E dit v|| M easurements v|| A-Scan Recovery v|
L=119.3 mm
H =199 mm

2204 ps

t- 23.0 |Is

| File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recavery -
L=119.3 mm

H=199 mm | dH=4.1 mm

t=23.0 s dt=0.4ps

22.04 ps

t-TOFD
POSTPROCESSIE

t-TOFD
POSTPROCESSING o 50 100 150 200 250 200 250

28.26 ps

ESC
To interrupt width measurement procedure at any moment right mouse click or press @ on front
panel keyboard or on external keyboard

ISONIC 2006 from Sonotron NDT - Operating Manual — Revision 1.21 - Page 235 of 480



Vertical |[depth/height measurement mark| appears on the t-TOFD / TOFD image upon fixing position of

second horizontal cursor \
| File v|| Wig v|| Parameters v|| E dit v|| Mea&ements v|| A-Scan Recovery v|

File =|| “iew =|| Parameters «|| Edit = | Measurements v|| A-Scan Recovery -

Point 1:
L=119.3 mm
— =23.04 5, dt=0.44 is
t-TOFD H=19.9 mm, dH=4.1 mm

POSTPROCESSII

t-TOFD
POSTPROCESSING o Y 100 150 200 250 300 350

Depth measurement results may be recalled into accompanied with corresponding A-Scan
through double click on the depth measurement mark

In the subwindow appearing:
o L is coordinate of depth measurement mark along scanning line
o H represents defect depth
o 1 represents time of flight for first diffracted signal
o dH represents defect's height
o dt represents delay of second diffracted signal relatively first diffracted signal

Clicking on = will print current screen snapshot accompanied with depth measurement mark data

Clicking on v will hide subwindow with depth measurement mark data

Clicking on X will hide subwindow with depth measurement mark data and erase corresponding
depth measurement mark
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Measurements>Add Measure>Length — generates left parabolic cursor that may be guided over t-

e using either touch screen stylus or mouse or !J ij '_’J !J on front panel

TOFD / TOFD imag

keyboard or , , , on external keyboard . A-Scan, corresponding to coordinate (L) of tip of left
parabolic cursor along scanning line is recovered synchronously. Left parabolic cursor to be placed over
left defect's end providing shape matching. To fix position of left parabolic cursor left mouse click or

| Erlte.r
release touch screen stylus or press ij on front panel keyboard or [Enter| on external keyboard

| File v|| Wig v|| Parameters v|| E dit v|| M easurements v|| A-Scan Recovery v|

| Add Measure | Length
Height

Clear Last
i| Clear Al

File v|| Wiew v|| Parameters v|| Edit v|| Meazurements v|| A-Scan Recovery v|
L=106.1 mm |

t-TOFD
POSTPROCESSII

t-TOFD
POSTPROCESSING

50 400 150 200 250 200 250

=]
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Right parabolic cursor appears upon fixing left parabolic cursor. It may be manipulated by the same way
and must be placed over right defect's end providing shape matching. Coordinate of right parabolic
cursor along t-TOFD / TOFD image measured relatively to position of left parabolic cursor (dL) is
indicated synchronously, it represents length of defect area provided that both parabolic cursors are

placed properly

| File v|| Wigw v|| Parameters v|| Edit v|| Meazurements v|| A-Scan Fecovery v|

|[L=106.1 mm | dL=43.9 mm

22.04 p=

2826 p=

t-TOFD
POSTPROCESSING | © S

180 200 2a0 200 280

ESC
To interrupt length measurement procedure at any moment right mouse click or press m on front
panel keyboard or on external keyboard
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Horizontal {length measurement mark{ appears on t-TOFD / TOFD image upon fixing position of right
parabolic cursor
| File v|| Wi v|| Farameters v|| Edit v|| Measkments v|| A-Scan Recovery v|

22.04 ps

| File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-5can Recovery -

Point 2:
L=106.1 mm
dL=43.9 mm

t-TOFD
POSTPROCESSI!

S |

t-TOFD
POSTPROCESSING

Length measurement results may be recalled into through double click on the length
measurement mark
In the subwindow appearing:

o L is coordinate of left end of the length measurement mark

o dL is length of defect area covered by length measurement mark

o Hisdistance between scanning line and length measurement mark

Clicking on = will print current screen snapshot accompanied with length measurement mark data

Clicking on ¥ will hide subwindow with length measurement mark data

Clicking on x will hide subwindow with length measurement mark data and erase corresponding

length measurement mark

Measurements—=>Clear Last — erases last length or depth/height measurement mark placed on the t-t-
TOFD / TOFD image

Measurements—=>Clear All — erases all length and depth/height measurement marks placed on the t-
TOFD / TOFD image
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7.6. CB-Scan horizontal plane-view imaging and recording of
defects for shear, surface, and guided wave inspection — t-
FLOORMAP L or FLOORMAP L

7.6.1. Setup Pulser Receiver for t-FLOORMAP L and FLOORMAP L

UDS 3-5 Pulser Receiver window — main operating surface — appears on ISONIC 2006 screen upon

clicking on

l ZIt-Floorm apL

|L-Floormap L
or

‘. The settings as below to be provided

7.6.1.1. Angle Beam Inspection — Shear and Longitudinal Waves

# | Parameter or Submenu Required Settings Note
Mode
1 Gain BASICS Gain setting to be performed
according to inspection procedure
providing required echo heights
from defects to be detected
2 DAC/TCG DAC/TCG DAC/TCG settings to meet
requirements of inspection
procedure
3 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
4 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing To synchronize with Gain
Firing Level, Level, and Damping settings to setting procedure
Damping provide optimal signal to noise ratio
5 Filter, Frequency RECEIVER Filter and Frequency settings to To synchronize with Gain
match with probe's frequency setting procedure
6 Display RECEIVER Display setting may be either Full, | The same Display mode to be
RF, PosHalf, or NegHalf used for both Probe Delay
determining and t-FLOORMAP L
/ FLOORMAP L Recording
7 USVelocity BASICS USVelocity setting to be equal to
actual value of ultrasound velocity
in the object under test
8 Probe Delay MEASURE Probe Delay setting to be equal to | For shear wave / longitudinal
actual probe delay wave angle beam inspection
probe delay may be determined
according to paragraph 5.2.13.5,
5.2.13.6 or 5.2.13.8 of this
Operating Manual or similarly
9 Display Delay BASICS Display Delay setting to be equal Recommend
to actual probe delay Display Delay = Probe Delay
10 | Angle MEASURE Angle setting to be equal to actual
probe angle
11 | Settings for other

parameters and
modes have no
significance

I
Click on _| or press LJ on front panel keyboard or on external keyboard upon completing
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7.6.1.2. Guided, Surface, Creeping, and Head Wave Inspection

# | Parameter or Submenu Required Settings Note
Mode
1 Gain BASICS Gain setting to be performed For guided / surface / creeping /
according to inspection procedure head wave inspection Gain
providing required echo heights setting may be implemented
from defects to be detected according to paragraph 7.6.1.4
of this Operating Manual or
similarly
2 DAC/TCG DAC/TCG DAC/TCG settings to meet For guided / surface / creeping /
requirements of inspection head wave inspection DAC may
procedure be created according to
paragraph 7.6.1.4 of this
Operating Manual or similarly
3 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
4 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing To synchronize with Gain
Firing Level, Level, and Damping settings to setting procedure
Damping provide optimal signal to noise ratio
5 Filter, Frequency RECEIVER Filter and Frequency settings to To synchronize with Gain
match with probe's frequency setting procedure
6 Display RECEIVER Display setting may be either Full, | The same Display mode to be
RF, PosHalf, or NegHalf used for both Probe Delay
determining and t-FLOORMAP L
/ FLOORMAP L Recording
7 USVelocity BASICS USVelocity setting to be equal to For guided / surface / creeping /
actual value of ultrasound velocity head wave inspection
in the object under test ultrasound velocity may be
determined according to
paragraph 7.6.1.3 of this
Operating Manual or similarly
8 Probe Delay MEASURE Probe Delay setting to be equal to | For guided / surface / creeping /
actual probe delay head wave inspection probe
delay may be determined
according to paragraph 7.6.1.3
of this Operating Manual or
similarly
9 Display Delay BASICS Display Delay setting to be equal Recommend
to actual probe delay Display Delay = Probe Delay
10 | Angle MEASURE 90°
11 | Settings for other

parameters and
modes have no
significance

I
Click on _| or press LJ on front panel keyboard or on external keyboard upon completing
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7.6.1.3. Determining Probe Delay and Ultrasound Velocity for Guided / Surface /
Creeping / Head Wave Inspection

The following procedure is recommended for finding Probe Delay and US Velocity settings necessary to
perform guided wave inspection:

(a)
(b)

(©

(d)
(e)

(®
(9)
(h)
(i)

)

==
= L)
I
L]
— Pos 2
300 mm
12in J—
600 mm
24in

In the UDS 3-5 Pulser Receiver window — submenu BASICS setup Range = 750 mm (or 30 in)

In the UDS 3-5 Pulser Receiver window — submenu BASICS setup US Velocity = 3000 m/s (or 120
in/ms)

Place guided wave probe into position Pos 1 on a reference plate providing 300 mm (or 12 in) distance
between probe's frontal surface and plate end

Tune Gain to provide plate end echo reaching 80-90% of A-Scan screen height

Tune Display Delay (submenu BASICS) to provide rising edge of plate end echo matching with 40%
grid on horizontal A-Scan screen scale

Place guided wave probe into position Pos 2 on a reference plate providing 600 mm (or 24 in) distance
between probe's frontal surface and plate end

Tune the US Velocity (submenu BASICS) to provide rising edge of plate end echo matching with 80%
grid on horizontal A-Scan screen scale

Place again guided wave probe into position Pos 1 on a reference plate providing 300 mm (or 12 in)
distance between probe's frontal surface and plate end

Repeat steps (e) through (h) as above until further tuning will not be necessary, i.e. placement of guided
wave probe into positions Pos 1 and Pos 2 causes rising edge of plate end echo appearing at 40% and
80% on horizontal A-Scan screen scale correspondingly. Since that Display Delay and US Velocity
settings are proper

In the submenu MEASURE provide Probe Delay = Display Delay whereas Display Delay value to be
found according to above steps (a) through (i)

®

O Probe Delay and US Velocity for surface / creeping / head wave inspection may be found similarly
O Automatic Calibration (AUTOCAL) procedure according to paragraph 5.2.13.8 of this Operating Manual

is also applicable
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7.6.1.4. Setting Gain and DAC for Guided / Surface / Creeping / Head Wave
Inspection
For setting up Gain and DAC a reference plate containing artificial defects is required; said reference plate

must have acoustical properties (longitudinal and shear wave propagation velocity, attenuation) thickness
and curvature differing from the same properties of the plate to be inspected in not more than +10%.

Gain setting to be performed through providing sure detection of artificial defect from selected distances
according to required inspection range
Optional DAC setting for guided wave inspection to be performed as below:

Place guided wave probe into position on reference plate providing receiving of an echo from a reflector

(a) Place guided wave probe into position on reference plate providing receiving of an echo from a reflector
passing minimal travel distance

(b) Follow instructions of paragraph 5.2.10 of this Operating Manual to record first DAC echo

(c) Move the probe away from the reflector keeping it's echo maximized for each new DAC echo recording
paragraph 5.2.10 of this Operating Manual
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7.6.2. t-FLOORMAP L and FLOORMAP L — Implementation

7.6.2.1. t-FLOORMAP L — Prior to Scanning

t-FLOORMAP L control panel is shown below

+

100
1

150 200
1 1

250
1

200
1

260
1

20 Length o
370 mm ‘ 1
1 Time o ) ) .
10 s 2 Scan Length not exceeding 400 mm or 16 in / Scan Time
Time-W ait o <
3
Coloring:
IF'seudn:n j
Empty t-FLOORMAP record field
4 = =
Start Open Save
E
X E
(]
uUpDs3-5 Text

+ o+ + + H o+ o+
+ o+ 4+ o+ S+
?+ L

3
[
F+ ot ot o+ K+ o+ o+ o+
B

P T I E
E 8 |

e

T
S

=
=
T
-
i
[4
S+ o+ o+ o+ A+ o+ 4

A+ o+ o+ H o+ o+ o+

13

+ R+ o+ o+

e

20 Length g
710 mm ‘ 1 *
1 Time a
10s ‘ 2 .
Time-W ait rF
3s ‘ 3 .
Colonng:
IPseudo j
> = =
Start Open Save
uUDs3-h Text Close

400.0 mm

0 mm

250 300 350 400
1 I 1

450

500
I

550
1

GO0
I

<

Empty t-FLOORMAP record field

Segment of Scrolled Total Scan Length
exceeding 400 mm or 16 in / Scan Time

t-FLOORMAP scrolling controls

>
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Scan Length and Scan Time

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period. Time (Scan Time) is the duration of recording period

20" Length

290 mm

Time-W ait

To control Length the following
manipulations are applicable:

e Mouse /Touch Screen
B Click on corresponding

o Keyboard

-
B Press 1 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J _J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J 2J :J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 1000 mm or 2 and 40 in
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20 Lehgth

290 mm

Time-w ait
B «

To control Time P // Ve
the following manipulations are applicable: , “»
7
v/
e Mouse /Touch Screen e’

B Click on corresponding
e Keyboard

'l
s Press LJ on front panel keyboard or on external keyboard = Time fore color changes to

white - then use !J _J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Time = Time fore color changes to white - then use !J '_’J :J !J on front panel
keyboard or , , on external keyboard

®

The value of Time is adjustable between 5 and 60 sec
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Time-Wait

Time-Wait is waiting time for intermissions predcessing t-TOFD recording, which starts unconditionally upon
Time-Wait period is over

20 Length

200 R

Current value of 290 mm

. o »

Time-Out 1 Time

N 7 CHL
e

P4

\1 e By

. . . / -’
To control Time-Wait the following -
manipulations are applicable: 7 -
77
e Mouse /Touch Screen /,//
B Click on corresponding
e Keyboard
-
B Press 3 on front panel keyboard or on external keyboard = Time-Wait fore color changes
to white - then use !_ 2/, « ! on front panel keyboard or [f, , , on external
keyboard

e Combined

LJ

B Click on Time-Wait = Time-Wait fore color changes to white - then use =/,

front panel keyboard or , , , on external keyboard

» & &,

®

The value of Time-Wait is adjustable between 0 and 15 sec

t-FLOORMAP L Record Palette

There are four palettes available through — select

N
N

Coloring:
Pzeudo - I

Insert Text Note

Refer to paragraph 7.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 7.3.2.1 of this Operating Manual
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Start/Stop t-FLOORMAP L recording

4
Click on ﬂl or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard to

start t-FLOORMAP L recording

{ LI
Start | button becomes invisible since t-FLOORMAP L recording starts. __3P | putton occupies its

[ |
position. Click on ﬁ' or press LJ on front panel keyboard or or <Alt>+<S> on external

keyboard to terminate t-FLOORMAP L recording prior to automatic completion

N 4 |
ﬂ' button becomes invisible after completion / termination of t-FLOORMAP L record. Start

button returns to its position

Save record into afile

Refer to paragraph 7.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 7.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 7.3.2.1 of this Operating Manual
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7.6.2.2. t-FLOORMAP L — Scanning

a Apply probes pair to test object in the start point of selected scanning line

4 |
O Click on 3t |or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe over the scanning line synchronously with Position Icon moving with constant speed above
t-FLOORMAP L record field — typical scanning progress display during is shown and explained below

200 280
Current A-Scan A A

+

dnld

+
.+
¥
+

+
+
+ o+
+ o+
+

+

+ o+ o+ A4+ o+

+ o+ + F o+ o+ o+

+
+
+
+
+
+

h+
W al ’HFH
| i Al
'Eﬂ"l"f"hﬂ "M I'-“I‘L-.q P Current Probe

Position

20 Length o -
kK
1 Time o
Ok
Time-'w ait o
3
Colonng:
I Pzeudo j
H [l
Stop Open Save

uD53-5 Text Cloze

t-FLOORMAP L record
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7.6.2.3. FLOORMAP L - Prior to Scanning
FLOORMAP_L control panel is shown below

(]

a0 100 150 200 250 200 260
1 1 1 1 1 1

Current A-Scan

+ + +

QO0.0 mm

+
+
+
+
+
+
+

+

|
’
’
’
:
'
R R,

10 Length o
I o

Scan Length not exceeding 400 mm or 16 in

Colonng:
IF'seuu:h:u j <
Encoder:
IDefault j
2 = ] Empty FLOORMAP L record

Start Open Save

5%

uDs3-5 Text Close

0 mm

41000 1100 1200 1300 1400 1500 1600 4700
I I I I I I I 1

+ o4+ o+ o+ S+

+ o+ o+ o+ o+ o+

4 o+ F o+ o+ o+ o+ o+
400.0 mm

+

T +
i w lt,"u pr\f-.ﬁ‘a'u\;u*u‘

Vgt Empty FLOORMAP L record

+ o+ o+ o+ K+ o+ o+t

+
+
+
+
+
+
+
+
+

Segment of Scrolled Total Scan Length

200 Length ) .
65650 mm ‘ < exceeding 400 mm or 16 in q

Colonng:
IGrayscaIe j
Encoder; FLOORMAP L scrolling controls
IDefauIt j
> = =]
Start Open Save
b g]
UDS35| Test | Close | |5
4 [
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Scan Length

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period

To control Length the following 7 -~
manipulations are applicable: P /’ -
e Mouse /Touch Screen 4/’ -

B Click on corresponding
o Keyboard

-
B Press 1 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J 2J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J 2J :J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 20000 mm or 2 and 800 in

FLOORMAP L Record Palette

There are four palettes available through — select
S
N

Coloring:
IPseudD vI

Select encoder to be used through appropriate box

Encoder

Encoder:

IDehuh _:J

Clamp probe into encoder — refer to Chapter 7 of this Operating Manual

Connect encoder to its input on the right side of ISONIC 2006 instrument

Insert Text Note

Refer to paragraph 7.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 7.3.2.1 of this Operating Manual
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Start/Stop FLOORMAP L recording

4
Click on ﬂl or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard to

start FLOORMAP L recording

4 | N |
stait | putton becomes invisible since FLOORMAP L recording starts. _ 2P | putton occupies its

[ |
position. Click on ﬁ' or press LJ on front panel keyboard or or <Alt>+<S> on external

keyboard to terminate FLOORMAP L recording

| 4 |
ﬂ' button becomes invisible after termination of FLOORMAP L record. __3tait | putton returns to its

position

Save record into afile

Refer to paragraph 7.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 7.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 7.3.2.1 of this Operating Manual
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7.6.2.4. FLOORMAP L — Scanning

a Apply probes pair to test object in the start point of selected scanning line

4 | |
O Click on 3%t |or press llj on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe over the scanning line — typical scanning progress display during is shown and explained
below

280 300 340
1 1 1

10 Length
Rl <

Coloring:
IPseudDE
Encoder:
IDehuﬂ
i
Open
ups3-5 Text
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7.6.2.5. t-FLOORMAP L / FLOORMAP L — Postprocessing
Versatile postprocessing of t-FLOORMAP L/FLOORMAP L (CB-Scan) records is featured with:

a Sizing of the defects at any location along stored images (coordinates, projection size,
amplitude-based evaluation)

a Play-back and evaluation of A-Scans obtained and captured during t-FLOORMAP L /
FLOORMAP L (CB-Scan) defects imaging and recording

a Defects outlining and pattern recognition based on A-Scan sequence analysis — Echo
Dynamic Pattern Analysis

O Reconstruction of t-FLOORMAP L / FLOORMAP L (CB-Scan) defects images for various
Gain, Reject, and off-line Gate level settings

o DAC/DGS t-FLOORMAP L / FLOORMAP L (CB-Scan) normalization

The screen as below appears upon opening file. All postprocessing procedures are performed through
— touch screen stylus or front panel or external mouse to be used

—y
*File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

t-FloorMap L
POSTPROCESSING

Menu Bar Functions

e File>Open - opens new t-FLOORMAP L / FLOORMAP L (CB-Scan) file

e File>Snapshots>Add Snapshot — stores current postprocessing screen snapshot accompanied with

appropriate settings and measurements into postprocessing session memory stack
e File>Snapshots>Restore Snapshot — recalls earlier stored postprocessing screen snapshot

accompanied with appropriate settings and measurements from postprocessing session memory stack

e File>Snapshots>Delete Snapshot — deletes earlier stored postprocessing screen snapshot

accompanied with appropriate settings and measurements from postprocessing session memory stack
e File=>Print — prints out postprocessing screen snapshot(s) accompanied with appropriate settings and

measurements
e File>Exit — returns to t-FLOORMAP L / FLOORMAP L (CB-Scan) control panel

e View-—2>Instrument — indicates setup of UDS 3-5 Pulser Receiver used for scanning when file was
created

e View->Inspection Data — indicates operator's comments entered prior to scanning
e View—>Coloring — selects palette for t-FLOORMAP L / FLOORMAP L (CB-Scan) image
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A-Scan Recovery 2ON — generates cursor representing sound path of probe's central beam in the
object under test that may be guided over t-FLOORMAP L / FLOORMAP L (CB-Scan) image using

|

either touch screen stylus or mouse or : ¥ on front panel keyboard or , on external
keyboard — corresponding A-Scan is recovered synchronously according to sound path cursor position.
Indication of starting position of cursor (L) corresponding to probe's center accompanies recovered A-
Scan. On the recovered A-Scan there is red Off-line Gate presented. Initially Off-line Gate covers
whole A-Scan range

File v|| Wiew v|| E dit v|| I easurements v|| A-Scan Recovery v|
L=129.3 mm

IR T
S S S

s =0.0mm H=55%
AVC= 3.14dB

FloorMap L e B
POSTPROCESSING a 50 100 150 200 250 300

/
|Automatic Measurements Display| accompanies recovered A-Scan and indicates (refer to
paragraphs 5.1.12, 5.2.13.1 and 5.2.13.2 of this Operating Manual):

0 sound path S between reflector and probe's center (measurement mode - Flank)

o amplitude H of the maximal signal in the Off-line Gate expressed in % of full A-Scan height

o AVC (dB to DAC) of the maximal signal in the Off-line Gate provided that DAC was active
whilst recording t-FLOORMAP L / FLOORMAP L (CB-Scan) data

To fix position of sound path cursor with corresponding recovered A-Scan and Automatic
Enfe.r |

Measurements Display data left mouse click or release touch screen stylus or press ' *=_ on front
panel keyboard or [Enter| on external keyboard

ESC
To interrupt recovery of A-Scans and empty A-Scan Recovery field right mouse click or press L)
on front panel keyboard or on external keyboard

A-Scan Recovery>OFF — erases sound path cursor with recovered A-Scan, indicator of sound path
cursor position, and Automatic Measurements Display
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Edit>Change Gain>0ON — generates cursor representing sound path of probe's central beam in the
object under test that may be guided over t-FLOORMAP L / FLOORMAP L (CB-Scan) image using

either touch screen stylus or mouse or !/ f on front panel keyboard or , on external
keyboard — corresponding A-Scan is recovered synchronously according to sound path cursor position.
Ente.! |

To select reference A-Scan release touch screen stylus or left mouse click or press ' *=_J on front

panel keyboard or on external keyboard — this generates subwindow allowing off-line re-
adjusting of Gain for all A-Scans captured during t-FLOORMAP L / FLOORMAP L (CB-Scan)

recording in £6dB range with £0.1 dB increments through clicking or pressing and holding on ﬁ or

pressing —/, . / on front panel keyboard or , on external keyboard

ISONIC 2005 |

Select Gain Change:

+4.4 dB il

0K Cancel

by
During Gain re-adjusting reference A-Scan is modified accordingly. Upon completing re-adjusting Gain

DK Ente’r |
click on or press *=_ on front panel keyboard or on external keyboard — this
applies new Gain value to all captured A-Scans and redraws t-FLOORMAP L / FLOORMAP L (CB-

Scan) image accordingly

Cancel | g
To interrupt re-adjusting of Gain click on or press L) on front panel keyboard or

on external keyboard

Edit>Change Gain>OFF — negates Gain re-adjustment and returns to originally recorded t-
FLOORMAP L / FLOORMAP L (CB-Scan) image and original Gain setting
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e Edit>ROI2>0ON - generates cursor representing sound path of probe's central beam in the object under
test that may be guided over t-FLOORMAP L / FLOORMAP L (CB-Scan) image using either touch

screen stylus or mouse or : : on front panel keyboard or , on external keyboard —
corresponding A-Scan is recovered synchronously according to sound path cursor position. To select

L
Enter |

reference A-Scan release touch screen stylus or left mouse click or press ' *=_J on front panel
keyboard or [Enter| on external keyboard — this generates Off-line Gate controls n n n

n, u n allowing to redefine Region Of Interest for t-FLOORMAP L / FLOORMAP L (CB-
Scan) imaging

| File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

+
+
+
+
+
+
+
+

FloorMap L
POSTPROCESSING

ESC
To interrupt selection of reference of A-Scan right mouse click or press L) on front panel keyboard
or on external keyboard

To interrupt re-adjustment of Region Of Interest after selection of reference of A-Scan click on .
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Upon completing redefining of Region Of Interest click on — this applies new Off-line Gate to all
captured A-Scans and updates t-FLOORMAP L / FLOORMAP L (CB-Scan) image accordingly — only
segment of t-FLOORMAP L / FLOORMAP L (CB-Scan) image covered by newly adjusted Off-line
Gate remains visible

| File v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|

425.0 mm

E
E

FloorMap L | ¢
POSTPROCESSING 0 &0 100 150 200 260 300

It is possible then to perform A-Scan signal evaluation using newly adjusted Off-Line Gate through A-
Scan Recovery >ON

File: v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|
L=1286 mm

435.0 mm

+ o+
+ o+
+
+ o+
+ o+
+ o+
+ o+
+ o+
+ o+

s=2268mm H=21% m——
AVC= 79 dB o :

FloorMap L
POSTPROCESSING a 50 100 150 200 250 300

amm

e Edit>ROI2>OFF — negates Off-line Gate re-adjustment and returns to originally recorded t-
FLOORMAP L / FLOORMAP L (CB-Scan) image and initial Off-line Gate setting
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Edit>Filtering>ON — generates amplitude palette bar with sliding cursor, which may be controlled

using either touch screen stylus or mouse or 2» tj on front panel keyboard or , on external
keyboard . Position of the sliding cursor on the amplitude palette bar determines filtering level, which is
indicated as Filtering. All elements of t-FLOORMAP L / FLOORMAP L (CB-Scan) image representing

signal amplitude below filtering level are suppressed:

| File v|| Wigw v|| Edit v|| Measurements v|| A-Scan Recavery v|

435.0 mm

||1

Filtering:
>33.b dB
FloorMap L
POSTPROCESSING

e Edit>Filtering>OFF — returns to originally recorded t-FLOORMAP L / FLOORMAP L (CB-Scan)
image and removes Filtering indication
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Edit>Normalize to DAC>0N - applies DAC/DGS normalized color palette to t-FLOORMAP L /
FLOORMAP L (CB-Scan) image, which was recorded with active DAC/DGS and redraws t-
FLOORMAP L / FLOORMAP L (CB-Scan) image correspondingly (dB to DAC/DGS normalization)

File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

L=8 Filering
ROl

Change Gain

3
4
»

| Momalize to DAC
- Flip Horizontal

s=948mm H=99%

AVC= 17 dB

FloorMap L
POSTPROCESSING

0 mm

0N
= OFF

T
50

T
1460

T
200

File v|| Wigw v|| Edit v|| Measurements v|| A-Scan Recavery -
L =827 mm
E
+ + E
+ + g
+ + g
+ +
+ +
¥ +
+ +
+ +
-
5=94.8mm H=59% gé e
F—a
- = [ -
AVC= 1.7 dB i —— 'l;=___ -
= o5 "-:_‘5.;_
==
= e ]
'3 _,!' -
= . = = E
FloorMap L | £
[=}

POSTPROCESSING 0

T
lule]

T
150 200

T
250

300

Edit>Normalize to DAC>OFF — negates dB to DAC/DGS normalization and returns to originally
recorded t-FLOORMAP L / FLOORMAP L (CB-Scan) image

®

Applying of Edit->Normalize to DAC->ON or Edit->Normalize to DAC->OFF negates Filtering
(Edit>Filtering>OFF)
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_ —reorders A-Scans captured during t-FLOORMAP L / FLOORMAP L (CB-Scan)
recording in reverse succession and redraws t-FLOORMAP L / FLOORMAP L (CB-Scan) image
accordingly. This service function may be useful for merging scans of neighboring sections of an object,
which were scanned in opposite direction due to access conditions, etc

Filterirg »
ROl 4
Change Gain 4
Momnalize to DAC » |

FloorMap L (Am T e e
POSTPROCESSING 200

FloorMap L
POSTPROCESSING
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Measurements>Add Measure=>Length — generates horizontal cursor that may be guided over t-

*

—

FLOORMAP L / FLOORMAP L (CB-Scan) image using either touch screen stylus or mouse or

_'.'_/ on front panel keyboard or , on external keyboard . Horizontal cursor to be positioned over

defect area, which's length along the scanning line to be evaluated. Position of horizontal cursor
characterizes its coordinate (H) relatively scanning line. To fix position of horizontal cursor left mouse

L ]
Enter |

click or release touch screen stylus or press *=_ on front panel keyboard or [Enter| on external
keyboard

File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|
H=2159mm
I £
=}
w0
7
‘éi& = e =";:_I_"
= [} S ie= -
-
= Ee
il e
e —
= = = E
FloorMap L | £
= T T T T T
PosTPnocEssl"G a an 100 180 200 280 200
File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|
H=217.0 mm
L-68 e e ==
mm I 3 F—JE-_.- = 'S"q!—— .; =
SR el
gl
E%.:’_H— =] w— -—=".-‘."
¥ — e
=== :_:- = :-i-;_
-0
h - e
= e
FloorMap L | £}
[}

POSTPROCESSING o

First vertical cursor appears upon fixing horizontal cursor, it may be guided over t-FLOORMAP L /

|

FLOORMAP L (CB-Scan) image using either touch screen stylus or mouse or ' =/, ¥ on front panel

keyboard or , on external keyboard . Coordinate of the first vertical cursor along t-FLOORMAP L /
FLOORMAP L (CB-Scan) image (L) is indicated synchronously. To fix position of the first vertical cursor

L ]
Enter |

left mouse click or release touch screen stylus or press - *=_/ on front panel keyboard or [Enter|on
external keyboard
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Second vertical cursor appears upon fixing first one, it may be manipulated by the same way. Coordinate

of the second vertical cursor along t-FLOORMAP L / FLOORMAP L (CB-Scan) image measured with
relatively first vertical cursor (dL) is indicated synchronously, it represents projection length of defect

area provided that vertical cursors are placed properly

ESC
To interrupt length measurement procedure at any moment right mouse click or press L) on front

panel keyboard or on external keyboard

File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

H=2159mm

L=68mm [dL=406 mm

435.0 mm

&%g === R .
=:...—§ :: g—% p=
e
— =1
e =3 5 —
":i!- v o
B ——
B = = E
FloorMap L | £
= T T T T T
POSTPROCESSING 0 50 100 180 200 250 300
| File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery -

FloorMap L
POSTPROCESSING

435.0 mm

’

T
50

T
100

T T
150 200

200

Horizontal [length measurement markl appears on the t-FLOORMAP L / FLOORMAP L (CB-Scan)

image upon fixing position of second vertical cursor
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Length measurement results may be recalled through double click on the length measurement mark

| File v|| Wig v|| Edit v|| Meazurements v|| A-Scan Recoverny v|

435.0 mm

Point 1:
L=6.8 mm
dL=40.6 mm
H=2159 mm

s |

0mm

Floophlap L
P PROCESSING ] 5|0 10|0 15|0 20|0 25|0 200
&
In the appearing:

o L is coordinate of left end of the length measurement mark
o dL is length of defect area covered by length measurement mark
o Hisdistance between scanning line and length measurement mark

= will print current screen snapshot accompanied with length measurement mark data

Clicking on

Clicking on ¥ will hide subwindow with length measurement mark data

Clicking on x will hide subwindow with length measurement mark data and erase corresponding

length measurement mark
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Measurements>Add Measure>Width — generates cursor representing sound path of probe's central
beam in the object under test that may be guided over t-FLOORMAP L / FLOORMAP L (CB-Scan)
image using either touch screen stylus or mouse or *_ . on front panel keyboard or , on
external keyboard — corresponding A-Scan is recovered synchronously according to sound path cursor
position. Indication of starting position of cursor (L) corresponding to probe's center accompanies
recovered A-Scan. Sound path cursor to be positioned over defect area, which's width along the sound
path line to be evaluated. To fix position of sound path cursor left mouse click or release touch screen

L
Enter
stylus or press *=_ on front panel keyboard or [Enter| on external keyboard
File v|| Wigw v|| Edit v|| Measurements v|| A-Scan Recavery v|

L=278 mm

435.0 mm

+ o+ o+

LY, P N
Pl

I+ o+ o+ o+ o+ o+ o+ o+ +

y
:
.
.
.
:
.

A

!!'.
\'h |

s=807mm  H=40% [}

AWC=25dB

%"h

27
il 'lj |I|II
L

_E 4 _l. - =
FloorMap L | ¢
POSTPROCESSING 0 50 100 180 200 260 300
File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery -
L=278 mm
E
E
N
| o
Hi“l'\\ Mll:f J:i"':':J'rd'lj\:'J = “‘“:-‘I.' Ih'L‘
s=80.7mm  H=40% U=z == e
———ge
AVC= 25 dB = = %
% _ﬂiEsL
= = =
'E = i e
= = E =
FloorMap L | ¢
POSTPROCESSING 0 s0 100 150 200 260 300
First horizontal cursor appears upon fixing sound path cursor, it may be guided over t-FLOORMAP L /
FLOORMAP L (CB-Scan) image using either touch screen stylus or mouse or ? , '.' / on front panel

keyboard or , on external keyboard . Coordinate of the first horizontal cursor along sound path (H) is
indicated synchronously
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To fix position of the first horizontal cursor left mouse click or release touch screen stylus or press

L
Enter |

)

on front panel keyboard or on external keyboard . Second horizontal cursor appears upon fixing
first one, it may be manipulated by the same way. Coordinate of the second horizontal cursor along
sound path measured with relatively first horizontal cursor (dH) is indicated synchronously, it represents
projection with of defect area provided that horizontal cursors are placed properly. To interrupt width

ESC
measurement procedure at any moment right mouse click or press L) on front panel keyboard or

on external keyboard

File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

L=278 mm

H=189.7 mm | dH=61.1 mm

435.0 mm

+
+
+
+
+
+
+
+

£ o+ ok o+ o+ o+ o+ o+

|Hw co
e

2N : — =
=_F

s=80.7mm  H=40% = = = -
AVC= 25 dB = %ﬁ
=
= Ee
'E":;!; (o
- =
£ —
= = = E
FloorMap L | £
= T T T T T
POSTPROCESSING i 50 100 150 200 250 300
| File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|
3
E
=3¢
w
¥
FloorMap L | ¢
o

POSTPROCESSING

Vertical jwidth measurement mark{ appears on the t-FLOORMAP L / FLOORMAP L (CB-Scan) image

upon fixing position of second horizontal cursor
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Width measurement results may be recalled through double click on the width measurement mark This

causes appearance of corresponding A-Scan and

subwindov-vl

| File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|
+ + +
+ + + E
+ + + =3
w0
+ + + [l
+ + +
+ + +
+ + +
+ o+ o+ o+
T |
Tl e 'm
s=80.7mm H = 40% Point 2:
AVC= 25 dB 2l L=27.8 mm
[ v H=189.7 mm
== dH=61.1 mm

FloorMap L

0 mm

v |

x |

S |

T
50

POSTPROCESSING

T T
100 1460

T T
200 2480 200

In the subwindow appearing:
o L is coordinate of the width measurement mark along scanning line
o His distance between scanning line and width measurement mark
o dH is width of defect area covered by width measurement mark

Clicking on
Clicking on

Clicking on
width meas

=

v
X

urement mark

will print current screen snapshot accompanied with width measurement mark data
will hide subwindow with width measurement mark data

will hide subwindow with width measurement mark data and erase corresponding

Measurements—=>Clear Last — erases last length or with measurement mark placed on the t-

FLOORMA

PL/FLOORMAP L (CB-Scan) image

Measurements—=>Clear All — erases all length and with measurement marks placed on the t-

FLOORMA

PL/FLOORMAP L (CB-Scan) image
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8. XY Scanning Recording and Imaging —
General Notes
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8.1. XY Scanning Recording and Imaging Menu

XY Scanning Recording and Imaging Menu is shown below:

~ISONIC 2006 Applications
2 0
(0]
12-SONIC Circross LongWeld PLCross
" . &
. 5 ¢ -
P El ]
: MultiScan
SMPipe Nozzle Expert Combo-S
'y " .
; -\ | [y 1)
IS0HIC RD RD
tscan
FloorMap Corromap u "~ Corromap CU
L J Combo-5 CU )
. S ¢
IS0HIC E
'IlouFfI::I TranScan
- 7 &
’ 3
< Back @
ISONIC 2006 Postprocessing

———l "

ISONIC 2006 Applications field includes group of controls related to various inspections:

e Straight beam Inspection
(" ™

FLUMED
RO
E;..;, Activates mode of operation covered by MULTISCAN COMBO S license.
a MultiScan Refer to paragraph 3.4 of this Operating Manual for brief characteristics and
Combo-5 to paragraph 9.1 for operating instructions
" e
e "y
g
E}'Eﬁ Activates mode of operation covered by mode of operation covered by
a MultiScan MULTISCAN COMBO S CU license. Refer to paragraph 3.4 of this
Operating Manual for brief characteristics and to paragraph 9.2 for
Combo-5 CU . ;
h, . operating instructions
i
o Activates mode of operation covered by CORROMAP license. Refer to
a paragraph 3.4 of this Operating Manual for brief characteristics and to
Currumﬂp paragraph 9.3 for operating instructions
o r
-
RD Activates mode of operation covered by CORROMAP CU license. Refer to
a paragraph 3.4 of this Operating Manual for brief characteristics and to
Corromap CU paragraph 9.4 for operating instructions
e a
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Angle beam weld inspection

3
a
12-50NIC
e '
Q 0y
E
Expert
r* 3
| B
SMPipe
" o
5
| 1B
Nozzle
e o
"
Cary
- L]
PLCross
" il
%
D %
Circross
. i
!
.
LongWeld
. i
%
| =
TranScan
. i
Long range Inspection
* 3
1S0OHIC
==
a : 2T
FrHap
FloorMap
. '
TOFD Inspection
* 3
1S0OHIC
a
TOFD
Totd
'

Activates mode of operation covered by 12-SONIC license. Refer to
paragraph 3.4 of this Operating Manual for brief characteristics and to
paragraph 10.1 for operating instructions

Activates mode of operation covered by EXPERT license. Refer to
paragraph 3.4 of this Operating Manual for brief characteristics and to
paragraph 10.7 for operating instructions

Activates mode of operation covered by SMPIPE license. Refer to
paragraph 3.4 of this Operating Manual for brief characteristics and to
paragraph 10.5 for operating instructions

Activates mode of operation covered by NOZZLE license. Refer to
paragraph 3.4 of this Operating Manual for brief characteristics and to
paragraph 10.6 for operating instructions

Activates mode of operation covered by PLCROSS license. Refer to
paragraph 3.4 of this Operating Manual for brief characteristics and to
paragraph 10.2 for operating instructions

Activates mode of operation covered by CIRCROSS license. Refer to
paragraph 3.4 of this Operating Manual for brief characteristics and to
paragraph 10.3 for operating instructions

Activates CORROMAP CU license. Refer to paragraph 3.4 of this Operating
Manual for brief characteristics and to paragraph 10.4 for operating
instructions

Activates mode of operation covered by TRANSCAN license. Refer to
paragraph 3.4 of this Operating Manual for brief characteristics and to
paragraph 10.8 for operating instructions

Activates mode of operation covered by FLOORMAP license. Refer to
paragraph 3.4 of this Operating Manual for brief characteristics and to
paragraph 11 for operating instructions

Activates mode of operation covered by TOFD license. Refer to paragraph
3.4 of this Operating Manual for brief characteristics and to paragraph 12 for
operating instructions
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In order to activate a mode of operation click on its button

OR

| | | fa—
select mode using L _’_» f_J !,/ or ™ Jon front panel keyboard or , , , or on
Enre.r |!
external keyboard then press ' LJ or *=_ on front panel keyboard or press or on external
keyboard — selected mode is indicated through framing of it's icon and name as it is shown below:

e

Circross

&

ISONIC 2006 Postprocessing
To enter postprocessing mode click on F

OR

| II |
select this button using L _’_, f.) !,/ on front panel keyboard or , , , on external keyboard

Enter |
then press LJ or *=_ on front panel keyboard or press or on external keyboard

< Back

To return to Main Recording and Imaging Menu click on 4

OR

ESC

press X" _J on front panel keyboard or on external keyboard

OR

.. I| ]
select this using L _’_, f.) !,/ on front panel keyboard or , , , on external keyboard then

Enter |
press ' LJ or ' *==_ on front panel keyboard or press or on external keyboard
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8.2. Airborne Ultrasound Encoder of Probe Position and
Orientation (Swiveling Angle)

In ISONIC 2006 instrument encoding of manually manipulated ultrasonic probe position and orientation
during XY scanning is provided by means of airborne ultrasound. To perform XY scanning probe is fitted into
appropriate probe holder, equipped with detachable single or dual emitter of airborne ultrasound:

FProbe Haolder

=ingle Emitter of
Tighter D Ajthorne Ultrasound

Probe Probe Haolder

Dual Emitter of
Airbarne Lltrasound

2

0

Operator grips probe holder and manipulates it over scanning area whilst probe is applied to object under
test. Emitter of airborne ultrasound produces pulses, which propagate around in the air. For standard XY
scanning applications there are two receivers of airborne ultrasound placed near scanning area to pickup
signals produced by emitter of airborne ultrasound. Distance between receivers of airborne ultrasound
(Base) is determines width of scanning area, it must be entered into ISONIC 2006 instrument prior to
scanning. Receivers of airborne ultrasound are mounted on the graded bar with magnetic clamps or vacuum
cups ensuring placement on variously oriented surfaces:

Base

FProbe Haolder

Base
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ISONIC 2006 instrument determines probe coordinates through detecting travel time for airborne ultrasound
propagating between emitter and receivers followed by real time triangulation. Probe orientation (swiveling
angle) may be additionally determined if using dual emitter of airborne ultrasound — for that purpose
detecting travel time and triangulation are provided for both emitting elements displaced at predetermined
distance from each other

Scanning of ferromagnetic materials — magnetic clamps

Airborne ultrasound based encoding
of probe position only

Airborne ultrasound based encoding
of probe position and swiveling angle
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Scanning of non-magnetic materials — pumped vacuum cups

Airborne ultrasound based encoding of probe position
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®

¢ Itis necessary to grip probe holder providing open space around emitting element airborne ultrasound

\/Proper Gripping

F&f

> Improper Gripping

?
b
+ Airborne ultrasound velocity and zero offset must be properly calibrated according to Chapter 14 of this

ok A

Operating Manual

¢ Sue of two receivers of airborne ultrasound allows determining of probe position and orientation on flat,
quasi-flat, tubular, and quasi-tubular, round, and quasi-round surfaces. For non flat surfaces software
application requires keying-in of curvature diameter (radius) at setup time

.

In ISONIC 2006 instrument is featured with third input of airborne ultrasound for implementation of
special inspection software packages related to scanning on complex geometry objects
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8.3. Coupling Monitor

There is coupling monitor channel in ISONIC 2006 instrument, which generates low frequency noise signal
emitted into object under test by appropriate emitter. Low frequency noise saturating volume of object under
test is available for pick up by probe at any point of scanning area. Coupling monitor signal received by
probe is converted into electrical input in probe holder and delivered to dedicated input of ISONIC 2006

instrument
Emmitting of Low Frequency Moise P
for Coupling Monitor ,f”,,
d

Receiving of Low Frequency NMoise
for Coupling Manitor

ISONIC 2006 instrument analyses level of received low frequency noise and provides perceptible indication
and recording during XY scanning
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8.4. Cabling for XY Scanning and Recording

Umbilical cable S 70200 (or S 70200 HT) is necessary to perform XY Scanning and recording
8.4.1. Instrument

8.4.1.1. Use of
Single
Element Probe

¢ Red Plug 2
Red Socket

¢ White Plug >
White Socket

¢ Black Socket
is FREE

8.4.1.2. Use of
Dual Probe or
Two Single
Element
Probes for
Through-
transmission
Inspection

¢ Red Plug 2>
Red Socket

¢ White Plug >
Black Socket

+ White Socket
is FREE
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8.4.2. Airborne Ultrasound Encoder, Coupling Monitor, and Probe

8.4.2.1. Use of Single Element probe
and Dual Emitter of Airborne
Ultrasound

+ Receivers of airborne ultrasound = sockets
IN Xand INY

+ Emitter of low frequency noise - socket
Out Cpl through cable S 799028 with Blue
jacketed plugs

¢ Socket IN Z is FREE for standard XY

Scanning applications

Red plug = Ultrasonic probe

Orange plug = Orange marked socket

White plug - White marked socket

Yellow plug = Yellow marked socket

If probe holder is not equipped with

coupling monitor receiver then:

0 Yellow plug does not exist and Yellow
socket is FREE

0 Socket Out Cpl is FREE, cable S
799028 with Blue jacketed plugs and
emitter of low frequency noise are not in
use

8.4.2.2. Use of Single Element Probe
and Single Emitter of Airborne
Ultrasound

+ Receivers of airborne ultrasound - sockets
IN Xand INY

+ Emitter of low frequency noise - socket
Out Cpl through cable S 799028 with Blue
jacketed plugs

¢ Socket IN Z is FREE for standard XY

Scanning applications

Red plug = Ultrasonic probe

Orange plug = Orange marked socket

White marked socket is FREE

Yellow plug > Yellow marked socket

If probe holder is not equipped with

coupling monitor receiver then:

0 Yellow plug does not exist and Yellow
socket is FREE

0 Socket Out Cpl is FREE, cable S
799028 with Blue jacketed plugs and
emitter of low frequency noise are not in
use

> & & o

> & o o

! S 70200

third micraphone

ellow

! S 70200

third micraphone

Red “Fellow
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8.4.2.3. Use of Dual Element Probe
and Single Emitter of Airborne
Ultrasound

+ Receivers of airborne ultrasound = sockets
IN Xand INY

+ Emitter of low frequency noise - socket
Out Cpl through cable S 799028 with Blue
jacketed plugs

¢ Socket IN Z is FREE for standard XY
Scanning applications

¢ Red plug 2 Emitting element of ultrasonic
probe

+ White marked socket 2 Receiving
element of ultrasonic probe through
appropriate Jumper

¢ Orange plug 2 Orange marked socket

+ Yellow plug = Yellow marked socket

If probe holder is not equipped with

coupling monitor receiver then:

0 Yellow plug does not exist and Yellow
socket is FREE

0 Socket Out Cpl is FREE, cable S
799028 with Blue jacketed plugs and
emitter of low frequency noise are not in
use

8.4.2.4. Through-transmission
Inspection — Two Single Element
Probes and Single Emitter of
Airborne Ultrasound

+ Receivers of airborne ultrasound = sockets
IN Xand INY

¢ Out Cplis FREE

¢ Socket IN Z is FREE for standard XY
Scanning applications

¢ Red plug = Emitting ultrasonic probe
through appropriate Extension cable

+ White marked socket 2 Receiving
ultrasonic probe through appropriate
Extension cable

¢+ Orange plug 2 Orange marked socket
through appropriate Extension cable

¢ Yellow marked socket is FREE
Probes / probe holders to be placed into

appropriate yoke to provide necessary
concentricity during scanning

!

5 70200

third micraphone

c_ |
Fed  vellow

!

5 70200

third micraphone

(o=

Extenzion cakle

Extenszion cakle

Extension cakle
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8.5. Off-line analysis (postprocessing) for XY Scanning records

While in postprocessing mode it is strictly recommended to use external USB mouse. ISONIC 2006 XY
Scanning Records Postprocessing explorer window appears on entering into postprocessing mode

- 5 ¢ - 5 ¢ - 5
Open Copy To... Move To... Delete Exit
& &

>

Desktop Al Mame I Type I
) My Computer B o.ioe ISOMIC 2006 Expert
=9 Remevable Disk (4] B noo.ios ISONIC 2005 Expert
gz [T B Ex000001.i06 ISONIC 2006 Expert
- B Exoonn0z.ing ISOMIC 2006 Expert

-] lsonic A .
EXD00003 08 ISONIC 2006 E spert
-0 ISONIC 2005 Fresuls = : #pet

E-_] ISONIC 2006 Results
(] Cireross

[Z] CombaS

[ CombaSCU
-] Comomap

[ ComomapCU

[ TranScan

2] UDS 35 Pulser B>
N I

Left panel of ISONIC 2006 XY Scanning Records Postprocessing explorer window allows selecting of
required directory (folder); right panel represents all XY scanning record files in selected folder, which are
accompanied with name of mode used for inspect_ion. To open record file for off-line analysis and reporting

b
a
Open [ & ] Enter |
double click on its name or mark file and click on 2 or press “2e= ) or  *=_J on front panel

keyboard or or on external keyboard . Upon opening file off-line analysis (postprocessing) is
possible in accordance with instructions related to corresponding XY scanning mode

Other functions

Q Copy marked file into a new location
Copy To...

a Relocate marked file into a new location
Move To...

m] x Delete marked file (relocate into Recycle Bin)
Delete

Exit ESC
To return to XY Scanning Recording and Imaging Menu click on & or press - C

front panel keyboard or on external keyboard

on
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9. XY Scanning and Recording for
Straight Beam Inspection
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9.1. Running MULTISCAN COMBO S Mode

9.1.1. Preparations

, Base , For Pulse Echo or Back Wall Echo

Attenuation inspection insert ultrasonic

probe into probe holder then fix single

—- emitter of airborne ultrasound on the

f = top of probe holder — refer to paragraph
" 8.2 of this Operating Manual

<

Fedion Wicdth

For Through Transmission inspection
probes to be mounted into yoke — refer
to paragraph 9.3 of this Operating

Manual
Region Lencgth

Provide cabling according to paragraph

| 8.4.2 of this Operating Manual
=canning Area (Hegion)

Apply bar with receivers of airborne
ultrasound at parallel to selected side
of rectangle probe manipulation area.
Single emitter and receivers of airborne
ultrasound located on the bar to be
equally distanced from scanning
surface level. Distance between two
receivers of airborne ultrasound (Base)
is defined as:

Base = Bg + Pos1 + Pos2

Pos1 and Pos2 are positions of

receivers at left and right side of the bar

correspondingly;

Bo is parameter of the bar:

e Bp=200mm /8 in for long bar
(order code / part # S 2040 B)

e Bp=100mm /4 in for short bar
(order code / part # S 86000)

Region Length = Base

MG UMELD
(R
E*‘J" Enter MULTISCAN COMBO S mode according to paragraph 8.1 of this Operating
MultiScan Manual
Combo-5
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9.1.2. Description Data

In the BESG R EXCJEG R EIMICISI®M screen it is possible to key in description of object under test —
this may be required for inspection report — use virtual keyboard generated on the touch screen or external
keyboard:

Describe the Object Under Test__.

Job No: Location: C B

2931177 Manufacturing Shop |  [Goal of inspection - finding =]
Date: Diawing Mo / Position: internal defects
[ 21-Nov-2006 95T00787764 such as lamination, porosity,

Welding Method: and the likel
N/A ]

Object Under Tesk:

Panel
Manufacturer: Material:

)
)
( DFMU - Plant ] [ cmc ]
J
J

Inspection Site: Surface Condition:
DFMU - Plant Good ]
Inspecting Company:

ASTRA

Inspector:

Bill ] d

anonopooEnnEEn
|o||w||e||a||T||v||u||u||o||P||{||}| |
EE RG] %@

| |z||x||c||v||e||~||m||<||>|| ||Emer|

I. Exit [4] | - -

ESC

(| Exitpa ;)
To return back to XY Scanning Recording and Imaging Menu click on IE orpress _4 Jor - C
on front panel keyboard or or on external keyboard

To continue click on @ or press LJ on front panel keyboard or on external keyboard —

[Nl WBEIE screen appears allowing to key in data describing inspection process — this may be
required for inspection report — use virtual keyboard generated on the touch screen or external keyboard

Ingpection Data
Specification: Test Class:
SIP-468690

Scanning Position: Comrection Yalue ¥1 or ¥2:
A-200821
Transfer C tion: C.
0B | Water ]
Scope of the Test:
XY scanning - pulse echo lechnique| -
BN EnNNEn
[ RN CIPG]

(omsa ] REREEE L] (e )
B 2 | e v o o < ) 2 o]
Exit [4] | |

ESC

(" Exit 14 A
To return back to XY Scanning Recording and Imaging Menu click on @ orpress _4 Jor . C
on front panel keyboard or H or H on external keyboard

< Back [ESC
To return to previous screen click on @ or press _) on front panel keyboard or on

external keyboard

To continue click on @ or press | LJ on front panel keyboard or |-g| on external keyboard — this
will enter next stage related to calibration of UDS 3-5 pulser receiver
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UDS53-4 - ISONIC Pulser/Receiver

BASICS PULSER RE

R
GATE B ALARM DAC/TCG

GATE A

MEASURE Selection

9.1.3. Pulser Receiver Settings

Calibration of UDS 3-5 Pulser Receiver
to be provided with reference to Chapter
5 and paragraphs 9.1.3.1 and 9.1.3.2 of
this Operating Manual

To return to previous screen click on

0.5 Gain
39 dB ‘
Filter
.
Frequency
0.35-35 MHz ‘

Close

T By | e By | I By | 1 By

- ESC
Display or press L‘\ on front panel
keyboard or ESC|or <Alt>+<C> on

0% external keyboard

Menu "Ds' ?.s On completing calibration click on

v dh dh dh 4\ 4

len '|;

N value:orr | “-» H|l=|2 . I
Cloze ml Freeze Save | Open | Print DG5S or preSS I IOI"I front panel
keyboard or on external keyboard
9.1.3.1. Pulse Echo
# | Parameter or Mode Submenu Required Settings Note
1 aSwitch GATE A ON
2 Gain BASICS Gain setting to be performed according
to inspection procedure providing
required echo heights from defects to be
detected
3 aThreshold GATE A aThreshold settings to provide echo
heights from defects to be detected
exceeding aThreshold; signals from
other reflectors — not exceeding
aThreshold
4 DAC/TCG DAC/TCG DAC/TCG settings to meet requirements
of inspection procedure
5 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
6 Tuning, Pulse Width, PULSER Tuning, Pulse Width, Firing Level, To synchronize with Gain and
Firing Level, Damping and Damping settings to provide aThreshold setting procedures
optimal signal to noise ratio
7 Filter, Frequency RECEIVER Filter and Frequency settings to match | To synchronize with Gain and
with probe's frequency aThreshold setting procedures
8 Display RECEIVER Display setting may be either Full, RF, The same Display mode to be
PosHalf, or NegHalf used for both Probe Delay
determining and MULTISCAN
COMBO S Recording
9 USVelocity BASIC USVelocity setting to be equal to actual
value of ultrasound velocity in the object
under test
10 | Probe Delay MEASURE Probe Delay setting to be equal to Probe delay may be
actual probe delay determined according to
paragraph 5.2.13.7 or 5.2.13.9
of this Operating Manual or
similarly
11 | Angle MEASURE Angle = 0°
12 | Meas Mode MEASURE Flank
13 | Range, Display Delay, BASIC Range, Display Delay, aStart, and
AStart, awidth GATE A aWidth settings to be performed with
reference to below table Region of
Interest for MULTISCAN COMBO S
14 | Settings for other

parameters and modes
have no significance
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Region of Interest for MULTISCAN COMBO S

. Scannin

Surface to ROI Distance

Surface

ROl Width -~ ROl = Region of Interest
Defect
Initial
Pulze
SRD = aStart
Case 1 -
preferred —_— RW = aWidth
embodiment !
| Dizplay Range
" Delay
Initial DisplavDel
Pulse SRD = Mx USVelocity
Case 2
N RW = aStart + aWidth — SRD
]
Display Range
" Delay
Initial
Pulze SRD = aStart
Case 3 B RW = w xUSVelocity +
Tmsplw Range + Range — aStart
" Delay
Initial
Pulze ]
SRD = DISPIYDelay e e 1ocity
Case 4 2
0 RW = Range
| Display Range
" Delay
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9.1.3.2. Back Wall Echo Attenuation and Through-Transmission

# | Parameter or Submenu Required Settings Note
Mode
1 Gain BASICS Gain setting to be performed according
to inspection procedure providing
required amplitude of back wall echo or
through-transmitted signal
2 aSwitch GATE A ON
3 Range, Display BASIC Range, Display Delay, aStart, and
Delay, aStart, awidth | GATE A aWidth settings to be performed to
provide presence of back wall echo or
though-transmitted signal on the A-Scan
and time coincidence of evaluated signal
with Gate A
4 DAC/TCG DAC/TCG DAC/TCG settings to meet requirements
of inspection procedure
5 Pulser Mode PULSER Dual for dual element probes and for
through-transmission inspection with
use of two probes
Single for single element probes
6 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing Level, To synchronize with Gain
Firing Level, and Damping settings to provide setting procedures
Damping optimal signal to noise ratio
7 Filter, Frequency RECEIVER Filter and Frequency settings to match | To synchronize with Gain
with probe's frequency setting procedures
8 Display RECEIVER Display setting may be either Full, RF,
PosHalf, or NegHalf
9 Settings for other

parameters and
modes have no
significance
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9.1.4. Probe

screen appears on completing calibration of UDS 3-5 Pulser Receiver; it is necessary to key in probe
name using either virtual keyboard generated on the touch screen or external keyboard. Value of Probe
Delay is imported from settings of UDS 3-5 Pulser Receiver

Probe:
8.83 us
L JCo {2 {3 [ ls|ls |2 [e][s o]l - |[-][]
Lolfwilef[rI{r][v|lul{v][o]le ] ][]
[al{s[o][F e ln[s J[e][c]ls]]-]

Lshirt ||z || x|[cl{vi[lfn]fm] ., [[.][/]Enter]
| |
Exit [4] I<Back [ESC]J IJ

_ , _ , l Exit [4] | = ]
To return back to XY Scanning Recording and Imaging Menu click on orpress _4 Jor .
on front panel keyboard or or on external keyboard

( | Esc
To return to previous screen click on @ or press L) on front panel keyboard or on

external keyboard

To continue click on @ or press LJ on front panel keyboard or on external keyboard — this
will enter next stage related to defining inspection mode and scanning parameters
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9.1.5. Inspection Modes and Scanning Parameters

Layout of [[iJ=Iqile]ilSEI]e] screen depends on option selected — it is necessary to check Pulse Echo or

Attenuation in the Inspection Method field (click on). Attenuation mode is suitable for both back wall echo
attenuation and through-transmission inspection

Inzpection Setup

Scan Index [SI] Base Region Depth [RD)
| b mm j | 180 mm j | 0 mm
e m
120 mm 2 - Pseudo 2 4 mm

Inspection Method: & |

) ¢ Aftenuation
Number of Colors: 255 | Origin Start | Interval |

0.0 0z o7

12 A0 a2
Ingpection Setup

@

s [Rw]
Scan Index [51] ‘ Base ‘
| 5 mm j | 180 mm j
| m
120 mm 2 - Pseudo 2

Inspection Method: © Pulse Echo &

Mumber of Colors: 255 | Origin Start | Interval |
i N P
a -40
e ( ( )
Exit[4] " Coarse {* Medium ¢ Fine { < Back [ESC] l Next >

In the [ eliBSEIMe) screen it is necessary to key in:

Q Base (distance between two receivers of airborne ultrasound), which defines length of rectangular
scanning area — refer to paragraph 9.1.1 of this Operating Manual

Q Region Width, which defines width of rectangular scanning area — refer to paragraph 9.1.1 of this
Operating Manual

Q Scan Index — value of Scan Index defining coverage of scanning area to be selected and entered
according to inspection procedure

A
Setting of said parameters to be performed through clicking / pressing corresponding spin button ﬂwith
Fine, Medium, or Coarse increments according to checked option (click on) in the Setup Step field

fa—
Alternatively parameter for setting may be selected through pressing ' =\ Jon front panel keyboard or
on external keyboard or through clicking on its label. Label indicating name of selected parameter changes

it's fore color from yellow to white — since that moment parameter may be modified using .!; » (= -'

!. on front panel keyboard or , , , on external keyboard

ISONIC 2006 from Sonotron NDT - Operating Manual — Revision 1.21 - Page 288 of 480



Values of Region Depth (RT) and Region Thick (RT) for pulse echo mode indicated in the Inspection
Setup screen are defined by Gate A settings of UDS 3-5 Pulser Receiver:

Region Depth (RD) = aStart

Region Thick (RT) = aWidth

Color scale (palette) representing signal amplitudes and defects coordinates may consist of up to 255
grades. Customizing is possible through corresponding (click on)
- ~

-

-
- N
Humber of Colors: 255 | Origin Start: 0.01 mm, 11.91dB Interval: 0.01 mm, 0.09 dB |

oo 0z 0.5 0.8 1.1 1.4 1.6 19 22 25 27 3.0 3.3
i i i i I I
_ _:|mm
T T T T T T ol
12 0 g 5] 4 2 a -2 -4 -G -8 -1 -12

Style of palette (Pseudo, Thermal, or Gray) is selectable through clicking :
/

/
2 - Pzeudo 2

(" Exit 14 A
To return back to XY Scanning Recording and Imaging Menu click on lx_“J orpress _4 Jor .
on front panel keyboard or -4 or on external keyboard

( ESC
To return to previous screen click on M or press L) on front panel keyboard or on

external keyboard

To continue click on M or press LJ on front panel keyboard or on external keyboard

ESC

'S
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9.1.6. Coupling Monitor (Pulse Echo Mode Only)
In the screen activation of

coupling monitor to be performed through setting of Coupling Monitor
Reference Signal Excitation Level

Setting of Reference Signal Excitation Level may Reference Signal Excitation Level ‘ ' i
be performed through clicking / pressing its spin 14 % =
fi .
button ¥ or through pressing !; !, ?
! on front panel keyboard or , , , on

external keyboard

To setup coupling monitor proceed as below:

a apply emitter of acoustic coupling monitor signal
and probe with probe holder equipped with
emitter of airborne ultrasound to object under
test using excessive quantity of couplant

a find threshold of Reference Signal Excitation
Level, which is perceptible trough changing
color of horizontal bar indicator (red color means

insufficient coupling or still low level of @ -
excitation) and audible alarm (if active) Coupling Monitor OFF
O add 3% to 7% to found threshold value L ~

—_— P \
Exit [4] l < Back [ESC] { Next = J
o

b

Coupling Monitor OFF J or set 0% for Reference Signal

To switch coupling monitor OFF click on l
Excitation Level

To switch ON / OFF audible alarm for insufficient coupling click on { i )

®

O If dimensions of object under test and / or its surface conditions don't allow reaching sufficient coupling
indication even if value of Reference Signal Excitation Level is set to 100% then two or more emitters of
acoustic coupling monitor signal must be connected to Out Cpl socket of ISONIC via appropriate splitter
SE 20220

O MULTISCAN COMBO S supposes use of straight beam single element or dual probes. If geometry of
object under test allows receiving of back wall echo then amplitude of back wall echo is automatically
recognized as an additional parameter for coupling monitoring provided it is in coincidence with Gate A

, , , , I Exit [4] - = }
To return back to XY Scanning Recording and Imaging Menu click on orpress _4 Jor
on front panel keyboard or -4 or on external keyboard

( ESC
To return to previous screen click on M or press L) on front panel keyboard or on

external keyboard

To continue click on M or press LJ on front panel keyboard or on external keyboard
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9.1.7. Referring Scanning Area (Zero Line)

Side of rectangle scanning area closest to bar with receivers of airborne ultrasound to be defined as Zero
Line in the [gge]ol-YMeJef-id[e]a M\ [e]4]ife]§ SCreen: place probe equipped with emitter of airborne ultrasound

above Zero Line — at this position absolute distance between bar and probe is indicated in X-coordinate
box — then:

bl

click on l Set Zero Line

OR

. '\ | |
selectl setZeroline  J using _'_, : : l!'/ or ] Jon front panel keyboard or 1], , ,
Enfe.r |

or on external keyboard then press ' *=_ on front panel keyboard or [Enter|on external keyboard

X-coordinate
. 84 mm

3
l Set Zero Line
o

Probe Location Monitor

X-coordinate
_ 0 mm

B
l Set Zero Line

Exit [4] <Bi

.L- Exit [4] J l < Back [ESC]: [ Next > J

ESC

(| Exitpa ;)
To return back to XY Scanning Recording and Imaging Menu click on lx_“J orpress _4 Jor . <
on front panel keyboard or or on external keyboard

( ESC
To return to previous screen click on M or press L) on front panel keyboard or on

external keyboard
To continue click on M or press LJ on front panel keyboard or on external keyboard
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9.1.8. Imaging Principles: Pulse Echo

## Sketch
. Baze = Region length ,
1
Zero Line
Al B1
X2
L2 Scanning Area
L1
X1 -
i
A____ D __ [ | [
—r\ \B =
I =
[T z
Y1 o =
| ™ 7
i | " v
Region Width |
_______ [_]___________:\ C B
E 9 F o~ E
R . E
i [l
" [
- i=l
- G E‘
H
Region Length
Top Yiew
Zero Line
A /s

|

I

|

|

I

|

. D) ———— ! c
E F
End Yiew ~.
Y
Y
h RS
H G
Side Yiew

0 Q1(L1, X1, Y1) —Internal Reflector 1
0 Q2(L2, X2,Y2) - Internal Reflector 2

Note

General

(@)

(b)

(©)

(d)

(e)

Volume Under Test
(Region of Interest) is
located between two
parallel rectangles namely
ABCD and EFGH
Scanning is provided
above surface of
rectangle A1B1C1D1
Lines A1B1 and AB are
parallel to line connecting
receivers of airborne
ultrasound. Position of
lines A1B1 and AB with
respect to said receivers
is defined by setting up
Zero Line as per
paragraph 9.1.6 of this
Operating Manual

With reference to

screen
— Pulse Echo Mode
(paragraph 9.1.4 of this
Operating Manual):

A1A = Region Depth

AB = Region Length
(Base)

AD = Region Width
DH = Region Thickness

In the present example it
is supposed that there are
two reflectors Q1 and Q2
in Region of Interest,
said reflectors have
different dimensions and
coordinates
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Sketch Note

Top View B Global Top, Side, and End View

Supposing that scanning is well completed
reflectors Q1 and Q2 will be detected and
.Q2 represented in global Top, Side, and End
View according to sketch # 2

Global Top View is obtained through
superimposing of parallel planes between
Q1 rectangles ABCD and EFGH. Global Top
View may be presented in two modes:
Depth Map and Amplitude Map. Amplitude
Map represents distribution of echo
amplitude above scanning surface. Depth
D - : C Map represents distribution of minimum

Side View reflector depth above scanning surface.
Thanks to complete raw data storing

. Q2 technology implemented in ISONIC 2006 it
Q1 is possible to switch between Depth Map
and Amplitude Map while scanning

H G Global Side View and End View are

End View orthogonal images composed through
A D superimposing of corresponding cross
. sectional views along and across of whole

Q2 Region of Interest. Side View and End

View images represent distribution of
el highest echo amplitudes, depth of reflectors
and their cross-sectional locations

Acquired data is converted into 3D-matrix
allowing sectional presentation of Top View,
Side View and End View during scanning —
refer to below sketches ## 3 through 8
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H##

Al

Sketch

B1

L2 e

Top View

i

Note

Sectional Top View

(Horizontal Slice)

Sketches ## 3 and 4 illustrate
composing of sectional Top
View

Top View section currently
represented on ISONIC 2006
screen corresponds to:

Q

Q

current probe coordinates
on scanning surface
depth of reflector closest
to probe on A-Scan
obtained for current probe
coordinates on scanning
surface — Top View
section represents
horizontal slice at depth
corresponding to reflector
closest to probe
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H#Hit Sketch
4 B1
L1
x1
Y2
A ____ D1V __ 1 ___‘\\E
I
|
Y1 ] |
[
|
0 }
_____D I iy
E 9 F .
H
A
&
D

ci

Note

Sectional Top View
(Horizontal Slice)

Sketches ## 3 and 4 illustrate
composing of sectional Top
View

Top View section currently
represented on ISONIC 2006
screen corresponds to:

Q current probe coordinates
on scanning surface

O depth of reflector closest
to probe on A-Scan
obtained for current probe
coordinates on scanning
surface — Top View
section represents
horizontal slice at depth
corresponding to reflector
closest to probe
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H#Hit Sketch
> B1
L1
x1
Y2
A ____ D1V __ 1 ___‘\\E
I
|
Y1 ] |
[
|
0 }
_____D I iy
E 9 F .
H
D
L ]
H
A
L
E

ci

Note

Sectional Side and End
View (Vertical Cut Slices)

Sketches ## 5, 6, 7, and 8
illustrate composing of
sectional Side View and End
View

Side View section currently
represented on ISONIC 2006
screen corresponds to current
X-coordinate of probe

End View section currently
represented on ISONIC 2006
screen corresponds to current
L-coordinate of probe
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H#Hit Sketch
6
Al xZ B1
L2
L1 -
*1
e
A ____ D1V __ 1 _T\E
I
|
1 :
|
I
0 }
. ___ I g
E 9 F .
H

ci

Note

Sectional Side and End
View (Vertical Cut Slices)

Sketches ## 5, 6, 7, and 8
illustrate composing of
sectional Side View and End
View

Side View section currently
represented on ISONIC 2006
screen corresponds to current
X-coordinate of probe

End View section currently
represented on ISONIC 2006
screen corresponds to current
L-coordinate of probe
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H##
7
Al
A
E

Sketch

B1
L2 e
L1
x1
Y2
Dl B
I
|
Y1 @ |
|
|
|
——— D ——————— -
® F~.
H

i

Note

Sectional Side and End
View (Vertical Cut Slices)

Sketches ## 5, 6, 7, and 8
illustrate composing of
sectional Side View and End
View

Side View section currently
represented on ISONIC 2006
screen corresponds to current
X-coordinate of probe

End View section currently
represented on ISONIC 2006
screen corresponds to current
L-coordinate of probe
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9.1.9. Imaging Principles: Attenuation

i

Note

Sectional Side and End
View (Vertical Cut Slices)

Sketches ## 5, 6, 7, and 8
illustrate composing of
sectional Side View and End
View

Side View section currently
represented on ISONIC 2006
screen corresponds to current
X-coordinate of probe

End View section currently
represented on ISONIC 2006
screen corresponds to current
L-coordinate of probe

In attenuation mode it is generated Amplitude Map representing distribution of back wall echo amplitude or

through transmission signal amplitude above scanning surface
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9.1.10. Scanning: Pulse Echo

During scanning [Sle]N[ege] BMIs [N 11E[lals] screen is accompanied with A-Scan and Digital Display box

ISONIC On-Line Imaging

N Top View - Depth

\

N
7

300

/

<=2mrm
>4db
<=2mm
»2db

Side View

7
/
o Coupling DK 200 mm

<=2mm
»0db

<=3mm
»-2db

1.4

o g

<=3mm
» -4 db
<=3mm
> 6 db

o

Amplitude | I Distance Top Section

<=3mm
»-8db
<=3mm
»-10db

<=3mm
Global Section Side End »-12db

] ]
= & Q
Save Clear [2] Zoom In [3]

< Back [ESC]
-

Exit [4]

5=2.02 mm. A=-1.2 dB

IS1e] Nl [exel BT R InETellgls] Screen represents:

@ Current Probe Position

a Current Coupling Status (optionally, provided that coupling monitor is active — refer to paragraph
9.1.6 of this Operating Manual)

a Top View:

-

Amplitud .
o for mpuce pressed down — Global Amplitude Map
Digt
o for fslance pressed down — Global Depth Map
o for Top Section pressed down — Horizontally Sliced Amplitude Map according to

sketches ## 3 and 4 — paragraph 9.1.8 of this Operating Manual

a Side View for Side | pressed down or End View for End |pressed down or press

pa—
—> Jon front panel keyboard or on external keyboard to switch between Side and End View

Global | Section
or

Depending on which button is pressed — — Side View and End View
are presented either in global mode according to sketch # 2 — paragraph 9.1.8 of this Operating
Manual or in sectional mode according to sketches ## 5, 6, and 7 — paragraph 9.1.8 of this
Operating Manual

®

a All A-Scans are captured during scanning unconditionally however projection images Top View, Side
View, and End View are updated only with signals exceeding threshold of Gate A presented on A-Scan
however

O Highest amplitude and minimal sound path are dominant while recording data into Top View — Amplitude
and Top View — Distance correspondingly

O Map Repair Function is active while keeping pressed LJ on front panel keyboard or on external
keyboard — new readings will overwrite already recorded data unconditionally; this allows record correction
after finding some non-relevant data recorded with dominance
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Digital Display represents:
a coordinate (sound path S) of reflector generating first signal in the Gate A (measurement mode —
Flank)
o amplitude A of maximal signal exceeding threshold of Gate A, which is expressed in dB referred
either to DAC (if active) or to 50% of A-Scan height level

Q -
To Zoom In ISONIC On-Line Imaging screen click on [Zen2B ] or press 3 on front panel keyboard or

ESC
3 on external keyboard. To Zoom Out click on l zoom O [ESA ) or press _j on front panel keyboard or
;

on external keyboard

&
To cleanup Top View, Side View, and End View fields in ISONIC On-Line Imaging screen click on C'BE'IZIJ
F
2_J on front panel keyboard or @ on external keyboard

or press

| =]
To save MULTISCAN COMBO S record into a file click on |_%**_J or press _J on front panel keyboard or
F12| n external keyboard. Refer to paragraph 5.2.17 of this Operating Manual to proceed with file saving

ESC

'S

o | rFa
To return back to XY Scanning Recording and Imaging Menu click on ™ or press _4 Jor on
Es

front panel keyboard or or ESCjon external keyboard

To return to previous screen click on l . [ESE', or press _j on front panel keyboard or on external
keyboard
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9.1.11. Scanning: Attenuation

During scanning [Sle]N[exelsEMIs[-W11F-Te[lals] sScreen is accompanied with A-Scan and Digital Display box

: Current Probe position :

SyrmwEEEEEEEEEE 7 llllllllllllllll
ISONIC On-Line Imaging
Scanning Pattern - Top Yiew = 0db
0 Lurgth, mm 210 /
;* F.—I P4
7/
g { I = -2db

. X
i {
lr_-. .;%1 = -4db

p - P 5
Save Zoom In [3] Clear [2]
s = -12db

P aanm (P — 1
E Dlgltal DISp|ay E < Back [ESC] | Exit [4]
. " = -20db

R \ et —
% = -40db

Width, mm.

= Gdb

100

= -2db

ISONIC On-Line ImagingiEGEERE] JENEICH

Q Current Probe Position
Q Top View as Amplitude Map representing distribution of back wall echo amplitude or through
transmission signal amplitude above scanning surface
Digital Display with reference to A-Scan represents amplitude A of maximal among all signals being in
coincidence with Gate A. Amplitude A is expressed in dB with reference to 100% of A-Scan height level

Q C
To Zoom In ISONIC On-Line Imaging screen click on \ ZoomInis] ] orpress 3 on front panel keyboard or

B ] ESC
F3 on external keyboard. To Zoom Out click on l Zoom OWESC [ or press L} on front panel keyboard or
;

on external keyboard

@ !
To cleanup T View field in ISONIC On-Line Imaging screen click on (%2 J or press ' _2__ on front panel

keyboard or F2 on external keyboard

| =]
To save MULTISCAN COMBO S record into a file click on |_%**_J or press ﬂ) on front panel keyboard or

F12| n external keyboard . Refer to paragraph 5.2.17 of this Operating Manual to proceed with file saving
( 1 - ESC

To return back to XY Scanning Recording and Imaging Menu click on\ o or press _4 ) or '\
front panel keyboard or or on external keyboard

( 1 ESC
To return to previous screen click on l e or press L) on front panel keyboard or on external
keyboard

on
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9.1.12. Postprocessing

Postprocessing of MULTISCAN COMBO S records may be performed directly in the instrument or in
external computer using IOFFICE or MULTIPP SW package. User interface and operations are practically
identical except two features listed below:

Off-line analysis directly | Off-line analysis in Off-line analysis in
in ISONIC 2006 external computer using | external computer using
instrument MULTIPP SW Package IOFFICE SW Package
Off-line re-adjustment
of Gain for NO YES YES
MULTISCAN COMBO S
record
Automatic creation of
Inspection report in NO YES YES
MS Word® format

Menu Bar Functions on Opening File

-

Top Vi - Depth <=1.4mm
o tH b el 12 db

. S

> 10 db

<=2mm
8 db
<=2mm
> 6 db
<=2mm
> 4 db
<=2rmm
> 2db
<=2mm
[>0db
<=3mm
-2 db
<=3mm
-4 db
<=3mm
- -6 db

<=3mm
-8 db
<=3mm

> -10db

<=3mm
L -12db

Colar Scale

300

Side View

14

33

33

e File > Print To
O selection of printer among available for printing out inspection report
0 selection of MS Word® as printer to create inspection report as doc file (IOFFICE SW Package only)
Q selection of paper sheet size either A4 or Letter

e File > Print > Whole Report — prints out complete inspection report including UDS 3-5 Pulser
Receiver settings, inspection setup and scanning parameters, recorded maps, and additional data
entered at the appropriate pre-inspection stages as it is described in paragraphs 9.1.2 and 10.1.3 of this
Operating Manual

e File > Print > Graphics Only — prints out scanning recorded maps
e File > Exit — ends postprocessing session

e View > Primary Information — previews UDS 3-5 Pulser Receiver settings, inspection setup and
scanning parameters, and additional data entered at the appropriate pre-inspection stages as it is
described in paragraphs 9.1.2 and 9.1.3 of this Operating Manual

e View = ISONIC Image Processing — activates menu for detailed off-line analysis of the record
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ISONIC Image Processing Menu Bar Functions

| Fil= v|| Wiew v|| Measurements v|| ROl v|| Filtering 'H Prafiling -
Amplitude Filtration Level: Top Yiew - Depth <=1.4mm
" - =} > 12db
No Filtration . =
<=2mm
Distanse Filtration Level: ‘ . i 120 db
i i <=2mm
No Filtration i
! <=2
Profiling > B db
<=2mm
[D" ] > 4 db
L-Coordinate <=2mm
o > 2db
=1
[l] o0 ] ” <=2mm
Projection Length > 0 db

Amplitude Filtration Level: . Top View - Depth §=112-4d“;"“
No Filtration , _ e
Distanse Filtration Level: . . > 10 db
No Filtration §=82;“Q1
! <=2mm
Profiling > B db
<=2mm
(o ] > b
L-Coordinate <=2mm
- > 2 db
[l] o ] @ <=2mm
Projection Length 0 db
[l] mm ] <=3mm
T -2 db
¥-Coordinate T <=3mm
[0 mm ] 5 -4 b
Projection Width o §=g";"b1
[l] mm ] <=3mm
- > -8 db
Y-Coordinate - Depth 3
[0 mm ] NETIS
Projection Height = <=3mm
[I] mm ] 0mm 300 mm beil2eh
Color Scale

e File > Print To
Q selection of printer among available for printing out inspection report
0 selection of MS Word® as printer to create inspection report as doc file (IOFFICE SW Package only)
Q selection of paper sheet size either A4 or Letter

e File > Print — prints current postprocessing page

e File > Exit — ends postprocessing session

e View > ISONIC Image Processing — returns to initial postprocessing screen appearing on opening file
e View = Top View Mode —represents Top View C-Scan image as either Amplitude or Distance Map
e View = Zoom — zooms either Top, or Side, or End View image as per operator's selection

e View > Coloring — allows to edit color scale (palette) applied to Top, Side, and End View images
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Measurements - L-Coordinate, Projection Length — generates first vertical cursor that may be

» @

guided over Top and Side View images using either touch screen stylus or mouse or '-—/, = on
front panel keyboard or , on external keyboard; coordinate of the first vertical cursor along Top and
Side View images is indicated in the L-Coordinate field. To fix position of the first vertical cursor left

Enter

mouse click or release touch screen stylus or press + J on front panel keyboard or on
external keyboard. Second vertical cursor appears upon fixing the first one; it may be manipulated by the
same way. Coordinate of the second vertical cursor along Top and Side View images measured
relatively first vertical cursor is indicated in the Projection Length field. Provided that vertical cursors
are placed properly:

o0 L-Coordinate represents distance between left border of scanning area and left defect's end

o0 Projection Length represents appropriate size of defect
To interrupt L-Coordinate and Projection Length measurement procedure at any moment right mouse

ESC
click or press L) on front panel keyboard or on external keyboard

| File v|| Wiew v|| Measurements v|| ROl v|| Filtering v|| Profiling v|
Amplitude Filtration Level: Top View - Depth i
n X =} 12 db
No Filtration . -
<=2mm
Distanse Filtration Level: . . ’ 120 iy
" . <=2mm
No Filtration N
[ < =2mm
Profiling % > B db
< =2mm
(nsa ] > 4db
L-Coordinate <=2mm
= > 2db
[12?__92_mm | 2 =2
Projection Length o mm 200 mm i_DBdb
[l].l] mm ] T Side View >-_2n;nb1
X-Coordinate T —— = <=3mm
(0 mm | — = == > 4 db
- - = = - < =3mm
Projection Width 2 — . Edb
m| File vH Wiew v|| Measuements v|| ROl v|| Filtering v|| Frofiing =
¥-C Amplitude Filtration Level: Top Yiew - Depth <=Tmrm
" - =} > 12db
0n Mo Filtration . -
el <=2mm
[: Distanse Filtration Level: ‘ ’ 120 i
Om i i <=2mrm
No Filtration N
<=2mm
Profiling > B db
<=2mm
[nsa ] % > 4db
L-Coordinate <=2mm
o > 2db
[1 2?_'92_""“ ] @ <=Z2mm
Projection Length o mm 200 mm >_03db
(30.57 mm J « Side View s
X-Coordinate i = = < =3mm
[l] . ] - = e > -4 db
Projsction Width o] S 8 i
[l] mm ] + End Yiew <=3mm
T — > -G db
¥-Coordinate - Depth = _  _
e T <=3mm
0 mm ] = — > 10 db
Projection Height 2 - <=3mm
[l] mm ] omm 300 mm blBdE
Calar Scale
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Measurements > X-Coordinate, Projection Width — generates first horizontal cursor that may be

LIS 4

guided over Top View image using either touch screen stylus or mouse or =, =/ on front panel
keyboard or , on external keyboard; coordinate of the first horizontal cursor along Top View image is
indicated in the X-Coordinate field. To fix position of the first horizontal cursor left mouse click or release
Enter

touch screen stylus or press *=_ on front panel keyboard or on external keyboard. Second
horizontal cursor appears upon fixing first one; it may be manipulated by the same way. Coordinate of
the second horizontal cursor along Top View image measured relatively first horizontal cursor is
indicated in the Projection Width field. Provided that horizontal cursors are placed properly:

o X-Coordinate represents distance between zero line of scanning area and closest defect end

o Projection Width represents appropriate size of defect
Horizontal cursors generated and manipulated over Top View image are accompanied with
synchronous vertical cursors over End View image
To interrupt X-Coordinate and Projection Width measurement procedure at any moment right mouse

ESC
click or press Lj on front panel keyboard or ESC| on external keyboard

| File vH Wiew v|| Measurements v|| ROl v|| Filtering v|| Frofiling =
Amplitude Filtration Level: o Top View - Depth §=112mé'?j
No Filtration . .

<=2mm
Distanse Filtration Level: . . > 10 db
<=2mm

No Filtration N
<=2mm
Profiling > B db
<=2mm
(/A ] b 4o
L-Coordinate [<=2mm
! > 2db
[1 2?_'92_""“ ] ® <=2mm
Projection Length o mm 200 mm >_03db
(30.57 mm J v_ Side View L
¥-Coordinate ” = = <=3mm
[1 00.63 mm ] —— — =, > -4 db
= =  ~rnrn
P":l File vH Wi v|| Measuements v|| ROI v|| Filtering v|| Profiing -
1] . o
Amplitude Filtration Level: o Top View - Depth §_112m£?3
Y-l No Filtration } -
@ <=2mim
o Distanse Filtration Level: ‘ p il
' No Filtration =i
@ > 8db
<=2mm
Profiling % > 6 db
<=2mm
[nsa ] > 4 db
L-Coordinate <=2mm
B > 2db
[1 2?_'92_""" ] @ <=2mm
Projection Length o mm 200 mm > ngb
(3057 mm ] . Side View =
R-Coordinate T == = <=3mm
(10063 mm | - = = > 4 db
Projection Width o e c §=g“;rg
(55.07 mm | o End View <=3mm
A > B db
Y-Coordinate - Depth E_'!:_j | c=3mm
=) ] =
[n mm ] = =] > 10 db
Projection Height 2 - <=3mm
[l] mm ] omm 200 mm b ilgeh
Calar Scale
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Measurements = Y-Coordinate - Depth, Projection Height — generates first horizontal cursor that
may be guided over Side and End View images using either touch screen stylus or mouse or !/

_____ / on front panel keyboard or , on external keyboard; coordinate of the first horizontal cursor along
Side and End View images is indicated in the Y-Coordinate-Depth field. To fix position of the first
Enter |

horizontal cursor left mouse click or release touch screen stylus or press +! _ on front panel keyboard
or on external keyboard. Second horizontal cursor appears upon fixing first one, it may be
manipulated by the same way. Coordinate of the second horizontal cursor along Side and End View
images measured relatively first horizontal cursor is indicated in the Projection Height field. Provided
that horizontal cursors are placed properly:

0 Y-Coordinate - Depth represents depth of defect

o Projection Height represents appropriate size of defect
To interrupt Y-Coordinate - Depth and Projection Height measurement procedure at any moment right

ESC
mouse click or press L) on front panel keyboard or on external keyboard

[ File «|[ Wiew «|[ Measurements +][ ROI +][ Fitering ~][ Prafiling +|
Amplitude Filtration Level: . Top View - Depth §=112m£?3
No Filtration . u
<=2mm
Distanse Filtration Level: . . ’ 120 2
" . <=2mm
No Filtration . & dh
<=2mm
Profiling > B db
<=2mm
(nsa ] b 4db
L-Coordinate <=2mm
g > 2db
[1 2?_'92_""" ] @ <=2mm
Projection Length o mm 200 mm > ngb
30.57 mm | . Side View =
X-Coordinate T === =" < =3mm
100.63 mm | e '—% - b4 db
s = = e = < =3mm
Projection Width 2 — — . 5 db
(55.07 mm ] - End View =3rmm
T m— > -8 db
Y-Coordinate - Depth :":_j — c<3mm
i [ ] S =
[1_95 mm ] e = > 10 db
Pre | Fil;e vH \u'-'ie-w v|| Meazuements v|| ROl v|| Filtering v|| Frofiing =
0.0
Amplitude Filtration Level: . Top View - Depth §=112m£?3
No Filtration . =
<=2mm
Distanse Filtration Level: ‘ . " 120 @
- - < =Zmm
No Filtration . & dh
<=2mm
Profiling > B db
<=2mm
[nsa ] > 4db
L-Coordinate <=22$'3“
o >
[1 2?_'92_""" ] @ <=2mm
Projection Length o mm 200 mm >_03db
[30.57 mm ] . Side View =
R-Coordinate T === — <=3mm
(10063 mm ] —_— = e == > -4db
Proiection Width o SEEES = PR
(55.07 mm | o End View <=3mm
[ m— > -Bdb
Y-Coordinate - Depth — | —
i |t - <=3mm
[1.95 mm ] = > -10 db
Projection Height 2 - <=3mm
LI 12db
0.51 o 300
[ mn ] mn " Calar Scale
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Measurements - Point TOF & Echo Amplitude = Set Points — generates pointing cursor that may
be guided over Top View image using either touch screen stylus or mouse or ' '.' ‘ « on
front panel keyboard or , , , on external keyboard; by means of said pointing cursor representing
probe's central point virtual off-line scanning is performed with recovering of recorded A-Scans, which
are accompanied with appropriate Gate A measurements — refer to paragraph 5.2.13 of this Operating
Manual for measurements legend. To memorize A-Scan related to current cursor pointing cursor for

further printing out release touch screen stylus or left mouse click or press

keyboard or
panel keyboard or on external keyboard

| File v|| Wiew v|| Meazurements v|| ROl v|| Filtering vH Frofiling v‘

Top View - Depth

Enter|on external keyboard. To interrupt virtual off-line scanning press

f N

300

0 mm 300 mm
Side View

1.4

Wl

lf'llv‘---
L

3.3

o+ End Yiew

. — o
s e

3.3

300 mm

o
3
3

Points with memorized A-Scans and measuring results are highlighted by appropriate numbered marks
on Top View image; to preview a point double click on it — this will generate popup box as below:

0 To erase highlighted mark click on

0 To print out individual point report click on

0 To return to main menu operation click on
| File: v|| Wiew v|| Measurements v|| ROl v|| Filtering vH Profiling v‘
Tew - <=1.4mm
- Top View - Depth 15 do
' -~ <=2rnmn
k . b 10db
<=2mm
> 8 db
[ <=2mm
> B db
<=2rmm
> 4 db
Point 1: <=2mm
g L=62.3 mm > 2db
@ X =43.7T mm <=2mm
D=1.7mm > 0db
o mm A= 0.3 db soemm =z
kA > -2 db
= x| 8lE
i = <=3mm
o == == > -4 db
- ;'— = = == <=3mm
lad > B db
T End View <=3rmim
L > -2 db
E.?:_j g <=3mm
e > 10 db
j <=3
L -12db
O mm 200 mm
Color Scale

e Measurements > Point TOF & Echo Amplitude - Remove Last Point — erases last pointed mark

from Top View image

e Measurements 2 Point TOF & Echo Amplitude 2 Remove All Points — erases all marks from Top

View image
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+_J on front panel

ESC

A

<=1.4mm
12 db
<=2rmm
> 10 db
<=2mm
> 8 db
<=2mm
B db
<=2
> 4 db
<=2mm
> 2 db
<=2rmm
> 0db
<=3mm
> -2 db
<=3mm
-4 db
<=3mm
-6 db

<=3mm
-8 db
<=3mm
- -10db

<=3mm
LI 12db

Color Scale




Measurements - Polygon — activates procedure of enveloping of area of interest on Top View image
by polygon, each apex of polygon is appointed through touch screen stylus or left mouse click; last apex

L
Enter

of polygon is appointed through double touch screen stylus or left mouse click or pressing - *=_/ on
front panel keyboard or on external keyboard. To interrupt creating of polygon right mouse click

ESC
or press L) on front panel keyboard or on external keyboard

| File vH Wiew v|| Measurements v|| ROl v|| Filtering v|| Profiling v|
Amplitude Filtration Level: Top View - Depth <=1.4mm
" X =} 12 db
No Filtration . o
< =2mm
Distanse Filtration Level: . . i 120 db
" . <=2mm
No Filtration [
<=2mm
Profiling > B db
<=2mm
(o ] > 4db
L-Coordinate <=2mm
o > 2db
0 mm = A
Pn:l File vH Wiew v|| Measuiements v|| ROI v|| Filtering v|| Prafiing -
0 Amplitude Filtration Level: o Top View - Depth :=112-4d“;"“
»x.r Mo Filtration . -
E [ [
@ Dis b
P No
@ 166.9 18970 g— =
Yo Pro § i | - =]
on [OF 7] :: =]
Prc  |LC .f =] %
@ 0Om o %__
J
Pro | =2
Om| | o o]
- w=F b
oy
CX Lie F o 1
Om - o] P
Fro D=2.0mm o™
o =0.00 =7 b
0 m S=1339 cm’ = : : : :
Y-C 1.40 1.78 26 254 2492 330 [
D, mm
Om Hb
Projection Height - [= I <=3mm
[u mm ] o mm 200 mm > 12 db
Color cale

Provided that polygon is placed properly:

o D represents the average value of informative parameter (amplitude or distance) represented by
colors in the area of polygon

0 © represents dispersion of informative parameter (amplitude or distance) represented by colors
in the area of polygon; statistical distribution is presented by appropriate graph
o S represents area occupied by defect

To printout polygon analysis click on ; to close polygon analysis window click on

ISONIC 2006 from Sonotron NDT - Operating Manual — Revision 1.21 - Page 309 of 480



ROI = ON (ISONIC 2006 instrument) or EDIT = ROI = ON (IOFFICE and MULTIPP SW Packages for
external computer) — generates pointing cursor that may be guided over Top View image using either

touch screen stylus or mouse or ? '.' ‘ , « on front panel keyboard or , , , on
external keyboard; by means said pointing cursor representing probe's central point virtual off-line
scanning is performed with recovering of recorded A-Scans, which are accompanied with appropriate
Gate A measurements — refer to paragraph 5.2.13 of this Operating Manual for measurements legend.

"
Enter

To select reference A-Scan release touch screen stylus or left mouse click or press ' *=_J on front
panel keyboard or Enter on external keyboard — — this generates off-line Gate A controls n n

n u m m allowing to redefine Region Of Interest for MULTISCAN COMBO S imaging.

Upon completing redefining of Region Of Interest click on — this applies new Gate A to all
captured A-Scans and updates Top, Side, and End View images accordingly

| Wiew -H Measurements v|| ROl v|| Filtering -|| Profiling v|

L

Top Yiew - Depth

@ N

200

Top View - Depth

amm 200 mm
Side View

Top Yiew - Depth

0 mm

200 mm

<=1.4mm
> 12 db
<=2
> 10 db
<=2mm
> & db
<=2mm
> Edb
=2
> 4db
<=2mm
> 2db

e =2

<=1.4mm
> 12 db
< =2mm
> 10 db
<=2mm
> 8 db
< =2mm
> Edb
< =2mm
> 4 db
< =2mm
> 2 db
<=2
> 0db
<=3mm
> -2 db

<=1.4mm
> 12 db
<=2
> 10 db
<=2mm
> &db
<=2mm
> Edb

=2
> 4db

m Yiew - Measurements - | ROl v|| Filtering v‘ | F’rofllmg -|
Amplitude Filtration Level: Top View - Depth §=112mé1‘13
Mo Filtration
< =2mm
Distanse Filtration Level: i 120 db
" - <=2mm
Mo Filtration i
<=2mm
Profiling > B db
<=2mm
Lo ] > 4db
L-Coordinate < =2mm
[ g > 2db
o me _ [§ o <=2mm
Projection Length o mm 200 mm Z_Uzdb
[l] mm ] - Side View >__2n;'E
X-Coordinate T = —_— <=2mm
(0 mm ] = = == > 4db
- = — - T— o
Projection Width @ et = — o i—gngilg
[l] mm ] o+ End Yiew <=3mm
- [ — > B db
Y-Coordinate - Depth -_=
= = e <=3mm
0 mm ;‘.’;"'_‘-: — > -10db
Projection Height 2l= - <=3mm
[l] mm ] 0 mm 300 mm >12d
Color Scale
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To interrupt selection of reference of A-Scan right mouse click or press L‘\ on front panel keyboard

or on external keyboard

To interrupt re-adjustment of Region Of Interest after selection of reference of A-Scan click on

ROI = OFF (ISONIC 2006 instrument) or EDIT = ROI 2 OFF (IOFFICE and MULTIPP SW Packages
for external computer) — negates Gate A re-adjustment and returns to originally recorded Top, Side, and
End View images and original Gate A setting

Edit>Change Gain>ON — (IOFFICE and MULTIPP SW Packages for external computer) — generates
pointing cursor that may be guided over Top View image either mouse or I I . .Pon external
keyboard; by means said pointing cursor representing probe's central point virtual off-line scanning is
performed with recovering of recorded A-Scans. To select reference A-Scan left mouse click or press
h-En

ter| — this generates popup window allowing off-line re-adjusting of Gain for all A-Scans captured
during MULTISCAN COMBO S Scanning in £6dB range with £0.1 dB increments through clicking or

ﬂ
pressing and holding on ‘ or pressing , on keyboard
isonicoos

Select Gain Change:

+4.4 dB ﬂ

0K Cancel
bay

During Gain re-adjusting reference A-Scan is modified accordingly. Upon completing re-adjusting Gain

OK
click on or press on keyboard — this applies new Gain value to all captured A-

Scans and updates Top, Side, and End View images accordingly

To interrupt selection of reference of A-Scan right mouse click or press on keyboard

Cancel |
To interrupt re-adjusting of Gain click on or press on keyboard

Edit>Change Gain=>OFF (IOFFICE and MULTIPP SW Packages for external computer)— negates
Gain re-adjustment and returns to originally recorded Top, Side, and End View images and original
Gain setting
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Filtering > Amplitude - Filtering ON — generates amplitude palette bar with sliding cursor, which may
be controlled using either touch screen stylus or mouse or _'_, L on front panel keyboard or , on
external keyboard. Position of sliding cursor on the amplitude palette bar determines Amplitude
Filtration Level, which is appropriately indicated. All elements of Top, Side, and End View images
representing signal amplitude below filtering level are suppressed

ESC
To interrupt filtering procedure right mouse click or press L) on front panel keyboard or on
external keyboard

| File v|| Wiew v|| Meazurements v|| ROl v|| Filtering vH Frofiling v‘
a:\[r;péit;ge Filtration Level: o Top View - Amplitude §=112m5?j

<=2mm

Distanse Filtration Level: > 10 db

No Filtration =2
<=2mm
Profiling > B db
<=2mm
(o ] > b
L-Coordinate [<=2mm
o > 2 db
[l] mm ] 3 <=2rmm
Projection Length o mm 200 mm > 0 db
0 mm J « Side View =
¥-Coordinate ” <=3mm
[u mm ] > -4 db
Projection Width @ P
[l] mm ] + End Yiew <=3mm
) - > -8 db
Y-Coordinate - Depth —5rmm
(0 mm J > 10 dh
Projection Height s <=3mm
[I] mm ] 0 mm 300 mm beiladh
Color Scale

Filtering = Amplitude - Filtering OFF — returns to originally recorded Top, Side, and End View
images

Filtering = Distance = Filtering ON — generates sliding horizontal cursor above Side and End View
images, which may be controlled using either touch screen stylus or mouse or _'_, !_z on front panel
keyboard or , on external keyboard. Position of the sliding horizontal cursor determines Distance

Filtration Level, which is appropriately indicated. All elements of Top, Side, and End View images
related to distances exceeding Distance Filtration Level are suppressed

ESC
To interrupt filtering procedure right mouse click or press L) on front panel keyboard or on
external keyboard

| File v|| Wiew v|| Measurements v|| ROl v|| Filtering v|| Profiling v|
Amplitude Filtration Level: Top View - Depth <=1rmm
" - o > 12db
No Filtration
<=2mm
Distanse Filtration Level: ‘ . ’ 120 @b
<=2mm
< 2.46 mm . e dh
<=2mrm
Profiling > Bdb
<=2mm
[Ell[ ] > 4 db
L-Coordinate <=2mm
o > 2db
[l] m_m _ ] @ <=2mm
Projection Length o mm 200 mm >_03db
0 mm J v_ Side View e
A-Coordinate T <=3mrm
[l] mm ] _— > -4 db
—— - <=3mm
Projection Width . £ db
[l] mm ] T End Yiew <=3mm
¥-Coordi Depth . P
-Coordinate - Deptl ¢ =mm
0 mm > 10 db
Projection Height <=3mm
[l] mm ] omm 300 mm bARGE
Color Scale

Filtering = Distance = Filtering OFF — returns to originally recorded Top, Side, and End View
images
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Profiling = L,X Profiling — generates sliding horizontal and vertical cursors above Top View, which
may be controlled using either touch screen stylus or mouse or !» ! !/ « on front panel
keyboard or , , , on external keyboard . Positions of both sliding cursors are appropriately
indicated in the Profiling box. Horizontal cursor determines sectional cut (vertical slice) represented as
Side View image; vertical cursor determines sectional cut (vertical slice) represented as End View
image

ESC
To interrupt profiling procedure right mouse click or press Lj on front panel keyboard or on
external keyboard

| File v|| Wiew v|| Measurements v|| ROI v|| Filtering v|| Prafiling v|
Amplitude Filtration Level: Top View - Depth =i
. X o > 12db
Mo Filtration . L -
) L L=271.7 mm; X=96.8 mm an
Distanse Filtration Level: 5
: : <=2mm
No Filtration b
[ < =2mm
Profiling > Bdb
<=2mm
[L=271.7 mm, X-96.84 mm | o
L-Coordinate <=2mm
o > 2db
[l] mm ] ! < =2mm
Projection Length O mm 300 mm >_El3db
0 mm ] “ Side View m
¥-Coordinate - — —_ <=3mm
[I] mm ] - S _ —':- — -4 db
—— n =— S <=3
Projection Width a2 ¥ . Edb
[l] mm ] o End View <=3mm
_ T — > -8 db
¥-Coordinate - Depth —_—
e o < =3mim
[0 mm ] S 10 b
Projection Height o= e <=3mm
[l] mm ] O mm 200 mm bzl
Color Scale

Profiling = Y Profiling — generates sliding horizontal cursor above Side and End View images, which

r §

may be controlled using either touch screen stylus or mouse or =/, T on front panel keyboard or ,
on external keyboard. Position of sliding horizontal cursor is appropriately indicated in the Profiling
box. Horizontal cursor determines sectional cut (horizontal slice) represented as Top View image

ESC
To interrupt profiling procedure right mouse click or press Lj on front panel keyboard or on
external keyboard

[ File ~][ iew +][ Measuements ~][ ROI «|[ Fitering +|[ Profiing ~|
Amplitude Filtration Level: Top View - Amplitude <=1rmm
" - =} 12 db
No Filtration
<=2mrm
Distanse Filtration Level: i I ) § 120 do
i i <=2mm
No Filtration N
<=2mm
Profiling > Bdb
[v-1.77 mm ) oz
L-Coordinate < =2mm
= > 2db
[l] m_m _ ] w <=2mrm
Projection Length o mm 200 mm >_03db
0 mm J v_ Side View e
¥-Coordinate T = — =_— <=3mm
[0 mm | — = > ; b
= = = e - < =amnrm
Projection Width o = — . £ db
[l] mm ] - End View <=3mim
) Te— > 8 db
¥-Coordinate - Depth T_J*T PR
L e R =
0 mm il 10 db
Projection Height 2 <=3mm
[l] mm ] omm 300 mm bl
Calor Scale

Profiling - Profiling Off — returns to global Top, Side, and End View images
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9.2. Running MULTISCAN COMBO S CU Mode

9.2.1. Preparations

Ease

Region Width Region Length

Scanning Area (Region)

PRI

For Pulse Echo or Back Wall Echo
Attenuation inspection insert ultrasonic probe
into probe holder then fix single emitter of
airborne ultrasound on the top of probe holder
— refer to paragraph 8.2 of this Operating
Manual

For Through Transmission inspection probes
to be mounted into yoke — refer to paragraph
9.3 of this Operating Manual

Provide cabling according to paragraph 8.4.2
of this Operating Manual

Apply bar with receivers of airborne
ultrasound at parallel to curved side of
rectangle probe manipulation area. Single
emitter and receivers of airborne ultrasound
located on the bar to be equally distanced
from scanning surface level. Distance
between two receivers of airborne ultrasound
(Base) is defined as:

Base = Bg + Pos1 + Pos2

Pos1 and Pos2 are positions of receivers at
left and right side of the bar correspondingly;

Bg is parameter of the bar:

e Bp=200mm/8in for long bar (order
code / part # S 2040 B)

e Bp =100 mm /4 in for short bar (order
code / part # S 86000)

e Exact length of Scanning area
(Region Length) depends on Base
and Curvature Diameter and
calculated automatically

e tmay occur that modifying of
preliminary entered value of Base
will be required — appropriate
correction will be performed by
ISONIC 2006 automatically

it
;f?‘?ﬁ Enter MULTISCAN COMBO S CU mode according to paragraph 8.1 of this
MultiScan Operating Manual
Combo-5 CU

9.2.2. Description Data
Refer to paragraph 9.1.2 of this Operating Manual

9.2.3. Pulser Receiver Settings
Refer to paragraph 9.1.3 of this Operating Manual
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9.2.4. Probe
Refer to paragraph 9.1.4 of this Operating Manual

9.2.5. Inspection Modes and Scanning Parameters

Layout of [[gi]eJ=Iaile]sBST=I8]e] screen depends on option selected — it is necessary to check Pulse Echo or
Attenuation in the Inspection Method field (click on). Attenuation mode is suitable for both back wall echo
attenuation and through-transmission inspection

Ingpection Setup

({p

il /&

Base ‘
T | 300 mm ji
5Scan Index [51]) ‘ Curvature Diameter ‘ FRegion Depth [RD)
13 mm ¥ | 800 mm EI | 1.4
Region Width (RW) A F_ Region Thick (RT)
| 300 mm '| U =il ht | 1.9 mm

Inspection Method: # Pulse Echo ¢ Attenuation

Humber of Colors: 255 | Origin Start | Interval |

1.4 16 1.7 1.9 2.0 22 2.3 2.5 27 2.8 20 3i1 33

Ingpection Setup

Im

S R
Scan Index [51] ‘ Curvature Diameter ‘
13 mm hd | 800 mm j
Region Width (Rw) A F_
300 mm ¥| |1-Pseudol ~

Inspection Method: ¢ Pulse Echo

Number of Colors: 255 | Origin Start | Interval |

N I 2 P

o -40
Exit[4] " Coaise (¢ Medium (" Fine l SlH=CHIESE] l (egdte

In the [[I]eLIqileJaRSTEINN]s) Screen it is necessary to key in:

Q Curvature Diameter, which must reflect outside diameter of object under test

Q Base (distance between two receivers of airborne ultrasound)

Q Region Width, which defines width of rectangular scanning area — refer to paragraph 9.2.1 of this
Operating Manual

Q Scan Index — value of Scan Index defining coverage of scanning area to be selected and entered
according to inspection procedure

Length of curved side of scanning area is defined by 2 parameters - Curvature Diameter and Base

A
Setting of said parameters to be performed through clicking / pressing corresponding spin button ﬂwith
Fine, Medium, or Coarse increments according to checked option (click on) in the Setup Step field

It may occur that reducing of preliminary entered value of Base will be required — the appropriate correction
is performed by ISONIC 2006 instrument automatically — hence it is necessary to monitor value of Base
whist keying in Curvature Diameter and readjust airborne ultrasound receivers on the bar if necessary
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fa—
Alternatively parameter for setting may be selected through pressing ' >\ Jon front panel keyboard or
on external keyboard or through clicking on it's label. Label indicating name of selected parameter changes

T » @

it's fore color from yellow to white — since that moment parameter may be modified using —/, ——/, —

!L, on front panel keyboard or , , , on external keyboard

Values of Region Depth (RT) and Region Thick (RT) reflected on the Inspection Setup screen for pulse
echo mode are defined by Gate A settings of UDS 3-5 Pulser Receiver:
Region Depth (RD) = aStart
Region Thick (RT) = aWidth
Color scale (palette) representing signal amplitudes and defects coordinates may have up to 255 grades. It
*

may be customized using corresponding jcontrolsj (click on)

- b .
- —_—
Humber of Colors: 255 Origin Start: 0.01 mm, 11.91 dB |I Interval: 0.01 mm, 0.09 dB
oo 0.z & 0g 1.1 1.4 16 14 2z il 2T 2.0 2.3

L P L1 M L1 L1 .
_ _:|dEI
1T T T T 1T 1T 11T L L T ]

-2 -10 -12

-
P
=]
.
o
]
=
o]
=
o

Style of palette (Pseudo, Thermal, or Gray) is selectable through clicking :
/

/
2 - Pzeudo 2
Exit [4] - Bae

To return back to XY Scanning Recording and Imaging Menu click on l_J orpress _4 ) or \ X
on front panel keyboard or or on external keyboard

( ESC
To return to previous screen click on M or press L} on front panel keyboard or on

external keyboard

To continue click on M or press LJ on front panel keyboard or on external keyboard

9.2.6. Coupling Monitor (Pulse Echo Mode Only)
Refer to paragraph 9.1.6 of this Operating Manual

9.2.7. Referring Scanning Area (Zero Line)

Curved side of scanning area closest to bar supporting receiver of airborne ultrasound must be defined as
Zero Line in the Probe Location Monitor screen — proceed according to paragraph 9.1.7 of this Operating
Manual

9.2.8. Imaging Principles: Pulse Echo

Refer to paragraph 9.1.8 of this Operating Manual
9.2.9. Imaging Principles: Attenuation
Refer to paragraph 9.1.9 of this Operating Manual
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9.2.10. Scanning: Pulse Echo

Side View - Real Shape image is provided in addition to unfolded Top, Side, and End View images. For
other notes and instructions refer to paragraph 9.1.10 of this Operating Manual

5=139 mm. A=12.0 dB |ISONIC On-Line Imaging

N Top View - Distance
A )
O mm 220 mm
Side View
s g1
[ i
o

Amplitude I Distance Top Section |
Side View - Real Shape I Global Section tL Side End |

< Back (=] < Q Exit
[ESC] [ Save J[ Eleer [20;’3{';'"] 0]

D

9.2.11. Scanning: Attenuation
Refer to paragraph 9.1.11 of this Operating Manual
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9.2.12. Postprocessing

Postprocessing menus for MULTISCAN COMBO S CU records are practically identical to the same related
to MULTISCAN COMBO S records — refer to paragraph 9.1.11 of this Operating Manual. In addition it is

possible to generate Real Shape image for Side View projection

Frimary Infarmation L4 Top View - Depth
ISOMIC Image Processing )

3

Real Shape

_ EndView

100 mm
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9.3. Yokes for Through Transmission Inspection
9.3.1. Short Yoke (0.5 m)

Assembling - Step 1 Assembling - Step 2

= S

Assembling - Step 3 Assembling - Step 4
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Assembling - Step 5 Assembling - Step 6

~—

Assembling - Step 7

Probe Fitting Preparation — 4 X M6 The emitter of airborne ultrasound to be placed above
the center of the emitting or receiving probes, said
probes to be oriented coincidentally

Handling yoke while scanning
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9.3.2. Long Yokes (>0.5m)

Assembling - Step 1 Assembling - Step 2
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Assembling - Step 5 Assembling - Step 6

Assembling - Step 7

Probe Fitting Preparation — 4 X M6 The emitter of airborne ultrasound to be placed above
the center of the emitting or receiving probes, said
probes to be oriented coincidentally

Handling yoke while scanning
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9.4. Running CORROMAP Mode

9.4.1. Preparations

Base

Region YWidth —

(\Reginn Lenigth

Scanning Area (Region)

Region Length = Base

Insert ultrasonic probe into probe
holder then fix single emitter of airborne
ultrasound on the top of probe holder —
refer to paragraph 8.2 of this Operating
Manual. Provide cabling according to
paragraph 8.4.2 of this Operating
Manual

Apply bar with receivers of airborne
ultrasound at parallel to a side of
rectangle probe manipulation area.
Single emitter and receivers of airborne
ultrasound located on the bar to be
equally distanced from scanning
surface level. Distance between two
receivers of airborne ultrasound (Base)
is defined as:

Base = Bg + Pos1 + Pos2

Pos1 and Pos2 are positions of

receivers at left and right side of the bar

correspondingly;

Bo is parameter of the bar:

e Bp=200mm /8 in for long bar
(order code / part # S 2040 B)

e Bp=100mm /4 in for short bar
(order code / part # S 86000)

Ry
[g% Enter CORROMAP mode according to paragraph 8.1 of this Operating Manual

Corromap

9.4.2. Description Data
Refer to paragraph 9.1.2 of this Operating Manual
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9.4.3. Pulser Receiver Settings

UDS53-4 - ISONIC Pulser/Receiver
1 Gain ‘
43 dB

5 Range
oromm K

200 US Velocity
6050 mfs ‘

0.02 Display Delay
883 us

e By | e By | By | 1= By
v dh dh dh b 4

L}
O|:U
X2

o

I
2 Sk s
I By

uns 2-5

Calibration of UDS 3-5 Pulser
Receiver to be provided with
reference to Chapter 5 of this
Operating Manual and tables below
To return to previous screen click on

ESC
Llose | or press _)'(\ on front

panel keyboard or or <Alt>+<C>
on external keyboard
On completing calibration click on

R value:sia) | “-» H|l=|2 IR¥ o I
Cloze m 18.9 mm Freeze Save | Open | Print DG5S or press I I on front panel
keyboard or on external keyboard
# | Parameter or Submenu Required Settings Note
Mode
1 aSwitch GATE A ON
2 Gain BASICS Gain and aThreshold settings to
aThreshold GATE A provide receiving an echo from the
minimal area of thickness degradation to
be detected; height of the said echo to
exceed aThreshold; signals from other
reflectors less then defined one not to
exceed aThreshold
3 DAC/TCG DAC/TCG DAC/TCG settings to meet requirements
of the Inspection Procedure
4 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
5 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing Level, To synchronize with Gain
Firing Level, and Damping settings to provide and aThreshold setting
Damping optimal signal to noise ratio procedure
6 Filter, Frequency RECEIVER Filter and Frequency settings to match | To synchronize with Gain
with probe's frequency and aThreshold setting
procedure
7 Display RECEIVER Display mode may be either Full, RF, The same Display mode to
PosHalf, or NegHalf be used for both Probe
Delay determining and
Thickness Profile Imaging
8 USVelocity BASIC USVelocity setting to be equal to actual
value of ultrasound velocity in the object
under test
9 Probe Delay MEASURE Probe Delay setting to be equal to Probe delay may be
actual probe delay determined according to
paragraph 5.2.13.7 or
5.2.13.9 of this Operating
Manual or similarly
10 | Angle MEASURE Angle = 0°
11 | Meas Mode MEASURE Flank
12 | Range, Display BASIC Range, Display Delay, AStart, and
Delay, AStart, GATE A aWidth settings to be performed with
aWidth reference to the Region of Interest for
CORROMAP table below
13 | Settings for other
parameters and
modes have no
significance
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Region of Interest for CORROMAP

. Scanning Surface

Surface to ROI Distance = SRD

ROl = Region of Interest

ROl Width = R
E;Ek Wall Profile
Initial
Pulze
SRD = aStart
Case 1
—_— RW = aWidth
0
Display Range
" Delay
Initial DisplavDel
ISplaybela .
Pulse SRD = %xUSVelomty
Case 2
-1 RW = aStart + aWidth — SRD
0
Dizplay Range
" Delay
Initial
Pulse SRD = aSta.rt
DisplayDelay .
Case 3 L RW = — 5, xUSVelocity +
0 —
| Display Range + Range — aStart
" Delay
Initial
Pulze
DisplayDela .
SRD = 2iplaybetay USVelocity
Case 4 2
0 RW = Range
Display Range
" Delay
Preferred Initial ¢ aStart and aWidth setting to provide
embodimen Pulse 1t back echo appearance of whole Gate A on the A-Scan
t ¢ aWidth =(0.75...0.95) x Range
¢ First Back Echo at the thickest area of object
under test to be fully matching with Gate A
0 — ¢ First Back Echo at the thickest area of object
Display Range under test to "occupy” 5-10% of the Gate A
" Delay width on the A-Scan
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9.4.4. Probe
Refer to paragraph 9.1.4 of this Operating Manual

9.4.5. Scanning Parameters

Inspection Setup

E m RT
Scan Index [S1]) ‘ Base A Region Depth [RD]
’ 7 mm EI | 220 mm ﬂ ’ 01
Region Width [Rw] ‘ Region Thick [RT]
’ 100 mm ﬂ |1 - Pseudo ! ’ 19.3 mm

Exit [4] o [<Bacx [EsclJ[ Next> J

" Coarse * Medium ¢ Fine

-

"
—

In the AL ileJsMSIEI8]e] SCreen it is necessary to key in:

O Base (distance between two receivers of airborne ultrasound), which defines length of rectangular
scanning area — refer to paragraph 9.4.1 of this Operating Manual

O Region Width, which defines width of rectangular scanning area — refer to paragraph 9.4.1 of this
Operating Manual

O Scan Index — value of Scan Index defining coverage of scanning area to be selected and entered
according to inspection procedure

ﬂ
Setting of said parameters to be performed through clicking / pressing corresponding spin button ¥ with
Fine, Medium, or Coarse increments according to checked option (click on) in the Setup Step field

pa—
Alternatively parameter for setting may be selected through pressing ' =\ Jon front panel keyboard or
on external keyboard or through clicking on its label. Label indicating name of selected parameter changes

T » @

it's fore color from yellow to white — since that moment parameter may be modified using =/, - =, =

!L, on front panel keyboard or , , , on external keyboard

Values of Region Depth (RT) and Region Thick (RT) for pulse echo mode indicated in the Inspection
Setup screen are defined by Gate A settings of UDS 3-5 Pulser Receiver:

Region Depth (RD) = aStart
Region Thick (RT) = aWidth
Style of palette (Pseudo, Thermal, Gray, or Custom) is selectable through clickin:
-~

-
b e
|2 - Pseudo 2 5

_ , _ , l Exit [4] | = }
To return back to XY Scanning Recording and Imaging Menu click on orpress _4 Jor
on front panel keyboard or or on external keyboard

( esc
To return to previous screen click on ij or press L) on front panel keyboard or on

external keyboard

To continue click on M or press LJ on front panel keyboard or |F-g| on external keyboard
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9.4.6. Coupling Monitor

Refer to paragraph 9.1.6 of this Operating Manual

9.4.7. Referring Scanning Area (Zero Line)
Refer to paragraph 9.1.7 of this Operating Manual

#

9.4.8. Imaging Principles
#

Sketch
Basze = Region length

Fero Line
Al B1
e
L2 Scanning Area
L1
1
Y2 < Ci
A____ D __ | ] L
—l\\.E =
N g
vi  FRZ_3 &
[ 1 . 5
fa]
| I N 2
Region Width . "
_______ D ___F C =
— T =, i
E all R £
| | o \\ E
'r:::J N 5
- G E
H
Redion Length
Top Yiew
Zero Line
A /s
I
|
I
I
|
I
. D __—__—_—_C ! C
E F-
End Yiew ~

\\
H G

Side View
0 Q1 (L1, X1, Y1) — Center of the Drill # 1's Bottom Surface
0 Q2(L2, X2, Y2)- Center of the Drill #2's Bottom Surface

Note
General

(&) Volume Under Test
(Region of Interest) is
located between the two
parallel rectangles
namely ABCD and EFGH

(b) Scanning is provided
above surface of
rectangle A1B1C1D1

(c) Lines A1B1 and AB are
parallel to line connecting
receivers of airborne
ultrasound. Position of
lines A1B1 and AB with
respect to said receivers
is defined by setting up
the Zero Line as per
paragraph 9.1.6 of this
Operating Manual

(d) With reference to
screen
— paragraph 9.4.4 of this
Operating Manual:

0 AlA =Region Depth

o AB =Region Length

0 AD = Region Width

o0 DH=Region Thickness

o AI1E = Normal Material
Thickness

(e) Inthe example itis
supposed that there are
two flat bottom drills in
the object under test, said
drills have different
diameters, coordinates
and depths of penetration
into Region of Interest
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## Sketch
2 A Top View B

Side View

End View

Note
Top View, Global Side and End View

Supposing that scanning is well completed
drills bottoms Q1 and Q2 will be detected
and represented in Top View, and global
Side View and End View

Top View is obtained through superimposing
of parallel planes between rectangles ABCD
and EFGH and represents distribution of
minimum thickness above scanning surface

Global Side View and End View are
orthogonal images composed through
superimposing of the corresponding cross
sectional profiles along and across the whole
Region of Interest, said superimposing is
performed by overwriting of high value of
remaining material thickness with lower
value and provides representation of least
remaining thickness values

Acquired data is converted into 3D-matrix
allowing sectional presentation of Side and
End View during scanning — refer to below
sketches ## 3, 4, and 5
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H#Hit Sketch

3
Al %7 B1
X1
Y2 o1
A____ D1 ] '_—I\\B
I
vil  FRZLa
| || -
C \
| | e
o N e s Y
o I i BN
I | T .,
L:;:J \“‘\
"
H G
A Top View B
D C

Side View

End View

Note

Sectional Side and End View (Vertical

Cut Slice)

Sketches ## 3, 4, and 5 illustrate
composing of sectional Side View and End
View

Side View section currently represented on
ISONIC 2006 screen corresponds to
current X-coordinate of probe

End View section currently represented on
ISONIC 2006 screen corresponds to
current L-coordinate of probe
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H##

Al

Top View

Side View

End View

c1

Note

Sectional Side and End View (Vertical

Cut Slice)

Sketches ## 3, 4, and 5 illustrate
composing of sectional Side View and End
View

Side View section currently represented on
ISONIC 2006 screen corresponds to
current X-coordinate of probe

End View section currently represented on
ISONIC 2006 screen corresponds to
current L-coordinate of probe
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H##

Al

Top View

Side View

End View

ci

Note

Sectional Side and End View (Vertical

Cut Slice)

Sketches ## 3, 4, and 5 illustrate
composing of sectional Side View and End
View

Side View section currently represented on
ISONIC 2006 screen corresponds to
current X-coordinate of probe

End View section currently represented on
ISONIC 2006 screen corresponds to
current L-coordinate of probe
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9.4.9. Scanning
During scanning [Sle]N[ege] BMIs [N 11E[lals] screen is accompanied with A-Scan and Digital Display box

.
TTTTTTTTT T rrTTTTTTTr T T T
ISONIC On-Line Imaging
Scanning Pattern - Top Yiew N 7
o — ==0mm
7/ ==2mm
7/ 7 ==3mm
==amm
==Trmm
==8mm
2 ==10mm
T ==11mm
omm 220 mm
_ Side View ==13mm
2 ==15mm
==16mm
=+
2 ==18mm
[ ———— P
b 2 g 2 r ==18mm
: Digital Display :
: E I Global Section | I Side End
“sasssrEsssEEEEEREEEEE snwa”
\\ _ = —
el .
{(Ba"k [ESC] l G J{ Clear [21}{ Zoom In [3] l Bl [‘HJ
7 S

ISONIC On-Line ImagingiEGCERNEINGENEIRT

Q Current Probe Position

Q Current Coupling Status (optionally, provided that coupling monitor is active — refer to paragraph
9.1.7 of this Operating Manual)

Q Top View

Q Side View for Side | pressed down or End View for End |pressed down or press

pa—
1] on front panel keyboard or on external keyboard to switch between Side and End View

_ . . Global | Secti . . _
Depending on which button is pressed — ona or eeHOM | side View and End View

are presented either in global mode according to sketch # 2 — paragraph 9.4.8 of this Operating
Manual or in sectional mode according to sketches ## 3, 4, and 5 — paragraph 9.4.8 of this
Operating Manual

O All A-Scans are captured during scanning unconditionally however projection images Top View, Side
View, and End View are updated only with signals exceeding threshold of Gate A presented on A-Scan
however

0 Minimal thickness is dominant while recording data into Top View

QO Map Repair Function is active while keeping pressed LJ on front panel keyboard or on external
keyboard — new readings will overwrite already recorded data unconditionally; this allows record correction
after finding some non-relevant data recorded with dominance

Digital Display represents thickness D for first signal in the Gate A (measurement mode — Flank)

Q -
To Zoom In ISONIC On-Line Imaging screen click on (28 J or press 3 on front panel keyboard or

B ] ESC
F3 on external keyboard. To Zoom Out click on | Zoom OWt[ESC] | Or press L‘\ on front panel keyboard or
i

on external keyboard
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&
To cleanup Top View, Side View, and End View fields in ISONIC On-Line Imaging screen click on C'BE'IZIJ
F
or press _2__ on front panel keyboard or @ on external keyboard

=]
To save CORROMAP record into a file click on {_32¢_J or press &j on front panel keyboard or on
external keyboard . Refer to paragraph 5.2.17 of this Operating Manual to proceed with file saving

=

=]
To save CORROMAP record into a file click on [_*=_J or press “22=J on front panel keyboard or n
external keyboard . Refer to paragraph 5.2.17 of this Operating Manual to proceed with file saving

o | rFa esc
To return back to XY Scanning Recording and Imaging Menu click on ™ or press _4 Jor L) on
front panel keyboard or or ESc|on external keyboard

[ 1 €sc
To return to previous screen click on l et or press L) on front panel keyboard or on external
keyboard
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9.4.10. Postprocessing

Postprocessing of CORROMAP records may be performed directly in the instrument or in external computer
using IOFFICE or MULTIPP SW package. User interface and operations are practically identical except two

features listed below:

Off-line analysis directly

Off-line analysis in

Off-line analysis in

in ISONIC 2006 external computer using | external computer using
instrument MULTIPP SW Package IOFFICE SW Package
Off-line re-adjustment
of Gain for NO YES YES
CORROMAP record
Automatic creation of
Inspection report in NO YES YES

MS Word® format

Menu Bar Functions on Opening File

ISONIC 2006 Corrosion Mapping

Scanning Pattern - Top Yiew

o

100

ks

o mm

a1

.

220 mm
Side View

19.4

=]

End Yiew

=+
@

C:AhpFilesh] 20064 S0OMIC 2006 Results\Corramap20 mm.i0&

0 mm 100 mm

<=01mm
<=1.71mm
<=3.32mm
<=4 .92mm
<=6.53mm
<=8.14rmm
«=9.75mm
<=11.36mm
«=12.97mm
<=14.57mm
<=16.18mm
<=17.79mm

<=19.4mm

e File 2 Print To

Q selection of printer among available for printing out inspection report
o selection of MS Word® as printer to create inspection report as doc file (IOFFICE SW Package only)
O selection of paper sheet size either A4 or Letter

e File > Print > Whole Report — prints out complete inspection report including UDS 3-5 Pulser
Receiver settings, inspection setup and scanning parameters, recorded maps, and additional data
entered at the appropriate pre-inspection stages as it is described in paragraphs 9.1.2 and 10.1.3 of this

Operating Manual

e File > Print > Graphics Only — prints out scanning recorded maps
e File > Exit — ends postprocessing session

e View > Primary Information — previews UDS 3-5 Pulser Receiver settings, inspection setup and
scanning parameters, and additional data entered at the appropriate pre-inspection stages as it is
described in paragraphs 9.1.2 and 9.1.3 of this Operating Manual

e View = ISONIC Image Processing — activates menu for detailed off-line analysis of the record
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ISONIC Image Processing Menu Bar Functions

| Fil= v|| Wiew v|| Measurements v|| ROl v|| Filtering 'H Prafiling -

Filtration Level: No
Filtration

L-Coordinate

[l].l] mm

Projection Length

[l].l] mm

X-Coordinate

[l].l] mm

Projection Width

Scanning Pattern - Top View

o

100

Filtration Level: No
Filtration

L-Coordinate
[l].l] mm

Projection Length
[l].l] mm

X-Coordinate
[l].l] mm

Projection Width
[l].l] mm

[l].l] mm

Projection Height
[l].l] mm

Y-Coordinate - Depth

a1 100

19.4

Scanning Pattern - Top View

o mm Zz0mm

Side View

.

End Yiew

=]

19.4

0 mm 100 mm

C:AhpFilesh] 20064 S0OMIC 2006 Results\Corramap20 mm.i0&

<=01mm
<=1.71mm
<=3.32mm
<=4.92mm
<=E.53mm
<=8.14rmm
«=9.75mm
<=11.36mm
«=12.97mm
<=14.57mm
<=16.18mm
<=17.79mm

<=19.4mm

e File 2 Print To

Q selection of printer among available for printing out inspection report
o selection of MS Word® as printer to create inspection report as doc file (IOFFICE SW Package only)

O selection of paper sheet size either A4 or Letter

e File = Print — prints current postprocessing page

e File > Exit — ends postprocessing session

e View 2> ISONIC Image Processing — returns to initial postprocessing screen appearing on opening file

e View 2 Zoom Top View —zoom Top View image

e View > Coloring — selection of color scale (palette) style for Top View image
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Measurements - L-Coordinate, Projection Length — generates first vertical cursor that may be

» @

guided over Top and Side View images using either touch screen stylus or mouse or '-—/, = on
front panel keyboard or , on external keyboard; coordinate of the first vertical cursor along Top and
Side View images is indicated in the L-Coordinate field. To fix position of the first vertical cursor left
Enter

mouse click or release touch screen stylus or press + J on front panel keyboard or on
external keyboard. Second vertical cursor appears upon fixing the first one; it may be manipulated by the
same way. Coordinate of the second vertical cursor along Top and Side View images measured
relatively first vertical cursor is indicated in the Projection Length field. Provided that vertical cursors
are placed properly:

0 L-Coordinate represents distance between left border of scanning area and left end of

corrosion damage

o0 Projection Length represents appropriate size of corrosion damage

To interrupt L-Coordinate and Projection Length measurement procedure at any moment right mouse

ESC
click or press L) on front panel keyboard or on external keyboard

| File vH Wiew v|| Measurements v|| ROl v|| Filtering v|| Profiling v|
- - Scanning Pattern - Top Yiew
Filtration Level: No o 9 d <=0mm
Filtration
<=2mrm
L-Coordinate <=3
(124.53 mm ]
Projection Length ¢=mm
[l].l] mm ] <=7mm
X-Coordinate <=Bmm
(0.0 mm ] o <=10mm
o
Projection Width T <=T1mm
0.0 mm ] Omm 220 mm
[ File «|[ Wiew ~][ Measwements ][ ROI +][ Fiteiing ~][ Prafiing +|
¥-C B . —
@ Filtration Level: No = Scanning Pattem - Top View <=Cmm
pro Filtration =3
@ L-Coordinate et
(124.53 mm ]
Projection Length <=5mm
(18.26 mm ] <=Frm
A-Coordinate ¢=Bmm
[l].l] mm ] o <=10mm
a
DMy Projection Width <=11mm
[u_u mm ] 0mm 220 mm
_ Side View <=13mm
¥-Coordinate - Depth e <=15mm
[l].l] i ] <=16mm
Projection Height ; 18
(0.0 mm | . End View e
o <=19mm
T
o
Omm 00 mm
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Measurements > X-Coordinate, Projection Width — generates first horizontal cursor that may be

guided over Top View image using either touch screen stylus or mouse or .!/ !. on front panel
keyboard or , on external keyboard; coordinate of the first horizontal cursor along Top View image is

indicated in the X-Coordinate field. To fix position of the first horizontal cursor left mouse click or release
Enter |

touch screen stylus or press *=_ on front panel keyboard or on external keyboard. Second
horizontal cursor appears upon fixing first one; it may be manipulated by the same way. Coordinate of
the second horizontal cursor along Top View image measured relatively first horizontal cursor is
indicated in the Projection Width field. Provided that horizontal cursors are placed properly:

o0 X-Coordinate represents distance between zero line of scanning area and closest end of

corrosion damage

o Projection Width represents appropriate size of corrosion damage
Horizontal cursors generated and manipulated over Top View image are accompanied with
synchronous vertical cursors over End View image
To interrupt X-Coordinate and Projection Width measurement procedure at any moment right mouse

ESC
click or press LJ on front panel keyboard or ESC| on external keyboard

| File vH Wiew v|| Measurements v|| ROl v|| Filtering v|| Frofiling =
Filtration Level: No o Scanning Patten - Top View <=0mm
Filtration 2
L-Coordinate <<3mm
(124.53 mm ]
Projection Length <=5mmm
(18.26 mm ] <=Tmm
X-Coordinate <=8mm
(77.22 mm ] - <=10mm
o
Projection Width ” e=11mm
[M mm 0mm 220 mm
| File 'H Wiew v|| Measuements v|| ROl v|| Filtering v|| Prafiing v|
¥-C . - e
5 Pattern - Top ¥i
@ Filtration Level: No =) canming Fatiém -, 1 op View <=0rnmm
Pro Filtration <2mm
@ L-Coordinate <<Im
(124.53 mm ]
Projection Length <=Gmrn
(18.26 mm ] <=Tmm
X-Coordinate <=8
[??.22 mm ] o <=10mm
=]
[Dimy Projection Width % P
[22_?3 mm ] 0mm 220 mm
- Side View <=13mm
¥-Coordinate - Depth = <=15mm
[D-D nm ] <=16mm
Projection Height ; "
(0.0 mm J - End View e
o <=19mm
T E
a
Omm 00 mm
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Measurements = Y-Coordinate - Depth, Projection Height — generates first horizontal cursor that

may be guided over Side and End View images using either touch screen stylus or mouse or L

4

_~_/ on front panel keyboard or , on external keyboard; coordinate of the first horizontal cursor along
Side and End View images is indicated in the Y-Coordinate-Depth field. To fix position of the first
Enter |

horizontal cursor left mouse click or release touch screen stylus or press + J on front panel keyboard
or on external keyboard. Second horizontal cursor appears upon fixing first one, it may be
manipulated by the same way. Coordinate of the second horizontal cursor along Side and End View
images measured relatively first horizontal cursor is indicated in the Projection Height field. Provided
that horizontal cursors are placed properly:

o0 Y-Coordinate - Depth represents remaining thickness

o Projection Height represents appropriate depth of corrosion damage
To interrupt Y-Coordinate - Depth and Projection Height measurement procedure at any moment right

ESC
mouse click or press L} on front panel keyboard or on external keyboard

[ File «|[ Wiew «|[ Measurements +][ ROI +][ Fitering ~][ Prafiling +|
) - Scanning Pattern - Top Yiew
Filtration Level: No o 9 d <=0mm
Filtration
<=2mm
L-Coordinate
<=3mm
(124.53 mm ]
Projection Length ¢=mm
(18.26 mm ] <=Tmm
X-Coordinate <=Bmm
(77.22 mm ] o <=10mm
=
Projection Width «=11mm
[22_?3 mm ] 0 mm 220 mm
_ Side View <=13mm
¥-Coordinate - Depth e <=15mm
(14.2 mm
<=16mm

gl File vH Wiew v|| Measuements v|| FTDI v|| Filtering v| Frofiing =
0.0

Scanning Pattern - Top View

Filtration Level: No o <=0mm
Filtration <2
L-Coordinate <mm
(124.53 mm ]
Projection Length <=Gmrn
(18.26 mm ] <=7mm
[r:Aby .
¥-Coordinate <=amm
(77.22 mm ] - <=10mm
o
Projection Width - c=11mm
[22.?8 mm ] omm 220 mm
_ Side View <=13mm
Y-Coordinate - Depth = <=15mm
[14-2 o ] <=16mm
Projection Height ; 18
@ <=18mm
(5.2 mm J - End View
o <=19mm

19.4

0 mm 100 mm
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Measurements - Point — generates pointing cursor that may be guided over Top View image using

either touch screen stylus or mouse or ?_ '.' ? ‘ on front panel keyboard or , , , on
external keyboard; by means of said pointing cursor representing probe's central point virtual off-line
scanning is performed with recovering of recorded A-Scans, which are accompanied with appropriate
Gate A measurements — refer to paragraph 5.2.13 of this Operating Manual for measurements legend.
To memorize A-Scan related to current cursor pointing cursor for further printing out release touch

Ente'r
screen stylus or left mouse click or press ' *=_/ on front panel keyboard or [Enter| on external

ESC
keyboard. To interrupt virtual off-line scanning press L) on front panel keyboard or on external
keyboard

| Fil= v|| Wiew v|| Measurements v|| ROl v|| Filtering 'H Prafiling v‘

o Scanning Pattern - Top View c=Omm

<=2mm
<=3mm
<=8mm
<=7rmm
<=Bmm

<=10mm

D = 14.28 mm H= =200%

100

<=11mm
0mm 220 mm

Side View <=13mm

s <=15mm
<=TEmm

<=18mm
End View

19.4

S <=19mm

TS B |

0 mm 100 mm

Points with memorized A-Scans and measuring results are highlighted by appropriate numbered marks
on Top View image; to preview a point double click on it — this will generate popup box as below:

x|

0 To erase highlighted mark click on

0 To print out individual point report click on
o0 To return to main menu operation click on
| File v|| Wiew v|| Meazurements v|| ROl v|| Filtering vH Frofiling v‘

o Scanning Pattern - Top Yiew O
<=2
<=3mm
<=Bmm
<=Fmm

Point1: <=Brmm

L=135.3 mm _
D=1426mm  H= 520 g X = 84.2 mm «=10m
=11

o D=1428mm | ... <=timm
H=201% <=13mm
2 b4 | =3 | % <=15mm
. ;W <=16mm

<=18mm
- End Yiew
o <=19mm

o
v I ||

0 mm 100 mm

Measurements = Point > Clear Last — erases last pointed mark from Top View image
Measurements - Point > Clear All — erases all marks from Top View image
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Measurements - Polygon — activates procedure of enveloping of area of interest on Top View image
by polygon, each apex of polygon is appointed through touch screen stylus or left mouse click; last apex

L ]
Enter |

of polygon is appointed through double touch screen stylus or left mouse click or pressing - *=_/ on
front panel keyboard or on external keyboard. To interrupt creating of polygon right mouse click

ESC
or press L) on front panel keyboard or on external keyboard

| File vH Wiew v|| Measurements v|| ROl v|| Filtering v|| Profiling v|

Filtration Level: No o Scanning Pattern - Top View <=0mm
Filtration

<=2mm
L-Coordinate

<=3mm
(124.53 mm ]

<=Bmm

Projection Length
(1826 mm ] | <=7rm

X-Coordinate <=Bmm
[77.22 mm ] o <=10mm
2
Proiection Width

<=11mm

@ File || “iew = | Measuements v|| ROl v|| Filtering v|| Profiing v|
) - Scanning Pattern - Top View
¥-C Filtration Level: No =} 9 p l<=Umm
[E Filtration | | =2mm
Pro L-Ci | X
=3
| 1536 1710 2 [FSmm
Proj 5 @ A
182 = 2 =7 rmm
XL 2 pmm
i =] % E10mm
wl
Plﬂi sz =11 mm
DMy | 225 L1 3mm
™~ =
Y-C o =15mm
14. - =8
m— D=14.4mm .:. N 1B
@ o =053 =] L18mm
- §=285cm’ =) - - - = 19
04 4.0 7.8 1.7 15.5 194 [0
D, mm
S W] ]
a
omm 100 mm

Provided that polygon is placed properly:
o D represents average remaining thickness represented by colors in the area of polygon

0 © represents dispersion of remaining thickness represented by colors in the area of polygon;
statistical distribution is presented by appropriate graph

o S represents area occupied by corrosion damage

To printout polygon analysis click on ; to close polygon analysis window click on

ISONIC 2006 from Sonotron NDT - Operating Manual — Revision 1.21 - Page 340 of 480



ROI = ON (ISONIC 2006 instrument) or EDIT = ROI = ON (IOFFICE and MULTIPP SW Packages for
external computer) — generates pointing cursor that may be guided over Top View image using either

touch screen stylus or mouse or ?_ '.' ? « on front panel keyboard or , , , on

external keyboard; by means said pointing cursor representing probe's central point virtual off-line
scanning is performed with recovering of recorded A-Scans, which are accompanied with appropriate
Gate A measurements — refer to paragraph 5.2.13 of this Operating Manual for measurements legend.

"
Enter

To select reference A-Scan release touch screen stylus or left mouse click or press ' *=_J on front

panel keyboard or [Enter| on external keyboard — — this generates off-line Gate A controls n n

n, u m m allowing to redefine Region Of Interest for CORROMAP imaging. Upon

completing redefining of Region Of Interest click on — this applies new Gate A to all captured A-
Scans and updates Top, Side, and End View images accordingly
| Wiew -H M eazuraments v|| ROI v|| Filtering -|| Prafiling v|

o Scanning Pattern - Top View <=Oram

<=2mm
<=3mm

<=Bmm

| ¢ <=Fmm
fiftpc et il g <=Bmm
<=100
mm  H=158% 2 i

Yiew -|| Measurements - | ROl v|| Filtering 'H Profiling -|
o Scanning Pattern - Top View <O
<=2mm
<=3
<=0mm
| | <=7mm
<=Bmm
o <=10mm
2
<=11mm
0 mm 220mm
_ Side View <=13mm
= F15mm
| g v|| Measuements -|| ROl -|| Filtering -|| Profiling v| [
. - F1Bmm
. . Scanning Pattern - Top View
Filtration Level: No o 9 L <=0mm |
" N F18mm
Filtration
<=2 L1g
L-Coordinate [
o
o <=d4mm
Projection Length
X-Coordinate <=

100

Projection Width % <=10mm
- Side View <=12mm
Y-Coordinate - Depth = <=13mm
5
Projection Height :

- <=16mm

. End View
o <=17mm

17.4

amm 100 mm

ESC
To interrupt selection of reference of A-Scan right mouse click or press L) on front panel keyboard

or on external keyboard

To interrupt re-adjustment of Region Of Interest after selection of reference of A-Scan click on .

ROI > OFF (ISONIC 2006 instrument) or EDIT = ROI 2 OFF (IOFFICE and MULTIPP SW Packages
for external computer) — negates Gate A re-adjustment and returns to originally recorded Top, Side, and
End View images and original Gate A setting
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Edit>Change Gain>0ON — (IOFFICE and MULTIPP SW Packages for external computer) — generates
pointing cursor that may be guided over Top View image either mouse or , , , on external
keyboard; by means said pointing cursor representing probe's central point virtual off-line scanning is
performed with recovering of recorded A-Scans. To select reference A-Scan left mouse click or press

— this generates popup window allowing off-line re-adjusting of Gain for all A-Scans captured

during CORROMAP Scanning in £6dB range with £0.1 dB increments through clicking or pressing and

ﬂ
holding on ‘r or pressing , on keyboard
isonicoos

Select Gain Change:

+4.4 dB il

0K Cancel

ke

During Gain re-adjusting reference A-Scan is modified accordingly. Upon completing re-adjusting Gain

]9
click on or press on keyboard — this applies new Gain value to all captured A-

Scans and updates Top, Side, and End View images accordingly

To interrupt selection of reference of A-Scan right mouse click or press on keyboard

Cancel
To interrupt re-adjusting of Gain click on or press on keyboard

Edit>Change Gain>OFF (IOFFICE and MULTIPP SW Packages for external computer)— negates
Gain re-adjustment and returns to originally recorded Top, Side, and End View images and original
Gain setting
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e Filtering > ON — generates sliding horizontal cursor above Side and End View images, which may be

r §

controlled using either touch screen stylus or mouse or =/, ' T / on front panel keyboard or , on
external keyboard. Position of the sliding horizontal cursor determines Distance Filtration Level, which
is appropriately indicated. All elements of Top, Side, and End View images related to distances
exceeding Distance Filtration Level are suppressed

ESC
To interrupt filtering procedure right mouse click or press L) on front panel keyboard or on
external keyboard

[ File ~][ iew +][ Measuements ~][ ROI «|[ Fitering +|[ Profiing ~|
- . 5 ing Patt - Top Vi
Filtration Level: < 16.06 mm o g een -, Op Fiow <=0mm
<=2mm
L-Coordinate =i
[l].l] mm ]
Projection Length <=5mm
[l].l] mm ] | <=7mm
X-Coordinate <=Bmm
[l].l] mm ] a <=T10mm
=]
Projection Width <=11mm
[u_u mm ] amm 220 mm
_ Side View <=13mm
Y-Coordinate - Depth - <=15mm
[l].l] mm <=1Bmm
Projection Height ;
[l] 0 mm ] - <=18mm
<=T19mm

0mm 100 mm

e Filtering > OFF — returns to originally recorded Top, Side, and End View images
e Profiling = ON — generates sliding horizontal and vertical cursors above Top View, which may be

controlled using either touch screen stylus or mouse or =, ' T S, = on front panel keyboard
or , , , on external keyboard. Positions of both sliding cursors are appropriately indicated in the
Profiling box. Horizontal cursor determines sectional cut (vertical slice) represented as Side View
image; vertical cursor determines sectional cut (vertical slice) represented as End View image

ESC
To interrupt profiling procedure right mouse click or press L) on front panel keyboard or on
external keyboard

[ File ~][ iew +][ Measuements ~][ ROI «|[ Fitering +|[ Profiing ~|
Filiration Level: No o Scanning Pattern - Top Yiew c=0mm
Filtration
<=2mm
L-Coordinate c<Imm
[l].l] mm ]
Projection Length €=5mm
[l].l] mm ] | <=7mm
- <=8mrm
#-Coordinate L=137.0 mm; X=81.1 mm
[l].l] mm ] <=T10mm
Projection Width <=1Tmm
[l].l] mm ] omm 220 mm
_ Side View <=T13mm
¥-Coordinate - Depth = <=15mm
[l].l] MM ] <=1Bmm
Projection Height ; L= == &= 440000 0 | 18
(0.0 mm ] - End View e
o <=T19mm
T
]
Omm 100 mm

e Profiling > OFF —returns to global Top, Side, and End View images
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9.5. Running CORROMAP CU Mode
9.5.1. Preparations

Base

Redion Lencth

Scanning Area (Region)

Corromap CU

Insert ultrasonic probe into probe holder then
fix single emitter of airborne ultrasound on the
top of probe holder — refer to paragraph 8.2 of
this Operating Manual. Provide cabling
according to paragraph 8.4.2 of this Operating
Manual

Apply bar with receivers of airborne
ultrasound at parallel to curved side of
rectangle probe manipulation area. Single
emitter and receivers of airborne ultrasound
located on the bar to be equally distanced
from scanning surface level. Distance
between two receivers of airborne ultrasound
(Base) is defined as:

Base = Bg + Pos1 + Pos?2

Pos1 and Pos2 are positions of receivers at
left and right side of the bar correspondingly;

By is parameter of the bar:

e Bp=200mm/8in for long bar (order
code / part # S 2040 B)

e Bp=100 mm /4 in for short bar (order
code / part # S 86000)

e Exact length of Scanning area
(Region Length) is defined on
Base and Curvature Diameter and
calculated automatically

e It may occur that reducing of
preliminary entered value of Base
will be required — the appropriate
indication will be generated by
ISONIC 2006 — refer to paragraph
9.2.5 below

RD
[ [%I Enter CORROMAP CU mode according to paragraph 8.1 of this Operating Manual

9.5.2. Description Data
Refer to paragraph 9.1.2 of this Operating Manual

9.5.3. Pulser Receiver Settings
Refer to paragraph 9.1.3 of this Operating Manual
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9.5.4. Probe
Refer to paragraph 9.1.4 of this Operating Manual
9.5.5. Scanning Parameters

Inzpection S5etup

.
[ T
Scan Index (S1) ‘ Curvature Diameter A Region Deplh (RD])
¥ ' 205 mm hi
Region Width [RW) Region Thick (RT)
100 mm Y [1- Pseudo [ | 19.3 mm

4 Setup Step ( ANl
Exit [4] = 5 l < Back [ESC] { Hext >
r

" Coarse (% Medium ¢ Fine

S

In the AL ieJsMSIEI8]e] SCreen it is necessary to key in:

a Curvature Diameter, which must reflect outside diameter of object under test

O Base (distance between two receivers of airborne ultrasound)

O Region Width, which defines width of rectangular scanning area — refer to paragraph 9.5.1 of this
Operating Manual

O Scan Index — value of Scan Index defining coverage of scanning area to be selected and entered
according to inspection procedure

Unfolded length of curved side of scanning area is defined by 2 parameters - Curvature Diameter and Base

A
Setting of said parameters to be performed through clicking / pressing corresponding spin button ﬂwith
Fine, Medium, or Coarse increments according to checked option (click on) in the Setup Step field

fa—
Alternatively parameter for setting may be selected through pressing ' —*\ Jon front panel keyboard or
on external keyboard or through clicking on its label. Label indicating name of selected parameter changes

T » @&

it's fore color from yellow to white — since that moment parameter may be modified using —~/, ' =/, =/,

4

¥ on front panel keyboard or 1}, , , on external keyboard

Values of Region Depth (RT) and Region Thick (RT) for pulse echo mode indicated in the Inspection
Setup screen are defined by Gate A settings of UDS 3-5 Pulser Receiver:

Region Depth (RD) = aStart
Region Thick (RT) = aWidth

Style of palette (Pseudo, Thermal, Gray, or Custom) is selectable through clickin:
-~

-
b e
|2 - Pseudo 2 ;

, , , , I Exit [4] | o }
To return back to XY Scanning Recording and Imaging Menu click on orpress _4 Jor
on front panel keyboard or -4 or on external keyboard

( ESC
To return to previous screen click on M or press LJ on front panel keyboard or on

external keyboard

To continue click on M or press LJ on front panel keyboard or on external keyboard
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9.5.6. Coupling Monitor
Refer to paragraph 9.1.6 of this Operating Manual

9.5.7. Referring Scanning Area (Zero Line)
Refer to paragraph 9.1.7 of this Operating Manual

9.5.8. Imaging Principles

Refer to paragraph 9.4.8 of this Operating Manual

9.5.9. Scanning

Side View - Real Shape image is provided in addition to unfolded Top, Side, and End View images. For
other notes and instructions refer to paragraph 9.5.9 of this Operating Manual

D=15.19 mm ISONIC On-Line Imaging
<=2 A-Scan Scanning Pattern® Top Yiew
= o
7
g
/ O mm 220 mm

- Side View
/ o
/ -
/ <=19rmm =

- Side View - Real Shapei I Global Section | Side End
: ’ i t 3 Q
< Back _
Clear Zoom In Exit [4]
|
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9.5.10. Postprocessing

Postprocessing menus for CORROMAP CU records are practically identical to the same related to
CORROMAP records — refer to paragraph 9.4.10 of this Operating Manual. In addition it is possible to
generate Real Shape image for Side View projection

Primary Infarmation L Scanning Pattern - Top View <=Trm
ISOMIC Image Processing e ‘ a

<=2mm

Feal Shane
| ¢

bas -
-

Scanning Pattern - Top View <=0mm

<=2mm
<=3mm
<=5mm
<=7mm

<=Bmm

<=10mm

<=11mm
220 mm
<=13mm

<=15mm

o
- . <=16mm
=
2 <=18mm
- End View

o <=19mm

(DR [T}
T
a@

0 mm 100 mm
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10. XY Scanning and Recording for Angle
Beam Weld Inspection
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10.1. Running I12-SONIC Mode — Inspection of Planar Butt
Welds — Scanning from One Side

10.1.1. Preparations

Insert ultrasonic probe into probe holder and fix single or double emitter of airborne ultrasound on the top of
probe holder — refer to paragraph 8.2 of this Operating Manual. Provide cabling according to paragraph 8.4.2
of this Operating Manual

| Base | Apply bar with receivers of airborne
ultrasound at parallel to the weld:
scanning area and bar to be situated at
opposite sides of the weld. Single

Pus? Weld emitter or top element of double emitter
0s ® and receivers of airborne ultrasound

| - located on the bar to be equally
distanced from scanning surface level
Weld Length Distance between two receivers of
Base airborne ultrasound (Base) is defined
— as:
/ Base = Bg + Pos1 + Pos2

Scanning Area
- Pos1 and Pos2 are positions of
receivers at left and right side of the bar
correspondingly;
Bg is parameter of the bar. Long bar
(order code / part # S 2040 B) to be
used for 12-SONIC mode: Bg = 200 mm
/8in

Base defines length of weld section, for which scanning and recording will be performed
Weld Length = Base

Enter 12-SONIC mode according to paragraph 8.1 of this Operating Manual
12-SONIC

10.1.2. Description Data
Refer to paragraph 9.1.2 of this Operating Manual

ISONIC 2006 from Sonotron NDT - Operating Manual — Revision 1.21 - Page 349 of 480



10.1.3. Pulser Receiver Settings

Calibration of UDS 3-5 Pulser Receiver to be provided with reference to Chapter 5 of this Operating Manual
and table below

UDS53-4 - ISONIC Pulser/Receiver DG5S active [MWB-60-4 1.5 mm FEH)
1 Gain
v «
5 Range
oo K
50 US Yelocit
32_50 m,-'sy ‘
20 Display Dela:
5_1p3yus_ ” ‘
5 Beject
vl ¢
uns 2-5

&

FPrint

e By | e By | By | 1= By
v dh dh dh b 4

I By

BASICS
GATE B

PULSER RECEIVER GATE A Menu
ALARM DAC/TCG  MEASURE Selection

~u

=
Open

e
DGS

Save

Cloze Freeze

ESC
To return to previous screen click on &' or press L‘\ on front panel keyboard or or

<Alt>+<C> on external keyboard

I
On completing calibration click on or press LJ on front panel keyboard or on external
keyboard
# | Parameter or Submenu Required Settings Note
Mode
1 Gain BASICS Gain setting to be performed according
to inspection procedure providing
required echo heights from defects to be
detected
2 DAC/TCG DAC/TCG DAC/TCG settings to meet requirements
of inspection procedure
3 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
4 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing Level, To synchronize with Gain
Firing Level, and Damping settings to provide setting procedure
Damping optimal signal to noise ratio
5 Filter, Frequency RECEIVER Filter and Frequency settings to match | To synchronize with Gain
with probe's frequency setting procedure
6 Display RECEIVER Display setting may be either Full, RF, The same Display mode to
PosHalf, or NegHalf be used for both Probe
Delay determining and t-
ABIScan / ABIScan
Recording
7 USVelocity BASIC USVelocity setting to be equal to actual
value of ultrasound velocity in the object
under test
8 Probe Delay MEASURE Probe Delay setting to be equal to Probe delay may be
actual probe delay determined according to
paragraph 5.2.13.5 or
5.2.13.6 or 5.2.13.9 of this
Operating Manual or
similarly
9 Angle MEASURE Angle setting to be equal to actual
probe angle
10 | Settings for other
parameters and
modes have no
significance
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10.1.4. Probe
In the screen it is necessary to select probe from database through clic

-
Select Probe: -
MWB-60-4 A
OR

to key in name of new probe to be used

Probe

Probe: Select Probe:
MWBE0-4 -
Probe Delay A

bi13ps ¥

Angle [A) ‘ ‘
_ 60deg ¥ 13mm ¥

Exit [4]

" Coarse {* Medium (" Fine

L=l el s Jls - Jla = D -101]
Lofiwlef[ri[vil¥fluftilofr[c][s]
[afls|lofleflelnjlajlrilc]l:]["]

IS (2 [~ ][ [ [T e ] L T [Enter]

I |

It is necessary to key in or confirm:

Q Probe Delay - value of Probe Delay is imported from settings of UDS 3-5 Pulser Receiver or from
probes database, it may be corrected if necessary. Value of probe delay confirmed in the
screen is dominant and will be used for automatic measurements and imaging whilst scanning

a Angle —incidence angle to be entered or imported from probes data base or from settings of UDS 3-
5 Pulser Receiver

a X-value —to be entered or imported from probes data base

A
Setting of said parameters to be performed through clicking / pressing corresponding spin button ﬂwith
Fine, Medium, or Coarse increments according to checked option (click on) in the Setup Step field

pa—
Alternatively parameter for setting may be selected through pressing ' =\ Jon front panel keyboard or
on external keyboard or through clicking on its label. Label indicating name of selected parameter changes

t» .

it's fore color from yellow to white — since that moment parameter may be modified using —-/, ' —/

_'.'_/I on front panel keyboard or , , , on external keyboard

_ _ _ _ l Exit [4] < B ]
To return back to XY Scanning Recording and Imaging Menu click on orpress _4 Jor -
on front panel keyboard or or on external keyboard

( ESC
To return to previous screen click on M or press L) on front panel keyboard or on

external keyboard

To continue click on M or press LJ on front panel keyboard or on external keyboard - this
will enter next stage related to defining inspection mode and scanning parameters
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10.1.5. Scanning Parameters

Inspection Setup

Scan Index [S1) |1 Pseudo |
7 mm
Huut

| I:‘E [ Scan Above Top of Weld
|- MultiE cho
’ 20 mm j | 30 mm l_ Normalize To Dac

Exit [4] { < Back [ESC] { Mext =

(" Coarse (* Medium ¢ Fine

3

"

In the [l =) screen it is necessary to key in:

Q Base - distance between two receivers of airborne ultrasound, which defines length of weld
section, for which scanning and recording will be performed
Q Skip # — defines cross-sectional insonification scheme; Skip # setting to be according to inspection

procedure
Q Scan Index — defines coverage of scanning area — to be selected and entered according to

inspection procedure
Q Weld Thick — thickness of parent material
a Weld Width — depending on inspection procedure value of Weld Width must cover weld metal

width either with or without heat affected zone

A
Setting of said parameters to be performed through clicking / pressing corresponding spin button ﬂwith
Fine, Medium, or Coarse increments according to checked option (click on) in the Setup Step field

fa—
Alternatively parameter for setting may be selected through pressing ' = Jon front panel keyboard or
on external keyboard or through clicking on its label. Label indicating name of selected parameter changes

Tt » @&

it's fore color from yellow to white — since that moment parameter may be modified using =/, ' =, ./,

_'!;, on front panel keyboard or , , , on external keyboard

If scanning above machined weld cap is required — check Scan Above Top of Weld — refer also to
paragraph 10.1.9.3 of this Operating Manual

ISONIC 2006 from Sonotron NDT - Operating Manual — Revision 1.21 - Page 352 of 480



Imaging options:

|
O Root signals imaging to be activated/negated through click on {L
a Multiecho or SAFT imaging protocol to be activated/negated trough check/don't check Multiecho
option
O Normalize to DAC — echo amplitude color palette may be normalized either to DAC/DGS (check
option) or to 50% of A-Scan height level (don't check option) — refer also to paragraph 10.1.9.2 of
this Operating Manual

Style of palette (Pseudo, Thermal, Gray, or Custom) is selectable through clicking lonl:

|2 - Pzeudo 2 v|

(r— >~ ESC
. , . . l Exit [4] | e !
To return back to XY Scanning Recording and Imaging Menu click on orpress _4 Jor
on front panel keyboard or or on external keyboard

( ESC
To return to previous screen click on M or press Lj on front panel keyboard or on

external keyboard
To continue click on M or press LJ on front panel keyboard or on external keyboard
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10.1.6. Coupling Monitor
In the screen activation of

coupling monitor to be performed through setting of Coupling Monitor |
Reference Signal Excitation Level

Setting of Reference Signal Excitation Level may Reference Signal Excitation Level ‘ ( i
be performed through clicking / pressing its spin 14 % A
fl .
button T or through pressing .!; !, f
!. on front panel keyboard or , , , on

external keyboard

To setup coupling monitor proceed as below:

Q apply emitter of acoustic coupling monitor signal
and probe with probe holder equipped with
emitter of airborne ultrasound to object under
test using excessive quantity of couplant

a find threshold of Reference Signal Excitation
Level, which is perceptible trough changing
color of horizontal bar indicator (red color means

insufficient coupling or still low level of # ~..,
excitation) and audible alarm (if active) Coupling Monitor OFF
0 add 3% to 7% to found threshold value “ o

3 N
Exit [4] l < Back [ESC] L Mext > J
"

]
» or set 0% for Reference Signal

Coupling Monitor OFF

To switch coupling monitor OFF click on l
Excitation Level

To switch ON / OFF audible alarm for insufficient coupling click on { i )

®

If dimensions of object under test and / or its surface conditions don't allow reaching sufficient coupling
indication even if value of Reference Signal Excitation Level is set to 100% then two or more emitters of
acoustic coupling monitor signal must be connected to Out Cpl socket of ISONIC via appropriate splitter SE
20220

. : : : | Exit [4] 7 ).\ )
To return back to XY Scanning Recording and Imaging Menu click on orpress _% Jor
on front panel keyboard or or on external keyboard

( ESC
To return to previous screen click on M or press L) on front panel keyboard or on

external keyboard .
To continue click on M or press LJ on front panel keyboard or on external keyboard
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10.1.7. Referring Scanning Area

Place probe equipped with emitter of airborne ultrasound into scanning area according to sketch generated
in the [gfe]of-YMeJet-1ife]gW\Y/[e]oli{e]§ SCreen then:

Adjust to X-Value (XV) J

click on [

OR

select[ Adiustto X-Value (V) Jusing !_, : ¥ or ]on front panel keyboard or 1}, . .
Enfe.r |

or [F7| on external keyboard then press ' *=_ on front panel keyboard or on external keyboard

Probe Location Monitor
X-coordinate
91 mm

{ Adjust to X-Value (XV)

Probe Location Monitor

r N X-coordinate
B ) 13 mm

L Adjust to X-Value (XV) J

- “\ - .
Exit [4] l < Back [ESC] J l Mext > J

| Exitpa >
To return back to XY Scanning Recording and Imaging Menu click on lx_“J orpress _4 Jor L)
on front panel keyboard or or on external keyboard

( esc
To return to previous screen click on ij or press L) on front panel keyboard or on

external keyboard

To continue click on M or press LJ on front panel keyboard or |F-g| on external keyboard
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10.1.8. Probe Swiveling Monitor

In (e ERSIVE el e]alife]§ screen it is necessary to activate/negate probe swiveling monitor through click
on appropriate button. Double emitter of airborne ultrasound S 4050 is necessary to monitor probe swiveling
angle

Probe Sviweling Monitor

Swiveling Monitor Status

ON

Check Probe Swiveling

Don't Check Probe Swiveling

e/ S/

¥50
¥<0 wi Swiveling Angle, deg
7 -5 deg
Limit for Probe
TQY Swiveling Angle, deg
o + 1b deg ‘

P N ¢ P
[ Exit [4] l < Back [ESC] J { HNext =
J - |

If Probe Swiveling Monitor is active then it is necessary to set Limit for Probe Swiveling Angle in

ﬂ
accordance with inspection procedure trough clicking / pressing its spin button ¥ or through pressing L
:-, : L on front panel keyboard or T, , , on external keyboard

| Exitpa A o3
To return back to XY Scanning Recording and Imaging Menu click on i orpress _4 Jor - <

on front panel keyboard or or on external keyboard

( ESC
To return to previous screen click on M or press L) on front panel keyboard or on

external keyboard

To continue click on M or press LJ on front panel keyboard or on external keyboard
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10.1.9. Imaging Principles

10.1.9.1. Scanning Plan and Projection Images of Weld Volume

Top View

Scanning Pattern

=

Scanning Pattern

Testing Integrity - Coverage

Scanning Plan

IARRRRRR

U

Side View 150 Top Yiew
. -
| 5.0
f— 0 mm Side View 220 o —
End View 0 ' ' I I I I
a0 ]
End View
Projection Images of Defect 0]
150 450

Q Background Images are generated for:
0 Scanning Plan
o0 Top View
0 Side View
o End View
said images are stipulated by Weld Thickness, Weld Width, Scan Index, Skip#, and Probe Angle

O Actually Performed Probe Trace is imaged in real time above Scanning Plan in the Scanning Pattern
area. If Coupling Monitor and/or Probe Swiveling Monitor are/is active then image of Actually
Performed Probe Trace is updated by condition of sufficient coupling and/or swiveling angle; said
image represents Testing Integrity

o Defects Projection Images are generated in 3 planes — Top, Side, and End View — through on-line

correlating between received echoes, probe coordinates, swiveling angle (optionally), and coupling
degree (optionally)
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10.1.9.2. Echo Amplitude Palette

Echo amplitude is represented by color of corresponding segment of defect image in Top, Side, End View;
there are 13 color grades covering 24 dB range with 2 dB increment according to protocol selected by
operator. There are 3 protocols available:

B Standard Level Normalizing (in the [[foJqile]aBSIei¥]e] Screen uncheck Normalize to DAC
option) — dB rate of echo height is determined through relation to 50% A-Scan Height level:

ight .9
Color _Grade =6+ |n»{%x [20)( Log, Echo _ Height, /Oﬂ

50%

100%

Echo
Height

+ 4+ o+ + o+ o+ o+

+
¥
+
+
+
+
1-.
+
+

o+ + o+ + + F o+ o+
+ o+ 4+ o+ + F o+ o+

Hormalization Level (50°%)

Color Grade Echo Height (EH) in % of the Color /dB
A-Scan Screen Height
0 EH<125% -12
1 125% <EH<15.8 % -10
2 15.8 % < EH < 19.9 % -8
3 19.9 % < EH < 25.0 % -6
4 25.0 % < EH < 31.5 % -4
5 315%<EH<39.7% -2
6 39.7 % < EH < 50.0 % 0
7 50.0 % < EH < 62.9 % 2
8 62.9 % < EH <79.2 % 4
9 79.2 % < EH < 100.0 % 6
10 100.0 % < EH < 125.6 % 8
11 125.6 % < EH < 158.1 % 10
12 158.1 % < EH 12
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Standard Level TCG Normalizing (in the [l eIl ile]sBST=1l8]s] screen uncheck Normalize to DAC
option) — dB rate of TCG-normalized echo height is determined through relation to 50% A-Scan
Height level:

i 0,
Color _Grade =6+ IntEx (ZOx Log,, Echo_ Height, A)H

50%

+ o+
¥+
+ o+
+ +
+ o+
+ o+
+ o+
+ o+
+ o+

Hormalization Level (50%)
Recommended TCG Setup Level

Color Index Echo Height (EH) in % of the Color /dB
A-Scan Screen Height
0 EH <12.5% -12
1 12.5 % < EH < 15.8 % -10
2 15.8% <EH <19.9 % -8
3 19.9% <EH < 25.0% -6
4 25.0% <EH < 31.5% -4
5 31.5% <EH<39.7% -2
6 39.7 % < EH < 50.0 % 0
7 50.0 % < EH < 62.9 % 2
8 62.9% <EH<79.2% 4
9 79.2 % < EH < 100.0 % 6
10 100.0 % < EH < 125.6 % 8
11 125.6 % < EH < 158.1 % 10
12 158.1 % < EH 12

®

TCG to be active — refer to paragraph 10.1.3 of this Operating Manual
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B DAC/DGS Normalizing (in the [[iJ=Iaile]sBST=I¥]e] screen check Normalize to DAC option) — dB
rate of echo height is determined through relation to corresponding DAC/DGS level

ight .o
Color _Grade =6+ Int[%x (20x Log, Echo _ Height,% ﬂ

DAC/DGS _ Level,%

EH#
DACH?

DACH

100%

+ 4+ T+ +

EH#2

+
+
+
+
+
+
+
+

i+

B A N N
4+ + o+ A 4+ [+ |+
++ &+ o+ o+ [+ |+

B G S - S o

EH# - Echo Height #1
DACH - DAC Level Corresponding to the Echo #1
EH#2 - Echo Height # 2
DACH? - DAC Level Correzponding to the Echo # 2

Color Index Echo Height (EH) with Color /dB
respect to the
Corresponding DAC Level
0 EH/DAC < 0.250 -12
1 0.250 < EH/DAC < 0.316 -10
2 0.316 < EH/DAC < 0.398 -8
3 0.398 < EH/DAC < 0.500 -6
4 0.500 < EH/DAC < 0.630 -4
5 0.630 < EH/DAC < 0.794 -2
6 0.794 < EH/DAC < 1.000 0
7 1.000 < EH/DAC < 1.258 2
8 1.258 < EH/DAC < 1.584 4
9 1.584 < EH/DAC < 2.000 6
10 2.000 < EH/DAC < 2.512 8
11 2.512 < EH/DAC < 3.162 10
12 3.162 < EH/DAC 12

®

DAC/DGS to be active — refer to paragraph 10.1.3 of this Operating Manual
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10.1.9.3. Scanning Area
Scanning Scheme # 1:

To perform scanning above the
Position 2 parent material only uncheck
Position 1 Scan Above Top of Weld option
in the screen;
the limits for the transversal
probe manipulation will be
defined then automatically as:

X-¥alue Position 1 = X-Value

_\_f Position 2 = 2 * Skip# * Material

Thickness * Tan (ProbeAngle)

Scanning Scheme # 2:

To perform scanning above the
Pozition 2 parent material and machined
Position 1 weld cap check Scan Above Top
of Weld option in the
screen; the limits for the
transversal probe manipulation

will be defined then automatically
as:
x-¥alue
Weld Width Position 1 = — Weld Width

Position 2 = 2 * Skip# * Material
Thickness * Tan (ProbeAngle)

Background image of scanning plan depends on the Scanning Scheme selected:

| Scanning 5cheme 1 |

Scanming Pattern

N
k K-value Probe
Weld Width Ve
- Position 2
|5canning Scheme 2
Scanning Pattern

", ™, |

Il. | 1/ 2 3 A

I
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10.1.10. Scanning
During scanning [Sle]N[ege] EMIs [N 11ETe[lls] screen is accompanied with A-Scan

Scanning Pattern

f— 0 mm Side View 220 mm—4

20 =

I Side View End View |

3

.- ¥ N - "y
=] @ Q ;
l‘Ba‘:k [EsC] { Save Clear 2] || Zoom Inf3] || EX*14 [I
’ ’ o ’

IS1e] Nl [exel EmT R InETellgls] Screen represents:

@ Current Probe Position

a Current Coupling Status (optionally, provided that coupling monitor is active — refer to paragraph
10.1.6 of this Operating Manual)

a Current Probe Swiveling Status (optionally, provided that probe swiveling monitor is active — refer to
paragraph 10.1.8 of this Operating Manual)

a Top View

Side Yiew

O Side View for | pressed down or End View for End View

fa—
pressed down or press > Jon front panel keyboard or on external keyboard to switch
between Side and End View

®

While scanning delay and width of the Gate A are changed dynamically depending on the probe position; this
represents corresponding part od weld volume, which is currently insonified. All A-Scans are captured

unconditionally however projection images Top View, Side View, and End View are updated only with signals

exceeding threshold of Gate A presented on the A-Scan

Q -
To Zoom In ISONIC On-Line Imaging screen click on [Ze"B Jor press 3 on front panel keyboard or

i 1 ESC
F3 on external keyboard. To Zoom Out click on |_?e2m 0 [ES€1 | or press L) on front panel keyboard or
on external keyboard

To cleanup Top View, Side View, and End View fields in [SlelN[eXeli BRI =RInE]lgle] screen click

& F
on \ Cleaal ] or press _2_ on front panel keyboard or ﬁ on external keyboard

= =
To save 12-SONIC record into a file click on l Save ]or press ﬂ) on front panel keyboard or press on
external keyboard. Refer to paragraph 5.2.17 of this Operating Manual to proceed with file saving

o | - esc
To return back to XY Scanning Recording and Imaging Menu click on ™ or press _4 Jor L) on
front panel keyboard or or ESc|on external keyboard

1 €sc
To return to previous screen click on l et or press L) on front panel keyboard or on external
keyboard
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: Scanning Pattern 12eB
* <=10dB
: <=8dB
: =68
:i'l <=4dB
- 00 Top Yiew =248 On case of scanning above parent
— - material is combined with scanning
00 =28 above the machined weld cap the
o2 Side View 20 mm (Al scanning screen depends on current
=B probe position: on case of probe is
; A placed above the machined weld cap
=% 1 there is additional control indicated
[ e eaview ||=—7" | under the A-Scan field:
{‘ Back [ESC]J{ SEe M mf[z] J z.mn?fn [3]}{ S HIJ +
4= M‘ -

Use of this control is possible through

Scanning Pattern <1248 press'ng _'_ | » « ‘
<B 1 front panel keyboard orI . . Ion
<% 1 external keyboard — this allows to adjust
jj:i threshold and minimal limit for the delay
o Wik . of Gate A to avpid imaging of _
= : _ - reverbf-:-ratlons in the probe wedge while
- probe is placed above top of the weld
Side View 260 mm— <=-4dB
. . . <=-6dB
= <=-8db
4 =10 dB
<=-12dB
I Side View End Yiew |

) ) =)
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10.1.11. Postrocessing

Postprocessing may be performed in the instrument or in external computer using IOFFICE SW package.
User interface and operations are practically identical except two features listed below:

Off-line analysis in the Off-line analysis in external
instrument computer using IOFFICE
SW Package
Off-line re-adjustment of Gain NO YES
Automatic creation of Inspection report in
MS Word® format NO YES

Menu Bar Functions on Opening File

ISONIC Inspection of Planar Butt Joints

Scanning Pattern

«=12dB
<=10dB
<=8dB
<=6dB
<=4dB

150 Top View 2d8
0 <=0dB
- =2
450
[~ 0mm Side View 220 mm— =4 dB
0
<=6
B - <=8
o End View A0
=128
20
150 150

UnderCut_i06

e File > Print To
Q selection of printer among available for printing out inspection report
0 selection of MS Word® as printer to create inspection report as doc file (IOFFICE SW Package only)
O selection of paper sheet size either A4 or Letter

e File > Print > Whole Report — prints out complete inspection report including UDS 3-5 Pulser
Receiver settings, inspection setup and scanning parameters, recorded maps, and additional data
entered at the appropriate pre-inspection stages as it is described in paragraphs 9.1.2 and 10.1.3 of this
Operating Manual

e File > Print > Graphics Only — prints out scanning recorded maps

e File > Exit — ends postprocessing session

e View 2 Primary Information — previews UDS 3-5 Pulser Receiver settings, inspection setup and
scanning parameters, and additional data entered at the appropriate pre-inspection stages as it is
described in paragraphs 9.1.2 and 10.1.3 of this Operating Manual

e View - Scanning Pattern — allows to select between black and gray colors for image of actually
performed probe trace

e View = ISONIC Image Processing — activates menu for detailed off-line analysis of the record
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ISONIC Image Processing Menu Bar Functions

e File 2 Print To

| File v|| Wiew v|| Measurements v|| Amplitude Filtration v|| Prafiling v|| Fecover A-Scan v|

. = |50KIC Image Processing Scannlng Fallem

1 =
i Zoom «=12dB
Colonng <=10dB
Scannlng F. Black <=8dB
L Cooldmale = Gray - ;= =g |J U <=EdB

[Imm

ISONIC Inspection of Planar Butt Joints

Measurements =|| Edit =|| Recowver A-Scan =

Filtration Level: No Scanning Pattern

Filtration

Profiling: OFF

L-Coordinate
[l] mm ]

Projection Length

(tom )

HCoordinate !
[0 mm ] 450
Projection Width 0 Side View
—] <=5 dB
20 ==
End Yiew
0

Top View

15.0

#— 0 mm 220 mm—

[[I mm

<=-8dE
Y-Coordinate - Depth

[l] mm ]
Projection Height

[l] mm ]

<=-10dB
«=-12dB

150 5.0

UnderCut i06

O selection of printer among available for printing out inspection report

0 selection of MS Word® as printer to create inspection report as doc file (IOFFICE SW Package only)

O selection of paper sheet size either A4 or Letter

e File = Print — prints current postprocessing page

e File > Exit — ends postprocessing session

e View 2 ISONIC Image Processing

e View 2 Zoom — zooms maps as per operator's selection

e View > Coloring — selection of color scale (palette) style applied to maps

e View = Scanning Pattern — selection of black or gray color for representation of actually performed

probe trace
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Measurements - L-Coordinate, Projection Length — generates first vertical cursor that may be

-»

guided over Top and Side View images using either touch screen stylus or mouse or ' -—/, fz on
front panel keyboard or , on external keyboard; coordinate of the first vertical cursor along Top and
Side View images is indicated in the L-Coordinate field. To fix position of the first vertical cursor left

Enter

mouse click or release touch screen stylus or press += J on front panel keyboard or on
external keyboard. Second vertical cursor appears upon fixing the first one; it may be manipulated by the
same way. Coordinate of the second vertical cursor along Top and Side View images measured
relatively first vertical cursor is indicated in the Projection Length field. Provided that vertical cursors
are placed properly:

o0 L-Coordinate represents distance between left border of scanning area and selected defect's

end

o0 Projection Length represents appropriate size of defect

To interrupt L-Coordinate and Projection Length measurement procedure at any moment right mouse

ESC
click or press L) on front panel keyboard or on external keyboard

| File vH Wiew v|| Measurements v|| Amplitude Filtration v|| Profiing v|| Fecover A-5can v|
Filtration Level: No _Scanning Pattern ¢=12dB
Filtration |
<=10dB
Profiling: OFF 1.
il <=8d8
L-Coordinate - ol =g J U <=EdB
Projection Length Top View Jr
<=0dB
01—
X-Coordinate ‘ ¢=2dB
180 N = s
f— 0 mm i i mm— 4=~
Projection Width il ide: View
20 <=-8dB
['| File vH Wiew v|| Measurements v|| Amnplitude Filtration v|| Profiling v|| Recover &-Scan v|
| F!Itrat!on Level: No ) S'_canning Pattern =12dB
Filtration |
[ <=10d8
Profiling: OFF 1.
1 - <=8dB
L-Coordinate R T | |J U <«=EdB
Projection Length .
Top ¥ =
<=0dB
D_
X-Coordinate =2 dB
—a i 3 220 mm— ¢=-
Projection Width i} mm Sidg o o
20 <=-3db
Y-Coordinate - Depth 0 End View = A0 dB
Projection Height a0 ¢=-12d8

ISONIC 2006 from Sonotron NDT - Operating Manual — Revision 1.21 - Page 366 of 480



Measurements > X-Coordinate, Projection Width — generates first horizontal cursor that may be

LIS 4

guided over Top View image using either touch screen stylus or mouse or =, =/ on front panel
keyboard or , on external keyboard; coordinate of the first horizontal cursor along Top View image is
indicated in the X-Coordinate field. To fix position of the first horizontal cursor left mouse click or release
Enter |

touch screen stylus or press *=_ on front panel keyboard or on external keyboard. Second
horizontal cursor appears upon fixing first one; it may be manipulated by the same way. Coordinate of
the second horizontal cursor along Top View image measured relatively first horizontal cursor is
indicated in the Projection Width field. Provided that horizontal cursors are placed properly:

o X-Coordinate represents distance between weld centerline and selected defect's end

o Projection Width represents appropriate size of defect
Horizontal cursors generated and manipulated over Top View image are accompanied with
synchronous vertical cursors over End View image
To interrupt X-Coordinate and Projection Width measurement procedure at any moment right mouse

ESC
click or press L) on front panel keyboard or on external keyboard

| File vH Wiew v|| Measurements v|| Amplitude Filtration v|| Profiing v|| Fecover A-5can v|
Filtration Level: No _Scanning Pattern ¢=12dB
Filtration |
<=10dB
Profiling: OFF 1.
0l <-8d8
L-Coordinate - ol =g J U <=EdB
Projection Length .
Top ¥i =2dB
| <=0dB
01—
X-Coordinate q [% ¢=2dB
f— 0 mm i i mm— 4=~
Projection Width il Side View
20 <=-8dB
Y-Coordinate - Depth o End View e A0 dB
Projection Height a0 ¢=12dp
N mm 15. .
| File vH Wiew v|| Measurements v|| Amnplitude Filtration v|| Frofiling v|| Fecover &-Scan v|
Filtration Level: No ) S'_canning Pattern =12dB
Filtration |
<=10d8
Profiling: OFF 1.
1 - <=8dB
L-Coordinate - ;= =g |J U L <«=EdB
Projection Length .
Top ¥ =
| <=0dB
D_
X-Coordinate ﬂ =2 dB
5
—a i 220 mm— 4=~
Projection Width i} mm Side ¥ o
20 <=-3db
Y-Coordinate - Depth 0 End View = A0 dB
Projection Height 20 ¢=-12d8
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Measurements = Y-Coordinate - Depth, Projection Height — generates first horizontal cursor that

may be guided over Side and End View images using either touch screen stylus or mouse or L

4

_~_/ on front panel keyboard or , on external keyboard; coordinate of the first horizontal cursor along
Side and End View images is indicated in the Y-Coordinate-Depth field. To fix position of the first

L
Enter

horizontal cursor left mouse click or release touch screen stylus or press +=_J on front panel keyboard

or on external keyboard. Second horizontal cursor appears upon fixing first one, it may be
manipulated by the same way. Coordinate of the second horizontal cursor along Side and End View
images measured relatively first horizontal cursor is indicated in the Projection Height field. Provided
that horizontal cursors are placed properly:

0 Y-Coordinate - Depth represents depth of defect

o Projection Height represents appropriate size of defect
To interrupt Y-Coordinate - Depth and Projection Height measurement procedure at any moment right

ESC
mouse click or press L) on front panel keyboard or on external keyboard

| File vH Wiew v|| Measurements v|| Amplitude Filtration v|| Profiing v|| Fecover A-5can v|
Filtration Level: No _Scanning Pattern ¢=12dB
Filtration |
<=10dB
Profiling: OFF 1.
1 - <=8dB
L-Coordinate - r =l @] \J U <=6dE
Projection Length .
Top ¥ =
| <=0dB
A-Coordinate 0= ﬂ ¢=-2dB
-0 ide Vi 220 mr— <=-
Projection Width il ™ Side View o
20 <=-8dB
Y-Coordinate - Depth End ¥i e A0 dB
0
Projection Height a I <=-12dB
0 mm 18.0— F—-15.0
| File vH Wiew v|| Measurements v|| Amplitude Filtration v|| Profiling v|| Fecover A-5can v|
Filtration Level: No _Scanning Pattern =12 dB
Filtration |
<=10d8
Profiling: OFF 1.
il =8B
L-Coordinate -y = =] \J U L <=FdB
Projection Length .
Top ¥ =2dB
| <=0dB
X-Coordinate 0= ﬂ ¢=-2db
—a i i 220 mm— ¢=-
Projection Width i} mm Side View o
20 <=-8d
Y-Coordinate - Depth o End V| :;u =0 dB
P - <=-12dB
Projection Height a0 I
oo T e
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Recover A-Scan = Add Point — generates pointing cursor that may be guided over Scanning Pattern
image using either touch screen stylus or mouse or ?_ '.' ? ‘ on front panel keyboard or
, , , on external keyboard; by means of said pointing cursor representing probe's incidence point
virtual off-line scanning is performed with recovering of recorded A-Scans, which are accompanied with
appropriate Gate A measurements — refer to paragraph 5.2.13 of this Operating Manual for
measurements legend. Pointing cursor is accompanied with blue beam indicator above Scanning
Pattern and Tope View images, said beam indicator represents probe swiveling angle and weld volume
crossing for recovered A-Scan. To memorize A-Scan related to current pointing cursor position for

L
Enter
further printing out release touch screen stylus or left mouse click or press + J on front panel
ESC

keyboard or [Enter| on external keyboard. To interrupt virtual off-line scanning press X" ) on front
panel keyboard or on external keyboard

[ Fie ~|[ iew ~][ Measurements ~|[ Amplitude Filtration ~|[ Profilng «][ Recover A-5can -|
- S'_canning Pattern o128
& —‘ H =1048
1k =g d8
'—A—w—nulju <=6
<=4dB
150 Top View =208
mm t=19.9 mm 0
- m D_
H=146"
# =248
-15.0
0o Side View 2200 e — ez dB
1]
<=-6dB
B <=-8dB
0 End Yiew 1D
<=-12dE
20
18.0 450

Points with memaorized A-Scans and measuring results are highlighted by appropriate numbered marks
on Top View image; to preview a point double click on it — this will generate popup box as below:

0 To erase highlighted mark click on

o0 To print out individual point report click on

0 To return to main menu operation click on
[ Fie +][ Wiew +][ Measuements +|[ Amplitude Fitration «| [ Profilng ~][ Recover &-5can -]
Filtration Level: No _Scanning Paltern =12 dB
Filtration |
. <=10dB
A-5can: L=94.8 mm, X=-43.0 mm X | - <=8db
Fespect Angle: L e IJ U eEde
+
N <=4dB
* Top View ¢=2dB
+
+ <=0dB
e
- e =28
: Side View 220 i —) <=-4dB
«=-EdB
T=2443ps a=344mm t . = <=-3dB
5=39.7 mm WC=5.8 db ’ -
End View
0 <=-10dB
<=-12dB
20
150 5.0

Recover A-Scan = Clear Last — erases last pointed mark from Scanning Pattern image
Recover A-Scan > Clear All — erases all marks from Scanning Pattern image
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e Amplitude Filtration (instrument) or Edit > Amplitude Filtration (IOFFICE SW Package for external

computer) — applies reject level to Top, Side,

and End View maps — segments of these images

corresponding to echo amplitudes below selected level will be suppressed

ml View v|| Meazurements vH Aimplitude Filkration v|| Profiing = || Recover A-Scan v
»12dB
Filtration Level: No _ Scanning Pa“e"' co12dm
Filtration » Wl
»8de <=10dB
Profiling: OFF
9 > 6 dB =B dB
) 4B IJ U
L-Coordinate . 4R -, - __gm <=6dB
Projection Length 2B K Top View 2
>-5db -
X-Coordinate s ad ‘ ¢=-2dB
_ >-10d8 m i i 220 ram — ¢=-4dB
Projection Width e Side View
el o L
¥-Coordinate - Depth 0 End View ¢=-10d8
Projection Height an =128
0 mm 18.0 -158.0

| Wigw 'H Measurements v|| Arnplitude Filtration v|| Profiling 'H Recover A-Scan v|

Filtration Level: >0 dB _ Seanning Pattern =128
&
W <=10dB
Profiling: OFF
<=8dB
L-Coordinate R T | \J U <=6dB
P
Projection Length
roreeton —ena % Top View =28
a <=0dB
X-Coordinate - = 2dB
—0 ide Vi 220 o — <=4 dB
Projection Width ] mn Side View o
20 — - <= B dB
Y-Coordinate - Depth 5 End Yiew =10 dB
Projection Height 20 ey <=ledd
o B o

e Edit>Change Gain=>ON — (IOFFICE SW Package for external computer) — generates popup window
allowing off-line re-adjusting of Gain for all A-Scans captured during 12-SONIC Scanning in £6dB range

A

with £2 dB increments through clicking or pressing and holding on ‘ or pressing , on keyboard

ISONIC 2006

Select Gain Change:

+2dB  E

¥

OK

Cancel ‘

Upon completing re-adjusting Gain click on

OK

or press on keyboard — this applies

new Gain value to all captured A-Scans and updates Top, Side, and End View images accordingly

Cancel
To interrupt re-adjusting of Gain click on 4| or press on keyboard

Edit>Change Gain>OFF (IOFFICE SW Package for external computer)— negates Gain re-adjustment

and returns to originally recorded Top, Side, and End View images and original Gain setting
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Profiling = L,X Profiling (instrument) or Edit = Profiling = L,X Profiling (IOFFICE SW Package for
external computer) — generates sliding horizontal and vertical cursors above Top View, which may be

T § » @&

controlled using either touch screen stylus or mouse or =/, _~_J, ' =, "/ on front panel keyboard
or , , , on external keyboard . Positions of both sliding cursors are appropriately indicated.
Horizontal cursor determines vertical slice represented as Side View image; vertical cursor determines
vertical slice represented as End View image

ESC
To interrupt profiling procedure right mouse click or press L) on front panel keyboard or on
external keyboard

| File v|| Wiew v|| Measurements v|| Amplitude Filtration vH Frofiling vH Fecover A-5can v|
Filtration Level: No _Seanning Pattern =12 dB
Filtration |
<=10dE
Profiling: ON el L
L=93.1mm, X=5.9mm b =88
L-Coordinate T |J <=6dB
e
Projection Length
Lo Top View <=2dB
<=0dE
¥-Coordinate 0= ¢=-2dB
Qmm ] 0 b po— ‘
f—0 mm i i mm— {=-
Projection Width i} Side View
x srach =8B
Y-Coordinate - Depth 0 End View e AN dE
Projection Height 0 7 oy =12d8
0 B e

Profiling = Y Profiling (instrument) or Edit = Profiling = Y Profiling (IOFFICE SW Package for
external computer) — generates sliding horizontal cursor above Side and End View images, which may

L

be controlled using either touch screen stylus or mouse or =/, !. on front panel keyboard or , on
external keyboard. Position of sliding horizontal cursor is appropriately indicated. Horizontal cursor
determines horizontal slice represented as Top View image

ESC
To interrupt profiling procedure right mouse click or press LJ on front panel keyboard or on
external keyboard

[ File ~][ iew +][ Measurements ~][ Ampitude Filiation ~|[ Profiing ~][ Recover &-5can |
Filtration Level: No _Scanning Paltern =128
Filtration |
<=10dE
Profiling: ON | L
Y=17.1mm | <=8d8
L-Coordinate e T |J <=EdB
oom | —_
Projection Length Top View o2
<=0de
D_
X-Coordinate - ¢=-2dB
180 o8
=0 i i 220 mm— {=-
Projection Width i] o Side View o
o
20 <=-8dB
¥-Coordinate - Depth o End Vi = A0 dB
Projection Height 20 <=1z

Profiling = Profiling Off (instrument) or Edit = Profiling = Profiling Off (IOFFICE SW Package for
external computer) — returns to global Top, Side, and End View images
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10.2. Running EXPERT Mode — Expert Evaluation of Short
Welded Sections

10.2.1. Preparations

Insert ultrasonic probe into probe holder and fix single or double emitter of airborne ultrasound on the top of
probe holder — refer to paragraph 8.2 of this Operating Manual. Provide cabling according to paragraph 8.4.2
of this Operating Manual

| Base | Apply bar with receivers of airborne
ultrasound at parallel to the weld:
scanning area and bar to be situated at
opposite sides of the weld. Single

Pus? Weld emitter or top element of double emitter
0s ® and receivers of airborne ultrasound

| - located on the bar to be equally
distanced from scanning surface level
Weld Length Distance between two receivers of
Base airborne ultrasound (Base) is defined
— as:
/ Base = Bg + Pos1 + Pos2

Scanning Area

Pos1 and Pos2 are positions of

receivers at left and right side of the bar

correspondingly;

By is parameter of the bar:

e Bp=200mm//8in for long bar
(order code / part # S 2040 B)

e Bg=100 mm /4 in for short bar
(order code / part # S 86000)

Base defines length of weld section, for which scanning and recording will be performed
Weld Length = Base

ol

: Enter EXPERT mode according to paragraph 8.1 of this Operating Manual

Expert

10.2.2. Description Data
Refer to paragraph 9.1.2 of this Operating Manual
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10.2.3. Pulser Receiver Settings
Refer to paragraph 10.1.3 of this Operating Manual
10.2.4. Probe

Refer to paragraph 10.1.4 of this Operating Manual
10.2.5. Scanning Parameters

To provide highest frontal resolution the value of Scan Index may be setup to 0.25 or 0.5 mm / 0.01 or 0.02
in. For other instructions and notes refer to paragraph 10.1.4 of this Operating Manual

10.2.6. Coupling Monitor
Refer to paragraph 10.1.6 of this Operating Manual

10.2.7. Referring Scanning Area
Refer to paragraph 10.1.7 of this Operating Manual

10.2.8. Probe Swiveling Monitor
Refer to paragraph 10.1.8 of this Operating Manual

10.2.9. Imaging Principles

Top, Side, and End View of weld with projection images of defects are formed as it is explained in
paragraph 10.1.9 of this Operating Manual. It is also possible to provide raw data B-Scan cross sectional
imaging at any location along weld and to compress all raw data cross-sectional B-Scans and Scanning
Pattern, Top, Side, and End View data into a sole inspection file. B-Scan cross sectional imaging is
provided as true-to-location ABIScan according to paragraphs 7.4.2.7 and 7.4.2.8 of this Operating Manual
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10.2.10. Cross Sectional Weld Profile

Haw Data B-5can Pre-Setup

Root Offset:
3 A
¥
Bottom
2 Fy
¥

Bottom Bead Width

Bottom Bead Width 10
T I e

| Exity) [ < Back [ESC] J {
In [REWAPEICY S BSIE NN ECRSTEI0]e] Screen it is necessary to key in:

a Top - level of excessive weld metal above scanning side of parent material — for the standard
EXPERT configuration Top value may vary in the range 0...30% of Weld Thickness

O Bottom — level of excessive weld metal below bottom side of the weld — for the standard EXPERT
configuration Bottom value may vary in the range 0...30% of Weld Thickness

O Bottom Bead Width — width of the weld at bottom side

Bottom

e

 —

A
Setting of said parameters to be performed through clicking / pressing corresponding spin button ﬂ

pa—
Alternatively parameter for setting may be selected through pressing ' =\ Jon front panel keyboard or
on external keyboard or through clicking on its label. Label indicating name of selected parameter changes

it's fore color from yellow to white — since that moment parameter may be modified using !.« _‘_, :‘I,
_'.'_/ on front panel keyboard or , , , on external keyboard

_ _ _ _ l Exit [4] < B ]
To return back to XY Scanning Recording and Imaging Menu click on orpress _4 Jor -
on front panel keyboard or or on external keyboard

( ESC
To return to previous screen click on @ or press L) on front panel keyboard or on

external keyboard

To continue click on @ or press LJ on front panel keyboard or on external keyboard
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10.2.11. Scanning

During scanning [S{e]N[eXel BRI RNEC]lils] screen is accompanied with A-Scan

Scanning Pattern

Top View

0— - .
125 T T T T
f—0 n, 2200 riirn —+]
P 'Slde View . . .
<
” // T - -
2 - ¥
- 40 —

I Side View End Yiew | B |

oS [N [ 8 )

IS1e]\l[ege] EMI Y IniETellgle] sScreen represents:

a
a

a

a

Current Probe Position

Current Coupling Status (optionally, provided that coupling monitor is active — refer to paragraph
10.1.6 of this Operating Manual)

Current Probe Swiveling Status (optionally, provided that probe swiveling monitor is active — refer to
paragraph 10.1.8 of this Operating Manual)

Top View:

Side Yiew End View

Side View for | pressed down or End View for

( K._
pressed down or press = jon front panel keyboard or on external keyboard to switch
between Side and End View)
Marks indicating cross sections where raw data B-Scan was additionally captured

To capture additional raw data B-Scan for selected cross section of the weld place probe appropriately then

click on

- the screen as below appears:
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Raw data B-Scan capturing screen represents:

Q Current Probe Position

a Current Coupling Status (optionally, provided that coupling monitor is active — refer to paragraph
10.1.6 of this Operating Manual)

a Current Probe Swiveling Status (optionally, provided that probe swiveling monitor is active — refer to
paragraph 10.1.8 of this Operating Manual)

a Coordinate of cross-section along weld

a Plane view of cross-section, which's width is determined by Scan Index

O Raw data B-Scan above cross sectional image of the weld

The following controls are available in the rw data B-Scan capturing screen:

a e , E T , ] , | I defining signal amplitude representation palette
a Z]. erasing raw data B-Scan data for rescanning selected cross-section

a x]. erasing raw data B-Scan data and returning to screen

a = - storing of aw data B-Scan with embedding into Scanning Pattern, Top View, Side View,

and End View data batch

For other instructions and notes refer to paragraph 10.1.9 of this Operating Manual
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10.2.12. Postrocessing

Postprocessing of EXPERT records may be performed in the instrument or in external computer using
IOFFICE SW package. User interface and operations are practically identical except two features listed

below:

Off-line analysis directly

Off-line analysis in external

in ISONIC 2006 computer using IOFFICE
instrument SW Package
Off-line re-adjustment of Gain for EXPERT NO YES
record
Automatic creation of Inspection report in
MS Word® format NO YES

Menu Bar Functions on Opening File

Refer to paragraph 10.1.11 of this Operating Manual

ISONIC Image Processing Menu Bar Functions

ISONIC Image Processing menu and operations for EXPERT records are identical to the same menu
related to 12-SONIC records — refer to paragraph 10.1.11 of this Operating Manual. The only addition is B-
Scan topic, which opens list of coordinates of cross sections, for which raw data B-Scan imaging was

performed:

[ Fie +][ Wiew +][ Measurements ~|[ Amplitude Fitration +][ Profilng ~|[ BSean =][ Recover 45can ~

Filtration Level: No

Filtration

Profiling: OFF

L-Coordinate

ISONIC Expert

File ~|| Wiew ~|| Measurements «|| Edit <|| B-3can =|| Reco

64.1 mm

Scanl
k L N5mm [ |

Filtration Level: No
Filtration

Profiling: OFF

[l] mm

0 mm

[l] mm

EX000005.i06

L-Coordinate

Projection Length
[l] mm

X-Coordinate

Projection Width
[l] mm

Y-Coordinate - Depth

Projection Height
[l] mm

ITop \Il'iewl

-

f—0 mm

[ il
220 mm—
Side View

End View
o

12.5 125

Clicking on one of selected coordinates enters into Raw Data B-Scan Postprocessing Menu
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Raw Data B-Scan Postprocessing Menu

[ Fie +][[BScan +][ Maasuements ~|[ Recover &-5can |[ Fitering ~|[ Caloring ~]

L =E4.1 mm k

= | =51.5 mm
¥-Coordinate

Projection Width

¥-Coordinate - Depth

Projection Height
Filtration Level:
No Filtration

12.5 o] -12.5

o
g

L =91.5 mm

Fie || B-Scan ~|| Measurements =|| Edit -|| Recover A-Scan

¥-Coordinate

[l] mm ]
Projection Width
[l] mm ]

¥-Coordinate - Depth
0 mm

Projection Height
] Filtration Level:

[l] mm No Filtration

L=915mm

e File > Print To
a selection of printer among available for printing out inspection report
0 selection of MS Word® as printer to create inspection report as doc file (IOFFICE SW Package only)
O selection of paper sheet size either A4 or Letter

e File = Print — prints current postprocessing page
e File > Exit — ends postprocessing session for raw data B-Scan

e B-Scan - returns to initial postprocessing screen appearing on opening file
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Measurements = X-Coordinate, Projection Width — generates first vertical cursor that may be guided

over raw data B-Scan image using either touch screen stylus or mouse or ' =/, « on front panel

keyboard or , on external keyboard. Coordinate of the first vertical cursor along raw data B-Scan

image is indicated in the X-Coordinate field. To fix position of the first vertical cursor left mouse click or
Ente.r

release touch screen stylus or press - *=_/ on front panel keyboard or [Enter| on external keyboard.

Second vertical cursor appears upon fixing first one, it may be manipulated by the same way. Coordinate

of the second vertical cursor along raw data B-Scan image respectively first vertical cursor is indicated

in the Projection Width field. Provided that vertical cursors are placed appropriately — displacement of

defect from weld centerline and it's Projection Width will be measured

To interrupt vertical cursor manipulations and empty X-Coordinate and Projection Width fields right

ESC
mouse click or press L) on front panel keyboard or on external keyboard

Measurements = Y-Coordinate - Depth, Projection Height — generates first horizontal cursor that
may be guided over raw data B-Scan image using either touch screen stylus or mouse or ' =/, « on
front panel keyboard or , on external keyboard. Coordinate of the first horizontal cursor along raw
data B-Scan image is indicated in the Y-Coordinate - Depth field. To fix position of the first horizontal

Enter
cursor left mouse click or release touch screen stylus or press *=_/ on front panel keyboard or
on external keyboard.
Second horizontal cursor appears upon fixing first one, it may be manipulated by the same way.
Coordinate of the second horizontal cursor along raw data B-Scan image respectively first horizontal
cursor is indicated in the Projection Height field. Provided that horizontal cursors are placed
appropriately — depth of defect and it's Projection Height will be measured
To interrupt horizontal cursor manipulations and empty Y-Coordinate - Depth and Projection Height

ESC
fields right mouse click or press L‘\ on front panel keyboard or on external keyboard

Measurements = OFF — erases horizontal and vertical cursors and empties X-Coordinate, Projection
Width, Y-Coordinate — Depth, and Projection Height fields

| File v|| B-Scan v|| Meazurements v|| Recover A-Scan || Filtering v|| Calaring v|

¥-Coordinate

Projection Width

¥-Coordinate - Depth

Projection Height

Filtration Level:
(o7mm ] W Eiaion

12.5 o]

L =91.5 mm
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Recover A-Scan — generates cursor representing sound path of angle beam probe's central beam in the
object under test that may be guided over raw data B-Scan image using either touch screen stylus or

mouse or ? ‘ on front panel keyboard or , on external keyboard — corresponding A-Scan is

recovered synchronously according to sound path cursor position. Starting position of cursor (X)
corresponding to probe’s incidence point is appropriately indicated

| File v|| B-Scan v|| Measurements v|| Fecover &-5can || Filtering v|| Coloring v|

Probe Position: X = -38.2mm  %-Coordinate

Projection Width

Y-Coordinate - Depth

S

— L
N

Filtration Level:
Mo Filtration

e

L =915 mm

ESC
To interrupt recovery of A-Scans right mouse click or press L) on front panel keyboard or on
external keyboard

Filtering = ON — (instrument) or Edit = Filtering 2 ON (IOFFICE SW Package for external computer)
— generates amplitude palette bar with sliding cursor, which may be controlled using either touch screen

stylus or mouse or ? ‘ on front panel keyboard or , on external keyboard. Position of the
sliding cursor on the amplitude palette bar determines filtering level, which is appropriately indicated. All
elements of raw data B-Scan image representing signal amplitude below filtering level are suppressed:

| File v|| B-Scan v|| Meazurements v|| Recover A-Scan || Filtering v|| Calaring v|

¥-Coordinate

Projection Width

¥-Coordinate - Depth

Projection Height
Filtration Level:
7.0 db

40.0

L =91.5 mm _ l& -

Filtering = ON — (instrument) or Edit = Filtering = ON (IOFFICE SW Package for external computer)
— returns to originally recorded raw data B-Scan image
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e Coloring — (instrument) or Edit = Coloring (IOFFICE SW Package for external computer) — selecting
of palette style and DAC Normalized or Linear color coding applied to raw data B-Scan image:

= Pzeydo 1
Pseudo 2

Themal

GrayScale

L =915 mm
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Edit 2 Change Gain (IOFFICE SW Package for external computer) — generates cursor representing
sound path of probe's central beam in the object under test that may be guided over raw data B-Scan

image using mouse or , on keyboard — corresponding A-Scan is recovered synchronously
according to sound path cursor position. To select reference A-Scan left mouse click or press on
keyboard — this generates popup window allowing off-line re-adjusting of Gain for all A-Scans
composing raw data B-Scan record in £6dB range with £0.1 dB increments through clicking or pressing

ﬂ
and holding on ‘ or pressing , on keyboard

ISONIC 2006

Select Gain Change:

+1.3dB ﬂ

0K Cancel ‘

During Gain re-adjusting reference A-Scan is modified accordingly. Upon completing re-adjusting Gain

OK
click on or press on keyboard - this applies new Gain value to all captured A-

Scans and redraws raw data B-Scan image accordingly

Cancel
To interrupt re-adjusting of Gain click on or press on keyboard

Edit>Change Gain=>OFF — negates Gain re-adjustment and returns to originally recorded raw data B-
Scan image and original Gain setting
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10.2.13 Optional Extended EXPERT SW Configuration

10.2.13.1. Top and Bottom Settings for Using Optional Extended EXPERT SW
Configuration

Optional extended EXPERT SW configuration allows cross sectional defect outlining for butt welds and for
corner, edge, fillet and other types of welds as well

Raw Data B-Scan Pre-5etup

Root Offset:

3 &
¥

Bottom
2 &
¥

Bottom Bead Width

Bottom | | Bottom Bead Width 10
Exit [4] [ < Back [ESC] J {J

In [REWAPEICY SRS M ERSTEIe] screen it is necessary to key in:
Q Top - level of excessive weld metal above scanning side of parent material — for the standard

EXPERT configuration Top value [EVAC AR ERE SN0 LN o RNl TS

a Bottom — level of excessive weld metal below bottom side of the weld — for the standard EXPERT

configuration Bottom value [EVAE AR ENE NN SN AW E e RNl G ESES

Q Bottom Bead Width — width of the weld at bottom side

10.2.13.2. Example - Using Optional Extended EXPERT SW For Corner Welds

Fillet weld geometry:

T1

T4

_

T3

T2

- e

Goal of the inspection — detection and outlining lack of penetration at the flange side
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Scanning Area and Placement of airborne ultrasound receivers:

RN R

Settings required:

Inspection Setup

j”jm_
o,

[T Scan Above Top of Weld

mml m 4|V MuliEcho
20 mm j 30 mm [¥ Normalize To Dac

' - )
Exn [4] " Coarse (* Medium ¢ Fine { < Back [ESC] { Next > J |
Raw Data B-5can Pre-Setup
Root Difset:
3 Fy
¥
Bottom
2 F
¥
Bottom Bead Width
| | Bottom Bead Width 10

Exit [4] l < Back [ESC] J l Next >

 S—

WeldThick = T3
WeldWidth =T1 + T2

Skip#=1or 1.5

Top=T4

Bottom = Maximal Possible
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Scanning and Postprocessing:

The routine scanning screen is lined out as for the standard EXPERT SW configuration

ISONIC On-Line Imaging |

Scanning Pattern

<=12dB
<=10dB
<=H0dB

<=6dB
<=4dB

<=2dB

«=0dB

I
1
B

¢=2dB
<=-4 dB
<=6dB
2= 6db

—0 mirn 220 mrn —|
Side View

» W
"N

<=-10d8
<=-12 dB

I Side View End Yiew | B |

[ ( H | Y Q Y b
&7 N
{ < Back [ESE]J T { Clear [2] {Zuum In [3] { Exit [4]
- i - a

Background of B-Scan capturing screen represents actual geometry of the seam under inspection

A-5

D e

] Ty . P L R

-]
—
N 4+
-]
(X}

\ T1+T2

L = 90.8 mm
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10.2.13.3. Implementation for Other Geometry Welds
Scanning Area and Placement of airborne ultrasound receivers:

Flanges:

Nozzles:
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Typical cross sectional images:
=4 |SONIC Expert

File =|| B-Scan =|| Measurements =[] Edit =|| Recover &-Scan

. ¥-Coordinate
Probe Position: X = -50_7mm [I] = ]

Projection Width

(0 om )

Y-Coordinate - Depth
[I] mm ]
Projection Height
) [I] mm

+ o+ o+ + o+ + + o+

+

If +

L i}

+ + + + + + + + o+
+=Sr + + + + + + +
+ + + + + + + + o+

i'+++++++++
[+ + + & o+ o+ o+ o+ o+
i

] Filtration Level:
Mo Filtration

L+ +

12.5 o] -13.5

L=91.1mm

Fil= =|| B-3can ~|| Measurements =|| Edit =|| Recover A-Scan

X-Coordinate

Probe Position: X = -78.9mm [l] - ]
ot + Projection Width
+ o+ +
- N [l] mm ]
+ o+ +
+ o+ + Y-Coordinate - Depth
+ o+ + [l] mm
+ o+ + o+
P + J; " Projection Height Filtration Level
iltration Level:
v+ W TR (0 mm ) Zodb
13.8 DI -13.8
I n
=1 — =
= -~ L
- ::—

L = 85.6 mm
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10.3. Running SMPIPE Mode — Inspection of Butt Welds

between Small Diameter Pipes (80 to 800 mm) — Scanning from
One Side

10.3.1. Preparations

Insert ultrasonic probe into probe holder and fix single or double emitter of airborne ultrasound on the top of

probe holder — refer to paragraph 8.2 of this Operating Manual. Provide cabling according to paragraph 8.4.2
of this Operating Manual

Long Cable Box

Long or Short Bar Long or Shart Bar

1
T Mo M Long Cable Box

Base

Fisture

-l SN

Apply bar with receivers of airborne ultrasound at parallel to weld to be inspected using either magnetic legs,
or vacuum cups, or fixture S 89000 may be used — scanning area and bar to be situated at opposite sides of
the weld. Single emitter or top element of double emitter and receivers of airborne ultrasound located on the

bar to be equally distanced from scanning surface level while probe is located in front of the bar center.
Distance between two receivers (Base) is defined as:

Base = Bg + Pos1 + Pos2
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Pos1 and Pos2 are positions of receivers at left and right side of the bar correspondingly;
Bg is parameter of the bar:
e Bp=200mm/8in for long bar (order code / part # S 2040 B)
e Bp =100 mm /4 in for short bar (order code / part # S 86000)

e Length of weld section to be scanned (Weld Length) depends on Base and Curvature Diameter
and calculated automatically

e It may occur that modifying of preliminary entered value of Base will be required — appropriate
calculation will be performed by instrument automatically and indicated in the [[gE]ol{qileJalS=1(0]e}

screen
b
% Enter SMPIPE mode according to paragraph 8.1 of this Operating Manual
SMFipe
o

10.3.2. Description Data
Refer to paragraph 9.1.2 of this Operating Manual

10.3.3. Pulser Receiver Settings
Refer to paragraph 10.1.3 of this Operating Manual

10.3.4. Probe
Refer to paragraph 10.1.4 of this Operating Manual
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10.3.5. Scanning Parameters

Inspection Setup

!@] ot
A A
’ 30 mm '| ’ 20 mm '|
Scan Index [S1)

’ 2 mm 5
Weld Diameter[wD]

| 180 mm

Base
| 220 mm
' 1 ¥
N

1.

> [ [

¥ MultiEcho
[~ Scan Above Top of Weld IRII
¥ Mormalize To Dac eeB

b Setup St ( (
Exit [4] S0 Sy { < Back [ESC] l Next >
o

" Coarse (* Medium " Fine

In the [[I]eLIqile]aRSTEINN]s) Screen it is necessary to key in:

O Base - distance between two receivers of airborne ultrasound

O Weld Diameter — outside diameter of pipe at side, above which scanning will be performed

Q Skip # — defines cross-sectional insonification scheme; Skip # setting to be according to inspection
procedure

O Scan Index — defines coverage of scanning area — to be selected and entered according to

inspection procedure
QO Weld Thick — thickness of parent material

O Weld Width — depending on inspection procedure value of Weld Width must cover weld metal

width either with or without heat affected zone

Length of curved weld section to be inspected and recorded is defined by 2 parameters - Weld Diameter

and Base and calculated by instrument automatically

For other notes and instructions refer to paragraph 10.1.5 of this Operating Manual

10.3.6. Coupling Monitor
Refer to paragraph 10.1.6 of this Operating Manual

10.3.7. Referring Scanning Area
Refer to paragraph 10.1.7 of this Operating Manual

10.3.8. Probe Swiveling Monitor
Refer to paragraph 10.1.8 of this Operating Manual

10.3.9. Imaging Principles
Refer to paragraph 10.1.9 of this Operating Manual
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10.3.10. Scanning

Side View - Real Shape image is provided in addition to unfolded Scanning Pattern, Top, Side, and End

B
View images. Clicking on allows reproducing of enlarged cross sectional B-Scan for interesting
cases while scanning. For other notes and instructions refer to paragraph 10.1.10 of this Operating Manual

ISONIC On-Line Imaging

Scanning Pattern
e "

<=12dB
<=10dB
<=8dB
<=6dB
<=4dB

=

Top View <=2dB

¢=0dk
¢=-2dB
¢=-4dB
<= 6dB
20 ] : <=2 dB

-
-15.0 =
f— 0 mm Side View 103 mim—

<=-10dB

«=-12dB
I Side View End View | B |
']
o Lo |
Clear [2] m In [3]

Exit [4]
-

< Back [ESC]J

Save
v ]

10.3.11. Postrocessing

Postprocessing menus for SMPIPE records are practically identical to the same related to 12-SONIC records
— refer to paragraph 10.1.11 of this Operating Manual. In addition it is possible to generate Real Shape
image for Side View projection

Frimary Information 4 Scanning Pattern
ISONIC Image Frocessing T L.

| Fieal Shape I |
Scanning PatterN L4

Scanning Pattern

e

Filtration Level: No
Filtration

e diliom - k1

Real Shape E3

-
Q Top View
T

X-Coordinate 4

-0 ide Vi 1013 o —
Projection Width mm Side View mm

1]
20 «=-8dB
Y-Coordinate - Depth End View

Projection Height - > «=-12dB

FE— o BT ks
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10.4. Running NOZZLE Mode — Inspection of Nozzle and Corner
Welds

10.4.1. Preparations

Insert ultrasonic probe into probe holder and fix single or double emitter of airborne ultrasound on the top of
probe holder. For single emitter of airborne ultrasound refer to paragraph 8.2 of this Operating Manual.
Double emitter of airborne ultrasound to be fitted into probe holder using twister S 904050:

Double Emitter of
Airborne Ultrasound

Probe Halder
Provide cabling according to paragraph 8.4.2 of this Operating Manual

Scanning Area
Long ar Short Bar

Long Cable Box

Baze

Apply bar with receivers of airborne ultrasound at parallel to weld to be inspected behind scanning area.
Single emitter or top element of double emitter and receivers of airborne ultrasound located on the bar to be
equally distanced from scanning surface level. Distance between two receivers (Base) is defined as:

Base = Bg + Pos1 + Pos2

Pos1 and Pos2 are positions of receivers at left and right side of the bar correspondingly;
Bo is parameter of the bar:
e Bp=200mm /8 in for long bar (order code / part # S 2040 B)
e Bp =100 mm /4 in for short bar (order code / part # S 86000)

®

Base defines length of weld section, for which scanning and recording will be performed
Weld Length = Base
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@ Enter NOZZLE mode according to paragraph 8.1 of this Operating Manual
Nozzle

10.4.2. Description Data
Refer to paragraph 9.1.2 of this Operating Manual

10.4.3. Pulser Receiver Settings

Refer to paragraph 10.1.3 of this Operating Manual
10.4.4. Probe
Refer to paragraph 10.1.4 of this Operating Manual

10.4.5. Scanning Parameters

Inspection Setup

Scan Index (5] m_
i I;!;] n.ml

[T Scan Above Top of Weld

m‘ mﬂm ¥ MultiEcho
20 mm j 30 mm j ¥ Mormalize To Dac

—
Exit [4]

" Coarse % Medium ¢ Fine chaCK [ESCIJ Next > J

In the [AJoIIdile]sMSISI8]] SCreen it is necessary to key in:

O Base - distance between two receivers of airborne ultrasound, which defines length of weld
section, for which scanning and recording will be performed

O Skip # — defines cross-sectional insonification scheme; Skip # setting to be according to inspection
procedure

O Scan Index — defines coverage of scanning area — to be selected and entered according to
inspection procedure

Q Weld Thick — thickness of parent material

o Weld Width — depending on inspection procedure value of Weld Width must cover weld metal
width either with or without heat affected zone

For other notes and instructions refer to paragraph 10.1.5 of this Operating Manual

10.4.6. Coupling Monitor
Refer to paragraph 10.1.6 of this Operating Manual
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10.4.7. Referring Scanning Area

Place probe equipped with emitter of airborne ultrasound into scanning area as it is shown in the
Moo= 1{[e]g W\ [e]4llfe]§ Screen — at this position absolute distance between bar and probe is indicated in X-
coordinate box — then:

click on[ Adjust to X-Value (XV) J

OR

select[ Adiustto X-Value (V) Jusing !_, : : _'.'_, or 5 ]on front panel keyboard or 1}, , ,
Enfe.r |

or [F7| on external keyboard then press ' *=_ on front panel keyboard or on external keyboard

Probe Location Monitor
X-coordinate
-238 mm

[ Adjust to X-Value {XV) J

X-coordinate
_ 13 mm

L Adjust to X-Value (XV1 J

Probe Location Monitor

- ~
Exit [4]

’ 3 ) )
Exit [1] l< Back [ESC]J l Next > J
I\ -
it 4] ESC

[E i
To return back to XY Scanning Recording and Imaging Menu click on lx_J orpress _4 Jor - <
on front panel keyboard or or on external keyboard

( ESC
To return to previous screen click on M or press &) on front panel keyboard or on

external keyboard

To continue click on M or press LJ on front panel keyboard or on external keyboard
10.4.8. Probe Swiveling Monitor

Refer to paragraph 10.1.8 of this Operating Manual

10.4.9. Imaging Principles

Refer to paragraph 10.1.9 of this Operating Manual
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10.4.10. Scanning

B
Clicking on 4| allows reproducing of enlarged cross sectional B-Scan for interesting cases while
scanning. For other notes and instructions refer to paragraph 10.1.10 of this Operating Manual

ISONIC On-Line Imaging

Scanning Palm 1240
I
i =
2 <=T0d8
|| <=8d8
<=6dB
<=4d8
150 Top View =248
<=0d8
0— -
=28
150
[~ 0 rom Side View 220 mm— <=-4dB
0
<=EdB -
a - <= -8B
<= 1048
1248
IW End View | B |

=] @ Q :
l SEack [Esql Save Clear [2] ZoomInp3) || E¥tM

ISONIC On-Line Imaging

Scanning Pattern

<=12dB
<=10dB
<=8dB

<=6dB
<=4dB
Top View <=2dB

<=0dB
¢=-2dB

[~ 0 mm Side View 220 mm— <=-4dB

150 154 <= -BdB
<=8d8

<=-10dB

E <=-12dE
I i i End Vi ||

T Side View nd Yiew ITX

l(BaCk 'Escli Sge Jl Elef[Z] Jl Zooﬁn [3]}{ Exit [4]

0z

10.4.11. Postrocessing
Refer to paragraph 10.1.11 of this Operating Manual
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10.5. Running PLCROSS Mode — Inspection of Planar Butt
Welds — Scanning from Both Sides

10.5.1. Preparations

Insert ultrasonic probe into probe holder and fix single or double emitter of airborne ultrasound on the top of
probe holder. For single emitter of airborne ultrasound refer to paragraph 8.2 of this Operating Manual.
Double emitter of airborne ultrasound to be fitted into probe holder using twister S 904050:

Double Emitter of
Airborne Ultrasound

Twister 5 904050

Probe Holder

Provide cabling according to paragraph 8.4.2 of this Operating Manual

, Base

Posl
Scanning Area 1

Scanning Area 2

e

There are two scanning areas at opposite sides of the weld.
Standard long bar (order code / part # S 2040 B) or custom
made bar may be used while working in PLCROSS mode

Apply bar with receivers of airborne ultrasound to object under test at rectangle to the weld. Center of the bar
must be located above weld centerline. Depending on probe to be used and scanning scheme selected
positions Pos1 and Pos2 of receivers at left and right side of the bar correspondingly will be calculated by
instrument automatically and indicated for providing — refer to paragraph 10.5.7 of this Operating Manual

Ca
(L] Enter PLCROSS mode according to paragraph 8.1 of this Operating Manual

PLCross
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10.5.2. Description Data
Refer to paragraph 9.1.2 of this Operating Manual

10.5.3. Pulser Receiver Settings
Refer to paragraph 10.1.3 of this Operating Manual
10.5.4. Probe

Refer to paragraph 10.1.4 of this Operating Manual
10.5.5. Scanning Parameters

Inspection Setup

Scan Index [51) weld Length [wL]
7 mm 250 mm
¥ Heat Affected Zone [HAZ)
m: ] ¥ MultiEcho
[+ Mommalize To Dac
Fﬁ_ Hool
20 mm 30 mm 1 - Pseudo

Setup Step "

" Coarze (v Medium ¢ Fine l<BaCK [ESC] Next >

Exit [4]

In the [[I]eLIqileJaRSTEINN]e) Screen it is necessary to key in:

a
a

a

a
a

Weld Length — length of weld section, for which scanning and recording will be performed

Skip # — defines cross-sectional insonification scheme; Skip # setting to be according to inspection
procedure

Scan Index — defines coverage of scanning area — to be selected and entered according to
inspection procedure

Weld Thick — thickness of parent material

Weld Width — depending on inspection procedure value of Weld Width must cover weld metal
width either with or without heat affected zone

If it is necessary to inspect weld metal and heat-affected zone then option Heat Affected Zone (HAZ) must
be checked

For other notes and instructions refer to paragraph 10.1.5 of this Operating Manual

10.5.6. Coupling Monitor
Refer to paragraph 10.1.6 of this Operating Manual
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10.5.7. Referring Scanning Area

On opening screen positions of airborne ultrasound receivers (Pos 1 and Pos 2)
and distance between (Base) them on the bar are calculated automatically to cover scanning areas at both
sides of the welds completely — refer to paragraph 10.5.1 of this Operating Manual. If calculated value of
Base does not exceed 480 mm / 19 in then standard long bar (part # S 2040 B) to be used and
corresponding positions are indicated on opening screen (Pos 1 =L ; Pos 2 = R):

Probe Location Monitor

Microphones Position

L R
40 mm 40 mm

l Confirm L & R Positions

Set Zero Line

l Adjust to X-Value (X1)

ll New Setup ﬂ l Adjust to X -Value (X2} J

) ) N
Exit [4] I<Back [ESC] l Next > J
>

If calculated value of Base exceeds 480 mm / 19 in then customized long bar to be used and value of Base

to be provided is indicated on opening [gfe]ofRMeler-\i{e]s W\ [e]glife]§ SCreen:

Probe Location Monitor
Base
570 mm

Confirm Base Value

Set Zero Line

[ Adjust to X Value (X1) J

[I New Setup ﬂ [ Adiust to X Value (X2) J

p p N
Exit [4] l < Back [ESC] l Next > J
v

Top refer probe location monitor:

New Setu J Encer |
P or press *=_J on front

e clickon l
panel keyboard [Enter|on external keyboard
o fix receivers of airborne ultrasound in appropriate positions on the bar then click on either

l Confirm L & R Positions J l Confirm Base Value J j:'i' |
or or press ' *=_J on front panel

keyboard [Enter| on external keyboard
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e place probe at position closest to the bar as it is shown in the [gfe]olsY Melef=1dle]s W% [e]s]ife]§ SCreen then

L ]
Enter |

Set fero Line J .
or press ' *=_ on front panel keyboard [Enter| on external

click on l
keyboard

. . . o [ Adjust to X-Value (X1) J oo |
e keeping probe in the previous position click on orpress  *=_ on

front panel keyboard on external keyboard — this will define Scanning Area 1 and change
sketch in the [gfe]olRMeIef-1i[e]s W\ le]g]i{e]§ SCreen:

Probe Location Monitor

Microphones Position
L R

40 mm 40 mm

l Confirm L & R Positions J

L-coordinate
0 mm

l Set Zero Line J

X-coordinate
-13 mm

[ Adjust to X Value (X1) J

[ New Setup J [I Adiust to X Value (X2) IJ

p p N
Exit [4] l < Back [ESC] l Next > J
v

e place probe at new position as it is shown in the [gfe]osJ-JXeIe-1ile]gW\/[e]sli{e]§ SCreen then click on

Adjust to X-Value (X2 J Enter |
l ! LR press ' *=_J on front panel keyboard on external

keyboard

ESC

| Exita il
To return back to XY Scanning Recording and Imaging Menu click on IE orpress _4 Jor C
on front panel keyboard or or on external keyboard

( ESC
To return to previous screen click on @ or press L) on front panel keyboard or on

external keyboard

To continue click on IE or press LJ on front panel keyboard or on external keyboard
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10.5.8. Probe Swiveling Monitor

Double emitter of airborne ultrasound S 4050 and twister S 904050 are necessary to monitor probe swiveling
angle. Depending on scanning side — 45° or + 45° to be provided as it is shown in above paragraph 10.5.1

of this Operating Manual and in [gge]o=ESWINVE T leQVile]glite]§ Screen. In the o] RSN Tals Wi lelglife]§ Screen

it is necessary to activate/negate probe swiveling monitor through click on appropriate button

Probe Sviweling Monitor

Swiveling Monitor Status
k ON

{ Check Probe Swiveling J

¥ <0 { Check Probe Swiveling J

¥=0 Swiveling Angle, deg
¥<0 | w0 1 deg

Limit for Probe ‘
Swiveling Angle. deg

+ 15 deg '

P
P i .
I Exit [4] L<Back[ESC]Jl Next > J

If Probe Swiveling Monitor is active then it is necessary to set appropriate Limit for Probe Swiveling

*t » @& 3

A
Angle trough clicking / pressing its spin button ﬂor through pressing =/, =, =, _T_J on front panel
keyboard or , , , on external keyboard

ESC

i Exit [4 A
To return back to XY Scanning Recording and Imaging Menu click on lx_“J orpress _4 Jor C
on front panel keyboard or or on external keyboard

( ESC
To return to previous screen click on M or press &) on front panel keyboard or on

external keyboard
To continue click on M or press LJ on front panel keyboard or on external keyboard

10.5.9. Imaging Principles

Refer to paragraph 10.1.9 of this Operating Manual
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10.5.10. Scanning

Two scanning areas are represented in the Scanning Pattern field in [SlelN[eXels BNl {-NliiEle[lile] Screen
Top View field proportionally represents weld metal and heat affected zone area provided that
corresponding option was checked as it is noted in paragraph 10.5.5 of this Operating Manual. For other

notes and instructions refer to paragraph 10.1.10 of this Operating Manual

ISONIC 2006 Imaging

«=12dB
<=10dB
Scanning Pattern <=8dB
<«=6dB
<=4dB

Top View <=2dB

o] A > 1'\: <=0dB
v Vo T B

o~
T T T T T T anam - - 0 mm Side View 250 mm <=-4 dB

: E . ]
E. Weld Metal = <=-6dB

-------------- wus o ™ ¢=-8dB

<=-10dB

«=-12dB
I Side View End Yiew |

p p p vz N N
= & Q ]
{ EE [ESE]JI Save || Clear[2] || ZoomIn[3] Exit [4] ]

10.5.11. Postrocessing

Refer to paragraph 10.1.11 of this Operating Manual

: Weld Metal and  :
I Heat Affected
:  Zone(HAZ) i

ISONIC 2006 from Sonotron NDT - Operating Manual — Revision 1.21 - Page 401 of 480



10.6. Running CIRCROSS Mode — Inspection of Circumferential
Butt Welds — Scanning from Both Sides

10.6.1. Preparations

Refer to paragraph 10.5.1 of this Operating Manual for airborne ultrasound stuff, probe holder, and cabling

—

@9 Enter CIRCROSS mode according to paragraph 8.1 of this Operating Manual
Circross

10.6.2. Description Data
Refer to paragraph 9.1.2 of this Operating Manual

10.6.3. Pulser Receiver Settings

Refer to paragraph 10.1.3 of this Operating Manual
10.6.4. Probe
Refer to paragraph 10.1.4 of this Operating Manual
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10.6.5. Scanning Parameters

Inspection Setup

weld Length [wL] ﬂ

| 260 mm ¥

r Weld Diameter(wD) [y

@D 620 mm ¥

A

D] 30 mm ¥

v

20 mm ¥

Scan Index [S51] ‘

| 7 mm ﬂ
1.5

¥ Heat Affected Zone [HAZ]

¥ MultiEcho A
[ Mormalize To Dac 1 ‘
¢ Bl SetwpStep I [ ]

Exit [4] T H—— { < Back [ESC] [ Next >

" Coarse {» Medium (" Fine

|1 - Pseudo v| [ 1
Root

&

In the [[I A ielilSEIMs] screen it is necessary to key in:

Weld Length — unfolded length of weld section, for which scanning and recording will be performed
Skip # — defines cross-sectional insonification scheme; Skip # setting to be according to inspection

Scan Index — defines coverage of scanning area — to be selected and entered according to

a
a
procedure
a
inspection procedure
a Weld Thick — thickness of parent material
a

Weld Width — depending on inspection procedure value of Weld Width must cover weld metal
width either with or without heat affected zone

If it is necessary to inspect weld metal and heat-affected zone then option Heat Affected Zone (HAZ) must
be checked

For other notes and instructions refer to paragraph 10.1.5 of this Operating Manual

10.6.6. Coupling Monitor

Refer to paragraph 10.1.6 of this Operating Manual

10.6.7. Referring Scanning Area
Refer to paragraph 10.5.7 of this Operating Manual

10.6.8. Probe Swiveling Monitor

Refer to paragraph 10.5.8 of this Operating Manual

10.6.9. Imaging Principles

Refer to paragraph 10.1.9 of this Operating Manual
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10.6.10. Scanning

Side View - Real Shape image is provided in addition to unfolded Scanning Pattern, Top, Side, and End

View images. For other notes and instructions refer to paragraphs 10.1.10 and 10.5.10 of this Operating
Manual

ISONIC On-Line Imaging

<=12dB Ealil

<= 10 dB
<=5 dB
<=6 dB
<=4 dB
<=2 dB

Scanning Pattern

==0dB Top View
«=-2dB ] L
a—
<= -4 4B ] - i
-25.01 r
<= 5 dB 0 mm Side View 260 mm
<=8 4B ]
<=-10dE 20— %‘-
<= -12 dE
| Side View End View |

=) )]t =)

10.6.11. Postrocessing
Refer to paragraph 10.1.11 of this Operating Manual
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10.7. Running LONGWELD Mode — Inspection of Longitudinal
Butt Welds in Tubular Objects — Scanning from Both Sides

10.7.1. Preparations

Refer to paragraph 10.5.1 of this Operating Manual for airborne ultrasound stuff, probe holder, and cabling

Ease

Scanning Area 2
weld |

Scanning Area 1

Enter LONGWELD mode according to paragraph 8.1 of this Operating Manual
Long¥eld

10.7.2. Description Data
Refer to paragraph 9.1.2 of this Operating Manual

10.7.3. Pulser Receiver Settings

Refer to paragraph 10.1.3 of this Operating Manual
10.7.4. Probe
Refer to paragraph 10.1.4 of this Operating Manual
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10.7.5. Scanning Parameters

Inspection Setup

Weld Length [WL) ﬂ

| 450 mm b4
Pipe Diameter[PD) ‘

| 4000 mm ﬂ
A

30 mm ¥

v

20 mm Y

Scan Index [51) ‘

| 3 mm ﬂ

1.5
¥ MultiEcho
[# Heat Affected Zone [HAZ) 1 - Pseudo -
¥ Mormalize To Dac
A
05 ¥

BTEEREN SctwStep 1
Exit [4] Setuplslep { < Back [ESC] l Next > J
el

" Coarse  Medium ¢ Fine

In the [[I] eI ileJaRSTEINN]s) Screen it is necessary to key in:

O Weld Length — length of weld section, for which scanning and recording will be performed

O Pipe Diameter — outside diameter to be entered

Q Skip # — defines cross-sectional insonification scheme; Skip # setting to be according to inspection
procedure

O Scan Index — defines coverage of scanning area — to be selected and entered according to
inspection procedure

O Weld Thick — thickness of parent material

O Weld Width — depending on inspection procedure value of Weld Width must cover weld metal
width either with or without heat affected zone

If it is necessary to inspect weld metal and heat-affected zone then option Heat Affected Zone (HAZ) must
be checked

For other notes and instructions refer to paragraph 10.1.5 of this Operating Manual

10.7.6. Coupling Monitor
Refer to paragraph 10.1.6 of this Operating Manual

10.7.7. Referring Scanning Area
Refer to paragraph 10.5.7 of this Operating Manual

10.7.8. Probe Swiveling Monitor
Refer to paragraph 10.5.8 of this Operating Manual

10.7.9. Imaging Principles
Refer to paragraph 10.1.9 of this Operating Manual

10.7.10. Scanning

Refer to paragraph 10.5.10 of this Operating Manual
10.7.11. Postrocessing

Refer to paragraph 10.1.11 of this Operating Manual
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10.8. Running TRANSCAN Mode — Inspection of Butt Joints —
for Defects Transversal to Weld Scanning from Both Sides
and/or Above Machined Weld Cap (Standard HP 5/3)

10.8.1. Preparations

Insert ultrasonic probe into probe holder and fix single or double emitter of airborne ultrasound on the top of
probe holder. For single emitter of airborne ultrasound refer to paragraph 8.2 of this Operating Manual.
Double emitter of airborne ultrasound to be fitted into probe holder using twister S 904050:

Double Emitter of
Airborne Ultrasound

Twister 3 904050

Probe Holder
Provide cabling according to paragraph 8.4.2 of this Operating Manual
Base

There are two scanning areas at
opposite sides of the weld.
Standard long bar (order code /
g A part # S 2040 B) or custom made
bar may be used while working in

Posl TRANSCAN mode. Apply bar
Seanning Area | with receivers of airborne
g\,______a ultrasound to object under test at

rectangle to the weld. Center of
the bar to be located above weld
centerline. Depending on probe
to be used and scanning scheme
selected positions Pos1 and
Pos2 of receivers at left and right
side of the bar correspondingly
will be calculated by instrument
automatically and indicated for
Rase providing — refer to paragraph
[ { 10.8.7 of this Operating Manual.

Respect Angle

Weld
Respect Angle \\v’/
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E Enter TRANSCAN mode according to paragraph 8.1 of this Operating Manual
TranScan

10.8.2. Description Data
Refer to paragraph 9.1.2 of this Operating Manual

10.8.3. Pulser Receiver Settings

Refer to paragraph 10.1.3 of this Operating Manual
10.8.4. Probe
Refer to paragraph 10.1.4 of this Operating Manual
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10.8.5. Scanning Parameters

Ingpection Setup

Scan Index (S}
| 7 mm
Reszpect Angle (RA)
| 0 deg

Weld Length (WL)
180 mm

| 20 mm
| 30 mm

] i | [ |

( i (
Exit [4] o

~ Coarse {* Medium { Fine l < Back [ESC] J { Next > J |

In the [[IYeLIqileJaRSTEINN]s) Screen it is necessary to key in:

a
a

a

Weld Length — length of weld section, for which scanning and recording will be performed

Skip # — defines cross-sectional insonification scheme; Skip # setting to be according to inspection
procedure

Scan Index — defines coverage of scanning area — to be selected and entered according to
inspection procedure

Weld Thick — thickness of parent material

Weld Width — depending on inspection procedure value of Weld Width must cover weld metal
width either with or without heat affected zone

Respect Angle — for welds with machined weld cap to be 0°; for weld with non machined weld cap

to be selected 0...10° or 5...15° or 10...20° according to inspection procedure

For other notes and instructions refer to paragraph 10.1.5 of this Operating Manual

10.8.6. Coupling Monitor
Refer to paragraph 10.1.6 of this Operating Manual

10.8.7. Referring Scanning Area
Refer to paragraph 10.5.7 of this Operating Manual
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10.8.8. Probe Width
Probe Width to be measured prior to scanning while running TRANSCAN Mode;

Probe Width

Zeta Line { New Setup ]

Scanning Area 2

Relative L-Coordinate of
UT Probe

16 mm

X-coordinate
3 mm

X Hal ( Y
e l Position 1

Scanning Area 1

30 mim
[1.2in)

Position 2

Probe Width
9 mm

.
Exit l < Back [ESC] { Next > J
o

e place probe into Scanning Area 1 as it is shown on the sketch in [gge]oJ=RWlelds] screen then click on
H ; .

[ Hew Setup J l Position 1
then on 4

Probe Width

New Setyp

Zero Line k
Relative L-Coordirsate of
UT Probe

16 mm

X-coordinate
-42 mm

W al ( )
= l Position 1

Scanning Area 2

Scanning Area 1

30 mm

"
e [ Posiionz ||

Probe Width
9 mm

N [
Exit l<Back [ESC] { Next > J
" |

. place probe into Scanning Area 2 as it is shown on the sketch in Probe Width screen then click on

b
l Position 2
e

ESC

( Exit [4 A
To return back to XY Scanning Recording and Imaging Menu click on @ orpress _4 Jor . C

on front panel keyboard or -4 or on external keyboard

( ESC
To return to previous screen click on @ or press L) on front panel keyboard or on

external keyboard

To continue click on @ or press LJ on front panel keyboard or on external keyboard
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10.8.9. Probe Swiveling Monitor

Probe 5viweling Monitor |

L w0 Swiveling Monitor Status
@l ON

¥=0
¥<0

Swiveling Angle, deg
|| -3 deg

Limit for Probe Swiveling Angle, ‘

deg

J. + 15 deg '

—_— . .

I Exit [4] l«:Back[ESC] L Next > J
o

Set Limit for Probe Swiveling Angle in accordance with inspection procedure trough clicking / pressing its

A
spin button ﬂor through pressing !_, : : _!', on front panel keyboard or , , , on

external keyboard

. . : . | Exit [4] 7 ). &)
To return back to XY Scanning Recording and Imaging Menu click on orpress _4 Jor -
on front panel keyboard or or on external keyboard

( esc
To return to previous screen click on ij or press L) on front panel keyboard or on

external keyboard

To continue click on M or press LJ on front panel keyboard or |F-g| on external keyboard

10.8.10. Imaging Principles

Refer to paragraph 10.1.9 of this Operating Manual
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10.8.11. Scanning

Two scanning areas are represented in the Scanning Pattern field in [SlelN[eXels BNl {-NliiEle[lile] Screen
Top View field proportionally represents weld metal and heat affected zone area

According to HP5/3 and ASME practice scanning for transversal cracks to be performed in 2 opposite
directions with respect to weld centerline — after covering scanning plan in one direction click on

[ Change Scanning Direction... J ) o ) )
then turn twister S 904050 as it is shown in paragraph 10.8.1 of this
Operating Manual and continue scanning

For other notes and instructions refer to paragraph 10.1.10 of this Operating Manual

ISONIC On-Line Imaging

Scanning Pattern =12 R
W =1048
<=8dB
& = g| WY
1‘ <=4dB
Top View <=2dB
250 |
] E <=0dB
0— b
1 w ; =2d8
250
o 1} mm . Side View . I18D mm <=-4dB
: - E <=-6dB
20 =
<=-8dB
<=-10dB
<=-12dB
I Side View End View |
- . - N = a N
o _
{ ek [ESE]J{ Save { Clear[2] || Zoominpzy || B
7 7
; 1
{ Change Scanning Direction... J

10.8.12. Postrocessing
Refer to paragraph 10.1.11 of this Operating Manual
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11. XY Scanning and Recording for Long
Range Inspection
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11.1. FLOORMAP Foreword

FLOORMAP is technology for express ultrasonic screening and mapping of pitting (corrosion) in large
metallic plates either flat or curved. Complete ultrasonic coverage of plate volume is provided by use of
guided waves and does not require scanning above whole surface of the plate. Typical objects under test:

ODoO0oOo

a

Annular plates of storage tanks - inspection from outside

Shell and walls of storage tanks - inspection from outside

Floor plates of storage tanks - inspection from inside

Inaccessible pipe walls — inspection from outside (for example pipe walls above support, coated
pipes, etc.)

Walls of underground storage tanks — inspection from outside

FLOORMAP technology is also useful for encoded scanning with surface wave and angle beam probes

’ FLOORMAP technology package provides screening and
mapping of pitting (corrosion) through:

continuous linear or XY encoded scanning with
guided wave probe at plate end

o]
y ' ’ 0 encoded guided wave probe swiveling at plate end
: 0 combined encoded linear-XY-swiveling scanning at

®

plate end

High degree scattered corrosion, inter-crystal corrosion dropping elastic properties of plate material, coatings
of some types may decrease inspection range

Restrictions

¢ No discrimination between top and reverse side corrosion is possible

e Scanning surface must be free of impurities, welding droplets, surface corrosion and coating (well
bonded paint or coating is acceptable)

e Poor annular plate condition may decrease inspection range
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11.2. Preparations

11.2.1 Placement of receivers of airborne ultrasound behind scanning
area

XY Scanning with swiveling

Fit double emitter of airborne ultrasound S 4050 into clamper located on the top of guided wave probe. Bar
supporting receivers of airborne ultrasound to be placed behind scanning area at parallel to tank shell

Flate Under Test
Scanning Ares

Scanning Strategy

ﬂ|||||||||||||||||||| oL JO

ISONIC 2006 from Sonotron NDT - Operating Manual — Revision 1.21 - Page 415 of 480



Cabling at probe side to be according to sketch and photo below, jumper S 544000 to be used:

| S 70200

S544008

Front Side

Guided Wave Probe Jumper

S 544000

Cabling at the instrument side to be according to paragraph 8.4.1.1 of this Operating Manual

XY Scanning without swiveling

Fit single emitter of airborne ultrasound S 4060 into clamper located on the top of guided wave probe. Bar
supporting receivers of airborne ultrasound to be placed behind scanning area at parallel to tank shell

Plate Under Test

Scanning Ares

Scanning Strategy

a—

ﬂ|||||||||||||||||||| oo (EJE I

(

Baze

Cabling at probe side to be according to sketch below, jumper S 544000 to be used:

ISONIC 2006 from Sonotron NDT - Operating Manual — Revision 1.21 - Page 416 of 480



| S 70200

Guided Wave Probe Jumper

S 544000

Cabling at the instrument side to be according to paragraph 8.4.1.1 of this Operating Manual
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11.2.2 Placement of receivers of airborne ultrasound on tank shell

XY Scanning with swiveling

Fit double emitter of airborne ultrasound S 4055 into clamper located on the top of guided wave probe. Bar
supporting receivers of airborne ultrasound to be placed on tank shell

Plate
Under
Test

. . O ' Scanning Area /

Baze

Cabling at probe side to be according to sketch and photo below, jumper S 544000 to be used:

! S 70200

Front Side

Guided Wave Probe
Jumper

S 544000

Cabling at Instrument site to be according to paragraph 8.4.1.1 of this Operating Manual
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XY Scanning without swiveling

Fit single emitter of airborne ultrasound S 4060 into clamper located on the top of guided wave probe. Bar
supporting receivers of airborne ultrasound to be placed on tank shell

— ] Plate
Shell Undler

Scanning Strategy

— 0

O Scanning A7

Baze

Cabling at probe side to be according to sketch below, jumper S 544000 to be used:

| S 70200

Orange

Fed

Guided Wave Probe Jumper

S 544000

Cabling at Instrument site to be according to paragraph 8.4.1.1 of this Operating Manual
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Fixture S 2045B is required to place receivers of airborne ultrasound on the tank shell:

1. Equipping 2 magnetic legs with elbow

2. Fitting the legs into the receivers bar

4. Equipping cable box with separate magnetic
leg

5. Applying bar with receivers or airborne
ultrasound and cable box on the tank shell
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Distance between two receivers of airborne ultrasound (Basel) is defined as:
Base = Bg + Pos1 + Pos?2

Pos1 and Pos2 are positions of receivers at left and right side of the bar correspondingly;
Bg is parameter of the bar. Long bar only (order code / part # S 2040 B) may be used while working in TOFD
mode: Bo =200 mm /8 in

]

ISOHIC
El

Enter FLOORMAP mode according to paragraph 8.1 of this Operating Manual

FloorMap
A

11.3. Pulser Receiver Settings

UDS53-4 - ISONIC Pulser/Receiver

| 0.5 Gain ‘
52 dB
10 Range
307 mm ‘
50 US Velocity ‘
3020 mfs
0.01 Display Delay ‘
2784 s
H +
L . 5 Reject
W ot . 0 % ‘
[Tl FULSER  RECEIVER  GATEA Menu "Ds’ ?_s
GATE B ALARM  DAC/TCG  MEASURE  Selection
] Value: OFF
Cloze ml FrzPeak ﬁ é

i By | e By | By f = By
vdh dh 4h b 4

I By

Sav

Provide instrument settings according to paragraphs 7.6.1.2 through 7.6.1.4 of this Operating Manual

ESC
To return to previous screen click on __Elose |or press L) on front panel keyboard or or

<Alt>+<C> on external keyboard

I
On completing calibration click on _| or press L on front panel keyboard or on external

keyboard
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11.4. Referring Scanning Area

In the I ielilSElMs) screen it is necessary to enter value of Base — distance between receivers of
airborne ultrasound on the bar, said distance defines length of scanning area. It is also possible to key in
textual comments to be added to inspection report if necessary. Popup screen for that purpose will appear if

b
. C ts
click on lﬂ/

A
Setting of Base to be performed through clicking / pressing spin button ﬂwith Fine, Medium, or Coarse
increments according to checked option (click on) in the Setup Step field

pa—
Alternatively Base for setting to be selected through pressing | = Jon front panel keyboard or on
external keyboard or through clicking on its label. Label indicating name of selected parameter changes it's

T » @

fore color from yellow to white — since that moment parameter may be modified using =/, ' - =/, u../',

_'!;, on front panel keyboard or , , , on external keyboard

_ , _ , l Exit [4] | = }
To return back to XY Scanning Recording and Imaging Menu click on orpress _4 Jor -
on front panel keyboard or or on external keyboard

( esc
To return to previous screen click on ij or press L) on front panel keyboard or on

external keyboard

To continue click on M or press LJ on front panel keyboard or |-d| on external keyboard - this will
elssflProbe Location Monitorj eIk

Inspection Setup

220 - 480 mm [9-19in)

R Y Base
I Comments A00 mm
] (

Iy

Exit [4] {* Coarse ( Medium (" Fine L = Back [ESCIJ l Next >

X-coordinate
=296 mm
L SetZero Line J

[ "y
Probe Location Monitor

X-coordinate
0 mm

L Set Zero Line J

Probe Location Monitor

Exit

Microphones Position

— . . 5
Exit [4] | o [ <Back [ESC] J [ Next> |
—-—

—7—

—

It is necessary to location of bar with receivers of airborne ultrasound — either behind scanning
area or on the tank shell
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Set Zero Line

On completing place guided probe onto selected Zero Line and click on [ J or press or

L ]
Enter |

press ' *=1_ on front panel keyboard on external keyboard

_ _ _ _ l Exit [4] < B ]
To return back to XY Scanning Recording and Imaging Menu click on orpress _4 Jor -
on front panel keyboard or or on external keyboard

( ESC
To return to previous screen click on @ or press L) on front panel keyboard or on

external keyboard

To continue click on @ or press LJ on front panel keyboard or on external keyboard
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11.5. Probe Swiveling Monitor

. . . . . ChetikP_ruhe | { Dun‘|Cf_|ecl_(Pruhe 1
To activate / negate Probe Swiveling Monitor click on Sl / Szl

Swiveling Monitor Status
OFF

Check Probe
Swiveling

Probe Sviweling Monitor

-

< W

Don'‘t Check Probe
Swiveling

&

Swiveling Angle, deg

Angle Limits, deg

——
I Exit [4]

There are two limits for Probe Swiveling Angle to be entered (Angle Limits):

If Min = 0 deg then signals related to insonification of whole sector [- Max ...
+ Max] will be recorded and whole sector image will be provided

- Max +' Max

If Min > 0 deg then: -Min +Min

e Signals related to insonification of sectors [- Max ...— Min] and [+
Min ... + Max] will be recorded and imaging of these two sectors will
be provided

e Signals related to insonification of sector [— Min ...+ Min] will not be
recorded — this allows to avoid recording of echoes from fillet weld
between the shell and annular plate, which may mask the close to
shell pitting (corrosion damage) — for such setting it is necessary to -Max + Max
combine XY scanning and probe swiveling to provide complete
volume insonification and recording

ESC

( Exit [4 ;s
To return back to XY Scanning Recording and Imaging Menu click on lx_“J orpress _4 Jor - C

on front panel keyboard or -4 or on external keyboard

( ESC
To return to previous screen click on M or press L) on front panel keyboard or on

external keyboard

To continue click on M or press LJ on front panel keyboard or on external keyboard

ISONIC 2006 from Sonotron NDT - Operating Manual — Revision 1.21 - Page 424 of 480



11.6. Scanning

Map of inspected volume is accompanied with A-Scan while scanning. Current probe position and swiveling
angle are represented by arrow l, which moves synchronously with probe in the scanning area

B
Gray Thermal Pseudo g
s
X
Clear =
=]
Save = ,
- 1} 50 o0 150 350 400
“( Back [ESC] [ Exit [4] | i
X | F
To cleanup recorded map click on Clea or press LJ on front panel keyboard or on
external keyboard B
ot « | (8
To save FLOORMAP record into a file click on Save or press 22 J on front panel keyboard or

on external keyboard. Refer to paragraph 5.2.17 of this Operating Manual to proceed with file saving

il - Il' e
To return back to XY Scanning Recording and Imaging Menu click on @ orpress _4 Jor &) on
front panel keyboard or or [ESc| on external keyboard

< Bacl Il' Esc
To return to previous screen click on @ or press &) on front panel keyboard or on external
keyboard
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11.7. Postprocessing

Postprocessing may be performed in the instrument or in external computer using IOFFICE SW package.
User interface and operations are practically identical except two features listed below:

Off-line analysis in the
instrument

Off-line analysis in external
computer using IOFFICE

SW Package
Off-line re-adjustment of Gain NO YES
Automatic creation of Inspection report in
MS Word® format NO YES

Menu Bar Functions on Opening File

ISONIC 2006 Floormap

FMO0DO10.i06

e File 2 Print To

O selection of printer among available for printing out inspection report

0 selection of MS Word® as printer to create inspection report as doc file (IOFFICE SW Package only)
O selection of paper sheet size either A4 or Letter

e File = Print — prints complete FLOORMAP inspection report

e File > Exit — ends postprocessing session

e View = Primary Information — previews UDS 3-5 Pulser Receiver settings, inspection setup and
operator's comments if entered at pre-scanning stage stages as it is described in paragraph 11.4 of this

Operating Manual

e View 2> ISONIC Image Processing — activates menu for detailed off-line analysis of the record
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ISONIC Image Processing Menu Bar Functions

| File v|| Wiew v|| Measurements v|| Amplitude Filtration v|| Prafiling v|| Fecover A-Scan v|

. = |50KIC Image Processing Scannlng Fallem

Fi =128
Fl oom

Colaring <=10dB
Pl—

Scannlng F. Black <=8dB
L Cooldmale = Gray - ;= =g |J U <=EdB

[Imm

ISONIC Inspection of Planar Butt Joints

File ~|| View =|| Measurements ~|| Edit ~|| Recover A-Scan ~

Filtration Level: No Scanning Pattern

Filtration

Profiling: OFF

L-Coordinate

[l] mm ]
Projection Length

(0 mm ] 15.0

X-Coordinate 0= !

[0 mm ] 150
Projection Width i}
[[I mm ] <=-6dB
20 o =8de
Y-Coordinate - Depth End Yiew
[l] mm ] o
Projection Height
(omm ] 15.0 150

Top View

#— 0 mm Side View 220 mm—

<=-10dB
«=-12dB

UnderCut i06

e File > Print To
O selection of printer among available for printing out inspection report
0 selection of MS Word® as printer to create inspection report as doc file (IOFFICE SW Package only)
Q selection of paper sheet size either A4 or Letter

e File = Print — prints current postprocessing page
e File > Exit — ends postprocessing session
e View = ISONIC Image Processing — returns to initial postprocessing screen appearing on opening file

e View > Coloring — selection of color scale (palette) style applied to FLOORMAP image
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Measurements - L-Coordinate, Projection Length — generates first vertical cursor that may be

i
guided over FLOORMAP image using either touch screen stylus or mouse or ._), :J on front panel
keyboard or , on external keyboard; coordinate of the first vertical cursor along FLOORMAP image
is indicated in the L-Coordinate field. To fix position of the first vertical cursor left mouse click or release

Enre.r
touch screen stylus or press :J on front panel keyboard or [Enter| on external keyboard. Second
vertical cursor appears upon fixing the first one; it may be manipulated by the same way. Coordinate of

the second vertical cursor along FLOORMAP image measured relatively first vertical cursor is indicated
in the Projection Length field. Provided that vertical cursors are placed properly:

o0 L-Coordinate represents distance between left border of scanning area and selected defect's
end

o0 Projection Length represents appropriate size of defect
To interrupt L-Coordinate and Projection Length measurement procedure at any moment right mouse

ar—
click or press &j on front panel keyboard or on external keyboard

| File vH Wiew v|| Measurments v||ﬂ|tering v|| Wirtual A-Scan v|

Filtration Level: No
Filtration

L-Coordinate

Projection Length

X-Coordinate

Projection Width

Filtration Level: No
Filtration

L-Coordinate

Projection Length

Projection Width

Click left mouse button to end vour measurement
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Measurements > X-Coordinate, Projection Width — generates first horizontal cursor that may be

| /
guided over FLOORMAP image using either touch screen stylus or mouse or !J !) on front panel
keyboard or , on external keyboard; coordinate of the first horizontal cursor along FLOORMAP

image is indicated in the X-Coordinate field. To fix position of the first horizontal cursor left mouse click

Enter
or release touch screen stylus or press :J on front panel keyboard or on external keyboard.
Second horizontal cursor appears upon fixing first one; it may be manipulated by the same way.
Coordinate of the second horizontal cursor along FLOORMAP image measured relatively first horizontal
cursor is indicated in the Projection Width field. Provided that horizontal cursors are placed properly:
o0 X-Coordinate represents distance between scanning zero line and selected defect's end
o Projection Width represents appropriate size of defect

To interrupt X-Coordinate and Projection Width measurement procedure at any moment right mouse

| ESC
click or press &j on front panel keyboard or on external keyboard

| File vH Wiew v|| Measurments v||ﬂ|tering v|| Wirtual A-Scan v|

Filtration Level: No
Filtration

L-Coordinate

Projection Length

X-Coordinate

Projection Width

Filtration Level: No
Filtration

L-Coordinate

Projection Length
163 mm

X-Coordinate

]
o
C

Projection Width

Click left mouse button to end pour measurement
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Measurements - Normalize to DAC > ON — applies DAC normalized color palette to FLOORMAP

data recorded with active DAC and redraws FLOORMAP image correspondingly (dB to DAC
normalization)

[ File +|[ wiew ~][ Measuments +|[ Fitering ~|[ Vitual &-5can ]

L-Coordinate, Projection Length

Filtration Lew:
Filtration #-Coordinate, Prajection Width

L-Coordinate | MNormalize to DAC
96 mm

|

Projection Length

X-Coordinate

Projection Width

Filtration Level: No
Filtration

L-Coordinate
FMO

i

Projection Length

A-Coordinate

Projection Width

| FM000010.i06

Measurements - Normalize to DAC - OFF — negates dB to DAC normalization

®

Applying / negating of dB to DAC normalization negates Filtering
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Filtering = ON — (instrument) or Edit = Filtering = ON (IOFFICE SW Package for external computer)
— generates sliding cursor above amplitude palette bar, which may be controlled using either touch

[ [
screen stylus or mouse or _’_, f.) on front panel keyboard or , on external keyboard. Position of
the sliding cursor on the amplitude palette bar determines filtering level, which is appropriately indicated.

All elements of FLOORMAP image representing signal amplitude below filtering level are suppressed:

[ File «|[ Wiew «|[ Measuments «| [ Fitering +] [ Virtual &-5can +]

Filtration Level: No
Filtration

L-Coordinate

Projection Length

A-Coordinate

Projection Width
-156 mm

Filtration Lewvel: > -6.7
ALARM:

L-Coordinate

FHDI
Projection Length

X-Coordinate

Projection Width

200

100

|FM000010.i06

Filtering = OFF — (instrument) or Edit - Filtering - OFF (IOFFICE SW Package for external
computer) — returns to originally recorded FLOORMAP image
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¢ Edit>Change Gain>0ON — (IOFFICE SW Package for external computer) — generates popup window
allowing off-line re-adjusting of Gain for all data captured during FLOORMAP Scanning in £6dB range

ﬂ
with £0.1 dB increments through clicking or pressing and holding on ‘ or pressing , on keyboard

ISONIC 2005 |

Select Gain Change:

+4.4 dB il

0K Cancel
bay

0].4
Upon completing re-adjusting Gain click on 4| or press on keyboard — this applies

new Gain value to all captured A-Scans and updates FLOORMAP image accordingly

Cancel |
To interrupt re-adjusting of Gain click on or press on keyboard

e Edit=>Change Gain=>0OFF (IOFFICE SW Package for external computer)— negates Gain re-adjustment
and returns to originally recorded FLOORMAP image and original Gain setting
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e Virtual A-Scan>ON — generates positioning vertical cursor that may be manipulated using either touch
screen stylus or mouse simulating positioning of probe along scanning area. To fix positioning vertical
cursor release touch screen stylus or left mouse click — this converts positioning vertical cursor into
direction cursor and fixes mouse pointer at top end of direction cursor. Direction cursor is controllable
using either touch screen stylus or mouse simulating swiveling of probe in selected position. Simulated

position of probe and its swiveling angle are indicated along with recovered A-Scan. To fix direction
cursor release touch screen stylus or left mouse click

[ File «|[ Wiew +][ Measurments v||ﬂ|tering -] [ wirtual -5 can +]

Filtration Level: No
Filtration

L-Coordinate

Projection Length

A-Coordinate

Projection Width

Range = 707 mm
L = 188 mm; Angle = D*

FMO0 7222
|—| File ~|[ Wiew «|[ Measuments v||j|tering -] [ vitual &-5can -

Filtration Level: No
Filtration

L-Coordinate

Projection Length

X-Coordinate

Projection Width

Range = 709 mm
L = 188 mm; Angle = 4.7*

|FM000010.106

e Virtual A-Scan>OFF — negates A-Scan recovery
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12. XY Scanning and Recording for TOFD
Inspection
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12.1. Preparations

Fit emitting and receiving TOFD probes and single emitter of airborne ultrasound into TOFD fixture bar and

provide cabling as below:
| S 70200

Pigtail jurnper
Receiving Ermitting -
TOFD Probe TOFD Probe  Pigtail jumper
= ) —
G||||||||||||||||| ““|““|C|U:|:O:|ZIOD|““|““
i ¢

IS OHIC

Cabling at the instrument side to be
according to paragraph 8.4.1.2 of this
Operating Manual

Apply bar with receivers of airborne
ultrasound at rectangle to weld to be
inspected. Distance between two
receivers or airborne ultrasound
(Basel) is defined as:

Basel = Bg + Posl1 + Pos2

Pos1 and Pos2 are positions of
receivers at left and right side of the
bar correspondingly;

Bg is parameter of the bar. Long bar
only (order code / part # S 2040 B)
may be used while working in TOFD

mode: Bo =200 mm /8 in

Emitting and receiving probes to be
located at opposite sides of the weld,
probe separation Base 2 to be
defined according to paragraph 7.5.1
of this Operating Manual

Longitudinal scanning to be
performed for defects finding;
transversal scanning to be performed
in defects section for evaluation
purposes. Value of Base 1 to be
selected by such way that for both
scanning directions single emitter of
airborne ultrasound will be in the
area limited by virtual lines outgoing
from receivers of airborne ultrasound
at parallel to weld centerline

Enter TOFD mode according to paragraph 8.1 of this Operating Manual

TOFD

Tofd
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12.2. Description Data
Refer to paragraph 9.1.2 of this Operating Manual
12.3. Pulser Receiver Settings

UDS53-4 - ISONIC Pulser/Receiver

0.5 Gain
=
Rt «

1 US Velocit
oo K
0.01 Display Dela
W «

5 Beject
vl
BATE D ALARM _ DAC/TCH _MEASURE _ Selecion uns -5

DEEAEAE-

Save FPrint

T By f e By fina By f = By
v dh dh dbh b 4

I By

~u

=
Open

e
DG5S

L vaue o |
Close | I |

Provide instrument settings according to paragraph 7.5.1 of this Operating Manual

ESC
To return to previous screen click on &' or press L) on front panel keyboard or or

<Alt>+<C> on external keyboard

I
On completing calibration click on or press LJ on front panel keyboard or on external
keyboard
12.4. Probes

Probe |

Probe 1: Probe 2:
5264017 5264017

~Nr el # s =)~ &= cl) &

QIWIEHRTHY (U TO|PI| {

mzxcuhnm,.IEnter

Del BS

( 3 [ 3
Exit l < Back [ESC] l Next =
v

[

Types of emitting and receiving probes to be entered in screen

-

_ , _ , l Exit [4] * = }
To return back to XY Scanning Recording and Imaging Menu click on orpress _4 Jor
on front panel keyboard or or on external keyboard

| ESC
To return to previous screen click on l N [ESC]J or press L) on front panel keyboard or on

external keyboard

To continue click on l next> Jor press LJ on front panel keyboard or |-g| on external keyboard — this
will enter next stage related to defining inspection mode and scanning parameters
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12.5. Scanning Parameters

Inzpection Setup

P R
ﬂ|||||||||||||||\| 01 TR e s s s = SETEEEET | EEEEIERCEINED)

RL|

Inspection Setup

(.

Change Direction
Averaging Region Length [RL) Baze 1 [B1)
OFF 200 mm 280 mm
Baze 2 [B2)
40 mm 20 mm 130 mm %
(e ' )
Exit [4] 1 - GrayScale *|  Coarse @ Medium " Fine l<Ba0k [ESC] l Hex(is

In the [[I]eLIqileJaRSTEINN]s) Screen it is necessary to key in:

O Base 1 - distance between two receivers of airborne ultrasound located on the bar

Base 2 — probes separation

Region Length — length of scanning line

Averaging — Averaging of sequential A-Scans is required sometimes to improve signal to noise

ratio of TOFD record; it may be either inactive (OFF) or setup for factor 2 or 4 or 8

O Weld Thick and Weld Width thickness of parent material and width of weld metal correspondingly,
these parameters to be entered for documenting purposes only

00D

A
Setting of said parameters to be performed through clicking / pressing corresponding spin button ﬂwith
Fine, Medium, or Coarse increments according to checked option (click on) in the Setup Step field

fa—
Alternatively parameter for setting may be selected through pressing ' —*\ Jon front panel keyboard or
on external keyboard or through clicking on its label. Label indicating name of selected parameter changes
t » 4-

it's fore color from yellow to white — since that moment parameter may be modified using —/, ——~/, .

!L, on front panel keyboard or , , , on external keyboard
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It is also necessary to select scanning direction either along or across the weld through clicking on

%
l Change Direction i
o — the appropriate

indication is provided

Style of palette applied to TOFD Map (Thermal or Gray) is selectable through clicking @:

1 - Gray5cale -

) . . . l Exit [4] A - l
To return back to XY Scanning Recording and Imaging Menu click on orpress _4 Jor -
on front panel keyboard or or on external keyboard

| ESC
To return to previous screen click on M or press L) on front panel keyboard or on

external keyboard

To continue click on M or press LJ on front panel keyboard or on external keyboard

12.6. Referring Scanning Area
While screen is active place probe pair into starting point of selected scanning line

) { Set Zero Point J
then click on

Probe Location Monitor

¥-coordinate L-coordinate
| 129 mm | 325 mm

[ Set Zero Point

the Location Monitor

A-coordinate L-coordinate
0 mm 0 mm

{ Set Zero Point

" ] " 3 ]
[ Exit [4] [<Back [ESC] L Hext >
r 4
N
I Exit [4] ;o Ef?
To return back to XY Scanning Recording and Imaging Menu click on orpress _4 Jor .

on front panel keyboard or -4 or on external keyboard

( ESC
To return to previous screen click on M or press L) on front panel keyboard or on

external keyboard

To continue click on M or press LJ on front panel keyboard or on external keyboard

12.7. Imaging Principles
TOFD Map is recorded as RF B-Scan — refer to paragraph 7.5 of this Operating Manual
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12.8. Scanning

To cleanup TOFD Map field and start scanning click on E or press {L on front panel keyboard or
on external keyboard

During scanning current probe position is represented by special marks:
. ® _ scanning is performed along current line selected
"

o a4 — unacceptable transversal displacements of probe pair respectively selected scanning line,
no record performing; it is necessary to return to selected scanning line
e X —unacceptable longitudinal displacement of probe pair respectively selected scanning line, no

record performing; it is necessary to return to selected scanning line

2192 p=

26 496 ps

o

an 100 140 200
Exit [4]

[C{

[ < Back [ESC]

[ Stop [ESC] [ S!e

200

[(Back[ESC][ Exit [4]

o | EsC
To complete or interrupt scanning click on @ or press &j on front panel keyboard or on

external keyboard

(5] | &
To save TOFD record into a file click on D or press @J on front panel keyboard or on

external keyboard. Refer to paragraph 5.2.17 of this Operating Manual to proceed with file saving
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( Exit [4] - | e
To return back to XY Scanning Recording and Imaging Menu click on\ ,orpress _4 _Jor \_)‘(\ on
front panel keyboard or or ESc|on external keyboard

. Back [ESC] 3
To return to previous screen click on l e or press \_)‘(\ on front panel keyboard or on external
keyboard

12.9. Postrocessing

Refer to paragraph 7.5.2.5 of this Operating Manual
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13. Incremental Encoders

ISONIC 2006 from Sonotron NDT - Operating Manual — Revision 1.21 - Page 441 of 480



13.1. Standard Encoder SK 2001108 ABI

Encoder SK 2001108 ABI is originally designed for BScan(Th) and ABISCan recording with ISONIC 2001,
ISONIC 2005, and ISONIC 2006 instruments. It does not require calibration for using with these instruments
(recognized as default encoder)

To start with encoder follow simple guidance as below
Step 1

Fit probe into appropriate probe holder and connect
signal cable(s) to probe

l' s
ETTITTF A

Step 2

Fit probe holder with probe into encoder

Step 3

Connect probe signal cable(s) to appropriate coaxial
socket on ISONIC 2006 unit — refer to paragraph 4.2
of this Operating Manual

Connect encoder data cable to the appropriate D-
Type connector on rear panel of ISONIC 2006 unit —
refer to paragraph 4.2 of this Operating Manual
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13.2. Standard Encoder SK 2001108 FM

Encoder SK 2001108 FM is originally designed for TOFD and FLOORMAP L recording with ISONIC 2001,
ISONIC 2005, and ISONIC 2006 instruments. It does not require calibration if using with these instruments
(recognized as default encoder). To start with encoder follow simple guidance as below

13.2.1. TOFD

Insert ultrasonic probes into their probe holders then:

O Fit probe holders with probes on TOFD bar and fix them at at necessary separation distance

O Fix twister S 904050 on the TOFD bar

O Fit encoder SK 2001108 FM into twister S 904050 and provide necessary orientation of encoder's
wheel — it must be oriented at parallel to the desired probes' trace either along or across the weld —
refer to the sketch and photos below

Basze

77
O 70w

Encoder

Encoder Wheel

TOFD Fixture and encoder positioning
for scanning along the weld

TOFD Fixture and encoder positioning
for scanning across the weld
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13.2.2. FLOORMAP L

Encoder SK 2001108 FM allows 2 ways of direct fitting of S 544 series guided wave probes or other probes

fitted into appropriate probe holders:

O Both encoder's wheel and probe contact face are situated on scanning surface:

Fitting probe into encoder

Ready to scan

a Encoder's wheel is situated on surface, which is rectangular to scanning surface:

Fitting probe into encoder

Ready to scan
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13.3. Customized Encoders for Proprietary Inspection Tasks

Various custom made encoders for proprietary inspection tasks may be used with ISONIC 2006. For
appropriate encoder data cable and connector pinout contact
O Nearest Sonotron NDT representative
OR

O Directly to Sonotron NDT — mail to Support@sonotronndt.com with subject ISONIC 2006
encoder connection

®

Improper cable outcoming from custom made encoder for proprietary inspection tasks may lead to
warranty exempted damaging ISONIC 2006 unit

13.4. Encoder Calibration

Custom made encoder must be calibrated once for further use with ISONIC 2006

[1]|operate

[ 2 |settings

[ 3 |Exit To Windows

|4 |shut Down

Fa

To proceed with the calibration in the ISONIC 2006 start screen or press 2 on front panel

keyboard or -2 on external keyboard

[ 1 ]international

[2|pisplay Settings

Positioning Devices

] Printer Selection

F]Back

! |
In the appeared ISONIC 2006 Settings Menu or press _3 J on front panel keyboard or on
external keyboard
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| 1|Airborne Velocity

lz‘ Encoders

[ 3 |Back

Fa

In the appeared ISONIC 2006 Positioning Devices Menu |c|ick onl or press _2_J on front panel keyboard

or on external keyboard

In the appeared ISONIC Encoder Settings window or press <Alt>+<A> on external keyboard

ISONIC Encoder Settings

Fiegiztered Encoders:

Eemame
Tiesf

[Ealitarate..

o
o
e

Hemave

aE, | Cancel

The Calibrate Encoder window appears; it contains simple instructions to follow:

Cahbrate Encoder I Cahbrate Encoder I
= Place the Encoder &t Zero Point and click on Step 1 \f Place the Encoder at Zera Point and click on Step 1
Mowe the Encoder to End Poirt and click on Step 2 = hove the Encoder to End Point and click on Step 2

Fero Point End Point Fero Point End Point
{+300 mm} {+300 mm}

Stepizil| | W8tep 1J resat_| |
Cancel | - Cancel |

Encoder’s wheel while calibrating must pass linearly the distance of 300 mm (12 in) between Zero Point
designated through clicking on Step 1 or pressing <Alt>+<1> on external keyboard and End Point along
scale bar attached to flat surface

Hestart |
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Upon reaching End Point and clicking on Step 2 button or pressing <Alt>+<2> on external keyboard new
Encoder Test window appears

®

If it's necessary to re-designate Zero Point click on Restart button or press <Alt>+<R> on external
keyboard

In the Encoder Test window:

a Click on Reset button or press <Alt>+<R>
on external keyboard to designate local

zero point for confinuing test EncoderTest |

L ]
Enter |

O Click on Yes button or press ' *=_ on front

panel keyboard or or <Alt>+<Y> on I -3.0 mm Beset
external keyboard to name the selected -
encoder — Key in the Encoder Name
window appears Click on Yes if the shown coordinate i canrect.

Clizk on Mo to recalibrate the Encoder.
- Mo |

Encader Coardinate:

ESC
a Click on No button or press L) on front

panel keyboard or press or <Alt>+<N>
on external keyboard to recalibrate the
encoder — return to Calibrate Encoder

window
Key in the Encoder Hame Ed
IMyNewEncnder

SHEBBRARERENRRERD
Qfwl e R T e o o[ e S—

Reaiztered Encoders:
ANSHDHUFHUGHHIJ KL Bl ek ncoder

mzxchNM<>
Test...

Save | Cancel Calibrate. ..

Bemove

Rename

o=l

41

] | LCancel

Upon keying in new Encoder name ISONIC Encoder Settings window returns upon

L ]
Enter |

To update the registry of ISONIC 2006 with new encoder data click on the OK button or press ' *=_ on

front panel keyboard or or <Alt>+<Y> on external keyboard — this will automatically return to ISONIC
2006 Settings Menu
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ISONIC Encoder Settings

Feqistered Encoders:

byl 2wk nicoder

Fename

Test...

b |

Bemove |

aE. | LCancel |

While running encoder calibration next time:

a

a

Click on Add... button or press <Alt>+<A> on external keyboard to proceed with next new encoder by
the same way as described above

Click on Rename button or press <Alt>+<N> on external keyboard to rename the selected encoder

Click on Test button or press <Alt>+<T> on external keyboard to check the accuracy of selected
encoder calibration

Click on Calibrate button or press <Alt>+<L> on external keyboard to recalibrate selected encoder

Click on Remove button or press <Alt>+<R> on external keyboard to remove selected encoder from the
registry of ISONIC 2006

ESC
Click on the Cancel button or press L) on front panel keyboard or press or <Alt>+<C> on
external keyboard to negate all changes and return to ISONIC 2006 Settings Menu
Ente.r |
Click on the OK button or press ' *=_J on front panel keyboard or or <Alt>+<K> on external
keyboard to update the registry of ISONIC 2006 and return to ISONIC 2006 Settings Menu
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14. Calibrating Airborne Ultrasound
Based Probe Location and Swiveling
Monitor
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Airborne ultrasound based probe location and swiveling monitor used for XY scanning and recording in the
ISONIC 2006 to be calibrated prior to working shift. During working shift calibration to be performed

repeatedly only for 10°C varying of ambient temperature; to proceed follow instructions below:

[1]|operate

2 | settings

3 |Exit To Windows

|4 |shut Down

I

;|
In the ISONIC 2006 start screen or press -2 on front panel keyboard or on external
keyboard

[ 1 ]international

[2]pisplay settings

Positioning Devices

1 Printer Selection

F]Back

. - |
In the appeared ISONIC 2006 Settings Menu Ic ick onI or press _3 J on front panel keyboard or on
external keyboard

| 1|Airborne Velocity

lz‘ Encoders
’

[ 3 |Back \
;o

In the appeared ISONIC 2006 Positioning Devices Menu or press ' _1 _J on front panel keyboard
or on external keyboard — the screen as below appears

ISONIC Airtbome Ultrasound Yelocity Setup

Current Airborne US Yelocity Current Hesult i
18 mm Get Short Distance [1]
330 mjls b J
Current Airborne Zero Offset N [ Get Long Distance [2]
18 mm Short Base L P

{ Repeat [3] J Sh'Bmm Close [Esc]
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Step 1 \ S 70200
Place airborne ultrasound receivers on the bar in

positions 10 and 70 mm and provide cabling
according to sketch. Cabling at instrument side to
be according to paragraph 8.4.1.1 of this
Operating Manual. On completing click on

Get Short Distance [1] - )
orpress _1 J on front panel

keyboard or on external keyboard

70mm 10 mmCEE

Step 2
Place airborne ultrasound receivers on the bar in 3 2 f1ail

positions 10 and 130 mm and provide cabling
according to sketch. Cabling at instrument side to
be according to paragraph 8.4.1.1 of this
Operating Manual. On completing click on

F
or press 2 on front panel

keyboard or on external keyboard — this will
complete calibration procedure

Get Long Distance [2] J

. , =
. . . R t
To repeat calibration click on { speat Bl , Or press 3 Jon front panel keyboard or on external

keyboard

[ ESC
On completing calibration click on { Close [Esc] J or press L) on front panel keyboard or on
external keyboard
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15. Miscellaneous
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15.1. International Settings

[1|operate

[ 2 |settings

[ 3 |Exit To Windows

|4 |shut Down

F
In the ISONIC 2006 start screen or press 2 J on front panel keyboard or on external

keyboard

[ 1 ]international
[2]pisplay setings

[3] Positionin#)evices

IE] Printe r/alec‘lion

5‘ Back

/

-
In the appeared ISONIC 2006 Settings Menu or press LJ on front panel keyboard or on
external keyboard , the International Settings screen appears:

E‘Language [§

[ 2|measurement Unit

[ 3 |Back

rd | ESC
or press 3 o Q on front panel keyboard or

To return to ISONIC 2006 Settings Menu

or on external keyboard
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15.1.1. Language

-,
In the International Settings screen or press ' on front panel keyboard or F1 on external

keyboard

ISONIC Language Selection |

Select language then

®

Standard languages of ISONIC 2006 ate English and German. Other languages are available upon request
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15.1.2. Metric and Imperial Units

E‘Language [3

[ 2|measurement Unit
/ [ 3 |Back
F

. . - |
In the International Settings screen or press 2 on front panel keyboard or on external
keyboard

Measurement Unit:
1 | © Metric

2 | 2 Imperial

Cancel |

/

Select measurement units then |c|ick onl
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15.2. Display Settings

[ 1 ]international

[2]pisplay settings

E‘Encoders

lz‘ Printer Selection

|?]Back

>,
In the ISONIC 2006 Settings Menu or press 2 on front panel keyboard or [F2| on external
keyboard

15.2.1. A-Scan Color Scheme

[1]A-scan Colors

| 2 |ToFD Display

’Eﬂack

o )
In the Display Settings Menu |c|ick onl or press ' _J on front panel keyboard or on external keyboard

Select A-5can Color Scheme:

Black =]

Black

then mark the selected color scheme

then

Select A-Scan Color Scheme:

Black =]

Save Cancel

To negate new selection |click on
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®

There are 4 A-Scan Color Schemes available:

Gain% 5 Gain%

28.5 dB - 28.5 dB
Value: Ao Value: Ao
-10.7 dB -10.7 dB

Gains Gains

28.5dB 28.5dB

Value: AV 4 Value: AV 4

-10.7 dB -10.7 dB
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15.2.2. TOFD Display Settings

[1]A-scan Colors

| 2 |ToFD Display

@Bauk

F
In the Display Settings Menu or press LJ on front panel keyboard or on external keyboard
then check the selected options:

Imaging Settings |

— TOFD Imaging
~ Logic — Contrast
) Negative > Natural
 Soft
= Positive @® Sharp

[ Save Cancel
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®

Natural Contrast TOFD Display

Negative

256 brightness levels of TOFD Map from absolutely white to absolutely black are distributed for RF signals,
which's half waves do vary from minus 100% to plus 100% of A-Scan display height. Positive half wave
signals equal or exceeding plus 100% of A-Scan display height are represented by absolutely black color.
Negative half wave signals equal or exceeding minus 100% of A-Scan display height are represented by
absolutely white color

Positive

256 brightness levels of TOFD Map from absolutely black to absolutely white are distributed for RF signals,
which's half waves do vary from minus 100% to plus 100% of A-Scan display height. Positive half wave
signals equal or exceeding plus 100% of A-Scan display height are represented by absolutely white color.
Negative half wave signals equal or exceeding minus 100% of A-Scan display height are represented by
absolutely black color

Negative Positive
+200% +200%

+ 100% + 100%
a a

é é

@f @f
agﬂ agﬂ
P base line 0% P base line 0%
¢ ¢
v v
g g

- 100% - 100%
- 200% - 200%
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®

Soft Contrast TOFD Display

Negative

256 brightness levels of TOFD Map from absolutely white to absolutely black are distributed for RF signals,
which's half waves do vary from minus 200% to plus 200% of A-Scan display height. Positive half wave
signals equal or exceeding plus 200% of A-Scan display height are represented by absolutely black color.
Negative half wave signals equal or exceeding minus 200% of A-Scan display height are represented by
absolutely white color

Positive

256 brightness levels of TOFD Map from absolutely black to absolutely white are distributed for RF signals,
which's half waves do vary from minus 200% to plus 200% of A-Scan display height. Positive half wave
signals equal or exceeding plus 200% of A-Scan display height are represented by absolutely white color.
Negative half wave signals equal or exceeding minus 200% of A-Scan display height are represented by
absolutely black color

Negative Positive

+200% +200%

+ 100% + 100%
i i

& &

M 4 f 4
éﬁﬁ éa@
p base line 0% p base line 0%
1¢ ¢
2
JiﬁirJ ,Jiﬁi

- 100% - 100%

- 200% - 200%
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®

Sharp Contrast TOFD Display

Negative

256 brightness levels of TOFD Map from absolutely white to absolutely black are distributed for RF signals,
which's half waves do vary from minus 50% to plus 50% of A-Scan display height. Positive half wave
signals equal or exceeding plus 50% of A-Scan display height are represented by absolutely black color.
Negative half wave signals equal or exceeding minus 50% of A-Scan display height are represented by
absolutely white color

Positive

256 brightness levels of TOFD Map from absolutely black to absolutely white are distributed for RF signals,
which's half waves do vary from minus 50% to plus 50% of A-Scan display height. Positive half wave
signals equal or exceeding plus 50% of A-Scan display height are represented by absolutely white color.
Negative half wave signals equal or exceeding minus 50% of A-Scan display height are represented by
absolutely black color

Negative Positive
+200% +200%
+100% +100%
o A
é é
g o
@ﬂ +50% 9” +50%,
5 5
" [ base line 0% , P base line 0%
I I
Ji?ip Jiﬁipr
50% 50%
-100% -100%
- 200% - 200%
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15.3. Printer Selection

This option is available if there are more than 1 printer drivers installed in ISONIC 2006

[1]|operate

[ 2 |settings

[ 3 |Exit To Windows

|4 |shut Down

lf?

In the ISONIC 2006 start screen or press 2 on front panel keyboard or [F2 on external

keyboard

[ 1 ]international

[2]pisplay settings

E‘Encoders

lz‘ Printer Selection

5 Back

-

In the appeared ISONIC 2006 Settings Menu or press _,‘.'_JI on front panel keyboard or on
external keyboard

Select Printer:
HP Laserlet 6P -

Save Cancel | A,

Select printer then
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15.4. Exit to Windows

[1]|operate

[ 2 |settings

[ 3 |Exit To Windows

|4 |shut Down

-
or press > _J on front panel keyboard or on external

In the ISONIC 2006 start screen
keyboard

%]
el
[ ey e

N

located in the Windows Desktop

To return to ISONIC 2006 Operation double click on icon 2l

®

Exit to Windows is required for:
a Connection to network
0 Printing inspection results to network printer
o Transferring data to / from remote PC

O Installing printer driver(s)
O Installing USB memory stick (disk on key) driver (for ISONIC 2006 instruments running under

Windows 98 SE Operating System)
O Quasi-disk management
In order to prevent overloading of ISONIC 2006 quasi-disk and memory with data and non ISONIC 2006
software that may affect instrument performance it's not allowed to install non ISONIC 2006 software except
drivers noted above. Affecting of instrument performance through installing on non ISONIC 2006 software
except drivers noted above is the warranty exemption damage

15.5. Connection to Network

To connect ISONIC 2006 to local area network using Ethernet connector (refer to paragraph 4.2 of this
Operating Manual) and standard Windows rules
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15.6. External USB Devices
15.6.1. Mouse

Use one of 2 USB Connectors (refer to paragraph 4.2 of this Operating Manual). ISONIC 2006 founds and
registers external USB mouse automatically through standard Windows routine. Microsoft optical mouse is
recommended

15.6.2. Keyboard

Use one of 2 USB Connectors (refer to paragraph 4.2 of this Operating Manual). ISONIC 2006 founds and
registers USB keyboard automatically through standard Windows routine. Microsoft keyboard is
recommended

15.6.3. Memory Stick (Disk on Key)

Use one of 2 USB Connectors (refer to paragraph 4.2 of this Operating Manual)

ISONIC 2006 running under Windows XP Embedded founds and registers USB memory stick (disk on key)
automatically through standard Windows routine.

For ISONIC 2006 instruments running under Windows 98 SE preliminary driver setup is required. To install
driver use network connection (refer to paragraph 8.5 of this Operating Manual)

15.6.4. Printer

Use one of 2 USB Connectors (refer to paragraph 4.2 of this Operating Manual). Preliminary driver setup is
required. To install driver use network connection (refer to paragraph 8.5 of this Operating Manual) or USB
memory stick (disk on key) if it's already registered in ISONIC 2006
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15.6.5. ISONIC Alarmer
For a variety of manual and automatic inspection applications it may be necessary:

genrating sound alarm on defect detection

controlling some external devices, such as sorters, multi-element go/no go display panels, etc
starting inspection and recording process upon receiving triggering signal from an external device
etc

A variety of above tasks is resolved by simple ISONIC Alarmer (part # SE 554780987), which is interfaced
to ISONIC 2005, 2006, 2007, 2008 instrument through USB port

®

e |SONIC Alarmer may be connected to the instrument at any moment since ISONIC 2005 Start
Screen became active (refer to paragraph 4.3 of this Operating Manual)

e ISONIC Alarmer may be disconnected from the instrument at any moment prior to shut down (refer
to paragraph 4.3 of this Operating Manual)
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ISONIC Alarmer includes:

Internal Speaker, which is switched ON / OF according to alarm logic settings of UDS 3-5 Pulser
Receiver in the ISONIC 2005, 2006, 2007 instruments / UDS 3-6 Pulser Receiver of ISONIC 2008
Instrument

Speaker Volume Control Wheel

Headphone Connector

Input / Output Control chip

25-pin programmable Input / Output interface

Input / Output 25-pin programmable Input
Controller Chip / Output interface

Internal
Speaker

USB Port for Headphone Speaker Volume
connection to ISONIC Connector Control Wheel
2005, 2006, 2007,

2008 Instrument

Initially ISONIC Alarmer is configured to deliver sound through speaker and headphone connector (standard
configuration)

25-pin input / output interface is configured according to the duty book, which is agreed with the customer
(optional configuration)
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Standard configuration pin-out of 25-pin input / output interface D-Type connector is shown below:

3
_ 0
GBI o 27_GND
GB2__15
~GB3 3| _Oo 26 GND
— T .°
—Tme T °
—GB 5 1.°
J
GAD 18 °
GAL__6 0
GAr 101 °
GA3 7 0
—_——0
—GasgT©
—Ga6 o1 1 °
Al o 1.°
— > [ °
o O
PR
11 0
P
P PR
%510
E] O
_o
/ ~
D Comnector 25
Pin Function

Numbe

Ground

Alarm Gate B — Channel 1 (Only Channel for ISONIC 2005, 2006)

Alarm Gate B — Channel 3

Alarm Gate B — Channel 5

Alarm Gate B — Channel 7

Alarm Gate A — Channel 1 (Only Channel for ISONIC 2005, 2006)

Alarm Gate A — Channel 3

Alarm Gate A — Channel 5

Alarm Gate A — Channel 7

NC

NC

NC

NC

Alarm Gate B — Channel 0

Alarm Gate B — Channel 2

Alarm Gate B — Channel 4

Alarm Gate B — Channel 6

Alarm Gate A — Channel 0

Alarm Gate A — Channel 2

Alarm Gate A — Channel 4

Alarm Gate A — Channel 6

NC

NC

NC

NINNNNN (R (R (R(R PR Rk
g~ W|N|P|O|o|m|~N|o|o|r|w|N|k|o|©R (N o0~ IWIN -

NC
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15.7. External VGA screen / VGA projector
Connect to appropriate connector (refer to paragraph 4.2 of this Operating Manual) while at least one of 2

devices either ISONIC 2006 or external screen / projector is switched OFF then switch on one or both
devices

15.8. Software Upgrade

Refer to http://www.sonotronndt.com/support.htm in the Internet

15.9. ISONIC Office Software package for office PC

ISONIC Office (IOFFICE) software package allows performing of all-function postprocessing for all types of
inspection files (XY scanning, Line scanning, par files) captured using ISONIC 2006 in an office PC. If
Microsoft Word is installed in an office PC then postprocessing snapshots including all graphics and
accompanying setup and / or measurement data may be converted into the Microsoft® Word (.doc) file
automatically
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15.10. ISONIC Par2Txt Converter Software package
®

Contents of this chapter is valid for the ISONIC Par2Txt Converter SW Package version 2.0.0.1 or higher

ISONIC Par2Txt Converter converts variously configured *.par files created by ISONIC 2001, ISONIC
2005, ISONIC 2006, ISONIC 2007, ISONIC 2008 instruments into *.txt files. Both pure A-Scans and A-
Scans accompanied with frequency domain (FFT) graphs are presented in ASCII format in *.txt files. This
allows further off-line signal analysis using popular software packages Mathlab, Labview, and the like

T
iy
15

Click on Start then select Programs = ISONIC = ISONIC Par2Txt Converter or click on [2]

in the desktop to run ISONIC Par2Txt Converter - window as below appears:
r

i AES

icon located

=) ISONIC 2005 Backup Disk | | File Mame | File Type | A
) ISONIC 2005 Results 29 PUDOOD34.PAR ISONIC 2005 PAR File
) ABIScan Inspection 22 PLIODO035.PAR ISONIC 2005 PAR File
) BScan(Th) Inspection 29 PLI0O003E PAR ISONIC 2005 PAR File
() Floormapl. Inspection 29 PLOD0037.PAR ISONIC 2005 P&R File
— t‘“BISEE'”hI”SDEE“D'? 22 PLIOO003E PAR ISONIC 2005 FAR File
— E'gf&""“ E i”‘-‘”E‘EfE‘” 20 pLI0N0033 PR ISONIC 2005 P&R File
= T_D,Sgrlr,:jpect?;:ec o 29 PUO00040 AR ISONIC 2005 PAR File
- pec 2% PUDOOD41 . PAR ISONIC 2005 PAR File
) t-TOFD Inspection 20 ‘ ;
o [ 22 PUDDOO42 PR ) ISONIC 2005 PAR File
~ [5ONIC 2006 22 PLIOOOD43 ARy ISONIC 2005 PAR File
20 .
) 150NIC Backup Disk. 93 PLIOOD044 AR ISONIC 2005 AR File
=) ISOMIC Hardware and Firmaware o, | | 05 PUOD004ZRAR ISONIC 2005 PAR File
- o2 PUOO0Z4E PAR ISOMIC 2005 F&R File

£ *

20 mmgem i m e Pt R e et a P

— W Convert to Text

+

[ 'l 4, l |
Wit WELE AR A Exit
r T L |r|

NT TR R TRRTIN L RYRUE v

Select the [file of interest] then |click on|
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L& ISONIC Par2Txt Convertor,

5) I50MIC 2005 Backup Disk,
0) I50MIC 2005 Results
() ABIScan Inspection
\5) BScan(Th) Inspection
\.5) Floormapl Inspection
() t-ABIScan Inspection
() t-BScan{Th) Inspection
) t-FloormapL Inspection
) TOFD Inspection
) E-TOFD Inspection
) UDS 3-5 Pulser Receiver
) I5ONIC 2006
[5) 150MIC Backup Disk:
[[5) I50MIC Hatdware and Firmaware ..

< ?

As a result the corresponding |*.txt file} appears

File: M arne File Type ~

52 PLIDDNN34. PAR
20 PUDDON35.PAR
29 PUD00D3G. AR
§2 PLIOO0OT. PR
2% PUIOO003E PAR
22\ U000039.PAR
00040, PAR
100041, PAR
PLIOOO04T. TT

29 PUDO0D4Z PAR
20 PUDD0D43.PAR
20 PUOD0044. PAR
&2 PLIDDNN4G. PAR

Z0 s e

ISOMIC 2005 P4R File
ISONIC 2005 FP4R File
ISONIC 2005 PAR File
ISOMIC 2005 F4R File
ISONIC 2005 PAR File
ISOMIC 2005 P4R File
ISONIC 2005 PAR File
I! 05 P&4R File
Text File
ISONIC 2005 PAR File
ISOMIC 2005 F4R File
ISONIC 2005 PAR File
ISOMIC 2005 P4R File

Tt e s R R ]

Exit

0 ISOMIC 2005 Results
) ABIScan Inspection
5) BScan(Th) Inspection
=) Floormapl Inspection
) t-ABIScan Inspection
5) t-BScan(Th) Inspection
() t-Floormapl Inspection
() TOFD Inspection
) E-TOFD Inspection
) UDS 3-5 Pulser Receiver

() ISOMIC 2008

5 ISOMIC Backup Disk

0 ISOMIC Hardware and Firmaware o

< ks

) [SOMIC 2005 Backup Disk. -

29 plNo0on36.PAR
20 pUNDOD3T.PAR
28 PUONDIOZE FAR
22 PUODND3S.PAR

& Looo0a, . Te=T
29 PUODDN4Z.PAR
22 PLIODDD43.PAR
29 PUODON44.PAR
29 PLO0ODUS. PAR

20~ mnenae ma e

Filk Mame File: Type -
22 RUoo0034.PaR ISONIC 2005 PAR File
22 PAIDDDD35.PaR ISOMIC 2005 P4R File

ISONIC 2005 PAR File
ISOMIC 2005 PAR File
ISONIC 2005 PAR File
ISOMIC 2005 PAR File
ISONIC 2005 PAR File
ISONIC 2005 PAR File

ISONIC 2005 PAR File
ISOMIC 2005 PAR File
ISONIC 2005 PAR File
ISONIC 2005 PAR File

[Tt R nintn n it s ]

To end ISONIC Par2Txt Converter session

Open

Exit
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15.11. ISONIC D-Line and ISONIC D-Spreadsheet Creator
Software Packages

15.11.1 t-BScan(Th)/BScan(Th) files

ISONIC D-Line and ISONIC D-Spreadsheet Creator software packages for office computer equipped with
Microsoft®Office allow converting of t-BScan(Th)/BScan(Th) files (special format *.bsi) into Microsoft® Excel
(.xIs) spreadsheet file

ISONIC D-Line

Click on Start then select Programs =* ISONIC = ISONIC D-Line or click on E icon located in the
desktop to run ISONIC D-Line

e File > Open allows selection and loading of *.bsi format t-BScan(Th)/BScan(Th) data file

“%: ISONIC D-Linuk

=% ISONIC D-Line
File RiOI

File Name:

Scanned Region Lend

Required L-Resolutio 0

File Name:

BS00001 bsi

Scanned Region Length: 100 mm

Required L-Resolution:
| sctual (0.2 mm)

—L —

Create Excel® File
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On completing download:

e ROI = ON — generates cursor representing sound path of probe's central beam in the object under test
that may be guided over t-BScan(Th) / BScan(Th) image using either mouse or , buttons on
keyboard — corresponding A-Scan is recovered synchronously according to cursor position. To select

reference A-Scan left mouse click or press |[Enter|on external keyboard — this generates off-line Gate

A controls n n n n u n allowing to redefine Region Of Interest for t-BScan(Th)

/ BScan(Th) imaging

“%: ISONIC D-Line
File ROI

File Name:

BS00001 bsi

Scanned Region Length: 100 mm

+ o+ o+ o+ o+ o+ o+

Required L-Resolution:
| ctual 0.2 mm) ~|

+
+
+
+
+
+
+
+

o+ttt ot ot o+t

B

Create Excel® File

Upon completing redefining of Region Of Interest click on — this applies new Gate A to all
captured A-Scans and updates t-BScan(Th) / BScan(Th) image accordingly

To interrupt selection of reference of A-Scan right mouse click or press on keyboard

To interrupt re-adjustment of Region Of Interest after selection of reference of A-Scan click on

e ROI>OFF — negates Gate A re-adjustment and returns to originally recorded t-BScan(Th) / BScan(Th)
image and original Gate A setting
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“%; ISONIC D-Line

File ROI

File Name:

BS00001 bsi

Scanned Region Length: 100 mm

Required L-Resolution:
| sctual (~0.2 mm) |
Actual [~0.2 mm)]
0.5

Create Excel® File

4

. |Required L—Resolutionl — this control allows selecting of necessary longitudinal scanning coordinate

increments for depth spreadsheet to be created. Best possible resolution (actual) corresponding to
minimal possible increment is default — it corresponds to single depth reading per each coordinate. On
selecting coordinate increment larger than actual ISONIC D-Line software will analyze all depth

readings with actual resolution for each interval covered by selected increment and place minimal values
into corresponding cells

#

5

—
1 Lancel

File Name:

BS00001. bsi
Scanned Region Length: 100 mm

Required L-Resolution:
|1 mm ﬂ

Create Excel® File

e Create Excel® File — clicking on this button will initiate automatic creation of spreadsheet followed by
starting Microsoft® Excel software

e File>Exit — quits ISONIC D-Line software
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ISONIC D-Spreadsheet Creator

Click on Start then select Programs = ISONIC = ISONIC D-Spreadsheet Creator or click on E icon
located in the desktop to run ISONIC D-Spreadsheet Creator

SONIC D-Spreadsheet Creator
File:

File Name:

i ISONIC D-Spreadsheet Creator;

Scanned Region L

Required L-Resol

Scanned Region W

Required X-Resol

File Name:

Example 01.bsi

Scanned Region Length: 100 mm

Required L-Resolution:
| ictual (0.2 mm) |

Create Excel® File

e File > Open allows selection and loading of *.bsi format t-BScan(Th)/BScan(Th) data file

All further operations are identical to above described for ISONIC D-Line
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15.11.2 CORROMAP, CORROMAP CU, MULTISCAN COMBO S, and
MULTISCAN COMBO S CU Files

ISONIC D-Spreadsheet Creator software packages for office computer equipped with Microsoft®Office
allows converting of CORROMAP, CORROMAP CU, MULTISCAN COMBO S, and MULTISCAN COMBO
S CU files (format *.rst) into Microsoft® Excel (.xIs) spreadsheet file

Click on Start then select Programs = ISONIC = ISONIC D-Spreadsheet Creator or click on E icon
located in the desktop to run ISONIC D-Spreadsheet Creator

e File > Open allows selection and loading of *.rst format CORROMAP, CORROMAP CU, MULTISCAN
COMBO S, and MULTISCAN COMBO S CU files data file:

i [SONIC D-Spreadsheet Creator,
File ROI

File Name: Top View - Depth

Godrich - RF.i06 °

Inspection Type: -
ISONIC Multiscan-Combo-5

Scanned Region Length: 300 mm

Required L-Resolution:

| ctual (113 mm) -] g
—1L — ®
0 mm 200 mm
Side View
Scanned Region Width: 300 mm =
—_— = —
Required X-Resolution: | T - e - .-__-__'
[Actual (1,90 mm) = o = ==
o End View

Create Excel® File

3z
']
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On completing download:

ROI = ON — generates probe center cursor that may be guided over CORROMAP, CORROMAP CU,
MULTISCAN COMBO S, or MULTISCAN COMBO S CU image using either mouse or 5, <, [,
buttons on keyboard — corresponding A-Scan is recovered synchronously according to cursor position.

To select reference A-Scan left mouse click or press Enter on external keyboard - this generates off-

line Gate A controls n n n n u n allowing to redefine Region Of Interest for

CORROMAP, CORROMAP Cu, MULTISCAN COMBO S, or MULTISCAN COMBO S CU imaging

£ [SONIC D-Spreadsheet Creator;
File ROI

Top ¥Yiew - Depth

300

14

3.3

Upon completing redefining of Region Of Interest click on — this applies new Gate A to all
captured A-Scans and updates CORROMAP, CORROMAP CU, MULTISCAN COMBO S, or
MULTISCAN COMBO S CU image accordingly

To interrupt selection of reference of A-Scan right mouse click or press on keyboard

To interrupt re-adjustment of Region Of Interest after selection of reference of A-Scan click on

ROI2>OFF - negates Gate A re-adjustment and returns to originally recorded CORROMAP,
CORROMAP CU, MULTISCAN COMBO S, or MULTISCAN COMBO S CU image and original Gate A
setting

ISONIC 2006 from Sonotron NDT - Operating Manual — Revision 1.21 - Page 476 of 480



ISONIC D-Spreadsheet Creator

File ROI

File Name: Top View - Depth

Godrich - RF.i06 "

Inspection Type: . 2 .
ISOMIC Multiscan-Combo-S

Scanned Region Length: 300 mm

Required L -Resolution:
|2 i j

300

—L —A
o mm 300 mm

Side View

Scanned Region Width: 300 mm

14

Required X-Resolution:

T
%
L

| Actual [~1.90 mm] |

3.3

4

|Required L-Resolution and X-Resolutionl — these controls allow selecting of necessary coordinate
increments for depth spreadsheet to be created. Best possible resolution (actual) corresponding to
minimal possible increment is default — it corresponds to single depth reading per each coordinate. On
selecting coordinate increment larger than actual ISONIC D-SHEET software will analyze all depth

readings with actual resolution for each interval covered by selected increment and place minimal values
into corresponding cells

%ﬂr" Craathi i@

File Name: Top View - Depth
Godrich - RF.i06 B g l

Inspection Type: .
ISONIC Multiscan-Combo-5

Scanned Region Length: 300 mm

Required L-Resolution:
5
=
] 300 mm
Side Vi

Scanned Region Width: 300 LCancel ki
Required X-Resolution: | T =

x o
| _J L o

Create Excel® File — clicking on this button will initiate automatic creation of spreadsheet followed by
starting Microsoft® Excel software

File>EXxit — quits ISONIC D-SHEET software
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15.12. Charging Battery

Battery of ISONIC 2006 may be charged while disconnected from the unit. The special charger is required
(refer to Chapter 3 of this Operating Manual). Connect charger to the battery as it is shown below

— T

i

There is Charge LED on the charger. While charging the battery this LED emits solid light. Charge LED
starts flashing upon charge is completed

®

If a battery is new and almost completely discharged then "boiling" effect in the electrolyte may start earlier
than battery is fully charged. In order to prevent battery charger stops on detecting boiling "boiling" effect:

O |If temperature inside battery does not exceed 60°C deg limit then Charge LED starts flashing — for
such case it is necessary to disconnect charger from mains for few minutes and to connect it to
mains again. The normal charging will continue

Q If temperature inside battery exceeds 60°C deg limit then Temp LED starts flashing — for such case
it is necessary to disconnect charger from mains for at least 2 hours and to connect it to mains
again. The normal charging will continue

After few charge / discharge cycles battery becomes "trained" and probability of "boiling" effect decreases to
almost zero
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16. Dual Channel TOFD preamplifier
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SA 80442 Fixed Gain Dual Channel

Preamplifier Package from Sonotron NDT

improves long cable connection to

ultrasonic probes, which may be required

in NDT practice very often. Typical
applications are TOFD, Corrosion
Detection, and the like implemented
through use of probes fitted into the
scanner / crawler frame

Technical Data:
Independent Channels

Frequency Band

Advanced Low Noise Design

Gain
Output Impedance
Output Driving Capacity — Cable Length

Terminals

Power

Flashing LED Indicators

Housing
Dimensions

Weight

0.2...25 MHz at -3dB

34 nV peak to peak input referred to 20 dB gain / 25
MHz bandwidth

20dB
50 Q
<30m

Input 2 X LEMO 00
Output 2 X LEMO 01

4 X Dry Alkaline Batteries AA Size
Channel 1 Switch ON

Channel 2 Switch ON

Low Battery

Sealed IP 67 Rugged Aluminum Case
62 X 30X 112mm (2.44 X 1.18 X4.4")

320 g (0.7 Ibs)
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